SIIr
CISCO.

(]
!
Z
=

B

-]

H
+

AsyncOS 9.1 for Cisco Web Security
Appliances User Guide

Published: March 14, 2016

Cisco Systems, Inc.
WWW.Cisco.com

Cisco has more than 200 offices worldwide.
Addresses, phone numbers, and fax numbers
are listed on the Cisco website at
www.cisco.com/go/offices.


http://www.cisco.com
http://www.cisco.com/go/offices

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL
STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT
SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE
OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public
domain version of the UNIX operating system. All rights reserved. Copyright 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF
DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING,
WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO
OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this
URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership
relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display
output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in
illustrative content is unintentional and coincidental.

AsyncOS 9.1 for Cisco Web Security Appliances User Guide
© 2016 Cisco Systems, Inc. All rights reserved.


http://www.cisco.com/go/trademarks

CONTENTS

cHAPTER 1 Introduction to the Product and the Release 1-1
Introduction to the Web Security Appliance  1-1
What's New  1-1

Using the Appliance Web Interface  1-1
Web Interface Browser Requirements ~ 1-2
Enabling Access to the Web Interface on Virtual Appliances  1-2
Accessing the Appliance Web Interface  1-2
Committing Changes in the Web Interface  1-3
Clearing Changes in the Web Interface  1-3
The Cisco SensorBase Network — 1-3
SensorBase Benefits and Privacy  1-4
Enabling Participation in The Cisco SensorBase Network ~ 1-4

CHAPTER 2 Connect, Install, and Configure 2-1
Overview of Connect, Install, and Configure  2-1
Deploying a Virtual Appliance  2-2
Migrating from a Physical to a Virtual Appliance  2-2
Task Qverview for Connecting, Installing, and Configuring ~ 2-2
Connecting the Appliance  2-2
Gathering Setup Information  2-4
System Setup Wizard ~ 2-5
System Setup Wizard Reference Information ~ 2-6
Network / System Settings ~ 2-6
2-7
Network / Network Interfaces and Wiring ~ 2-7
2-7
Network / Routes for Management and Data Traffic ~ 2-8
Network / Transparent Connection Settings ~ 2-8
Network /Administrative Settings  2-8
Comparison of Modes of Operation  2-9
Upstream Proxies  2-9
Upstream Proxies Task Overview — 2-10

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g




M Contents

Creating Proxy Groups for Upstream Proxies  2-10
Network Interfaces  2-11

IP Address Versions 211

Enabling or Changing Network Interfaces  2-12

Configuring Failover Groups for High Availability — 2-14
Add Failover Group  2-14
Edit High Availability Global Settings  2-15
View Status of Failover Groups ~ 2-15
Using the P2 Data Interface for Web Proxy Data  2-15
Configuring TCP/IP Traffic Routes ~ 2-16
Modifying the Default Route  2-17
Adding a Route  2-18
Saving and Loading Routing Tables  2-18
Deleting a Route ~ 2-18
Configuring Transparent Redirection ~ 2-18
Specifying a Transparent Redirection Device  2-18
Configuring WCCP Services ~ 2-19
Increasing Interface Capacity Using VLANs ~ 2-22
Configuring and Managing VLANs ~ 2-22
Redirect Hostname and System Hostname ~ 2-24
Changing the Redirect Hostname  2-25
Changing the System Hostname ~ 2-25
Configuring SMTP Relay Host Settings ~ 2-25
Configuring an SMTP Relay Host ~ 2-26
DNS Settings  2-26
Split DNS  2-26
Clearing the DNS Cache 2-26
Editing DNS Settings  2-27

Troubleshooting Connect, Install, and Configure  2-28

cHAPTER 3 Connect the Appliance to a Cisco Cloud Web Security Proxy  3-1
Comparison of Cloud Connector Mode and Standard Mode ~ 3-1
How to Configure and Use Features in Cloud Connector Mode ~ 3-4
Deployment in Cloud Connector Mode ~ 3-4
Configuring the Cloud Connector  3-5
Controlling Web Access Using Directory Groups in the Cloud 3-8
Bypassing the Cloud Proxy Server 3-8
Partial Support for FTP and HTTPS in Cloud Connector Mode 3-8

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

Preventing Loss of Secure Data  3-9
Viewing Group and User Names and IP Addresses  3-9
Subscribing to Cloud Connector Logs ~ 3-9

Identification Profiles and Authentication with Cloud Web Security Connector ~ 3-10
Identifying Machines for Policy Application  3-10
Guest Access for Unauthenticated Users ~ 3-11

Intercepting Web Requests  4-1

Overview of Intercepting Web Requests ~ 4-1
Tasks for Intercepting Web Requests  4-2
Best Practices for Intercepting Web Requests  4-2

Web Proxy Options for Intercepting Web Requests  4-3
Configuring Web Proxy Settings ~ 4-3
Web Proxy Cache 4-5
Clearing the Web Proxy Cache ~ 4-5
Removing URLs from the Web Proxy Cache  4-5
Specifying Domains or URLs that the Web Proxy never Caches  4-6
Choosing The Web Proxy Cache Mode ~ 4-7
Web Proxy IP Spoofing  4-8
Web Proxy Custom Headers  4-8
Adding Custom Headers To Web Requests ~ 4-8
Web Proxy Bypassing ~ 4-9
Web Proxy Bypassing for Web Requests  4-9
Configuring Web Proxy Bypassing for Web Requests ~ 4-10
Configuring Web Proxy Bypassing for Applications ~ 4-10
Web Proxy Usage Agreement  4-10
Client Options for Redirecting Web Requests ~ 4-10

Troubleshooting Intercepting Requests ~ 4-11

Acquire End-User Credentials 5-1

Overview of Acquire End-User Credentials ~ 5-1
Authentication Task Overview — 5-2

Authentication Best Practices  5-2

Authentication Planning  5-2
Active Directory/Kerberos  5-3
Active Directory/Basic ~ 5-4
Active Directory/NTLMSSP  5-5
LDAP/Basic  5-5

Async0S 9.1 for Cisco Web Security Appliances User Guide g



M Contents

Identifying Users Transparently — 5-5
Understanding Transparent User Identification ~ 5-6
Rules and Guidelines for Transparent User Identification ~ 5-9
Configuring Transparent User Identification  5-9

Using the CLI to Configure Advanced Transparent User Identification Settings

Configuring Single-Sign-on  5-10
Authentication Realms ~ 5-11
External Authentication  5-11
Configuring External Authentication through an LDAP Server ~ 5-11
Enabling RADIUS External Authentication ~ 5-12
Creating an Active Directory Realm for Kerberos Authentication Scheme

How to Create an Active Directory Authentication Realm (NTLMSSP and Basic)
Prerequisites for Creating an Active Directory Authentication Realm (NTLMSSP and Basic)

About Using Multiple NTLM Realms and Domains  5-14

Creating an Active Directory Authentication Realm (NTLMSSP and Basic)

Creating an LDAP Authentication Realm  5-16
About Deleting Authentication Realms  5-21
Configuring Global Authentication Settings ~ 5-21
Authentication Sequences  5-26
About Authentication Sequences  5-27
Creating Authentication Sequences — 5-27
Editing And Reordering Authentication Sequences — 5-28
Deleting Authentication Sequences  5-28
Failed Authentication  5-28
About Failed Authentication  5-29
Bypassing Authentication with Problematic User Agents ~ 5-29
Bypassing Authentication  5-31

Permitting Unauthenticated Traffic While Authentication Service is Unavailable

Granting Guest Access After Failed Authentication  5-31
Define an Identification Profile that Supports Guest Access — 5-32
Use an Identification Profile that Supports Guest Access in a Policy
Configure How Guest User Details are Logged ~ 5-32

Failed Authorization: Allowing Re-Authentication with Different Credentials

About Allowing Re-Authentication with Different Credentials  5-33

Allowing Re-Authentication with Different Credentials ~ 5-33
Tracking Identified Users ~ 5-33

Supported Authentication Surrogates for Explicit Requests  5-34

Supported Authentication Surrogates for Transparent Requests — 5-34

Tracking Re-Authenticated Users  5-34

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

Credentials  5-35
Tracking Credentials for Reuse During a Session ~ 5-35
Authentication and Authorization Failures  5-36
Credential Format  5-36
Credential Encryption for Basic Authentication  5-36
About Credential Encryption for Basic Authentication  5-36
Configuring Credential Encryption  5-36

Troubleshooting Authentication  5-37

cHAPTER 6 Classify End-Users and Client Software 6-1
Overview of Classify Users and Client Software ~ 6-1
Classify Users and Client Software: Best Practices  6-2
Identification Profile Criteria  6-2

Classifying Users and Client Software  6-3
Enable/Disable an Identity  6-8

|dentification Profiles and Authentication  6-8

Troubleshooting Identification Profiles  6-9

cHAPTER 7 SaaS$ Access Control  7-1
Overview of SaaS Access Control  7-1
Configuring the Appliance as an Identity Provider ~ 7-2
Using SaaS Access Control and Multiple Appliances  7-4
Creating SaaS Application Authentication Policies  7-4
Configuring End-user Access to the Single Sign-on URL ~ 7-6

cHAPTER 8 Integrate the Cisco Identity Services Engine  8-1

Overview of the Identity Services Engine Service  8-1
About pxGrid 81
About the ISE Server Deployment and Failover  8-2

Identity Services Engine Certificates  8-2

Using Self-signed Certificates  8-3

Using CA-signed Certificates  8-3
Tasks for Certifying and Integrating the ISE Service  8-3
Connect to the ISE Services  8-6

Troubleshooting Identity Services Engine Problems  8-7

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g s |



M Contents

CHAPTER 9

Classify URLs for Policy Application  9-1

Overview of Categorizing URL Transactions ~ 9-1
Categorization of Failed URL Transactions ~ 9-2
Enabling the Dynamic Content Analysis Engine  9-2
Uncategorized URLs ~ 9-2
Matching URLs to URL Categories  9-3
Reporting Uncategorized and Misclassified URLs ~ 9-3
URL Categories Database  9-3
Configuring the URL Filtering Engine ~ 9-4
Managing Updates to the Set of URL Categories  9-4
Understanding the Impacts of URL Category Set Updates  9-5
Effects of URL Category Set Changes on Policy Group Membership
Effects of URL Category Set Updates on Filtering Actions in Policies
Merged Categories - Examples ~ 9-6
Controlling Updates to the URL Category Set  9-7
Manually Updating the URL Category Set ~ 9-7
Default Settings for New and Changed Categories  9-8
Verifying Existing Settings and/or Making Changes ~ 9-8
Receiving Alerts About Category and Policy Changes  9-8
Responding to Alerts about URL Category Set Updates  9-8
Filtering Transactions Using URL Categories  9-9
Configuring URL Filters for Access Policy Groups ~ 9-9
Configuring URL Filters for Decryption Policy Groups  9-11
Configuring URL Filters for Data Security Policy Groups ~ 9-12
Creating and Editing Custom URL Categories ~ 9-13

Filtering Adult Content ~ 9-15
Enforcing Safe Searches and Site Content Ratings ~ 9-15
Logging Adult Content Access  9-16
Redirecting Traffic in the Access Policies  9-17
Logging and Reporting  9-17
Warning Users and Allowing Them to Continue ~ 9-17
Configuring Settings for the End-User Filtering Warning Page  9-18
Creating Time Based URL Filters ~ 9-19
Viewing URL Filtering Activity  9-19
Understanding Unfiltered and Uncategorized Data  9-19
URL Category Logging in Access Logs ~ 9-20
Regular Expressions  9-20
Forming Regular Expressions  9-20

9-5
9-5

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



cuaprter 10

cuaprTer 11

Contents W

Guidelines for Avoiding Validation Failures ~ 9-21
Regular Expression Character Table — 9-22

URL Category Descriptions ~ 9-23

Create Policies to Control Internet Requests  10-1
Overview of Policies: Control Intercepted Internet Requests  10-1
Managing Web Requests Through Policies Task Overview — 10-2
Managing Web Requests Through Policies Best Practices ~ 10-2
Policies  10-2
Policy Types  10-3
Policy Order  10-5
Creating a Policy ~ 10-5
Adding and Editing Secure Group Tags for a Policy  10-8
Policy Configuration ~ 10-8
Block, Allow, or Redirect Transaction Requests  10-9
Client Applications  10-10
About Client Applications ~ 10-10
Using Client Applications in Policies  10-10
Exempting Client Applications from Authentication ~ 10-11
Time Ranges and Volume Quotas  10-12
Volume Quota Calculations  10-12
Time Quota Calculations  10-13
Defining Time and Volume Quotas  10-13
Access Control by URL Category  10-14
Creating Custom URL Categories  10-14
Using URL Categories to Identify Web Requests ~ 10-15
Using URL Categories to Action Web Request  10-16
Remote Users  10-16
About Remote Users  10-17
How to Configure Identification of Remote Users  10-17
Configuring Identification of Remote Users ~ 10-17
Display Remote User Status and Statistics for ASAs  10-18
Troubleshooting Policies  10-19

Create Decryption Policies to Control HTTPS Traffic  11-1

Overview of Create Decryption Policies to Control HTTPS Traffic ~ 11-1
Managing HTTPS Traffic through Decryption Policies Task Overview — 11-2

Managing HTTPS Traffic through Decryption Policies Best Practices  11-2

Async0S 9.1 for Cisco Web Security Appliances User Guide g



M Contents

Decryption Policies  11-2
Enabling the HTTPS Proxy  11-3
Controlling HTTPS Traffic  11-4
Configuring Decryption Options ~ 11-4
Authentication and HTTPS Connections  11-5
Root Certificates  11-5
Managing Certificate Validation and Decryption for HTTPS ~ 11-6
Valid Certificates  11-6
Invalid Certificate Handling  11-6
Uploading a Root Certificate and Key  11-7
Generating a Certificate and Key for the HTTPS Proxy  11-7
Configuring Invalid Certificate Handling  11-8
Options for Certificate Revocation Status Checking  11-9
Enabling Real-Time Revocation Status Checking  11-9
Trusted Root Certificates  11-10
Adding Certificates to the Trusted List ~ 11-10
Removing Certificates from the Trusted List  11-11

Routing HTTPS Traffic  11-1
Troubleshooting Decryption/HTTPS/Certificates  11-11

cHarTER 12 Scan Outbound Traffic for Existing Infections 121

Overview of Scanning Outbound Traffic 121
User Experience When Requests Are Blocked by the DVS Engine  12-1

Understanding Upload Requests  12-2
Criteria for Group Membership ~ 12-2
Matching Client Requests to Outbound Malware Scanning Policy Groups

Creating Outbound Malware Scanning Policies  12-3
Controlling Upload Requests  12-4
Logging of DVS Scanning  12-6

cuarter 13 Configuring Security Services  13-1
Overview of Configuring Security Services — 13-1
Overview of Web Reputation Filters  13-2
Web Reputation Scores  13-2
Understanding How Web Reputation Filtering Works ~ 13-2
Web Reputation in Access Policies  13-3
Web Reputation in Decryption Policies 13-4
Web Reputation in Cisco IronPort Data Security Policies 13-4

12-2

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

Overview of Anti-Malware Scanning 13-4
Understanding How the DVS Engine Works 13-4
Working with Multiple Malware Verdicts ~ 13-5
Webroot Scanning  13-5
McAfee Scanning  13-6
Matching Virus Signature Patterns  13-6
Heuristic Analysis  13-6
McAfee Categories  13-7
Sophos Scanning  13-7
Understanding Adaptive Scanning  13-7
Adaptive Scanning and Access Policies  13-7
Enabling Anti-Malware and Reputation Filters  13-8
Configuring Anti-Malware and Reputation in Policies  13-9
Anti-Malware and Reputation Settings in Access Policies  13-10
Configuring Anti-Malware and Reputation Settings with Adaptive Scanning Enabled  13-10
Configuring Anti-Malware and Reputation Settings with Adaptive Scanning Disabled  13-11
Configuring Web Reputation Scores  13-12
Configuring Web Reputation Score Thresholds for Access Policies  13-13
Configuring Web Reputation Filter Settings for Decryption Policy Groups ~ 13-13
Configuring Web Reputation Filter Settings for Data Security Policy Groups ~ 13-13
Maintaining the Database Tables  13-14
The Web Reputation Database  13-14
Logging of Web Reputation Filtering Activity and DVS Scanning  13-14
Logging Adaptive Scanning  13-14
Caching 13-14

Malware Category Descriptions ~ 13-16

cuarTer 14 File Reputation Filtering and File Analysis  14-1
Overview of File Reputation Filtering and File Analysis ~ 14-1
File Threat Verdict Updates  14-1
File Processing Overview  14-2
Supported Files for File Reputation and Analysis Services  14-3
Archive or Compressed File Processing  14-4
Privacy of Information Sent to the Cloud  14-4

Configuring File Reputation and Analysis Features  14-5
Requirements for Communication with File Reputation and Analysis Services ~ 14-5
Routing Traffic to File Reputation and File Analysis Servers Through a Data Interface  14-6
Configuring an On-Premises File Analysis Server ~ 14-6
Enabling and Configuring File Reputation and Analysis Services  14-7

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g o |




M Contents

(Public Cloud File Analysis Services Only) Configuring Appliance Groups ~ 14-9
Which Appliances Are In the Analysis Group?  14-9
Configuring File Reputation and Analysis Service Action Per Access Policy ~ 14-10
Ensuring That You Receive Alerts About Advanced Malware Protection Issues  14-10
Configuring Centralized Reporting for Advanced Malware Protection Features  14-11
File Reputation and File Analysis Reporting and Tracking ~ 14-11
Identifying Files by SHA-256 Hash  14-11
File Reputation and File Analysis Report Pages  14-12
Viewing File Reputation Filtering Data in Other Reports ~ 14-13
About Web Tracking and Advanced Malware Protection Features  14-13
Taking Action When File Threat Verdicts Change  14-13

Troubleshooting File Reputation and Analysis ~ 14-14
Log Files  14-14
Several Alerts About Failure to Connect to File Reputation or File Analysis Servers — 14-14
API Key Error (On-Premises File Analysis)  14-15
Files are Not Uploaded As Expected  14-15
File Analysis Details in the Cloud Are Incomplete  14-15
Alerts about File Types That Can Be Sent for Analysis  14-16

cuarTer 15 Managing Access to Web Applications  15-1
Overview of Managing Access to Web Applications ~ 15-1

Enabling the AVC Engine  15-2
AVC Engine Updates and Default Actions ~ 15-2
User Experience When Requests Are Blocked by the AVC Engine  15-3
Policy Application Control Settings ~ 15-3
Range Request Settings ~ 15-3
Rules and Guidelines for Configuring Application Control ~ 15-4
Configuring Application Control Settings in an Access Policy Group ~ 15-5
Controlling Bandwidth  15-5
Configuring Overall Bandwidth Limits ~ 15-6
Configuring User Bandwidth Limits ~ 15-6
Configuring the Default Bandwidth Limit for an Application Type ~ 15-7
Overriding the Default Bandwidth Limit for an Application Type ~ 15-7
Configuring Bandwidth Controls for an Application ~ 15-7

Controlling Instant Messaging Traffic ~ 15-8
Viewing AVC Activity  15-8
AVC Information in Access Log File  15-9

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



cuapter 16 Prevent Loss of Sensitive Data  16-1

Overview of Prevent Loss of Sensitive Data ~ 16-1
Bypassing Upload Requests Below a Minimum Size  16-2
User Experience When Requests Are Blocked As Sensitive Data  16-2

Managing Upload Requests  16-2
Managing Upload Requests on an External DLP System  16-3

Evaluating Data Security and External DLP Policy Group Membership  16-4
Matching Client Requests to Data Security and External DLP Policy Groups ~ 16-4

Creating Data Security and External DLP Policies  16-5
Managing Settings for Upload Requests  16-7
URL Categories  16-8
Web Reputation  16-8
Content Blocking  16-8
Defining External DLP Systems  16-9
Configuring External DLP Servers  16-9
Controlling Upload Requests Using External DLP Policies ~ 16-11

Logging of Data Loss Prevention Scanning ~ 16-12

cuarter 17 Notify End-Users of Proxy Actions  17-1
End-User Notifications Overview — 17-1
Configuring General Settings for Notification Pages  17-2

End-User Acknowledgment Page  17-2
Access HTTPS and FTP Sites with the End-User Acknowledgment Page  17-3
About the End-user Acknowledgment Page  17-3
Configuring the End-User Acknowledgment Page ~ 17-3
End-User Notification Pages  17-5
Configuring On-Box End-User Notification Pages  17-6
Off-Box End-User Notification Pages  17-7
Displaying the Correct Off-Box Page Based on the Reason for Blocking Access
URL Criteria for Off-Box Notification Pages  17-7
Off-Box End-User Notification Page Parameters  17-7
Redirecting End-User Notification Pages to a Custom URL (Off-Box) 17-8
Configuring the End-User URL Filtering Warning Page  17-9
Configuring FTP Notification Messages  17-9

Custom Messages on Notification Pages  17-10
Supported HTML Tags in Custom Messages on Notification Pages  17-10
Caveats for URLs and Logos in Notification Pages  17-11

Contents W

17-1

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g



M Contents

Editing Notification Page HTML Files Directly ~ 17-12
Requirements for Editing Notification HTML Files Directly ~ 17-12
Editing Notification HTML Files Directly ~ 17-12
Using Variables in Notification HTML Files  17-13
Variables for Customizing Notification HTML Files ~ 17-13

Notification Page Types  17-15

cuarTer 18 Generate Reports to Monitor End-user Activity 18-1
Overview of Reporting ~ 18-1
Working with Usernames in Reports ~ 18-1
Report Pages ~ 18-2
Using the Reporting Tab ~ 18-2
Changing the Time Range  18-2
Searching Data  18-3
Choosing Which Data to Chart  18-4
Custom Reports ~ 18-4
Modules That Cannot Be Added to Custom Reports ~ 18-4
Creating Your Custom Report Page  18-5
Subdomains vs. Second-Level Domains in Reporting and Tracking
Printing and Exporting Reports from Report Pages ~ 18-5
Exporting Report Data  18-6

Enabling Centralized Reporting  18-7

Scheduling Reports ~ 18-7
Adding a Scheduled Report  18-7
Editing Scheduled Reports ~ 18-8
Deleting Scheduled Reports ~ 18-8
Generating Reports On Demand ~ 18-8

Archived Reports  18-9

cuarter 19 Web Security Appliance Reports  19-1
Overview Page  19-1
System Capacity Page  19-2
System Status Page  19-3

cHarTer 20 Detecting Rogue Traffic on Non-Standard Ports  20-1
Overview of Detecting Rogue Traffic 201
Configuring the L4 Traffic Monitor ~ 20-1
List of Known Sites ~ 20-2

18-5

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

Configuring L4 Traffic Monitor Global Settings ~ 20-2
Updating L4 Traffic Monitor Anti-Malware Rules  20-2

Creating a Policy to Detect Rogue Traffic ~ 20-3
Valid Formats  20-4
Viewing L4 Traffic Monitor Activity ~ 20-4
Monitoring Activity and Viewing Summary Statistics  20-4
L4 Traffic Monitor Log File Entries  20-5

cHarTer 21 Monitor System Activity Through Logs 211

Overview of Logging 211

Common Tasks for Logging  21-2

Best Practices for Logging  21-2

Troubleshooting Web Proxy Issues Using Logs ~ 21-2

Log File Types  21-3

Adding and Editing Log Subscriptions ~ 21-7

Pushing Log Files to Another Server  21-11

Archiving Log Files ~ 21-11

Log File Names and Appliance Directory Structure  21-12
Reading and Interpreting Log Files  21-12

Viewing Log Files  21-13

Web Proxy Information in Access Log Files — 21-13
Transaction Result Codes ~ 21-16

ACL Decision Tags ~ 21-16
Interpreting Access Log Scanning Verdict Entries  21-20
W3C Compliant Access Log Files  21-24
W3C Field Types ~ 21-24
Interpreting W3C Access Logs  21-24
W3C Log File Headers ~ 21-25
W3C Field Prefixes  21-25
Customizing Access Logs ~ 21-26
Access Log User Defined Fields ~ 21-26
Customizing Regular Access Logs ~ 21-27
Customizing W3C Access Logs ~ 21-27
Traffic Monitor Log Files  21-28
Interpreting Traffic Monitor Logs ~ 21-28

Log File Fields and Tags ~ 21-28
Access Log Format Specifiers and W3C Log File Fields  21-29

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g s |



M Contents

Malware Scanning Verdict Values  21-37

Troubleshooting Logging  21-38

CHAPTER 22 Perform System Administration Tasks 22-1

Overview of System Administration  22-1

Saving, Loading, and Resetting the Appliance Configuration

Viewing and Printing the Appliance Configuration
Saving the Appliance Configuration File  22-2
Loading the Appliance Configuration File  22-3

Resetting the Appliance Configuration to Factory Defaults

Working with Feature Keys  22-3
Displaying and Updating Feature Keys — 22-4
Changing Feature Key Update Settings ~ 22-4
Virtual Appliance License  22-4
Installing a Virtual Appliance License  22-5
Enabling Remote Power Management  22-5
Administering User Accounts ~ 22-6
Managing Local User Accounts ~ 22-6
Adding Local User Accounts  22-7
Deleting User Accounts ~ 22-8
Editing User Accounts ~ 22-8
Changing Passphrases  22-8
RADIUS User Authentication — 22-8
Sequence of Events For Radius Authentication

Enabling External Authentication Using RADIUS

Defining User Preferences  22-10

Configuring Administrator Settings ~ 22-11

Setting Passphrase Requirements for Administrative Users
Additional Security Settings for Accessing the Appliance

Resetting the Administrator Passphrase  22-13
Managing Alerts  22-14
Alert Classifications and Severities  22-14
Managing Alert Recipients  22-14
Adding and Editing Alert Recipients  22-14
Deleting Alert Recipients  22-15
Configuring Alert Settings ~ 22-15
Alert Listing  22-16
Feature Key Alerts  22-16

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

Hardware Alerts  22-17
Logging Alerts ~ 22-17
Reporting Alerts  22-18
System Alerts  22-20
Updater Alerts  22-21
Anti-Malware Alerts ~ 22-21

FIPS Compliance  22-21
FIPS Certificate Requirements ~ 22-22
Enabling or Disabling FIPS Mode  22-22
System Date and Time Management =~ 22-22
Setting the Time Zone ~ 22-23
Synchronizing the System Clock with an NTP Server ~ 22-23

SSL Configuration  22-23

Certificate Management ~ 22-24

About Certificates and Keys ~ 22-25

Managing Trusted Root Certificates  22-25

Certificate Updates  22-25

Viewing Blocked Certificates ~ 22-26

Uploading or Generating a Certificate and Key ~— 22-26
Uploading a Certificate and Key  22-26
Generating a Certificate and Key — 22-26
Certificate Signing Requests ~ 22-27
Intermediate Certificates ~ 22-27

AsyncOS for Web Upgrades and Updates  22-28
Best Practices For Upgrading AsyncOS for Web  22-28
Upgrading and Updating AsyncOS and Security Service Components  22-28
Upgrading AsyncOS for Web  22-28
Automatic and Manual Update and Upgrade Queries  22-29
Manually Updating Security Service Components  22-29
Local And Remote Update Servers — 22-30
Updating and Upgrading from the Cisco Update Servers — 22-30
Upgrading from a Local Server ~ 22-30
Differences Between Local and Remote Upgrading Methods ~ 22-32
Configuring Upgrade and Service Update Settings ~ 22-32
Reverting to a Previous Version of AsyncOS for Web  22-33
Reverting AsyncOS on Virtual Appliances Impacts the License ~ 22-33
Configuration File Use in the Revert Process  22-34
Reverting AsyncOS for an Appliance Managed by the SMA  22-34
Reverting AsyncOS for Web to a Previous Version — 22-34

Async0S 9.1 for Cisco Web Security Appliances User Guide g



M Contents

Monitoring System Health and Status Using SNMP  22-35
MIB Files  22-36
Enabling and Configuring SNMP Monitoring  22-36
Hardware Objects  22-36
SNMP Traps ~ 22-36
About the connectivityFailure SNMP Trap ~ 22-37
CLI Example: snmpconfig  22-37

appenpix A Troubleshooting  A-1
General Troubleshooting Best Practices  A-1
Authentication Problems ~ A-2
Troubleshooting Tools for Authentication Issues ~ A-2
Failed Authentication Impacts Normal Operations ~ A-2
LDAP Problems  A-2
LDAP User Fails Authentication due to NTLMSSP  A-2
LDAP Authentication Fails due to LDAP Referral ~ A-3
Basic Authentication Problems ~ A-3
Basic Authentication Fails  A-3
Single Sign-On Problems ~ A-3
Users Erroneously Prompted for Credentials ~ A-3
Browser Problems  A-4
WPAD Not Working With Firefox — A-4

DNS Problems ~ A-4
Alert: Failed to Bootstrap the DNS Cache ~ A-4

Feature Keys Expired  A-4
Failover Problems  A-4
Failover Issues on Virtual Appliances  A-5
FTP Problems  A-5
URL Categories Do Not Block Some FTP Sites  A-5
Large FTP Transfers Disconnect  A-5
Zero Byte File Appears On FTP Servers After File Upload  A-6
Chrome Browser Not Detected As User Agent in FTP-over-HTTP Requests ~ A-6
Hardware Issues  A-6
Cycling Appliance Power ~ A-6
Appliance Health and Status Indicators ~ A-6
Alert: Battery Relearn Timed Out (RAID Event) on 380 or 680 Hardware  A-6
HTTPS/Decryption/Certificate Problems ~ A-6
Accessing HTTPS Sites Using Routing Policies with URL Category Criteria ~ A-7
HTTPS Request Failures  A-7

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

HTTPS with IP-based Surrogates and Transparent Requests ~ A-7

Bypassing Decryption for Particular Websites ~ A-7
Alert: Problem with Security Certificate  A-8

Logging Problems  A-8
Custom URL Categories Not Appearing in Access Log Entries  A-8
Logging HTTPS Transactions ~ A-8
Alert: Unable to Maintain the Rate of Data Being Generated ~ A-9
Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs  A-9

Policy Problems  A-9
Access Policy not Configurable for HTTPS ~ A-9
Blocked Object Problems ~ A-10
Some Microsoft Office Files Not Blocked ~ A-10
Blocking DOS Executable Object Types Blocks Updates for Windows OneCare  A-10
Identification Profile Disappeared from Policy ~ A-10
Policy Match Failures  A-10
Policy is Never Applied  A-10

HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication ~ A-11

User Matches Global Policy for HTTPS and FTP over HTTP Requests ~ A-11
User Assigned Incorrect Access Policy  A-11
Problems with File Reputation and File Analysis ~ A-12
Reboot Issues  A-12
Virtual Appliance Running on KVM Hangs on Reboot  A-12
Hardware Appliances: Remotely Resetting Appliance Power ~ A-12

Site Access Problems  A-13
Cannot Access URLs that Do Not Support Authentication ~ A-13
Cannot Access Sites With POST Requests ~ A-13
Upstream Proxy Problems ~ A-14
Upstream Proxy Does Not Receive Basic Credentials ~ A-14
Client Requests Fail Upstream Proxy — A-14
Unable to Route FTP Requests Via an Upstream Proxy ~ A-14
Virtual Appliances ~ A-15
Do Not Use Force Reset, Power Off, or Reset Options During AsyncOS Startup ~ A-15
Network Connectivity on KVM Deployments Works Initially, Then Fails ~ A-15
Slow Performance, Watchdog Issues, and High CPU Usage on KVM Deployments ~ A-15
General Troubleshooting for Virtual Appliances Running on Linux Hosts ~ A-15

WCCP Problems  A-15
Maximum Port Entries  A-15

Packet Capture  A-16

Async0S 9.1 for Cisco Web Security Appliances User Guide g



M Contents

APPENDIX B

APPENDIX C

Starting a Packet Capture ~ A-16
Managing Packet Capture Files  A-17
Working With Support ~ A-17
Gathering Information for Efficient Service  A-17
Opening a Technical Support Request ~ A-17
Getting Support for Virtual Appliances  A-18
Enabling Remote Access to the Appliance  A-18

Command Line Interface B-1

Overview of the Command Line Interface  B-1

Accessing the Command Line Interface  B-1
First Access  B-1
Subsequent Access  B-2
Working with the Command Prompt ~ B-2
Command Syntax B-2
Select Lists  B-3
Yes/No Queries  B-3
Subcommands  B-3
Escaping Subcommands  B-4
Command History  B-4
Completing Commands  B-4
Committing Configuration Changes Using the CLI  B-4
General Purpose CLI Commands ~ B-4
CLI Example: Committing Configuration Changes ~ B-5
CLI Example: Clearing Configuration Changes B-5
CLI Example: Exiting the Command Line Interface Session  B-5
CLI Example: Seeking Help on the Command Line Interface  B-5

Web Security Appliance CLI Commands  B-6

Additional Resources C-1

Cisco Notification Service  €-1

Documentation Set  €-2

Training C-2

Knowledge Base Articles (TechNotes)  €-2

Cisco Support Community ~ €-2

Customer Support  €-3

Registering for a Cisco Account to Access Resources  €-3
Third Party Contributors ~ €-3

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



Contents W

Cisco Welcomes Your Comments  €-3

arpenpix D End User License Agreement  D-1
Cisco Systems End User License Agreement  D-1

Supplemental End User License Agreement for Cisco Systems Content Security Software  D-8

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g o |



M Contents

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



CHAPTER 1

Introduction to the Product and the Release

e Introduction to the Web Security Appliance, page 1-1
e What’s New, page 1-1

e Using the Appliance Web Interface, page 1-1

e The Cisco SensorBase Network, page 1-3

Introduction to the Web Security Appliance

The Cisco Web Security Appliance intercepts and monitors internet traffic and applies policies to help
keep your internal network secure from malware, sensitive data loss, productivity loss, and other
internet-based threats.

What's New

AsyncOS 9.1 for Cisco Web Security Appliances supports new 90-series hardware:

e S190
e S390
e S690

Related Topics

* Product release notes:
http://www.cisco.com/en/US/partner/products/ps10164/prod_release_notes_list.html

Using the Appllance Web Interface

Web Interface Browser Requirements, page 1-2
e Enabling Access to the Web Interface on Virtual Appliances, page 1-2
e Accessing the Appliance Web Interface, page 1-2
¢ Committing Changes in the Web Interface, page 1-3
¢ C(Clearing Changes in the Web Interface, page 1-3
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M Using the Appliance Web Interface

Web Interface Browser Requirements

To access the web interface, your browser must support and be enabled to accept JavaScript and cookies.
It must be able to render HTML pages containing Cascading Style Sheets (CSS).

The Cisco Web Security Appliance follows the Target Environments set by YUI:
http://yuilibrary.com/yui/environments/

Your session automatically times out after 30 minutes of inactivity.

Some buttons and links in the web interface cause additional windows to open. Therefore, you may need
to configure the browser’s pop-up blocking settings in order to use the web interface.

Note  Only use one browser window or tab at a time to edit the appliance configuration. Also, do not edit the
appliance using the web interface and the CLI at the same time. Editing the appliance from multiple
places concurrently results in unexpected behavior and is not supported.

Enabling Access to the Web Interface on Virtual Appliances

By default, the HTTP and HTTPS interfaces are not enabled on virtual appliances. To enable these
protocols, you must use the command-line interface.

Step 1 Access the command-line interface. See Accessing the Command Line Interface, page B-1.
Step 2 Run the interfaceconfig command.
Pressing Enter at a prompt accepts the default value.

Look for the prompts for HTTP and HTTPS and enable the protocol(s) that you will use.

Accessing the Appliance Web Interface

Before You Begin

If you are using a virtual appliance, see Enabling Access to the Web Interface on Virtual Appliances,
page 1-2.

Step1  Open a browser and enter the IP address (or hostname) of the Web Security appliance. If the appliance
has not been previously configured, use the default settings:

https://192.168.42.42:8443
_Or_
http://192.168.42.42:8080

where 192.168.42.42 is the default IP address, and 8080 is the default admin port setting for HTTP,
and 8443 is default admin port for HTTPS.

Otherwise, if the appliance is currently configured, use the IP address (or host name) of the M1 port.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
[ 12 | I



| Chapter1 Introduction to the Product and the Release

Note

Step 2

Step 3

The Cisco SensorBase Network 1l

You must use a port number when connecting to the appliance (by default, port 8080). Failing to specify
a port number when accessing the web interface results in a default port 80, Proxy Unlicensed error page.

When the appliance login screen appears, enter your user name and passphrase to access the appliance.
By default, the appliance ships with the following user name and passphrase:

e User name: admin

e Passphrase: ironport

If this is the first time you have logged in with the default aamin user name, you will be prompted to
immediately change the passphrase.

To view a listing of recent appliance access attempts, both successes and failures, for your user name,
click the recent-activity icon (i or ! for success or failure respectively) in front of the “Logged in as”
entry in the upper right corner of the application window.

Committing Changes in the Web Interface

~

Note

Step 1
Step 2
Step 3

You can make multiple configuration changes before you commit all of them.

Click the Commit Changes button.
Enter comments in the Comment field if you choose.

Click Commit Changes.

Clearing Changes in the Web Interface

Step 1
Step 2

Click the Commit Changes button.
Click Abandon Changes.

The Cisco SensorBase Network

The Cisco SensorBase Network is a threat management database that tracks millions of domains around
the world and maintains a global watch list for Internet traffic. SensorBase provides Cisco with an
assessment of reliability for known Internet domains. The Web Security appliance uses the SensorBase
data feeds to improve the accuracy of Web Reputation Scores.
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I The Cisco SensorBase Network

SensorBase Benefits and Privacy

Participating in the Cisco SensorBase Network means that Cisco collects data and shares that
information with the SensorBase threat management database. This data includes information about
request attributes and how the appliance handles requests.

Cisco recognizes the importance of maintaining your privacy, and does not collect or use personal or
confidential information such as usernames and passphrases. Additionally, the file names and URL
attributes that follow the hostname are obfuscated to ensure confidentiality. When it comes to decrypted
HTTPS transactions, the SensorBase Network only receives the IP address, web reputation score, and
URL category of the server name in the certificate.

If you agree to participate in the SensorBase Network, data sent from your appliance is transferred
securely using HTTPS. Sharing data improves Cisco’s ability to react to web-based threats and protect
your corporate environment from malicious activity.

Enabling Participation in The Cisco SensorBase Network

N

Note

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Standard SensorBase Network Participation is enabled by default during system setup.

Choose to the Security Services > SensorBase.
Verify that SensorBase Network Participation is enabled.

When it is disabled, none of the data that the appliance collects is sent back to the SensorBase Network
servers.

In the Participation Level section, choose one of the following levels:

e Limited. Basic participation summarizes server name information and sends MD5-hashed path
segments to the SensorBase Network servers.

¢ Standard. Enhanced participation sends the entire URL with unobfuscated path segments to the
SensorBase Network servers. This option assists in providing a more robust database, and
continually improves the integrity of Web Reputation Scores.

In the AnyConnect Network Participation field, choose whether or not to include information collected
from clients that connect to the Web Security appliance using Cisco AnyConnect Client.

AnyConnect Clients send their web traffic to the appliance using the Secure Mobility feature.

In the Excluded Domains and IP Addresses field, optionally enter any domains or IP addresses to
exclude from traffic sent to the SensorBase servers.

Submit and commit your changes.
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Connect, Install, and Configure

e Overview of Connect, Install, and Configure, page 2-1

e Deploying a Virtual Appliance, page 2-2

¢ Connecting the Appliance, page 2-2

e Gathering Setup Information, page 2-4

e System Setup Wizard, page 2-5

e Comparison of Modes of Operation, page 2-9

e Upstream Proxies, page 2-9

e Enabling or Changing Network Interfaces, page 2-12

e Configuring Failover Groups for High Availability, page 2-14
e Using the P2 Data Interface for Web Proxy Data, page 2-15
e Changing the System Hostname, page 2-25

e DNS Settings, page 2-26

Overview of Connect, Install, and Configure

The Standard mode of Web Security appliance operation includes on-site Web proxy services, which is
not available in Cloud Web Security Connector mode, and Layer-4 traffic monitoring, which is not
available in Cloud Web Security Connector mode.

In Cloud Web Security Connector mode, the appliance connects to and routes traffic to a Cisco Cloud
Web Security (CWS) proxy, where Web security policies are enforced.

The appliance has multiple network ports, with each assigned to manage one or more specific data types.

The appliance uses network routes, DNS, VLANSs, and other settings and services to manage network
connectivity and traffic interception. The System Setup Wizard lets you set up basic services and
settings, while the appliance’s Web interface lets you modify settings and configure additional options.

Async0S 9.1 for Cisco Web Security Appliances User Guide
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B Deploying a Virtual Appliance

Deploying a Virtual Appliance
To deploy a virtual web security appliance, see the Cisco Content Security Virtual Appliance Installation
Guide, available from

http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-lis
t.html.

Migrating from a Physical to a Virtual Appliance

To migrate your deployment from a physical appliance to a virtual appliance, see the virtual appliance
installation guide referenced in the previous topic and the Release Notes for your AsyncOS version.

Task Overview for Connecting, Installing, and Configuring

Task More Information

1. Connect the appliance to internet traffic. Connecting the Appliance, page 2-2

2. Gather and record setup information. Gathering Setup Information, page 2-4
3. Run the System Setup Wizard. System Setup Wizard, page 2-5

4. (Optional) Connect upstream proxies. Upstream Proxies, page 2-9

Connecting the Appliance

Before You Begin

¢ To mount the appliance, cable the appliance for management, and connect the appliance to power,
follow the instructions in the hardware guide for your appliance. For the location of this document
for your model, see Documentation Set, page C-2.

e Ifyou plan to physically connect the appliance to a WCCP v2 router for transparent redirection, first
verify that the WCCP router supports Layer 2 redirection.

e Be aware of Cisco configuration recommendations:

— Use simplex cabling (separate cables for incoming and outgoing traffic) if possible for enhanced
performance and security.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
[ 22 | I


http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html

Connect, Install, and Configure

Connecting the Appliance

Step1  Connect the Management interface if you have not already done so:
Ethernet Port Notes
M1 Connect M1 to where it can:
e Send and receive Management traffic.
e (Optional) Send and receive web proxy data traffic.
You can connect a laptop directly to M1 to administer the appliance.
To connect to the management interface using a hostname
(http://hostname:8080), add the appliance hostname and IP address to your DNS
server database.
P1 and P2 (optional) | e Available for outbound management services traffic but not administration.
¢ Enable Use M1 port for management only (Network > Interfaces page).
e Set routing for the service to use the Data interface.
Step2  (Optional) Connect the appliance to data traffic either directly or through a transparent redirection device:
Ethernet Port Explicit Forwarding Transparent Redirection
P1/P2 P1 only: Device: WCCP v2 router:
e Enable Use M1 port for e For Layer 2 redirection, physically
management only. connect router to P1/P2.
e Connect P1 and M1 to e For Layer 3 redirection, be aware of
different subnets. possible performance issues with
e Use a duplex cable to connect Generic Routing Encapsulation.
P1 the internal network and the | ¢ Create a WCCP Service on the
internet to receive both inbound appliance.
and outbound traffic. Device: Layer-4 Switch:
Pl and P2 e For Layer 2 redirection, physically
¢ Enable P1. connect switch to P1/P2.
e Connect M1, P1, and P2 to e For Layer 3 redirection, be aware of
different subnets. possible performance issues with
e Connect P2 to the internet to Generic Routing Encapsulation.
receive inbound internet traffic. | &
4
After running the System Setup Note  The appliance does not support
Wizard, enable P2. inline mode.
M1 (optional) If Use M1 port for management N/A
only is disabled, M1 is the default
port for data traffic.
Step3  Connect external proxies upstream of the appliance to allow the external proxies to receive data from

the appliance.
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M Gathering Setup Information

What to Do Next
e Gathering Setup Information, page 2-4

Related Topics
e Enabling or Changing Network Interfaces, page 2-12

e Using the P2 Data Interface for Web Proxy Data, page 2-15
¢ Adding and Editing a WCCP Service, page 2-19
e Configuring Transparent Redirection, page 2-18

e Upstream Proxies, page 2-9

Gathering Setup Information

You can use the worksheet below to record the configuration values you will need while running the
System Setup Wizard. For additional information about each property, see System Setup Wizard
Reference Information, page 2-6.

System Setup Wizard Worksheet

Property Value Property Value
Appliance Details Routes

Default System Hostname Management Traffic

Local DNS Server(s) Default Gateway

(Required if not using
Internet Root Servers)

DNS Server 1 (Optional) Static Route Table
Name

(Optional) DNS Server 2 (Optional) Static Route Table
Destination Network

(Optional) DNS Server 3 (Optional) Standard Service
Router Addresses

(Optional) Time Settings (Optional) Data Traffic

Network Time Protocol Default Gateway

Server

(Optional) External Proxy Static Route Table Name

Details

Proxy Group Name Static Route Table
Destination Network

Proxy Server Address (Optional) WCCP Settings

Proxy Port Number WCCP Router Address

Interface Details WCCP Router Passphrase

Management (M1) Port Administrative Settings

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
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System Setup Wizard W

System Setup Wizard Worksheet

IPv4 Address (required) Administrator Passphrase
IPv6 Address (optional)

Network Mask Email System Alerts To
Hostname (Optional) SMTP Relay Host

(Optional) Data (P1) Port
IPv4 (optional)

IPv6 Address (optional)
Network Mask

Hostname

System Setup Wizard

Before You Begin:
e Connect the Appliance to networks and devices. Connecting the Appliance, page 2-2

e Complete the System Setup Wizard worksheet.Gathering Setup Information, page 2-4.
e If you are setting up a virtual appliance:

— Use the 1oadlicense command to load the virtual appliance license. For complete information,
see the Cisco Content Security Virtual Appliance Installation Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-g
uides-list.html.

— Enable the HTTP and/or HTTPS interfaces: In the command-line interface (CLI), run the
interfaceconfig'COHHnand.

¢ Note that reference information for each configuration item used in the System Setup Wizard is
available at System Setup Wizard Reference Information, page 2-6.

>

Warning  Only use the System Setup Wizard the first time you install the appliance or if you want to completely
overwrite the existing configuration.

Step 1 Open a browser and enter the IP address of the Web Security appliance. The first time you run the System
Setup Wizard, use the default IP address:

https://192.168.42.42:8443
_Or-
http://192.168.42.42:8080

where 192.168.42.42 is the default IP address, and 8080 is the default admin port setting for HTTP,
and 8443 is default admin port for HTTPS.

Otherwise, if the appliance is currently configured, use the IP address of the M1 port.

Step2  When the appliance login screen appears, enter the username and passphrase to access the appliance. By
default, the appliance ships with the following username and passphrase:

e Username: admin

Async0S 9.1 for Cisco Web Security Appliances User Guide
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M System Setup Wizard

e Passphrase: ironport
Step3  You must immediately change the passphrase.
Step4  If the appliance is already configured, choose System Administration > System Setup Wizard.

If the appliance is already configured, you will be warned that you are about to reset the configuration.
To continue with the System Setup Wizard, click the Reset Configuration button. The appliance will
reset and the browser will refresh to the appliance home screen.

Step5 Read and accept the terms of the end user license agreement.

Step6  Click Begin Setup to continue.

Step7  Configure all settings using the provided reference tables as required.

Step8  Review the configuration information. If you need to change an option, click Edit for that section.

Step9  Click Install This Configuration.

A Next Steps page should appear once the configuration installed. However, depending on the IP, host
name, or DNS settings you configured during setup, you may lose connection to the appliance at this
stage. If a “page not found” error is displayed in your browser, change the URL to reflect any new
address settings and reload the page. Then continue with any post-setup tasks you wish to perform.

System Setup Wizard Reference Information

Network / System Settings
Property Description
Default System The system hostname is the fully-qualified hostname used to identify the
Hostname appliance in the following areas:
e the command line interface (CLI)
e system alerts
¢ end-user notification and acknowledgment pages
e when forming the machine NetBIOS name when the Web Security
appliance joins an Active Directory domain
The system hostname does not correspond directly to interface hostnames
and is not used by clients to connect to the appliance.
DNS Server(s) ¢ Use the Internet’s Root DNS Servers — You can choose to use the

Internet root DNS servers for domain name service lookups when the
appliance does not have access to DNS servers on your network.

Note Internet Root DNS servers will not resolve local host names. If you
need the appliance to resolve local host names you must use a local
DNS server, or add the appropriate static entries to the local DNS
using the CLI.

Use these DNS Servers — Provide address(es) for the local DNS server(s)
that the appliance can use to resolve host names.

See DNS Settings, page 2-26 for more information about these settings.
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System Setup Wizard W

Property Description

NTP Server The Network Time Protocol (NTP) server used to synchronize the system
clock with other servers on the network or the Internet.

The default is time.sco.cisco.com.

Time Zone Provide time-zone information for location of the appliance; affects
timestamps in message headers and log files.

Appliance Mode e Standard — Used for standard on-premise policy enforcement.

of Operation ¢ Cloud Web Security Connector — Used primarily to direct traffic to Cisco’s

Cloud Web Security service for policy enforcement and threat defense.

See Comparison of Modes of Operation, page 2-9 for more information about
these modes of operation.

Network / Network Interfaces and Wiring

The IP address, network mask, and host name to use to manage the Web Security appliance and, by
default, for proxy (data) traffic.

You can use the host name specified here when connecting to the appliance management interface (or in
browser proxy settings if M1 is used for proxy data), but you must register it in your organization’s DNS.

Setting Description

Ethernet Port (Optional) Check Use M1 port for management only if you want to use a separate
port for data traffic.

If you configure the M1 interface for management traffic only, you must configure
the P1 interface for data traffic. You must also define different routes for
management and data traffic. However, you can configure the P1 interface even
when the M1 interface is used for both management and data traffic.

You can enable and configure the P1 port only in the System Setup Wizard. If
you want to enable the P2 interface, you must do this after finishing the System
Setup Wizard.

IP Address / The IP address and network mask to use when managing the Web Security appliance
Netmask on this network interface.
Hostname The host name to use when managing the Web Security appliance on this

network interface.
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M System Setup Wizard

Network / Routes for Management and Data Traffic

S

Note  If you enable “Use M1 port for management only”, this section will have separate sections for
management and data traffic; otherwise one joint section will be shown.

Property

Description

Default Gateway

The default gateway IP address to use for the traffic through the Management and
Data interfaces.

Static Routes
Table

Optional static routes for management and data traffic. Multiple routes can be added.
e Name — A name used to identify the static route.
¢ Internal Network — The IPv4 address for this route’s destination on the network.

¢ Internal Gateway — The gateway IPv4 address for this route. A route gateway
must reside on the same subnet as the Management or Data interface on which
it is configured.

Network / Transparent Connection Settings

Property

Description

Layer-4 Switch or
No Device

Specifies that the Web Security appliance is connected to a layer 4 switch for
transparent redirection, or that no transparent redirection device is used and clients
will explicitly forward requests to the appliance.

WCCP v2 Router

Specifies that the Web Security appliance is connected to a version 2
WCCP-capable router.

If you connect the appliance to a version 2 WCCP router, you must create at
least one WCCP service. You can enable the standard service on this screen, or
after the System Setup Wizard is finished, where you can also create multiple
dynamic services.

When you enable the standard service, you can also enable router security and
enter a passphrase. The passphrase used here must be used all appliances and
WCCP routers within the same service group.

A standard service type (also known as the “web-cache” service) is assigned a
fixed ID of zero, a fixed redirection method (by destination port), and a fixed
destination port of 80.

A dynamic service type allows you to define a custom ID, port numbers, and
redirection and load balancing options.

Network /Administrative Settings

Property

Description

Administrator
Passphrase

The passphrase used to access the Web Security appliance for
administrative purposes.

Email System Alerts |The email address to which the appliance sends systems alerts.

To
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Comparison of Modes of Operation

Property

Description

Send Email via
SMTP Relay Host
(optional)

The address and port for an SMTP relay host that AsyncOS can use to send
system generated email messages.

If no SMTP relay host is defined, AsyncOS uses the mail servers listed in the
MX record.

AutoSupport

Specifies whether the appliance sends system alerts and weekly status reports
to Cisco Customer Support.

SensorBase Network
Participation

Specifies whether to participate in the Cisco SensorBase Network. If you
participate, you can configure Limited or Standard (full) participation. Default
is Standard.

The SensorBase Network is a threat management database that tracks millions
of domains around the world and maintains a global watch list for Internet
traffic. When you enable SensorBase Network Participation, the Web Security
appliance sends anonymous statistics about HTTP requests to Cisco to increase
the value of SensorBase Network data.

Comparison of Modes of Operation

The Standard mode of Web Security Appliance operation includes on-site Web proxy services, which is
not available in Cloud Web Security Connector mode, and Layer-4 traffic monitoring, which is not
available Cloud Web Security Connector modes.

In Cloud Web Security Connector mode, the appliance connects to and routes traffic to a Cisco Cloud
Web Security proxy, where Web security policies are enforced.

The following table presents the various menu commands available in each mode, thereby indicating the
various features available in each mode.

Upstream Proxies

The web proxy can forward web traffic directly to its destination web server or use routing policies to
redirect it to an external upstream proxy.

e Upstream Proxies Task Overview, page 2-10

e Creating Proxy Groups for Upstream Proxies, page 2-10
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M Upstream Proxies

Upstream Proxies Task Overview

Task More Information

1. Connect the external proxy upstream of the Cisco Web |Connecting the Appliance, page 2-2.
Security Appliance.

2. Create and configure a proxy group for the Creating Proxy Groups for Upstream Proxies, page 2-10.
upstream proxy.

3. Create a routing policy for the proxy group to manage |Create Policies to Control Internet Requests
which traffic is routed to the upstream proxy.

Creating Proxy Groups for Upstream Proxies

Step1  Choose Network > Upstream Proxies.
Step2  Click Add Group.
Step3  Complete the Proxy Group settings.

Property Description

Name The name used to identify proxy groups on the appliance, such as in routing
policies, for example.

Proxy Servers The address, port and reconnection attempts (should a proxy not respond) for
the proxy servers in the group. Rows for each proxy server can be added or
deleted as required.

Note  You can enter the same proxy server multiple times to allow unequal
load distribution among the proxies in the proxy group.
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Property Description

Load Balancing The strategy that the web proxy uses to load balance requests between
multiple upstream proxies. Choose from:

¢ None (failover). The Web Proxy directs transactions to one external
proxy in the group. It tries to connect to the proxies in the order they are
listed. If one proxy cannot be reached, the Web Proxy attempts to
connect to the next one in the list.

¢ Fewest connections. The Web Proxy keeps track of how many active
requests are with the different proxies in the group and it directs a
transaction to the proxy currently servicing the fewest number of
connections.

e Hash based. Least recently used. The Web Proxy directs a transaction
to the proxy that least recently received a transaction if all proxies are
currently active. This setting is similar to round robin except the Web
Proxy also takes into account transactions a proxy has received by being
a member in a different proxy group. That is, if a proxy is listed in
multiple proxy groups, the “least recently used” option is less likely to
overburden that proxy.

¢ Round robin. The Web Proxy cycles transactions equally among all
proxies in the group in the listed order.

Note The Load Balancing option is dimmed until two or more proxies
have been defined.

Failure Handling Specifies the default action to take if all proxies in this group fail. Choose
from:

e Connect directly. Send the requests directly to their destination servers.

¢ Drop requests. Discard the requests without forwarding them.

Stepd  Submit and commit your changes.

What to Do Next.
e Creating a Policy, page 10-5

Network Interfaces

e [P Address Versions, page 2-11
¢ Enabling or Changing Network Interfaces, page 2-12

IP Address Versions

In Standard mode, Cisco Web Security Appliance supports IPv4 and IPv6 addresses in most cases.

A

Note In Cloud Connector mode, Cisco Web Security Appliance supports [Pv4 only.
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A DNS server may return a result with both an IPv4 and an IPv6 address. DNS settings include an IP
Address Version Preference to configure AsyncOS behavior in these cases.

Interface/Service IPv4 IPv6 Notes

M1 interface Required Optional Use of IPv6 addresses requires an [Pv6
routing table that defines the default IPv6
gateway. Depending on the network, you
may also need to specify a static IPv6 route
in the routing table.

P1 interface Optional Optional If the P1 interface has an IPv6 address
configured and the appliance uses split
routing (separate management and data
routes), then the P1 interface cannot use the
IPv6 gateway configured on the
Management route. Instead, specify an IPv6
gateway for the Data routing table.

P2 interface Optional Optional —

Data services Supported Supported —

Control and Management Services Supported Partially Supported |Images, for example custom logos on
end-user notification pages, require IPv4.

AnyConnect Secure Mobility (MUS) Supported Not Supported —

Related Topics

e Enabling or Changing Network Interfaces, page 2-12

e DNS Settings, page 2-26

Enabling or Changing Network Interfaces

Step 1
Step 2

e Add or modify interface IP addresses

e Change the Layer-4 Traffic Monitor wiring type

¢ Enable split routing of management and data traffic

Choose Network > Interfaces.

Click Edit Settings.
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Step3  Configure the Interface options .

Option Description

Interfaces Modify or add new IPv4 or IPv6 Address, Netmask, and Hostname details for
the M1, P1, or P2 interfaces as required.

e M1 - AsyncOS requires an IPv4 address for the M1 (Management) port. In
addition to the IPv4 address, you can specify an IPv6 address. By default,
the Management interface is used to administer the appliance and Web
Proxy (data) monitoring. However, you can configure the M1 port for
management use only.

e P1 and P2 - Use an IPv4 address, IPv6 address, or both for the Data ports.
The Data interfaces are used for Web Proxy monitoring and Layer-4 Traffic
Monitor blocking (optional). You can also configure these interfaces to
support outbound services such as DNS, software upgrades, NTP, and
traceroute data traffic.

Note If the Management and Data interfaces are all configured, each must be
assigned IP addresses on different subnets.

Separate Routing for |Check Restrict M1 port to appliance management services only to limit M1
Management to management traffic only, requiring use of a separate port for data traffic.

Services Note When you use M1 for management traffic only, configure at least one

data interface, on another subnet, for proxy traffic. Define different
routes for management and data traffic.

Appliance Enable/disable use of, and specify a default port number for, the following
Management network protocols:
Services e FTP - Disabled by default.

e SSH

e HTTP

e HTTPS

Also, you can enable/disable redirection of HTTP traffic to HTTPS.

Step4  Submit and commit your changes.

What to Do Next
e If you added an IPv6 address, add an IPv6 routing table.

Related Topics
e Connecting the Appliance, page 2-2.

e [P Address Versions, page 2-11
e Configuring TCP/IP Traffic Routes, page 2-16
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Configuring Failover Groups for High Availability

Using the Common Address Redundancy Protocol (CARP), the WSA enables multiple hosts on your
network to share an IP address, providing IP redundancy to ensure high availability of services provided
by those hosts. In CARP there are three states for a host:

* master

e backup

e init
Only one master host can exist for each failover group that can provide services. High Availability
functions in Standard and Connector mode.

Add Failover Group

Before You Begin

e Identify a virtual IP address that will be used exclusively for this failover group. Clients will use this
IP address to connect to the failover group in explicit forward proxy mode.

¢ Configure all Appliances in the failover group with identical values for the following parameters:
— Failover Group ID
— Hostname
— Virtual IP Address

e If you are configuring this feature on a virtual appliance, ensure that the virtual switch and the
virtual interfaces specific to each appliance are configured to use promiscuous mode. For more
information, see the documentation for your virtual hypervisor.

Step 1 Choose Network > High Availability.

Step2  Click Add Failover Group.

Step3  Enter a Failover Group ID in the range 1 to 255.
Step4  (Optional) Enter a Description.

Step5  Enter the Hostname, for example www.example.com.

Step6  Enter the Virtual IP Address and Netmask, for example /0.0.0.3/24 (IPv4) or 2001:420:80:1::5/32
(IPv6).

Step7  Choose an option from the Interface menu. The Select Interface Automatically option will select the
interface based on the IP address you provided.

Note  If you do not select the Select Interface Automatically option, you must choose an interface in the same
subnet as the virtual IP address you provided.

Step8  Choose the priority. Click Master to set the priority to 255. Alternatively, select Backup and enter a
priority between 1 (lowest) and 254 in the Priority field.

Step9  (Optional). To enable security for the service, select the Enable Security for Service check box and
enter a string of characters that will be used as a shared secret in the Shared Secret and Retype Shared
Secret fields.
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Note  The shared secret, virtual IP, and failover group ID must be the same for all appliances in the failover
group.

Step10  Enter the delay in seconds (1 to 255) between hosts advertising their availability in the Advertisement
Interval field.

Step11  Submit and commit your changes.

Related Topics
e Failover Problems, page A-4

Edit High Availability Global Settings

Step 1 Choose Network > High Availability.
Step2  In the High Availability Global Settings area, click Edit Settings.
Step3  In the Failover Handling menu, choose an option.
e Preemptive—The highest priority host will assume control when available.

¢ Non-preemptive—The host in control will remain in control even if a higher priority host becomes
available.

Step4  Click Submit. Alternatively, click Cancel to abandon your changes.

View Status of Failover Groups

Choose Network > High Availability. The Failover Groups area displays the current fail-over group.
You can click Refresh Status to update the display. You can also view fail-over details by choosing
Network > Interfaces or Report > System Status.

Using the P2 Data Interface for Web Proxy Data

By default, the web proxy does not listen for requests on P2, even when enabled. However, you can
configure P2 to listen for web proxy data.

N
Note If you enable P2 to listen for client requests using the advancedproxyconfig > miscellaneous CLI

command, you can choose whether to use P1 or P2 for outgoing traffic. To use P1 for outgoing traffic,
change the Default Route for data traffic to specify the next IP address that the P1 interface is connected to.

Before You Begin

e Enable P2 (you must also enable P1 if not already enabled) (see Enabling or Changing Network
Interfaces, page 2-12).
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Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

Access the CLI.
Use the advancedproxyconfig ->miscellaneous commands to access the required area

example.com> advancedproxyconfig

Choose a parameter group:

- AUTHENTICATION - Authentication related parameters

- CACHING - Proxy Caching related parameters

- DNS - DNS related parameters

- EUN - EUN related parameters

- NATIVEFTP - Native FTP related parameters

- FTPOVERHTTP - FTP Over HTTP related parameters

- HTTPS - HTTPS related parameters

- SCANNING - Scanning related parameters

- PROXYCONN - Proxy connection header related parameters
- CUSTOMHEADERS - Manage custom request headers for specific domains
- MISCELLANEOUS - Miscellaneous proxy related parameters
- SOCKS - SOCKS Proxy parameters

[1> miscellaneous

Press Enter past each question until the question:
Do you want proxy to listen on P27

Enter ‘y’ for this question.

Press Enter past the remaining questions.

Commit your changes.

Related Topics
e Connecting the Appliance, page 2-2.

e Configuring TCP/IP Traffic Routes, page 2-16.

Configuring TCP/IP Traffic Routes

Routes are used for determining where to send (or route) network traffic. The Web Security appliance
routes the following kinds of traffic:

e Data traffic. Traffic the Web Proxy processes from end users browsing the web.

e Management traffic. Traffic created by managing the appliance through the web interface and
traffic the appliance creates for management services, such as AsyncOS upgrades, component
updates, DNS, authentication, and more.

By default, both types of traffic use the routes defined for all configured network interfaces. However,
you can choose to split the routing, so that management traffic uses a management routing table and data
traffic uses a data routing table. Both types of traffic split are split as follows:
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Management Traffic Data Traffic
e WebUI e HTTP
e SSH e HTTPS
e SNMP e FTP
e NTLM authentication (with domain controller) | ® WCCP negotiation

ICAP request with external DLP server
Syslogs

FTP push

DNS (configurable)
Update/Upgrade/Feature Key (configurable)

DNS (configurable)
Update/Upgrade/Feature Key (configurable)

The number of sections on the Network > Routes page is determined by whether or not split routing
is enabled:

Separate route configuration sections for Management and Data traffic (split routing enabled).
When you use the Management interface for management traffic only (Restrict M1 port to
appliance management services only is enabled), then this page includes two sections to enter
routes, one for management traffic and one for data traffic.

One route configuration section for all traffic (split routing not enabled). When you use the
Management interface for both management and data traffic (Restrict M1 port to appliance
management services only is disabled), then this page includes one section to enter routes for all
traffic that leaves the Web Security appliance, both management and data traffic.

A route gateway must reside on the same subnet as the Management or Data interface on which it is
configured. If multiple data ports are enabled, the web proxy sends out transactions on the data interface
that is on the same network as the default gateway configured for data traffic.

Related Topics

To enable split routing of management and data traffic, see Enabling or Changing Network

Interfaces, page 2-12

Modifying the Default Route

Step 1
Step 2

Step 3

Step 4

Choose Network > Routes.

Click on Default Route in the Management or Data table as required (or the combined

Management/Data table if split routing is not enabled).

In the Gateway column, enter the IP address of the computer system on the next hop of the network

connected to the network interface you are editing.

Submit and commit your changes.
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Adding a Route

Step 1 Choose Network > Routes.
Step2  Click the Add Route button corresponding to the interface for which you are creating the route.
Step 3 Enter a Name, Destination Network, and Gateway.

Stepd  Submit and commit your changes.

Saving and Loading Routing Tables

Step 1 Choose Network > Routes.
To save a route table, click Save Route Table and specify where to save the file.

To load a saved route table, click Load Route Table, navigate to the file, open it, and submit and commit
your changes.

Note = When the destination address is on the same subnet as one of the physical network interfaces, AsyncOS
sends data using the network interface with the same subnet. It does not consult the routing tables.

Deleting a Route

Step 1 Choose Network > Routes.
Step2  Check the checkbox in the Delete column for the appropriate route.
Step3  Click Delete and confirm.

Stepd  Submit and commit your changes.

Related Topics
e Enabling or Changing Network Interfaces, page 2-12.

Configuring Transparent Redirection

Specifying a Transparent Redirection Device

Before You Begin

e Connect the appliance to a Layer-4 switch or a WCCP v2 router.

Step 1 Choose Network > Transparent Redirection.
Step2  Click Edit Device.
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Step3  Choose the type of device that transparently redirects traffic to the appliance from the Type

drop-down list.
Step4  Submit and commit your changes.
Step5  For WCCP v2 devices, complete these additional steps:
a. Configure the WCCP device using device documentation.

b. Add a WCCP service.

c. If IP spoofing is enabled on the appliance, create a second WCCP service.

Related Topics
e Connecting the Appliance, page 2-2.
e Configuring WCCP Services, page 2-19.

Configuring WCCP Services

A WCCP service is an appliance configuration that defines a service group to a WCCP v2 router. It
includes information such as the service ID and ports used. Service groups allow a web proxy to establish
connectivity with a WCCP router and to handle redirected traffic from the router.

Adding and Editing a WCCP Service

Before You Begin

e Configure the appliance to use a WCCP v2 Router (see Specifying a Transparent Redirection

Device, page 2-18).

Step 1 Choose Network > Transparent Redirection.
Step 2 Click Add Service, or, to edit a WCCP service, click the name of the WCCP service in the Service
Profile Name column.

Step3  Configure the WCCP options as described:

WCCP Service Option Description

Service Profile Name The name for the WCCP service.

Note If you leave this empty and choose a standard service (see below),
the name ‘web_cache’ is automatically assigned here.
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WCCP Service Option Description

Service The service group type for the router. Choose from:

Standard service. This service type is assigned a fixed ID of zero, a fixed
redirection method of by destination port, and a fixed destination port of 80.
You can create one standard service only. If a standard service already exists
on the appliance, this option is dimmed.

Dynamic service. This service type allows you to define a custom ID, port
numbers, and redirection and load balancing options. Enter the same
parameters when creating the service on the WCCP router as you entered for
the dynamic service.

If you create a dynamic service, enter the following information:

e Service ID. Enter any number from 0 to 255 in the Dynamic Service
ID field.

e Port number(s). Enter up to eight port numbers for traffic to redirect in
the Port Numbers field.

¢ Redirection basis. Choose to redirect traffic based on the source or
destination port. Default is destination port.

~
Note  To configure Native FTP with transparent redirection and IP

spoofing, choose Redirect based on source port (return path) and set
the source port to 13007.

e Load balancing basis. When the network uses multiple Web Security
appliances, you can choose how to distribute packets among the
appliances. You can distribute packets based on the server or client
address. When you choose client address, packets from a client always
get distributed to the same appliance. Default is server address.

Router IP Addresses The IPv4 or IPv6 address for one or more WCCP enabled routers. Use each
router’s unique IP; you cannot enter a multicast address. You cannot mix
IPv4 and IPv6 addresses within a service group.

Router Security Specifies whether or not to require a passphrase for this service group. If
enabled, every appliance and WCCP router that uses the service group must
use the same passphrase.
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WCCP Service Option

Description

Advanced

Load-Balancing Method. This determines how the router performs load

balancing of packets among multiple Web Security appliances. Choose from:

e Allow Mask Only. WCCP routers make decisions using hardware in the
router. This method can increase router performance over the hash
method. Not all WCCP routers support mask assignment, however.

¢ Allow Hash Only. This method relies on a hash function to make
redirection decisions. This method can be less efficient than the mask
method, but may be the only option the router supports.

e Allow Hash or Mask. Allows AsyncOS to negotiate a method with the
router. If the router supports mask, then AsyncOS uses masking,
otherwise hashing is used.

Mask Customization. If you select Allow Mask Only or Allow Hash or
Mask, you can customize the mask or specify the number of bits:

e Custom mask (max 5 bits). You can specify the mask. The web
interface displays the number of bits associated with the mask you
provide.

e System generated mask. You can let the system generate a mask for
you. Optionally, you can specify the number of bits for the
system-generated mask, up to 5 bits.

Forwarding method. This is the method by which redirected packets are
transported from the router to the web proxy.

Return Method. This is the method by which redirected packets are
transported from the web proxy to the router.

Both the forwarding and return methods use one of the following method
types:

e Layer 2 (L2). This redirects traffic at layer 2 by replacing the packet’s
destination MAC address with the MAC address of the target web proxy.
The L2 method operates at hardware level and typically offers the best
performance. Not all WCCP routers support L2 forwarding, however. In
addition, WCCP routers only allow L2 negotiation with a directly
(physically) connected Web Security appliance.

¢ Generic Routing Encapsulation (GRE). This method redirects traffic
at layer 3 by encapsulating the IP packet with a GRE header and a
redirect header. GRE operates at software level, which can impact
performance.

e L2 or GRE. With this option, the appliance uses the method that the
router says it supports. If both the router and appliance support L2 and
GRE, the appliance uses L2.

If the router is not directly connected to the appliance, you must choose GRE.

Submit and commit your changes.
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Creating WCCP Services for IP Spoofing

Step 1 If you have enabled IP spoofing on the web proxy, create two WCCP services. Create a standard WCCP
service, or create a dynamic WCCP service that redirects traffic based on destination ports.

Step2  Create a dynamic WCCP service that redirects traffic based on source ports.

Use the same port numbers, router IP address, and router security settings as used for the service created
in Step 1.

S
Note  Cisco suggests using a service ID number from 90 to 97 for the WCCP service used for the return
path (based on the source port).

Related Topics
e Web Proxy Cache, page 4-5.

Increasing Interface Capacity Using VLANs

You can configure one or more VLANS to increase the number of networks the Cisco Web Security
Appliance can connect to beyond the number of physical interfaces included.

VLANS appear as dynamic “Data Ports” labeled in the format of: “VLAN DDDD” where the “DDDD”
is the ID and is an integer up to 4 digits long (VLAN 2, or VLAN 4094 for example). AsyncOS supports
up to 30 VLAN:S.

A physical port does not need an IP address configured in order to be in a VLAN. The physical port on
which a VLAN is created can have an IP that will receive non-VLAN traffic, so you can have both VLAN
and non-VLAN traffic on the same interface.

VLANS can only be created on the Management and P1 data ports.

Configuring and Managing VLANs

You can create, edit and delete VLANS via the etherconfig command. Once created, a VLAN can be
configured via the interfaceconfig command in the CLI.

Example 1: Creating a New VLAN

In this example, two VLANSs are created (named VLAN 31 and VLAN 34) on the P1 port:

Step 1 Do not create VLANSs on the T1 or T2 interfaces.Access the CLI.
Step2  Follow the steps shown.

example.com> etherconfig

Choose the operation you want to perform:

- MEDIA - View and edit ethernet media settings.
- VLAN - View and configure VLANs.

- MTU - View and configure MTU.

[1> vlan

VLAN interfaces:
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Choose the operation you want to perform:
- NEW - Create a new VLAN.
[1> new

VLAN ID for the interface (Ex: "34"):
[1> 34

Enter the name or number of the ethernet interface you wish bind to:
1. Management

2. P1
3. Tl
4. T2
[1]1> 2

VLAN interfaces:
1. VLAN 34 (P1)

Choose the operation you want to perform:
- NEW - Create a new VLAN.

- EDIT - Edit a VLAN.

- DELETE - Delete a VLAN.

[1> new

VLAN ID for the interface (Ex: "34"):
[1> 31

Enter the name or number of the ethernet interface you wish bind to:
. Management
. P1

=

1
2
2

H

1
2
3
4
[

1]

\

VLAN interfaces:
1. VLAN 31 (P1)
2. VLAN 34 (P1)

Choose the operation you want to perform:
- NEW - Create a new VLAN.

- EDIT - Edit a VLAN.

- DELETE - Delete a VLAN.

[1>

Commit your changes.

Example 2: Creating an IP Interface on a VLAN

N

Note

Step 1
Step 2

In this example, a new IP interface is created on the VLAN 34 ethernet interface.

Making changes to an interface may close your connection to the appliance.

Access the CLI
Follow the steps shown:

example.com> interfaceconfig

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Chapter 2

Connect, Install, and Configure |

Redirect Hostname and System Hostname

Step 3

Currently configured interfaces:
1. Management (10.10.1.10/24 on Management: example.com)
2. Pl (10.10.0.10 on Pl: example.com)

Choose the operation you want to perform:
- NEW - Create a new interface.

- EDIT - Modify an interface.

- DELETE - Remove an interface.

[1> new

IP Address (Ex: 10.10.10.10):
[1> 10.10.31.10

Ethernet interface:

1. Management
2. Pl

3. VLAN 31

4. VLAN 34
[1]> 4

Netmask (Ex: "255.255.255.0" or "Oxffffffoo"):
[255.255.255.0]>

Hostname:
[1> v.example.com

Currently configured interfaces:

1. Management (10.10.1.10/24 on Management: example.com)
2. P1 (10.10.0.10 on Pl: example.com)

3. VLAN 34 (10.10.31.10 on VLAN 34: v.example.com)

Choose the operation you want to perform:
- NEW - Create a new interface.

- EDIT - Modify an interface.

- DELETE - Remove an interface.

[1>

example.com> commit

Commit your changes.

Related Topics
e Enabling or Changing Network Interfaces, page 2-12.

e Configuring TCP/IP Traffic Routes, page 2-16.

Redirect Hostname and System Hostname

After running the System Setup Wizard, the System Hostname and the Redirect Hostname are the same.
However, changing the system hostname using the sethostname command does not change the redirect

hostname. Therefore the settings may have different values.

AsyncOS uses the redirect hostname for end-user notifications and acknowledgments.

The system hostname is the fully-qualified hostname used to identify the appliance in the

following areas:
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e The command line interface (CLI)
e System alerts

¢ When forming the machine NetBIOS name when the Web Security appliance joins an Active
Directory domain.

The system hostname does not correspond directly to interface hostnames and is not used by clients to
connect to the appliance.

Changing the Redirect Hostname

Step 1 In the web user interface, navigate to Network>Authentication.
Step2  Click Edit Global Settings.

Step3  Enter a new value for Redirect Hostname.

Changing the System Hostname

Step 1 Access the CLI.

Step2  Use the sethostname command to change the name of the Web Security appliance:

example.com> sethostname
example.com> hostname.com
example.com> commit

hostname.com>

Step3  Commit your changes.

Configuring SMTP Relay Host Settings

AsyncOS periodically sends system-generated email messages, such as notifications, alerts, and Cisco
Customer Support requests. By default, AsyncOS uses information listed in the MX record on your
domain to send email. However, if the appliance cannot directly reach the mail servers listed in the MX
record, you must configure at least one SMTP relay host on the appliance.

Note If the Web Security appliance cannot communicate with the mail servers listed in the MX record or
any of the configured SMTP relay hosts, it cannot send email messages and it writes a message in the
log files.

You can configure one or more SMTP relay hosts. When you configure multiple SMTP relay hosts,
AsyncOS uses the topmost available SMTP relay host. If an SMTP relay host is unavailable, it tries to
use the one below it in the list.
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Configuring an SMTP Relay Host

Step 1 Choose Network > Internal SMTP Relay.
Step2  Click Edit Settings.
Step3  Complete the Internal SMTP Relay settings.

Property Description

Relay Hostname or The hostname or IP address to use for the SMTP relay

IP Address

Port The port for connecting to the SMTP relay. If this property is left empty, the

appliance uses port 25.

Routing Table to Use | The routing table associated with an appliance network interface, either
for SMTP Management or Data, to use for connecting to the SMTP relay. Choose
whichever interface is on the same network as the relay system.

Stepd  (Optional) Click Add Row to add additional SMTP relay hosts.

Step5  Submit and commit your changes.

DNS Settings

AsyncOS for Web can use the Internet root DNS servers or your own DNS servers. When using the
Internet root servers, you can specify alternate servers to use for specific domains. Since an alternate
DNS server applies to a single domain, it must be authoritative (provide definitive DNS records) for
that domain.

e Split DNS, page 2-26
¢ C(Clearing the DNS Cache, page 2-26
e Editing DNS Settings, page 2-27

Split DNS

AsyncOS supports split DNS where internal servers are configured for specific domains and external or
root DNS servers are configured for other domains. If you are using your own internal server, you can
also specify exception domains and associated DNS servers.

Clearing the DNS Cache

Before You Begin

e Be aware that using this command might cause a temporary performance degradation while the
cache is repopulated.

Step 1 Choose Network > DNS.
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DNS Settings W

Step2  Click Clear DNS Cache.

Editing DNS Settings

Step 1 Choose Network > DNS
Step2  Click Edit Settings.
Step3  Configure the DNS settings as required.

Property Description

DNS Server(s) Use these DNS Servers. The local DNS server(s) that the appliance can use to
resolve hostnames.

Use the Internet’s Root DNS Servers. You can choose to use the Internet root
DNS servers for domain name service lookups when the appliance does not have
access to DNS servers on your network.

Note Internet Root DNS servers will not resolve local hostnames. If you need
the appliance to resolve local hostnames you must use a local DNS
server or add the appropriate static entries to the local DNS using the
Command Line Interface.

Alternate DNS servers Overrides (Optional). Authoritative DNS servers for
particular domains

Routing Table for Specifies which interface the DNS service will route traffic through.
DNS Traffic

IP Address Version |When a DNS server provides both an IPv4 and an IPv6 address, AsyncOS uses
Preference this preference to choose the IP address version.

A

Note  AsyncOS does not honor the version preference for transparent FTP
requests.

Wait Before Timing |The wait time in seconds before timing out non-responsive reverse DNS
out Reverse DNS lookups.
Lookups

Domain Search List |A DNS domain search list used when a request is sent to a bare hostname (with
no "' character). The domains specified will each be attempted in turn, in the
order entered, to see if a DNS match for the hostname plus domain can be found.

Step4  Submit and commit your changes.

Related Topics
e Configuring TCP/IP Traffic Routes, page 2-16

e [P Address Versions, page 2-11
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Bl Troubleshooting Connect, Install, and Configure

Troubleshooting Connect, Install, and Configure

¢ Failover Problems, page A-4
e Upstream Proxy Does Not Receive Basic Credentials, page A-14
¢ Client Requests Fail Upstream Proxy, page A-14

e Maximum Port Entries, page A-15
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Connect the Appliance to a Cisco Cloud Web
Security Proxy

e Comparison of Cloud Connector Mode and Standard Mode, page 3-1

e How to Configure and Use Features in Cloud Connector Mode, page 3-4
e Deployment in Cloud Connector Mode, page 3-4

¢ Configuring the Cloud Connector, page 3-5

e Controlling Web Access Using Directory Groups in the Cloud, page 3-8
e Bypassing the Cloud Proxy Server, page 3-8

e Partial Support for FTP and HTTPS in Cloud Connector Mode, page 3-8
e Preventing Loss of Secure Data, page 3-9

e Viewing Group and User Names and IP Addresses, page 3-9

e Subscribing to Cloud Connector Logs, page 3-9

e Identification Profiles and Authentication with Cloud Web Security Connector, page 3-10

Comparison of Cloud Connector Mode and Standard Mode

In Cloud Web Security Connector mode, the appliance connects to and routes traffic to a Cisco Cloud
Web Security proxy, where web security policies are enforced. The standard mode of the Web Security
Appliance includes on-site web proxy services and the Layer-4 Traffic Monitor; these services are not
available in Cloud Web Security Connector mode.
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M Comparison of Cloud Connector Mode and Standard Mode

Menu Available in Cloud Connector Mode |Available in Standard Mode
Reporting System Status System Status

Overview

Users

Web Sites

URL Categories
Application Visibility
Anti-Malware

Client Malware Risk
Web Reputation Filters
Layer-4 Traffic Monitor
Reports by User Location
Web Tracking

System Capacity
Scheduled Reports

Archived Reports
Web Security Manager  |Identification Profiles Identification Profiles
Cloud Routing Policies Cloud Routing Policies
External Data Loss Prevention External Data Loss Prevention
Custom URL Categories Custom URL Categories
Policies

Decryption Policies

Routing Policies

Access Policies

Overall Bandwidth Limits
Cisco Data Security

Outbound Malware Scanning
Define Time Ranges and Quotas
Bypass Settings

Layer-4 Traffic Monitor
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Comparison of Cloud Connector Mode and Standard Mode

Available in Cloud Connector Mode

Available in Standard Mode

Security Services

Web Proxy

Web Proxy

FTP Proxy

HTTPS Proxy

PAC File Hosting

Identity Provider for SaaS
Acceptable Use Controls
Anti-Malware and Reputation
Data Transfer Filters
AnyConnect Secure Mobility
End-User Notification
Layer-4 Traffic Monitor
SensorBase

Reporting

Network

Interfaces

Transparent Redirection
Routes

DNS

Internal SMTP Relay
Authentication

External DLP Servers
Cloud Connector

Machine ID Service

Interfaces

Transparent Redirection
Routes

DNS

Internal SMTP Relay
Authentication

External DLP Servers

Upstream Proxy
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How to Configure and Use Features in Cloud Connector Mode

Available in Cloud Connector Mode

Available in Standard Mode

System Administration

Users

Alerts

Log Subscriptions
Network Access

Time Zone

Time Settings
Configuration Summary
Configuration File
Feature Keys

Upgrade and Update Settings
System Upgrade
System Setup Wizard

Users

Alerts

Log Subscriptions
Network Access

Time Zone

Time Settings
Configuration Summary
Configuration File
Feature Keys

Upgrade and Update Settings
System Upgrade
System Setup Wizard
Policy Trace

Return Addresses
Feature Keys Settings
Next Steps

How to Configure and Use Features in Cloud Connector Mode

Use of the features included in the Cloud Connector subset is the same as in standard mode, except as
noted.

This chapter links to locations within this documentation that provide information about some of the major
features of the Web Security Appliance that are common to both standard mode and Cloud Web Security
Connector mode. With the exception of Cloud Connector configuration settings and information about

sending directory groups to the cloud, relevant information is in other locations throughout this document.

This chapter includes information about configuring the Cloud Web Security Connector that is not
applicable in standard mode.

This document does not include information about the Cisco Cloud Web Security product. Cisco Cloud
Web Security documentation is available from
http://www.cisco.com/c/en/us/support/security/cloud-web-security/tsd-products-support-series-home.h
tml.

Deployment in Cloud Connector Mode

When you initially set up the appliance, you choose whether to deploy in Cloud Connector mode or
standard mode. You can also run the System Setup Wizard on an appliance that is currently deployed in
standard mode to redeploy it in Cloud Connector mode, if you have the required licensing. Running the
System Setup Wizard overwrites your existing configurations and deletes all existing data.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| 34 | I


http://www.cisco.com/c/en/us/support/security/cloud-web-security/tsd-products-support-series-home.html
http://www.cisco.com/c/en/us/support/security/cloud-web-security/tsd-products-support-series-home.html

| Chapter3 Connectthe Appliance to a Cisco Cloud Web Security Proxy

Configuring the Cloud Connector Il

Deployment of the appliance is the same in both standard and Cloud Security mode except that
on-site web proxy services and Layer-4 Traffic Monitor services are not available in Cloud Web Security
Connector mode.

You can deploy the Cloud Web Security Connector in either explicit forward mode or in transparent mode.

To modify Cloud Connector settings after initial setup, select Network > Cloud Connector.

Related Topics
e Chapter 2, “Connect, Install, and Configure”

Configuring the Cloud Connector

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6
Step 7

Before You Begin
See Enabling Access to the Web Interface on Virtual Appliances, page 1-2.

Access the Web Interface for the Web Security Appliance:

Enter the IPv4 address of the Web Security appliance in an Internet browser.
The first time you run the System Setup Wizard, use the default [Pv4 address:
https://192.168.42.42:8443

-or-

http://192.168.42.42:8080

where 192.168.42.42 is the default IPv4 address, and 8080 is the default admin port setting for HTTP,
and 8443 is default admin port for HTTPS.

Select System Administration > System Setup Wizard.
Accept the terms of the license agreement.
Click Begin Setup.

Configure system settings:

Setting Description
Default System Hostname The fully-qualified hostname for the Web Security appliance.
DNS Server(s) The Internet root DNS servers for domain name service lookups.

See also DNS Settings, page 2-26.

NTP Server A server with which to synchronize the system clock. The
default is time.ironport.com.

Time Zone Sets the time zone on the appliance so that timestamps in
message headers and log files are correct.

Select Cloud Web Security Connector for the appliance mode.

Configure Cloud Connector settings:
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M Configuring the Cloud Connector

Setting Description

Cloud Web Security Proxy Servers | The address of the Cloud Proxy Server (CPS), for example,
proxy1743.scansafe.net.

Failure Handling If AsyncOS fails to connect to a Cloud Web Security proxy,
either Connect directly to the Internet or Drop requests.

Cloud Web Security Authorization |Method for authorizing transactions:

Scheme e  Web Security Appliance public facing IPv4 address

e Authorization key included with each transaction. You can
generate an authorization key within the Cisco Cloud Web
Security Portal.

Step8  Configure network interfaces and wiring:

Setting Description

Ethernet Port If you configure the M1 interface for management traffic only, you must configure
the P1 interface for data traffic. However, you can configure the P1 interface even
when the M1 interface is used for both management and data traffic.

IP Address The IPv4 address to use to manage the Web Security appliance.

Network Mask |The network mask to use when managing the Web Security appliance on this
network interface.

Hostname The hostname to use when managing the Web Security appliance on this
network interface.

Step9  Configure routes for Management and Data traffic:

Setting Description

Default Gateway |The default gateway IPv4 address to use for the traffic through the Management
and/or Data interface.

Name A name used to identify the static route.

Internal Network |The IPv4 address for this route’s destination on the network.

Internal Gateway |The gateway IPv4 address for this route. A route gateway must reside on the same
subnet as the Management or Data interface on which it is configured.

Step10 Configure transparent connection settings:

~

Note By default, the Cloud Connector is deployed in transparent mode. which requires a connection
to a Layer-4 switch or a version 2 WCCP router
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Step 11

Step 12

Configuring the Cloud Connector Il

Setting Description

Layer-4 Switch e The Web Security appliance is connected to a layer 4 switch.
or or

No Device ¢ You will deploy the Cloud Connector in explicit forward mode.

WCCP v2 Router |The Web Security appliance is connected to a version 2 WCCP capable router.

Note: A passphrase can contain up to seven characters and is optional.

Configure administrative settings:

Setting Description

Administrator Passphrase A passphrase to access the Web Security appliance. The passphrase

must be six characters or more.

Email system alerts to An email address to which the appliance sends alerts.

Send Email via SMTP Relay Host |(Optional) A hostname or address for an SMTP relay host that

AsyncOS uses for sending system generated email messages.

The default SMTP relay host is the mail servers listed in the MX
record.

The default port number is 25.

AutoSupport The appliance can send system alerts and weekly status report to

Cisco Customer Support.

Review and install:

a.
b.

C.

Review the installation.
Click Previous to go back and make changes.

Click Install This Configuration to continue with the information you provided.

Related Topics

Preventing Loss of Secure Data, page 3-9
Network Interfaces, page 2-11

Configuring TCP/IP Traffic Routes, page 2-16
Configuring Transparent Redirection, page 2-18
Managing Alerts, page 22-14

Configuring SMTP Relay Host Settings, page 2-25

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Chapter3  Connect the Appliance to a Cisco Cloud Web Security Proxy |

Il Controlling Web Access Using Directory Groups in the Cloud

Controlling Web Access Using Directory Groups in the Cloud

You can use Cisco Cloud Web Security to control web access based on directory groups. When traffic to
Cisco Cloud Web Security is being routed through a Web Security Appliance in Cloud Connector mode,
Cisco Cloud Web Security needs to receive the directory-group information with the transactions from
the Cloud Connector so it can apply the group-based cloud policies.

Before You Begin

e Add an authentication realm to the Web Security Appliance configuration.

Step1  Navigate to Network > Cloud Connector.
Step2  In the Cloud Policy Directory Groups area, click Edit Groups.

Step3  Select the User Groups and Machine Groups for which you have created Cloud Policies within Cisco
Cloud Web Security.

Stepd  Click Add.

Step5 Click Done and Commit your changes.

Related information
e Authentication Realms, page 5-11

Bypassing the Cloud Proxy Server

Cloud routing policies allow you to route web traffic to either Cisco Cloud Web Security proxies or
directly to the Internet based on these characteristics:

¢ Identification Profile
e Proxy Port

e Subnet

e URL Category

e User Agent

The process of creating cloud routing policies in Cloud Connector mode is identical to the process of
creating routing policies using the standard mode.

Related Topics
e Creating a Policy, page 10-5

Partial Support for FTP and HTTPS in Cloud Connector Mode

The Web Security appliance in Cloud Connector mode does not fully support FTP or HTTPS.

FTP

FTP is not supported by the Cloud Connector. AsyncOS drops native FTP traffic when the appliance is
configured for Cloud Connector.
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Preventing Loss of Secure Data W

FTP over HTTP is supported in Cloud Connector mode.

HTTPS
The Cloud Connector does not support decryption. It passes HTTPS traffic without decrypting.

Because the Cloud Connector does not support decryption, AsyncOS generally does not have access to
information in the client headers of HTTPS traffic. Therefore, AsyncOS generally cannot enforce
routing policies that rely on information in encrypted headers. This is always the case for transparent
HTTPS transactions. For example, for transparent HTTPS transactions, AsyncOS does not have access
to the port number in the HTTPS client header and therefore it cannot match a routing policy based on
port number. In this case, AsyncOS uses the default routing policy.

There are two exceptions for explicit HTTPS transactions. AsyncOS has access to the following
information for explicit HTTPS transactions:

e URL
e Destination port number

For explicit HTTPS transactions, it is possible to match a routing policy based on URL or port number.

Preventing Loss of Secure Data

You can integrate the Cloud Connector with external Data Loss Prevention servers through Network >
External DLP Servers.

Related Topics
e Chapter 16, “Prevent Loss of Sensitive Data”

Viewing Group and User Names and IP Addresses

To view the configured group names, user names, and IP addresses, go to whoami.scansafe.net.

Subscribing to Cloud Connector Logs

Step 1
Step 2
Step 3
Step 4
Step 5

The Cloud Connector Logs provides useful information for troubleshooting problems with the Cloud
Connector, for example, authenticated users and groups, the Cloud header, and the authorization key.

Navigate to System Administration > Log Subscriptions.
Select Cloud Connector Logs from the Log Type menu.
Type a name in the Log Name field.

Set the log level.

Submit and Commit your changes.

Related Topics
e Chapter 21, “Monitor System Activity Through Logs”
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M Identification Profiles and Authentication with Cloud Web Security Connector

Identification Profiles and Authentication with Cloud Web
Security Connector

The Cloud Web Security Connector supports basic authentication and NTLM. You can also bypass
authentication for certain destinations.

In Cloud Connector mode, using an Active Directory realm, you can identify transaction requests as
originating from specific machines. The Machine ID service is not available in standard mode.

With two exceptions, Authentication works the same throughout the Web Security Appliance, whether
in standard configuration or Cloud Connector configuration. Exceptions:

e The Machine ID service is not available in standard mode.

¢ AsyncOS does not support Kerberos when the appliance is configured in Cloud Connector mode.

Note Identification Profiles based on User Agent or Destination URL are not supported for HTTPS traffic.

Related Topics
e Identifying Machines for Policy Application, page 3-10
e Guest Access for Unauthenticated Users, page 3-11
e Chapter 6, “Classify End-Users and Client Software”
e Chapter 5, “Acquire End-User Credentials”

Identifying Machines for Policy Application

By enabling the Machine ID service, AsyncOS can apply policies based on the machine that made the
transaction request rather than the authenticated user or IP address or some other identifier. AsyncOS
uses NetBIOS to acquire the machine ID.

Before You Begin

¢ Be aware that the machine identity service is only available through Active Directory realms. If you
do not have an Active Directory realm configured, this service is disabled.

Step 1 Select Network > Machine ID Service.
Step2  Click Enable and Edit Settings.

Step3  Configure Machine Identification settings:

Setting Description

Enable NetBIOS for Machine Identification |Select to enable the machine identification service.

Realm The Active Directory realm to use to identify the
machine that is initiating the transaction request.

Failure Handling If AsyncOS cannot identify the machine, should it

drop the transaction or continue with policy matching?
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Identification Profiles and Authentication with Cloud Web Security Connector 1l

Stepd  Submit and Commit your changes.

Guest Access for Unauthenticated Users

If the Web Security appliance is configured to provide guest access for unauthenticated users, in Cloud
Connector mode, AsyncOS assigns guest users to the group, __ GUEST_GROUP__, and sends that
information to Cisco Cloud Web Security. Use Identities to provide guest access to unauthenticated
users. Use Cisco Cloud Web Security policies to control these guest users.

Related Topics
e Granting Guest Access After Failed Authentication, page 5-31
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Intercepting Web Requests

e Overview of Intercepting Web Requests, page 4-1.

e Tasks for Intercepting Web Requests, page 4-2.

e Best Practices for Intercepting Web Requests, page 4-2.

e Web Proxy Options for Intercepting Web Requests, page 4-3.
e Client Options for Redirecting Web Requests, page 4-10.

Overview of Intercepting Web Requests

The Web Security appliance intercepts requests that are forwarded to it by clients or other devices over
the network.

The appliance works in conjunction with other network devices to intercept traffic. These may be
ordinary switches, transparent redirection devices, and other proxy servers or Web Security appliances.
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B Tasks for Intercepting Web Requests

Tasks for Intercepting Web Requests

Steps | Task Links to Related Topics and Procedures
1. Review best practices. e Best Practices for Intercepting Web Requests,
page 4-2
2. (Optional) Perform follow up networking tasks: e Upstream Proxies, page 2-9
¢ Connect and configure upstream proxies. e Network Interfaces, page 2-11
¢ Configure network interface ports. e Configuring Transparent Redirection, page 2-18
e Configure transparent redirection devices. e Configuring TCP/IP Traffic Routes, page 2-16
e Configure TCP/IP routes. e Increasing Interface Capacity Using VLANS,
e Configure VLANS. page 2-22
3. (Optional) Perform follow up Web Proxy tasks: e Web Proxy Options for Intercepting Web Requests,
¢ Configure the web proxy to operate in either Forward page 4-3
or Transparent mode. ¢ Configuring Web Proxy Settings, page 4-3
e Decide if additional services are needed for the e Web Proxy Options for Intercepting Web Requests,
protocol types you want to intercept page 4-3
e Configure IP spoofing. e Web Proxy Cache, page 4-5
e Manage the web proxy cache. e  Web Proxy IP Spoofing, page 4-8
e Use custom web request headers. e Web Proxy Bypassing, page 4-9
e Bypass the proxy for some requests.
4. Perform client tasks: ¢ Client Options for Redirecting Web Requests,

e Decide how clients should redirect requests to the
web proxy.

e Configure clients and client resources.

page 4-10

Best Practices for Intercepting Web Requests

¢ Enable only the proxy services you require.

e Use the same forwarding and return method (either L2 or GRE) for all WCCP services defined in
the Web Security appliance. This allows the proxy bypass list to work consistently.

¢ Ensure that users cannot access PAC files from outside the corporate network. This allows your
mobile workers to use the web proxy when they are on the corporate network and to connect directly

to web servers at other times.

e Allow a web proxy to accept X-Forwarded-For headers from trustworthy downstream proxies or

load balancers only.

e Leave the web proxy in the default transparent mode, even if initially using only explicit forwarding.
Transparent mode also accepts explicitly forwarded requests.
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Web Proxy Options for Intercepting Web Requests

Web Proxy Options for Intercepting Web Requests

By itself, the Web Proxy can intercept web requests that use HTTP (including FTP over HTTP) and
HTTPS. Additional proxy modules are available to enhance protocol management:

e HTTPS Proxy. The HTTPS proxy supports the decryption of HTTPS traffic and allows the web
proxy to pass unencrypted HTTPS requests on to policies for content analysis.

A

Note  When in transparent mode, the Web Proxy drops all transparently redirected HTTPS requests if
the HTTPS proxy is not enabled. No log entries are created for dropped transparently redirected
HTTPS requests.

Each of these additional proxies requires the Web Proxy in order to function.You cannot enable them if
you disable the Web Proxy.

~

Note  The Web proxy is enabled by default. All other proxies are disabled by default.

Configuring Web Proxy Settings

Before You Begin
e Enable the web proxy.

Step1  Choose Security Services > Web Proxy.
Step2  Click Edit Settings.

Step3  Configure the basic web proxy settings as required.

Property Description

HTTP Ports to Proxy The ports that the web Proxy will listen on for HTTP connections

Caching Specifies whether to enable or disable Web Proxy caching.

The web proxy caches data to increase performance.

Proxy mode e Forward — Allow the client browser to name the internet target.
Requires individual configuration of each web browser to use the web
proxy. The web proxy can intercept only explicitly forwarded web
requests in this mode.

e Transparent (Recommended) — Allow the web proxy to name the
internet target. The web proxy can intercept both transparent and
explicitly forwarded web requests in this mode.

IP Spoofing e [P Spoofing disabled — The web proxy changes the request source IP
address to match its own address to increase security.

e [P Spoofing enabled — The web proxy retains the source address so
that it appears to originate from the source client rather than from the
Web Security appliance.
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B Web Proxy Options for Intercepting Web Requests

Stepd  Complete the advanced web proxy settings as required.

Property Description

Persistent Connection | The maximum time in seconds the web proxy keeps open a connection to a
Timeout client or server after a transaction has been completed and no further activity
is detected.

¢ Client side. The timeout value for connections to clients.
¢ Server side. The timeout value for connections to servers.

If you increase these values connections will remain open longer and reduce
the overhead used to open and close connections repeatedly. However, you
also reduce the ability of the Web Proxy to open new connections if the
maximum number of simultaneous persistent connections has been reached.

Cisco recommends keeping the default values.

In-Use Connection The maximum time in seconds that the web proxy waits for more data from
Timeout an idle client or server when the current transaction has not yet been com-
pleted.

¢ Client side. The timeout value for connections to clients.

e Server side. The timeout value for connections to servers.

Simultaneous Persistent | The maximum number of connections (sockets) the Web Proxy keeps open
Connections (Server with servers.
Maximum Number)

Generate Headers Generate and add headers that encode information about the request.

¢ X-Forwarded-For headers encode the IP address of the client from
which an HTTP request originated.

Note  To turn header forwarding on or off, use the CLI
advancedproxyconfig command, Miscellaneous option, “Do you
want to pass HTTP X-Forwarded-For headers?”

Note  Using an explicit forward upstream proxy to manage user
authentication or access control with proxy authentication requires
forwarding of these headers.

¢ Request Side VIA headers encode the proxies through which the
request passed on its way from the client to the server.

e Response Side VIA headers encode the proxies through which the
request passed on its way from the server to the client.
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Web Proxy Options for Intercepting Web Requests

Use Received Headers | Allows a Web proxy deployed as an upstream proxy to identify clients using
X-Forwarded-For headers send by downstream proxies. The Web Proxy will
not accept the IP address in a X-Forwarded-For header from a source that is
not included in this list.

If enabled, requires the IP address of a downstream proxy or load balancer
(you cannot enter subnets or host names).

Range Request Use the Enable Range Request Forwarding checkbox to enable or disable
Forwarding forwarding of range requests. Refer to Range Request Settings, page 15-3
for more information.

Step5  Submit and commit your changes.

Related Topics
e Web Proxy Cache, page 4-5.

e Configuring Transparent Redirection, page 2-18

Web Proxy Cache

The web proxy caches data to increase performance. AsyncOS includes defined caching modes that
range from safe to aggressive, and also allows customized caching. You can also exclude specific URLs
from being cached, either by removing them from the cache, or by configuring the cache to ignore them.

Clearing the Web Proxy Cache

Step 1 Choose Security Services > Web Proxy.

Step2  Click Clear Cache and confirm your action.

Removing URLs from the Web Proxy Cache

Step 1 Access the CLI.

Step2  Use the webcache > evict commands to access the required caching area:

example.com> webcache

Choose the operation you want to perform:

- EVICT - Remove URL from the cache

- DESCRIBE - Describe URL cache status

- IGNORE - Configure domains and URLs never to be cached
[1> evict

Enter the URL to be removed from the cache.

[1>

Step3  Enter the URL to be removed from the cache.
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S

Note If you do not include a protocol in the URL, nttp:// will be prepended to it (e.g.,
www.cisco.com Will become http://www.cisco.com)

Specifying Domains or URLs that the Web Proxy never Caches

Step 1 Access the CLI.

Step 2 Use the webcache -> ignore commands to access the required submenus:

example.com> webcache

Choose the operation you want to perform:

- EVICT - Remove URL from the cache

- DESCRIBE - Describe URL cache status

- IGNORE - Configure domains and URLs never to be cached
[1> ignore

Choose the operation you want to perform:
- DOMAINS - Manage domains

- URLS - Manage urls

[1>

Step3  Enter the address type you wish to manage: DOMAINS Or URLS.

[1> urls
Manage url entries:

Choose the operation you want to perform:
- DELETE - Delete entries

- ADD - Add new entries

- LIST - List entries

[1>

Stepd  Enter add to add new entries:

[1> add

Enter new url values; one on each line; an empty line to finish

[1>

Step5 Enter domains or URLSs, one per line; for example:

Enter new url values; one on each line; an empty line to finish
[]> www.examplel.com

Enter new url values; one on each line; an empty line to finish
[1>

You can include certain regular expression (regex) characters when specifying a domain or URLs. With
the poMAINS option, you can use a preceding dot character to exempt an entire domain and its subdomains
from caching. For example, you can enter .google.com rather than simply google.com to exempt
www.google.com, docs.google.com, and so on.

With the urLs option, you can use the full suite of regular-expression characters. See Regular
Expressions, page 9-20 for more information about using regular expressions.
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Step 6
Step 7

Web Proxy Options for Intercepting Web Requests

When you are finished entering values, press Enter until you are returned to the main command-line interface.

Commit your changes.

Choosing The Web Proxy Cache Mode

Step 1
Step 2

Step 3

Access the CLI.

Use the advancedproxyconfig -> caching commands to access the required submenus:

example.com> advancedproxyconfig

Choose a parameter group:

AUTHENTICATION - Authentication related parameters
CACHING - Proxy Caching related parameters

DNS - DNS related parameters

EUN - EUN related parameters

NATIVEFTP - Native FTP related parameters

FTPOVERHTTP - FTP Over HTTP related parameters

HTTPS - HTTPS related parameters

SCANNING - Scanning related parameters

PROXYCONN - Proxy connection header related parameters
CUSTOMHEADERS - Manage custom request headers for specific domains
MISCELLANEQOUS - Miscellaneous proxy related parameters
SOCKS - SOCKS Proxy parameters

[1> caching

Enter values for the caching options:

The following predefined choices exist for configuring advanced caching

options:

1. Safe Mode

2. Optimized Mode
3. Aggressive Mode
4. Customized Mode

Please select from one of the above choices:
[2]>

Enter a number corresponding to the web proxy cache settings you require:

Entry

Mode Description

1

Safe The least caching and the most adherence to RFC #2616

compared to the other modes.

Optimized Moderate caching and moderate adherence to RFC #2616.
Compared to safe mode, in optimized mode the Web Proxy
caches objects when no caching time is specified when a
Last-Modified header is present. The Web Proxy caches

negaﬁveresponse&

Aggressive The most caching and the least adherence to RFC #2616.
Compared to optimized mode, aggressive mode caches au-
thenticated content, ETag mismatches, and content without
a Last-Modified header. The Web Proxy ignores the

no-cache parameter.

Customized mode |Configure each parameter individually.
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Step 4 If you chose option 4 (Customized mode), enter values (or leave at the default values) for each of the
custom settings.

Step5  Press Enter until you return to the main command interface.

Step6  Commit your changes.

Related Topics
e Web Proxy Cache, page 4-5.

Web Proxy IP Spoofing

When the web proxy forwards a request, it changes the request source IP address to match its own
address by default. This increases security, but you can change this behavior by implementing IP
spoofing, so that requests retain their source address and appear to originate from the source client rather
than from the Web Security appliance.

IP spoofing works for transparent and explicitly forwarded traffic. When the Web Proxy is deployed in
transparent mode, you have the choice to enable IP spoofing for transparently redirected connections
only or for all connections (transparently redirected and explicitly forwarded). If explicitly forwarded
connections use IP spoofing, you should ensure that you have appropriate network devices to route return
packets back to the Web Security appliance.

When IP spoofing is enabled and the appliance is connected to a WCCP router, you must configure two
WCCP services: one based on source ports and one based on destination ports.

Related Topics
e Configuring Web Proxy Settings, page 4-3.
e Configuring WCCP Services, page 2-19.

Web Proxy Custom Headers

You can add custom headers to specific outgoing transactions to request special handling from
destination servers. For example, if you have a relationship with YouTube for Schools, you can use a
custom header to identify transaction requests to YouTube.com as coming from your network and as
requiring special handling.

Adding Custom Headers To Web Requests

Step 1 Access the CLI.

Step 2 Use the advancedproxyconfig -> customheaders commands to access the required submenus:

example.com> advancedproxyconfig

Choose a parameter group:

- AUTHENTICATION - Authentication related parameters
- CACHING - Proxy Caching related parameters

- DNS - DNS related parameters

- EUN - EUN related parameters

- NATIVEFTP - Native FTP related parameters
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- FTPOVERHTTP - FTP Over HTTP related parameters

- HTTPS - HTTPS related parameters

- SCANNING - Scanning related parameters

- PROXYCONN - Proxy connection header related parameters

- CUSTOMHEADERS - Manage custom request headers for specific domains
- MISCELLANEOUS - Miscellaneous proxy related parameters

- SOCKS - SOCKS Proxy parameters

[1> customheaders

Currently defined custom headers:

Choose the operation you want to perform:
- DELETE - Delete entries

- NEW - Add new entries

- EDIT - Edit entries

[1>

Step3  Enter the required subcommand as follows:

Option Description

Delete Deletes the custom header you identify. Identify the header to delete using the
number associated with the header in the list returned by the command.

New Creates the header you provide for use with the domain or domains you specify.
Example header:

X-YouTube-Edu-Filter: ABCD1234567890abcdef

(The value in this case is a unique key provided by YouTube.)

Example domain:

youtube.com

Edit Replaces an existing header with one you specify. Identify the header to delete using
the number associated with the header in the list returned by the command.

Step4  Press Enter until you return to the main command interface.

Step5 Commit your changes.

Web Proxy Bypassing

e Web Proxy Bypassing for Web Requests, page 4-9
e Configuring Web Proxy Bypassing for Web Requests, page 4-10
e Configuring Web Proxy Bypassing for Applications, page 4-10

Web Proxy Bypassing for Web Requests
You can configure the Web Security appliance so that transparent requests from particular clients, or to
particular destinations, bypass the Web Proxy.
Bypassing the web proxy allows you to:

e Prevent interference with non-HTTP-compliant (or proprietary) protocols that use HTTP ports but
do not work properly when they connect to a proxy server.
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e Ensure that traffic from a particular machine inside the network, such as a malware test machine,
bypasses the Web Proxy and all its built-in security protection.

Bypassing only works for requests that are transparently redirected to the web proxy. The web proxy
processes all requests that clients explicitly forward to it, whether the proxy is in transparent or
forward mode.

Configuring Web Proxy Bypassing for Web Requests

Step 1 Choose Web Security Manager > Bypass Settings.
Step2  Click Edit Bypass Settings.
Step3  Enter the addresses for which you wish to bypass the web proxy.

Stepd  Submit and commit your changes.

Configuring Web Proxy Bypassing for Applications

Step1  Choose Web Security Manager > Bypass Settings.
Step2  Click Edit Application Bypass Settings.
Step3  Select the application(s) you wish to bypass scanning for.

Step4  Submit and commit your changes.

Web Proxy Usage Agreement

You can configure the Web Security appliance to inform users that it is filtering and monitoring their
web activity. The appliance does this by displaying an end-user acknowledgment page when a user first
accesses a browser after a certain period of time. When the end-user acknowledgment page appears,
users must click a link to access the original site requested or any other website.

Related Topics
e Notify End-Users of Proxy Actions

Client Options for Redirecting Web Requests

If you choose to have clients explicitly forward requests to the web proxy, you must also decide how to
configure the clients to do this. Choose from the following methods:

e Configure Clients Using Explicit Settings. Configure clients with the web proxy hostname and
port number. See individual client documentation for details on how to do this.

N

Note  The web proxy port uses port numbers 80 and 3128 by default. Clients can use either port.
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Troubleshooting Intercepting Requests

e URL Categories Do Not Block Some FTP Sites, page A-5

e Large FTP Transfers Disconnect, page A-5

e Zero Byte File Appears On FTP Servers After File Upload, page A-6
e Unable to Route FTP Requests Via an Upstream Proxy, page A-14

e HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication, page A-11

e User Matches Global Policy for HTTPS and FTP over HTTP Requests, page A-11
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CHAPTER 5

Acquire End-User Credentials

e Overview of Acquire End-User Credentials, page 5-1
e Authentication Best Practices, page 5-2

e Authentication Realms, page 5-11

e Failed Authentication, page 5-28

e C(Credentials, page 5-35

e Troubleshooting Authentication, page 5-37

Overview of Acquire End-User Credentials

Authentication

Server Type/Realm |Scheme Supported Network Protocol Notes
Active Directory Kerberos HTTP, HTTPS Kerberos is only supported in Standard
NTLMSSP Native FTP, FTP over HTTP mode. Itis not supported in Cloud
Connector mode.
Basic SOCKS (Basic authentication)
LDAP Basic HTTP, HTTPS —
Native FTP, FTP over HTTP
SOCKS
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Authentication Task Overview

Step

Task

Links to Related Topics and Procedures

1.

Create an authentication realm.

How to Create an Active Directory Authentication Realm
(NTLMSSP and Basic), page 5-14

Creating an LDAP Authentication Realm, page 5-16

2. Configure global authentication settings. e Configuring Global Authentication Settings, page 5-21
3 Configure external authentication. e External Authentication, page 5-11
You can authenticate users through an external LDAP
or RADIUS server.
4. (Optional) Create and order additional ¢ Creating Authentication Sequences, page 5-27
authentication realms.
Create at least one authentication realm for each
authentication protocol and scheme combination you
plan to use.
5. (Optional) Configure credential encryption. e Configuring Credential Encryption, page 5-36
6. Create identities to classify users and client software | ¢ Classifying Users and Client Software, page 6-3
based on authentication requirements.
1. Create policies to manage web requests from the users | © Managing Web Requests Through Policies Best

and user groups for which you created identities.

Practices, page 10-2

Authentication Best Practices

¢ Create as few Active Directory realms as is practical. Multiple Active Directory realms require
additional memory usage for authentication.

e If using NTLMSSP, authenticate users using either the Web Security appliance or the upstream
proxy server, but not both. (Recommend Web Security appliance)

e If using Kerberos, authenticate using the Web Security appliance.

¢ For optimal performance, authenticate clients on the same subnet using a single realm.

e Some user agents are known to have issues with machine credentials or authentication failures,
which can negatively impact normal operations. You should bypass authentication with these user
agents. See Bypassing Authentication with Problematic User Agents, page 5-29.

Authentication Planning

e Active Directory/Kerberos, page 5-3

e Active Directory/Basic, page 5-4

e Active Directory/NTLMSSP, page 5-5

e LDAP/Basic, page 5-5

e Identifying Users Transparently, page 5-5
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Active Directory/Kerberos
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Explicit Forward

Transparent, IP-Based Caching

Transparent, Cookie-Based Caching

Advantages:

Better performance and interopera-
bility when compared to NTLM

Works with both Windows and
non-Windows clients that have
joined the domain

Supported by all browsers and most
other applications

RFC-based
Minimal overhead

Works for HTTPS
(CONNECT) requests

Because the passphrase is not
transmitted to the authentication
server, it iS more secure

Connection is authenticated, not the
host or IP address

Achieves true single sign-on in an
Active Directory environment
when the client applications are
configured to trust the Web
Security appliance

Advantages:

Better performance and interopera-
bility when compared to NTLM

Works with both Windows and
non-Windows clients that have
joined the domain

Works with all major browsers

With user agents that do not
support authentication, users
only need to authenticate first in
a supported browser

Relatively low overhead

Works for HTTPS requests if the
user has previously authenticated
with an HTTP request

Advantages:

Better performance and interopera-
bility when compared to NTLM

Works with both Windows and
non-Windows clients that have
joined the domain

Works with all major browsers

Authentication is associated
with the user rather than the host
or IP address

Disadvantages:

Each new web domain requires
the entire authentication process
because cookies are domain specific

Requires cookies to be enabled

Does not work for HTTPS requests
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Active Directory/Basic

Explicit Forward

Transparent, IP-Based Caching

Transparent, Cookie-Based Caching

Advantages:

Supported by all browsers and most
other applications

RFC-based
Minimal overhead

Works for HTTPS
(CONNECT) requests

Because the passphrase is not
transmitted to the authentication
server, it is more secure

Connection is authenticated, not the
host or IP address

Achieves true single sign-on in an
Active Directory environment
when the client applications are
configured to trust the Web
Security appliance

Disadvantages:

Passphrase sent as clear text
(Base64) for every request
No single sign-on

Moderate overhead: each new
connection needs to be
re-authenticated

Primarily supported on Windows
only and with major browsers only

Advantages:

Works with all major browsers

With user agents that do not
support authentication, users
only need to authenticate first in
a supported browser

Relatively low overhead

Works for HTTPS requests if the
user has previously authenticated
with an HTTP request

Disadvantages:

Authentication credentials are
associated with the IP address, not
the user (does not work in Citrix and
RDP environments, or if the user
changes IP address)

No single sign-on

Passphrase is sent as clear text
(Base64)

Advantages:
e Works with all major browsers

e Authentication is associated
with the user rather than the host
or IP address

Disadvantages:

e FEach new web domain requires the
entire authentication process
because cookies are domain specific

e Requires cookies to be enabled
e Does not work for HTTPS requests
e No single sign-on

e Passphrase is sent as clear text
(Base64)
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Active Directory/NTLMSSP

Authentication Planning W

Explicit Forward

Transparent

Advantages:

e Because the passphrase is not transmitted to the
authentication server, it iS more secure

e Connection is authenticated, not the host or IP address

e Achieves true single sign-on in an Active Directory
environment when the client applications are
configured to trust the Web Security appliance

Disadvantages:

e Moderate overhead: each new connection needs to be
re-authenticated

¢ Primarily supported on Windows only and with major
browsers only

Advantages:
e More Flexible

Transparent NTLMSSP authentication is similar to transparent
Basic authentication except that the Web Proxy communicates

with clients using challenge and response instead of basic clear
text username and passphrase.

The advantages and disadvantages of using transparent NTLM
authentication are the same as those of using transparent Basic
authentication except that transparent NTLM authentication
has the added advantaged of not sending the passphrase to
the authentication server and you can achieve single sign-on
when the client applications are configured to trust the Web
Security appliance.

LDAP/Basic

Explicit Forward Transparent
Advantages: Advantages:
e RFC-based e More Flexible than explicit forward.

e More browser support than NTLM

e Minimal overhead

e  Works for HTTPS (CONNECT) requests
Disadvantages:

e No single sign-on

e Passphrase sent as clear text (Base64) for every
request

Workarounds:

e Failed Authentication, page 5-28

e More browser support than NTLM

e With user agents that do not support authentication, users
only need to authenticate first in a supported browser

e Relatively low overhead

e  Works for HTTPS requests if the user has previously
authenticated with an HTTP request

Disadvantages:
e No single sign-on
e Passphrase is sent as clear text (Base64)

e Authentication credentials are associated with the IP address,
not the user (does not work in Citrix and RDP environments,
or if the user changes IP address)

Workarounds:

e Failed Authentication, page 5-28

Identifying Users Transparently

Traditionally, users are identified and authenticated by prompting them to enter a user name and
passphrase. These credentials are validated against an authentication server, and then the Web Proxy
applies the appropriate policies to the transaction based on the authenticated user name.
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Note

However, you can configure the Web Security appliance to authenticate users transparently—that is,
without prompting the end user for credentials. Transparent identification authenticates the user by
means of credentials obtained from another trusted source, with the assumption that the user has already
been authenticated by that trusted source, and then applies the appropriate policies.

You might want to identify users transparently to:
¢ Create a single sign-on environment so users are not aware of the presence of a proxy on the network.

e To apply authentication-based policies to transactions coming from client applications that are
incapable of displaying an authentication prompt to end users.

Identifying users transparently only affects how the Web Proxy obtains the user name and assigns an
Identification Profile. After it obtains the user name and assigns an Identification Profile, it applies all
other policies normally, regardless of how it assigned the Identification Profile.

If transparent authentication fails, you can configure how to handle the transaction: you can grant the
user guest access, or you can force an authentication prompt to appear to the user.

When an end user is shown an authentication prompt due to failed transparent user identification, and
the user then fails authentication due to invalid credentials, you can choose whether to allow the user
guest access.

When you enable re-authentication and a transaction is blocked by URL filtering, an end-user
notification page appears with the option to log in as a different user. Users who click the link are
prompted for authentication. For more information, see Failed Authorization: Allowing
Re-Authentication with Different Credentials, page 5-33.

Understanding Transparent User Identification

The available methods of transparent user identification are:

¢ Transparently identify users with ISE — Available when the Identity Services Engine (ISE) service
is enabled (Network > Identity Services Engine). For these transactions, the user name and
associated Secure Group Tags will be obtained from an Identity Services Engine server. See Tasks
for Certifying and Integrating the ISE Service, page 8-3.

e Transparently identify users with ASA — Users are identified by the current IP address-to-user
name mapping received from a Cisco Adaptive Security Appliance (for remote users only). This
option is available when AnyConnect Secure Mobility is enabled and integrated with an ASA. The
user name will be obtained from the ASA, and associated directory groups will be obtained from the
authentication realm or sequence specified on the Web Security appliance. See Remote Users,
page 10-16.

e Transparently identify users with authentication realms — This option is available when one or
more authentication realms are configured to support transparent identification using one of the
following authentication servers:

— Active Directory — Create an NTLM or Kerberos authentication realm and enable transparent
user identification. In addition, you must deploy a separate Active Directory agent such as
Cisco’s Context Directory Agent. For more information, see Transparent User Identification
with Active Directory, page 5-7.

— LDAP - Create an LDAP authentication realm configured as an eDirectory, and enable
transparent user identification. For more information, see Transparent User Identification with
LDAP, page 5-8.
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AsyncOS for Web communicates at regular intervals with eDirectory or an Active Directory agent
to maintain mappings that match authenticated user names to their current IP addresses.

Transparent User Identification with Active Directory

Active Directory does not record user log-in information in a format that is easily queried by other
systems such as the Web Security appliance. Active Directory agents, such as Cisco’s Context
Directory Agent (CDA), are necessary to query the Active Directory security event logs for information
about authenticated users.

AsyncOS for Web communicates with the Active Directory agent to maintain a local copy of the
IP-address-to-user-name mappings. When AsyncOS for Web needs to associate an IP address with a user
name, it first checks its local copy of the mappings. If no match is found, it queries an Active Directory
agent to find a match.

For more information on installing and configuring an Active Directory agent, see Setting Up an Active
Directory Agent to Provide Information to the Web Security Appliance, page 5-7.

Consider the following when you identify users transparently using Active Directory:

e Transparent user identification with Active Directory works with an NTLM or Kerberos
authentication scheme only. You cannot use it with an LDAP authentication realm that corresponds
to an Active Directory instance.

e Transparent user identification works with the versions of Active Directory supported by an Active
Directory agent.

* Youcan install a second instance of an Active Directory agent on a different machine to achieve high
availability. When you do this, each Active Directory agent maintains [P-address-to-user-name
mappings independently of the other agent. AsyncOS for Web uses the backup Active Directory
agent after three unsuccessful ping attempts to the primary agent.

e The Active Directory agent uses on-demand mode when it communicates with the Web Security
appliance.

e The Active Directory agent pushes user log-out information to the Web Security appliance.
Occasionally, some user log-out information is not recorded in the Active Directory security logs.
This can happen if the client machine crashes, or if the user shuts down the machine without logging
out. If there is no user log-out information in the security logs, an Active Directory agent cannot
inform the appliance that the IP address no longer is assigned to that user. To obviate this possibility,
you can define how long AsyncOS caches the IP-address-to-user mappings when there are no
updates from an Active Directory agent. For more information, see Using the CLI to Configure
Advanced Transparent User Identification Settings, page 5-9.

e The Active Directory agent records the saMAccountName for each user logging in from a particular
IP address to ensure the user name is unique.

¢ The client IP addresses that the client machines present to the Active Directory server and the Web
Security appliance must be the same.

¢ AsyncOS for Web searches only direct parent groups for a user. It does not search nested groups.

Setting Up an Active Directory Agent to Provide Information to the Web Security Appliance

Because AsyncOS for Web cannot obtain client IP addresses directly from Active Directory, it must
obtain IP-address-to-user-name mapping information from an Active Directory agent.
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Note

Note

Install an Active Directory agent on a machine in the network that is accessible to the Web Security
appliance, and which can communicate with all visible Windows domain controllers. For best
performance, this agent should be physically as close as possible to the Web Security appliance. In
smaller network environments, you may want to install the Active Directory agent directly on the Active
Directory server.

The Active Directory agent instance used to communicate with the Web Security appliance
can also support other appliances, including Cisco’s Adaptive Security Appliance and other Web
Security appliances.

Obtaining, Installing, and Configuring Cisco’s Context Directory Agent

You can find information about downloading, installing, and configuring the Cisco Context Directory
Agent here: http://www.cisco.com/en/US/docs/security/ibf/cda_10/Install_Config_guide/cdal0.html.

The Web Security appliance and Active Directory agent communicate with each other using the
RADIUS protocol. The appliance and the agent must be configured with the same shared secret to
obfuscate user passphrases. Other user attributes are not obfuscated.

Transparent User Identification with LDAP

AsyncOS for Web can communicate with an eDirectory server configured as a Lightweight Directory
Access Protocol (LDAP) realms maintaining IP-address-to-user-name mappings. When a user logs in
through an eDirectory client, the user is authenticated against the eDirectory server. When authentication
succeeds, the client IP address is recorded in the eDirectory server as an attribute (NetworkaAddress) of
the user who logged in.

Consider the following when you identify users transparently using LDAP (eDirectory):

e The eDirectory client must be installed on each client workstation, and end users must use it to
authenticate against an eDirectory server.

e The LDAP tree used by the eDirectory client log-in must be the same LDAP tree configured in the
authentication realm.

e If the eDirectory clients use multiple LDAP trees, create an authentication realm for each tree, and
then create an authentication sequence that uses each LDAP authentication realm.

e When you configure the LDAP authentication realm as an eDirectory, you must specify a Bind DN
for the query credentials.

e The eDirectory server must be configured to update the Networkaddress attribute of the user object
when a user logs in.

¢ AsyncOS for Web searches only direct parent groups for a user. It does not search nested groups.

® You can use the Networkaddress attribute for an eDirectory user to determine the most-recent log-in
IP address for the user.

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide


http://www.cisco.com/en/US/docs/security/ibf/cda_10/Install_Config_guide/cda10.html

| Chapter5 Acquire End-User Credentials

Authentication Planning W

Rules and Guidelines for Transparent User Identification

Consider the following rules and guidelines when using transparent user identification with any
authentication server:

When using DHCP to assign IP addresses to client machines, ensure the IP-address-to-user-name
mappings are updated on the Web Security appliance more frequently than the DHCP lease. Use the
tuiconfig CLI command to update the mapping update interval. For more information, see Using
the CLI to Configure Advanced Transparent User Identification Settings, page 5-9.

If a user logs out of a machine and another user logs into the same machine before the IP-address-to
user-name mapping is updated on the Web Security appliance, then the Web Proxy logs the client as
the previous user.

You can configure how the Web Proxy handles transactions when transparent user identification
fails. It can grant users guest access, or it can force an authentication prompt to appear to end users.

When a user is shown an authentication prompt due to failed transparent user identification, and the
user then fails authentication due to invalid credentials, you can choose whether to allow the user
guest access.

When the assigned Identification Profile uses an authentication sequence with multiple realms in
which the user exists, AsyncOS for Web fetches the user groups from the realms in the order in
which they appear in the sequence.

When you configure an Identification Profile to transparently identify users, the authentication
surrogate must be IP address. You cannot select a different surrogate type.

When you view detailed transactions for users, the Web Tracking page shows which users were
identified transparently.

You can log which users were identified transparently in the access and WC3 logs using the sm and
x-auth-mechanism custom fields. A log entry of sso_tur indicates that the user name was obtained
by matching the client IP address to an authenticated user name using transparent user identification.
(Similarly, a value of sso_asa indicates that the user is a remote user and the user name was obtained
from a Cisco ASA using AnyConnect Secure Mobility.)

Configuring Transparent User Identification

Configuring transparent user identification and authorization is detailed in Acquire End-User
Credentials, page 5-1. The basic steps are:

Create and order authentication realms.
Create Identification Profiles to classify users and client software.

Create policies to manage web requests from the identified users and user groups.

Using the CLI to Configure Advanced Transparent User Identification Settings

AsyncOS for Web provides the following TUI-related CLI commands:

tuiconfig — Configure advanced settings associated with transparent user identification. Batch
mode can be used to configure multiple parameters simultaneously.

— Configure mapping timeout for Active Directory agent — Length of time, in minutes,
[P-address-to-user mappings are cached for IP addresses retrieved by the AD agent when there
are no updates from the agent.
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— Configure proxy cache timeout for Active Directory agent —Length of time, in SeCOIldS,
proxy-specific IP-address-to-user mappings are cached; valid values range from five to 1200
seconds. The default and recommended value is 120 seconds. Specifying a lower value may
negatively affect proxy performance.

— Configure mapping timeout for Novell eDirectory — Length of time, in seconds, [P-address
to-user mappings are cached for IP addresses retrieved from the eDirectory server when there
are no updates from the server.

— Configure query wait time for Active Directory agent — The length of time, in seconds,
to wait for a reply from the Active Directory agent. When the query takes more than this value,
transparent user identification is considered to have failed. This limits the authentication delay
experienced by the end user.

— cConfigure query wait time for Novell eDirectory — The length of time, in seconds, to wait
for a reply from the eDirectory server. When the query takes more than this value, transparent
user identification is considered to have failed. This limits the authentication delay experienced
by the end user.

The Active Directory settings apply to all AD realms using an AD agent for transparent user
identification. The eDirectory settings apply to all LDAP realms using eDirectory for transparent
user identification.

If validation fails for any one parameter, none of the values will be changed.
e tuistatus — This command provides the following AD-related subcommands:

— adagentstatus — Displays the current status of all AD agents, as well as information about their
connections with the Windows domain controllers.

— 1listlocalmappings — Lists all IP-address-to-user-name mappings stored on the Web Security
appliance, as retrieved by the AD agent(s). It does not list entries stored on the agent(s), nor
does it list mappings for which queries are currently in progress.

Configuring Single-Sign-on

Obtaining credentials transparently facilitates a single-sign-on environment. Transparent user
identification is an authentication realm setting.

For Internet Explorer, be sure the Redirect Hostname is the short host name (containing no dots) or the
NetBIOS name rather than a fully qualified domain. Alternatively, you can add the appliance host name
to Internet Explorer’s Local intranet zone (Tools > Internet options > Security tab); however, this will be
required on every client. For more information about this, see How do I properly set up NTLM with SSO
(credentials sent transparently)?

With Firefox and other non-Microsoft browsers, the parameters network.negotiate-auth.delegation-uris,
network.negotiate-auth.trusted-uris and network.automatic-ntlm-auth.trusted-uris must be set to the
transparent-mode Redirect Hostname. You also can refer to Firefox is not sending authentication credentials
transparently (SSO). This article provides general information about changing Firefox parameters.

For information about the Redirect Hostname, see Configuring Global Authentication Settings, or the CLI
command sethostname.
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Authentication Realms

Authentication Realms

Authentication realms define the details required to contact the authentication servers and specify which
authentication scheme to use when communicating with clients. AsyncOS supports multiple
authentication realms. Realms can also be grouped into authentication sequences that allow users with
different authentication requirements to be managed through the same policies.

e External Authentication, page 5-11

e Creating an Active Directory Realm for Kerberos Authentication Scheme, page 5-12

e How to Create an Active Directory Authentication Realm (NTLMSSP and Basic), page 5-14
e C(Creating an LDAP Authentication Realm, page 5-16

e About Deleting Authentication Realms, page 5-21

¢ Configuring Global Authentication Settings, page 5-21

Related Topics
e RADIUS User Authentication, page 22-8

¢ Authentication Sequences, page 5-26

External Authentication

You can authenticate users through an external LDAP or RADIUS server.

Configuring External Authentication through an LDAP Server

Before You Begin

¢ Create an LDAP authentication realm and configure it with one or more external authentication
queries. Creating an LDAP Authentication Realm, page 5-16

Step1  Enable external authentication on the appliance:
a. Navigate to System Administration > Users.
b. Click Enable in the External Authentication section.

c. Configure the options:

Option Description

Enable External Authentication —

Authentication Type Select LDAP.

External Authentication Cache Timeout |The number of seconds AsyncOS stores the external
authentication credentials before contacting the LDAP
server again to re-authenticate. Default is zero (0).

LDAP External Authentication Query A query configured with the LDAP realm.

Timeout to wait for valid response The number of seconds AsyncOS waits for a response to
from server. the query from the server.
Group Mapping For each group name in the directory, assign a role.

Async0S 9.1 for Cisco Web Security Appliances User Guide
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Step2  Submit and commit your changes.

Enabling RADIUS External Authentication

See Enabling External Authentication Using RADIUS, page 22-9.

Creating an Active Directory Realm for Kerberos Authentication Scheme

Before You Begin

e Ensure the appliance is configured in Standard mode (not Cloud Connector Mode).

e Prepare the Active Directory Server.
— Install Active Directory on one of these servers: Windows server 2003, 2008, 2008R2 or 2012.
— Create a user on the Active Directory server that is a member of the domain administrators.

— Join your client to the domain. Supported clients are Windows XP, Windows 7 and
Mac OS 10.5+.

— Use the kerbtray tool from the Windows Resource Kit to verify the Kerberos ticket on the client:
http://www.microsoft.com/en-us/download/details.aspx?id=17657 .

— Ticket viewer application on Mac clients is available under main menu > KeyChain Access to
view the Kerberos tickets.

¢ Ensure you have the rights and domain information needed to join the Web Security appliance to the
Active Directory domain you wish to authenticate against.

e Compare the current time on the Web Security appliance with the current time on the Active
Directory server and verify that the difference is no greater than the time specified in the “Maximum
tolerance for computer clock synchronization” option on the Active Directory server.

e If the Web Security appliance is managed by a Security Management appliance, be prepared to
ensure that same-named authentication realms on different Web Security appliances have identical
properties defined on each appliance.

e Web Security appliance configuration:

— In explicit mode, the WSA host name (CLI command sethostname) and the proxy name
configured in the browser must be the same.

— In transparent mode, the WSA host name must be the same as the Redirect Hostname (see
Configuring Global Authentication Settings, page 5-21). Further, the WSA host name and
Redirect Hostname must be configured prior to creating a Kerberos realm.

e Be aware that once you commit the new realm, you cannot change a realm’s authentication protocol.

¢ Note that single sign on (SSO) must be configured on client browsers; see Configuring
Single-Sign-on, page 5-10.

¢ To simplify use of logs, customize the access log to use the m custom field parameter. See
Customizing Access Logs, page 21-26.

Step1  In the Cisco Web Security Appliance web interface, choose Network > Authentication.

Step2 Click Add Realm.
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Step 3
Step 4
Step 5

Step 6

Step 7

Step 8

Authentication Realms

Assign a unique name to the authentication realm using only alphanumeric and space characters.
Select Active Directory in the Authentication Protocol field.

Enter up to three fully-qualified domain names or IP addresses for the Active Directory server(s).
Example: ntlm.example.com.

An IP address is required only if the DNS servers configured on the appliance cannot resolve the Active
Directory server hostname.

When multiple authentication servers are configured in the realm, the appliance attempts to authorize
with up to three authentication servers before failing to authorize the transaction within this realm.

Join the appliance to the domain:

a. Configure the Active Directory Account:

Setting Description

Active Directory Domain |The Active Directory serve3r domain name. Also known as a DNS Domain
or realm.

NetBIOS domain name If the network uses NetBIOS, provide the domain name.

Tip If this option is not available use the setntlmsecuritymode CLI
command to verify that the NTLM security mode is set to “domain.”

Computer Account Specify a location within the Active Directory domain where AsyncOS
will create an Active Directory computer account, also known as a
“machine trust account”, to uniquely identify the computer on the domain.

If the Active Directory environment automatically deletes computer
objects at particular intervals, specify a location for the computer account
that is in a container, protected from automatic deletion.

b. Click Join Domain.

c. Provide login credentials (user name and passphrase) for the account on the Active Directory, and
click Create Account.

(Optional) Configure transparent user identification.

Setting Description

Enable Transparent Enter both the server name for the machine where the primary Context
User Identification using |Directory agent is installed and the shared secret used to access it.

Active Directory agent (Optional) Enter the server name for the machine where a backup Context

Directory agent is installed and its shared secret.

Configure Network Security:

Setting Description

Client Signing Required |Select this option if the Active Directory server is configured to require
client signing.

With this option selected, AsyncOS uses Transport Layer Security when
communicating with the Active Directory server.
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Step9  (Optional) Click Start Test. This will test the settings you have entered, ensuring they are correct before
real users use them to authenticate. For details on the testing performed, see *Create additional NTLM
realms to authenticate users in domains that are not trusted by existing NTLM realms., page 5-21.

Step10 Troubleshoot any issues found during testing. See Troubleshooting Tools for Authentication Issues

Step11  Submit and commit your changes.

What to Do Next

Create an Identification Profile that uses the Kerberos authentication scheme. Classifying Users and
Client Software, page 6-3.

How to Create an Active Directory Authentication Realm (NTLMSSP and Basic)

Prerequisites for Creating an Active Directory Authentication Realm (NTLMSSP and Basic)

Ensure you have the rights and domain information needed to join the Web Security appliance to the
Active Directory domain you wish to authenticate against.

If you plan to use “domain” as the NTLM security mode, use only nested Active Directory groups.
If Active Directory groups are not nested, use the default value, “ads”. See setntlmsecuritymode in
the Command Line Interface appendix of this guide.

Compare the current time on the Web Security appliance with the current time on the Active
Directory server and verify that the difference is no greater than the time specified in the “Maximum
tolerance for computer clock synchronization” option on the Active Directory server.

If the Web Security appliance is managed by a Security Management appliance, be prepared to
ensure that same-named authentication realms on different Web Security appliances have identical
properties defined on each appliance.

Be aware that once you commit the new realm, you cannot change a realm’s authentication protocol.

For NTLMSSP, single sign on (SSO) can be configured on client browsers. See Configuring
Single-Sign-on, page 5-10.

About Using Multiple NTLM Realms and Domains

The following rules apply in regard to using multiple NTLM realms and domains:

You can create up to 10 NTLM authentication realms.

The client IP addresses in one NTLM realm must not overlap with the client IP addresses in another
NTLM realm.

Each NTLM realm can join one Active Directory domain only but can authenticate users from any
domains trusted by that domain. This trust applies to other domains in the same forest by default and
to domains outside the forest to which at least a one way trust exists.

Create additional NTLM realms to authenticate users in domains that are not trusted by existing
NTLM realms.
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Authentication Realms

Creating an Active Directory Authentication Realm (NTLMSSP and Basic)

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Choose Network > Authentication.

Click Add Realm.

Assign a unique name to the authentication realm using only alphanumeric and space characters.
Select Active Directory in the Authentication Protocol and Scheme(s) field.

Enter up to three fully-qualified domain names or IP addresses for the Active Directory server(s).
Example: active.example.com.

An IP address is required only if the DNS servers configured on the appliance cannot resolve the Active
Directory server hostname.

When multiple authentication servers are configured in the realm, the appliance attempts to authorize
with up to three authentication servers before failing to authorize the transaction within this realm.

Join the appliance to the domain:

a. Configure the Active Directory Account:

Setting Description

Active Directory Domain |The Active Directory server domain name.
Also known as a DNS Domain or realm.

NetBIOS domain name If the network uses NetBIOS, provide the domain name.

Computer Account Specify a location within the Active Directory domain where AsyncOS
will create an Active Directory computer account, also known as a
“machine trust account”, to uniquely identify the computer on the domain.

If the Active Directory environment automatically deletes computer
objects at particular intervals, specify a location for the computer account
that is in a container, protected from automatic deletion.

b. Click Join Domain.

c. Enter the sSAMAccountName user name and passphrase for an existing Active Directory user that
has rights to create computer accounts in the domain.

Example: “jazzdoe” Do not use: “DOMAIN\jazzdoe” or “jazzdoe @domain”
This information is used once to establish the computer account and is not saved.
d. Click Create Account.

(Optional) Configure transparent authentication.

Setting Description

Enable Transparent Enter both the server name for the machine where the primary Context
User Identification using |Directory agent is installed and the shared secret used to access it.

Active Directory agent (Optional) Enter the server name for the machine where a backup Context

Directory agent is installed and its shared secret.
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Step8  Configure Network Security:

Setting Description

Client Signing Required |Select this option if the Active Directory server is configured to require
client signing.

With this option selected, AsyncOS uses Transport Layer Security when
communicating with the Active Directory server.

Step9  (Optional) Click Start Test. This will test the settings you have entered, ensuring they are correct before
real users use them to authenticate.

Step10  Submit and commit your changes.

Creating an LDAP Authentication Realm

Before You Begin

e Obtain the following information about LDAP in your organization:
— LDAP version
— Server addresses
- LDAP ports

e If the Web Security appliance is managed by a Security Management appliance, ensure that
same-named authentication realms on different Web Security appliances have identical properties
defined on each appliance.

Step 1 Choose Network > Authentication.
Step2  Click Add Realm.
Step3  Assign a unique name to the authentication realm using only alphanumeric and space characters.

Step 4 Select LDAP in the Authentication Protocol and Scheme(s) field.
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Authentication Realms

Step5  Enter the LDAP authentication settings:

Setting Description

LDAP Version Choose the version of LDAP, and choose whether or not to use Secure LDAP.

The appliance supports LDAP versions 2 and 3. Secure LDAP requires LDAP
version 3.

Choose whether or not this LDAP server supports Novell eDirectory to use with
transparent user identification.

LDAP Server Enter the LDAP server IP address or hostname and its port number. You can
specify up to three servers.

The hostname must be a fully-qualified domain name. For example,
ldap.example.com. An [P address is required only if the DNS servers
configured on the appliance cannot resolve the LDAP server hostname.

The default port number for Standard LDAP is 389. The default number for
Secure LDAP is 636.

If the LDAP server is an Active Directory server, enter the hostname or 1P
address and the port of the domain controller here. Whenever possible, enter the
name of the Global Catalog Server and use port 3268. However, you might want
to use a local domain controller when the global catalog server is physically far
away and you know you only need to authenticate users on the local domain
controller.

Note: When you configure multiple authentication servers in the realm, the
appliance attempts to authorize with up to three authentication servers before
failing to authenticate the transaction within that realm.

LDAP Persistent Choose one of the following values:

Connections e Use persistent connections (unlimited). Use existing connections. If no

(under the connections are available a new connection is opened.

Advanced section . . .. . .
) e Use persistent connections. Use existing connections to service the

number of requests specified. When the maximum is reached, establish a
new connection to the LDAP server.

¢ Do not use persistent connections. Always create a new connection to the
LDAP server.
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Setting Description

User Authentication |Enter values for the following fields:
Base Distinguished Name (Base DN)

The LDAP database is a tree-type directory structure and the appliance uses the
Base DN to navigate to the correct location in the LDAP directory tree to begin
a search. A valid Base DN filter string is composed of one or more components
of the form object-value. For example dc=companyname, dc=com.

User Name Attribute
Choose one of the following values:

e uid, cn, and sAMAccountName. Unique identifiers in the LDAP directory
that specify a username.

e custom. A custom identifier such as UseraAccount.
User Filter Query

The User Filter Query is an LDAP search filter that locates the users Base DN.
This is required if the user directory is in a hierarchy below the Base DN, or
if the login name is not included in the user-specific component of that users
Base DN.

Choose one of the following values:
¢ none. Filters any user.

e custom. Filters a particular group of users.

Query Credentials Choose whether or not the authentication server accepts anonymous queries.

If the authentication server does accept anonymous queries, choose Server
Accepts Anonymous Queries.

If the authentication server does not accept anonymous queries, choose Use
Bind DN and then enter the following information:

e Bind DN. The user on the external LDAP server permitted to search the
LDAP directory. Typically, the bind DN should be permitted to search the
entire directory.

e Passphrase. The passphrase associated with the user you enter in the
Bind DN field.

The following text lists some example users for the Bind DN field:

cn=administrator,cn=Users,dc=domain,dc=com
sAMAccountName=jdoe,cn=Users,dc=domain,dc=com.

If the LDAP server is an Active Directory server, you may also enter the Bind
DN username as “DOMAIN\username.”
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Step 6

Authentication Realms

(Optional) Enable Group Authorization via group object or user object and complete the settings for the
chosen option accordingly:

Group Object Setting

Description

Group Membership
Attribute Within Group
Object

Choose the LDAP attribute which lists all users that belong to this group.
Choose one of the following values:

e member and uniquemember. Unique identifiers in the LDAP
directory that specify group members.

e custom. A custom identifier such as UserInGroup.

Attribute that Contains
the Group Name

Choose the LDAP attribute which specifies the group name that can be
used in the policy group configuration.

Choose one of the following values:

¢ cn. A unique identifier in the LDAP directory that specifies the name
of a group.

e custom. A custom identifier such as FinanceGroup.

Query String to
Determine if Object
is a Group

Choose an LDAP search filter that determines if an LDAP object represents
a user group.

Choose one of the following values:
e objectclass=groupofnames
e objectclass=groupofuniquenames
¢ objectclass=group
e custom. A custom filter such as objectclass=person.

Note: The query defines the set of authentication groups which can be used
in policy groups.

User Object Setting

Description

Group Membership
Attribute Within
User Object

Choose the attribute which list all the groups that this user belongs to.
Choose one of the following values:

e memberOf. Unique identifiers in the LDAP directory that specify user
members.

e custom. A custom identifier such as UserInGroup.

Group Membership
Attribute is a DN

Specify whether the group membership attribute is a distinguished name
(DN) which refers to an LDAP object. For Active Directory servers, enable
this option.

When this is enabled, you must configure the subsequent settings.
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User Object Setting Description

Attribute that Contains |When the group membership attribute is a DN, this specifies the attribute that
the Group Name can be used as group name in policy group configurations.

Choose one of the following values:

e cn. A unique identifier in the LDAP directory that specifies the name of
a group.

e custom. A custom identifier such as FinanceGroup.

Query String to Choose an LDAP search filter that determines if an LDAP object represents a
Determine if Object user group.
is a Group

Choose one of the following values:
e objectclass=groupofnames
e objectclass=groupofuniquenames
e objectclass=group
e custom. A custom filter such as objectclass=person.

Note: The query defines the set of authentication groups which can be used
in Web Security Manager policies.

Step7  (Optional) Configure external LDAP authentication for users
a. Select External Authentication Queries.

b. Identify the user accounts:.

Base DN The Base DN to navigate to the correct location in the LDAP
directory tree to begin a search.

Query String The query to return the set of authentication groups, for example:
(& (objectClass=posixAccount) (uid={u}))

or

(& (objectClass=user) (sAMAccountName={u}))

Attribute containing the users full The LDAP attribute, for example, displayName Or gecos.
name

c. (Optional) Deny login to expired accounts based on RFC 2307 account expiration LDAP attributes.
d. Provide a query to retrieve group information for users.

If a user belongs to multiple LDAP groups with different user roles, AsyncOS grants the user the
permissions for the most restrictive role.

Base DN The Base DN to navigate to the correct location in the LDAP
directory tree to begin a search.

Query String (& (objectClass=posixAccount) (uid={u}))

Attribute containing the user's gecos

full name
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Step 8

Note

Step 9

Authentication Realms

(Optional) Click Start Test. This will test the settings you have entered, ensuring they are correct before
real users use them to authenticate. For details on the testing performed, see *Create additional NTLM
realms to authenticate users in domains that are not trusted by existing NTLM realms., page 5-21.

Once you submit and commit your changes, you cannot later change a realm’s authentication protocol.

Submit and commit your changes.

What to Do Next

¢ Create an Identification Profile that uses the Kerberos authentication scheme. Classifying Users and
Client Software, page 6-3.

Related Topics
e External Authentication, page 5-11

Using Multiple NTLM Realms and Domains

The following rules apply in regard to using multiple NTLM realms and domains:
® You can create up to 10 NTLM authentication realms.

e The client IP addresses in one NTLM realm must not overlap with the client IP addresses in another
NTLM realm.

e FEach NTLM realm can join one Active Directory domain only but can authenticate users from any
domains trusted by that domain. This trust applies to other domains in the same forest by default and
to domains outside the forest to which at least a one way trust exists.

¢ Create additional NTLM realms to authenticate users in domains that are not trusted by existing
NTLM realms.

About Deleting Authentication Realms

Deleting an authentication realm disables associated identities, which in turn removes those identities
from associated policies.

Deleting an authentication realm removes it from sequences.

Configuring Global Authentication Settings

Configure Global Authentication Settings to apply settings to all authentication realms, independent of
their authentication protocols.

The Web Proxy deployment mode affects which global authentication settings you can configure. More
settings are available when it is deployed in transparent mode than in explicit forward mode.

Before You Begin

e Be familiar with the following concepts:
— Failed Authentication, page 5-28
— Failed Authorization: Allowing Re-Authentication with Different Credentials, page 5-33
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Step 1
Step 2
Step 3

Choose Network > Authentication

Click Edit Global Settings.

Edit the settings in the Global Authentication Settings section:.

Setting

Description

Action if Authentication
Service Unavailable

Choose one of the following values:

¢ Permit traffic to proceed without authentication. Processing
continues as if the user was authenticated.

e Block all traffic if user authentication fails. Processing is
discontinued and all traffic is blocked.

Failed Authentication
Handling

When you grant users guest access in an Identification Profile policy,
this setting determines how the Web Proxy identifies and logs the user
as a guest in the access logs.

For more information on granting users guest access, see Granting
Guest Access After Failed Authentication, page 5-31.

Re-authentication

(Enable Re-Authentication
Prompt If End User Blocked
by URL Category or User
Session Restriction)

This setting allows users to authenticate again if the user is blocked
from a website due to a restrictive URL filtering policy or due to being
restricted from logging into another IP address.

The user sees a block page that includes a link that allows them to enter
new authentication credentials. If the user enters credentials that allow
greater access, the requested page appears in the browser.

Note: This setting only applies to authenticated users who are blocked
due to restrictive URL filtering policies or User Session Restrictions. It
does not apply to blocked transactions by subnet with no authentication.

For more information, see Failed Authorization: Allowing
Re-Authentication with Different Credentials, page 5-33.

Basic Authentication
Token TTL

Controls the length of time that user credentials are stored in the cache
before revalidating them with the authentication server. This includes
the username and passphrase and the directory groups associated with
the user.

The default value is the recommended setting. When the Surrogate
Timeout setting is configured and is greater than the Basic
Authentication Token TTL, then the Surrogate Timeout value takes
precedence and the Web Proxy contacts the authentication server after
surrogate timeout expires.

The remaining authentication settings you can configure depends on how the Web Proxy is deployed, in
transparent or explicit forward mode.
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Step 4

Authentication Realms

If the Web Proxy is deployed in transparent mode, edit the settings as follows:

Setting

Description

Credential Encryption

This setting specifies whether or not the client sends the login credentials to
the Web Proxy through an encrypted HTTPS connection.

This setting applies to both Basic and NTLMSSP authentication schemes,
but it is particularly useful for Basic authentication scheme because user
credentials are sent as plain text.

For more information, see Failed Authentication, page 5-28.

HTTPS Redirect Port

Specify a TCP port to use for redirecting requests for authenticating users
over an HTTPS connection.

This specifies through which port the client will open a connection to the
Web Proxy using HTTPS. This occurs when credential encryption is enabled
or when using Access Control and users are prompted to authenticate.

Redirect Hostname

Enter the short hostname of the network interface on which the Web Proxy
listens for incoming connections.

When you configure authentication on an appliance deployed in transparent
mode, the Web Proxy uses this hostname in the redirection URL sent to
clients for authenticating users.

You can enter either the following values:

¢ Single word hostname. You can enter the single word hostname that is
DNS resolvable by the client and the Web Security appliance. This
allows clients to achieve true single sign-on with Internet Explorer
without additional browser side setup.
Be sure to enter the single word hostname that is DNS resolvable by the
client and the Web Security appliance.
For example, if your clients are in domain mycompany .com and the
interface on which the Web Proxy is listening has a full hostname of
proxy.mycompany . com, then you should enter proxy in this field.
Clients perform a lookup on proxy and they should be able to resolve

proxy.mycompany . com.

e Fully qualified domain name (FQDN). You can also enter the FQDN
or IP address in this field. However, if you do that and want true single
sign-on for Internet Explorer and Firefox browsers, you must ensure
that the FQDN or IP address is added to the client’s Trusted Sites list in
the client browsers.

The default value is the FQDN of the M1 or P1 interface, depending on
which interface is used for proxy traffic.

Credential Cache
Options:

Surrogate Timeout

This setting specifies how long the Web Proxy waits before asking the client
for authentication credentials again. Until the Web Proxy asks for credentials
again, it uses the value stored in the surrogate (IP address or cookie).

It is common for user agents, such as browsers, to cache the authentication
credentials so the user will not be prompted to enter credentials each time.
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Setting Description
Credential Cache When IP address is used as the authentication surrogate, this setting
Options: specifies how long the Web Proxy waits before asking the client for

Client IP Idle Timeout

authentication credentials again when the client has been idle.

When this value is greater than the Surrogate Timeout value, this setting has
no effect and clients are prompted for authentication after the Surrogate
Timeout is reached.

You might want to use this setting to reduce the vulnerability of users who
leave their computers.

Credential Cache
Options:

Cache Size

Specifies the number of entries that are stored in the authentication cache.
Set this value to safely accommodate the number of users that are actually
using this device. The default value is the recommended setting.

User Session
Restrictions

This setting specifies whether or not authenticated users are allowed to
access the Internet from multiple IP addresses simultaneously.

You might want to restrict access to one machine to prevent users from
sharing their authentication credentials with non-authorized users. When a
user is prevented from logging in at a different machine, an end-user
notification page appears. You can choose whether or not users can click a
button to login as a different username using the Re-authentication setting
on this page.

When you enable this setting, enter the restriction timeout value, which
determines how long users must wait before being able to log into a machine
with a different IP address. The restriction timeout value must be greater
than the surrogate timeout value.

You can remove a specific user or all users from the authentication cache
using the authcache CLI command.

Advanced

When using Credential Encryption or Access Control, you can choose
whether the appliance uses the digital certificate and key shipped with the
appliance (the Cisco Web Security Appliance Demo Certificate) or a digital
certificate and key you upload here.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| 5-24 | I



| Chapter5 Acquire End-User Credentials

Authentication Realms

Step5  If the Web Proxy is deployed in explicit forward mode, edit the settings as follows:

Setting

Description

Credential Encryption

This setting specifies whether or not the client sends the login credentials to
the Web Proxy through an encrypted HTTPS connection. To enable
credential encryption, choose “HTTPS Redirect (Secure)”. When you
enable credential encryption, additional fields appear to configure how to
redirect clients to the Web Proxy for authentication.

This setting applies to both Basic and NTLMSSP authentication schemes,
but it is particularly useful for Basic authentication scheme because user
credentials are sent as plain text.

For more information, see Failed Authentication, page 5-28.

HTTPS Redirect Port

Specify a TCP port to use for redirecting requests for authenticating users
over an HTTPS connection.

This specifies through which port the client will open a connection to the
Web Proxy using HTTPS. This occurs when credential encryption is enabled
or when using Access Control and users are prompted to authenticate.

Redirect Hostname

Enter the short host name of the network interface on which the Web Proxy
listens for incoming connections.

When you enable Authentication Mode above, the Web Proxy uses this
hostname in the redirection URL sent to clients for authenticating users.

You can enter either the following values:

¢ Single word hostname. You can enter the single word host name that is
DNS resolvable by the client and the Web Security appliance. This
allows clients to achieve true single sign-on with Internet Explorer
without additional browser side setup.
Be sure to enter the single word host name that is DNS resolvable by the
client and the Web Security appliance.
For example, if your clients are in domain mycompany .com and the
interface on which the Web Proxy is listening has a full host name of
proxy .mycompany . com, then you should enter proxy in this field. Clients
perform a lookup on proxy and they should be able to resolve

proxy.mycompany . Ccom.

e Fully qualified domain name (FQDN). You can also enter the FQDN
or IP address in this field. However, if you do that and want true single
sign-on for Internet Explorer and Firefox browsers, you must ensure
that the FQDN or IP address is added to the client’s Trusted Sites list in
the client browsers.

The default value is the FQDN of the M1 or P1 interface, depending on
which interface is used for proxy traffic.

Credential Cache
Options:

Surrogate Timeout

This setting specifies how long the Web Proxy waits before asking the client
for authentication credentials again. Until the Web Proxy asks for credentials
again, it uses the value stored in the surrogate (IP address or cookie).

Note that it is common for user agents, such as browsers, to cache the
authentication credentials so the user will not be prompted to enter
credentials each time.
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Setting

Description

Credential Cache
Options:

Client IP Idle Timeout

When IP address is used as the authentication surrogate, this setting
specifies how long the Web Proxy waits before asking the client for
authentication credentials again when the client has been idle.

When this value is greater than the Surrogate Timeout value, this setting has
no effect and clients are prompted for authentication after the Surrogate
Timeout is reached.

You might want to use this setting to reduce the vulnerability of users who
leave their computers.

Credential Cache
Options:

Cache Size

Specifies the number of entries that are stored in the authentication cache.
Set this value to safely accommodate the number of users that are actually
using this device. The default value is the recommended setting.

User Session
Restrictions

This setting specifies whether or not authenticated users are allowed to
access the Internet from multiple IP addresses simultaneously.

You might want to restrict access to one machine to prevent users from
sharing their authentication credentials with non-authorized users. When a
user is prevented from logging at a different machine, an end-user
notification page appears. You can choose whether or not users can click a
button to login as a different username using the Re-authentication setting
on this page.

When you enable this setting, enter the restriction timeout value, which
determines how long users must wait before being able to log into a machine
with a different IP address. The restriction timeout value must be greater
than the surrogate timeout value.

You can remove a specific user or all users from the authentication cache
using the authcache CLI command.

Advanced

When using Credential Encryption or Access Control, you can choose
whether the appliance uses the digital certificate and key shipped with the
appliance (the Cisco Web Security Appliance Demo Certificate) or a digital
certificate and key you upload here.

To upload a digital certificate and key, click Browse and navigate to the
necessary file on your local machine. Then click Upload Files after you
select the files you want.

Step6  Submit and commit your changes.

Authentication Sequences

e About Authentication Sequences, page 5-27

¢ Creating Authentication Sequences, page 5-27

e Editing And Reordering Authentication Sequences, page 5-28

e Editing And Reordering Authentication Sequences, page 5-28
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About Authentication Sequences

L

Tip.

Use authentication sequences to allow single Identities to authenticate users via different authentication
servers or protocols. Authentication sequences are also useful for providing backup options in case
primary authentication options become unavailable.

Authentication sequences are collections of two or more authentication realms. The realms used can
have different authentication servers and different authentication protocols. For more information on
authentication realms, seeAuthentication Realms, page 5-11.

After you create a second authentication realm, the appliance automatically displays a Realm Sequences
section under Network > Authentication and includes a default authentication sequence named All
Realms. The All Realms sequence automatically includes each realm you define. You can change the
order of the realms within the All Realms sequence, but you cannot delete the All Realms sequence or
remove any realms from it.

When multiple NTLM authentication realms are defined, the Web Security appliance uses the
NTLMSSP authentication scheme with only one NTLM authentication realm per sequence. You can
choose which NTLM authentication realm to use for NTLMSSP within each sequence, including the All
Realms sequence. To use NTLMSSP with multiple NTLM realms, define a separate Identification
Profile for each realm.

Which authentication realms within a sequence get used during authentication depends on:

e The authentication scheme used. This is generally dictated by the type of credentials entered at
the client.

e The order in which realms are listed within the sequence (for Basic realms only, as only one
NTLMSSP realm is possible).

For optimal performance, authenticate clients on the same subnet using a single realm.

Creating Authentication Sequences

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Before You Begin

e Create two or more authentication realms (see Authentication Realms, page 5-11).

e If the Web Security appliance is managed by a Security Management appliance, ensure that
same-named authentication realms on different Web Security appliances have identical properties
defined on each appliance. Be aware that AsyncOS will use the realms to process authentication
sequentially, beginning with the first realm in the list.

Choose Network > Authentication
Click Add Sequence.
Enter a unique name for the sequence using alphanumeric and space characters.

In the first row of the Realm Sequence for Basic Scheme area, choose the first authentication realm you
want to include in the sequence.

In the second row of the Realm Sequence for Basic Scheme area, choose the next realm you want to
include in the sequence.

(Optional) Click Add Row to include another realm that uses Basic credentials.
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Step 7

Step 8

Editing And

Step 1
Step 2
Step 3

Step 4

Step 5

If an NTLM realm is defined, choose an NTLM realm in the Realm for NTLMSSP Scheme field.
The Web Proxy uses this NTLM realm when the client sends NTLMSSP authentication credentials.

Submit and commit your changes.

Reordering Authentication Sequences

Choose Network > Authentication.
Click the name of the sequence you wish to edit or re-order.

Choose a realm name from the Realms drop-down list on the row corresponding to the position number
you want the realm to occupy in the sequence.

~

Note  For the All Realms sequence, you can only change the order of its realms, you cannot change
the realms themselves. To change the order of realms in the All Realms sequence, click the
arrows in the Order column to reposition the corresponding realms.

Repeat Step 3 until all realms are listed and ordered as required, ensuring that each realm name appears
in one row only.

Submit and commit your changes.

Deleting Authentication Sequences

Step 1
Step 2
Step 3
Step 4

Before You Begin

e Be aware that deleting an authentication sequence also disables associated identities, which in turn
removes those identities from associated policies.

Choose Network > Authentication.
Click the trash can icon for the sequence name.
Click Delete to confirm that you want to delete the sequence.

Commit your changes.

Failed Authentication

e About Failed Authentication, page 5-29
e Bypassing Authentication with Problematic User Agents, page 5-29
e Bypassing Authentication, page 5-31

e Permitting Unauthenticated Traffic While Authentication Service is Unavailable, page 5-31
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e Granting Guest Access After Failed Authentication, page 5-31
e Failed Authorization: Allowing Re-Authentication with Different Credentials, page 5-33

About Failed Authentication

Users may be blocked from the web due to authentication failure for the following reasons:

¢ Client/user agent limitations. Some client applications may not properly support authentication.
You can bypass authentication for these clients by configuring Identification Profiles that do not
require authorization and basing their criteria on the clients (and, optionally, on the URLSs they need
to access).

e Authentication service is unavailable. An authentication service might be unavailable due to
network or server issues. You can choose to allow unauthenticated traffic in this circumstance.

¢ Invalid credentials. Some users may be unable to supply valid credentials for proper authentication
(for example, visitors or users awaiting credentials). You can choose to grant these users limited
access to the web.

Related Topics
e Bypassing Authentication with Problematic User Agents, page 5-29

e Bypassing Authentication, page 5-31
e Permitting Unauthenticated Traffic While Authentication Service is Unavailable, page 5-31

e Granting Guest Access After Failed Authentication, page 5-31

Bypassing Authentication with Problematic User Agents

Some user agents are known to have authentication issues that can impact normal operations.
You should bypass authentication via the following user agents:

e Windows-Update-Agent

e MICROSOFT_DEVICE_METADATA_RETRIEVAL_CLIENT

e Microsoft BITS

e SLSSoapClient

e Akamai NetSession Interface

¢ Microsoft-CryptoAPI

e NCSI

e MSDW

¢ Gnotify

e msde

¢ Google Update

A

Note The access policies will still filter (based on URL categories) and scan (McAfee, Webroot) traffic as per
the access policy setup.

Async0S 9.1 for Cisco Web Security Appliances User Guide
| ==




Chapter5  Acquire End-User Credentials |

M Failed Authentication

Step1  Configure the Identification Profile to bypass authentication with the specified user agents:
a. Select Web Security Manager > Identification Profile.
b. Click Add Identification Profile.

c. Enter information:

Option Value

Name User Agent AuthExempt Identification Profile
Insert Above Set to the first profile in the processing order
Define Members by Subnet Leave blank.

Define Members by Authentication No Authentication Required.

d. Click Advanced > User Agents.

e. Click None Selected.

f. Under Custom user Agents, specify the problematic User Agent strings.
Step2  Configure the Access Policy:

a. Choose Web Security Manager > Access Policies.

b. Click Add Policy.

c. Enter information:

Option Value

Policy Name Auth Exemption for User Agents

Insert Above Policy Set to the first policy in the processing order.
Identification Profile Policy User Agent AuthExempt Identification Profile
Advanced None

Step3  Submit and commit your changes.
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Bypassing Authentication

Step More Information

1. Create a custom URL category that contains
the affected websites by configuring the
Advanced properties.

2. Create an Identification Profile with Classifying Users and Client Software,
these characteristics: page 6-3

— Placed above all identities that
require authentication.

— Includes the custom URL category.
— Includes affected client applications.

— Does not require authentication

3. Create a policy for the Identification Profile. Creating a Policy, page 10-5

Related Topics
¢ Bypassing the Web Proxy

Permitting Unauthenticated Traffic While Authentication Service is Unavailable
N

Note  This configuration applies only when an authentication service is unavailable. It will not bypass
authentication permanently. For alternative options, see About Failed Authentication, page 5-29

Step 1 Choose Network > Authentication.
Step2  Click Edit Global Settings.

Step3  Click the Permit Traffic To Proceed Without Authentication in the Action If Authentication Service
Unavailable field.

Step4  Submit and commit your changes.

Granting Guest Access After Failed Authentication

Granting guest access requires that the following procedures are completed:

1. Define an Identification Profile that Supports Guest Access, page 5-32

2. Use an Identification Profile that Supports Guest Access in a Policy, page 5-32
3. (Optional) Configure How Guest User Details are Logged, page 5-32

N

Note  If an Identification Profile allows guest access and there is no user-defined policy that uses that
Identification Profile, users who fail authentication match the global policy of the applicable policy type.
For example, if MyldentificationProfile allows guest access and there is no user-defined Access Policy
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that uses MyldentificationProfile, users who fail authentication match the global Access Policy. If you
do not want guest users to match a global policy, create a policy above the global policy that applies to
guest users and blocks all access.

Define an Identification Profile that Supports Guest Access

Step 1
Step 2

Step 3
Step 4

Choose Web Security Manager > Identification Profiles.

Click Add Identification Profile to add a new identity, or click the name of an existing identity that you
wish to use.

Check the Support Guest Privileges check box.

Submit and commit your changes.

Use an Identification Profile that Supports Guest Access in a Policy

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Choose a policy type from the Web Security Manager menu.
Click a policy name in the policies table.

Choose Select One Or More Identification Profiles from the Identification Profiles And Users
drop-down list (if not already chosen).

Choose a profile that supports guest access from the drop-down list in the Identification Profile column.

Click the Guests (Users Failing Authentication) radio button.

S

Note  If this option is not available it means the profile you chose is not configured to support guest
access. Return to step 4 and choose another, or see Define an Identification Profile that Supports
Guest Access, page 5-32 to define a new one.

Submit and commit your changes.

Configure How Guest User Details are Logged

Step 1
Step 2
Step 3

Choose Network > Authentication.
Click Edit Global Settings.
Click a Log Guest User By radio button, described below, in the Failed Authentication Handling field.

Radio button Description
IP Address The IP address of the guest user’s client will be logged in the access logs.
User Name As Entered The user name that originally failed authentication will be logged in the
By End-User access logs.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| 5-32 | I



| Chapter5 Acquire End-User Credentials

Failed Authentication 1l

Stepd  Submit and commit your changes.

Failed Authorization: Allowing Re-Authentication with Different Credentials

e About Allowing Re-Authentication with Different Credentials, page 5-33
e Allowing Re-Authentication with Different Credentials, page 5-33

About Allowing Re-Authentication with Different Credentials

Use re-authentication to allow users the opportunity to authenticate again, using different credentials, if
the credentials they previously used have failed authorization. A user may authenticate successfully but
still be prevented from accessing a web resource if not authorized to do so. This is because authentication
merely identifies users for the purpose of passing their verified credentials on to policies, but it is the
policies that authorize those users (or not) to access resources.

A user must have authenticated successfully to be allowed to re-authenticate.

e To use the re-authentication feature with user defined end-user notification pages, the CGI script that
parses the redirect URL must parse and use the Reauth_URL parameter.

Allowing Re-Authentication with Different Credentials

Step 1 Choose Network > Authentication.
Step2  Click Edit Global Settings.

Step3  Check the Re-Authentication Prompt If End User Blocked by URL Category Or User Session
Restriction check box.

Step4  Click Submit.

Tracking Identified Users
S,

Note = When the appliance is configured to use cookie-based authentication surrogates, it does not get cookie
information from clients for HTTPS and FTP over HTTP requests. Therefore, it cannot get the user name
from the cookie.
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Supported Authentication Surrogates for Explicit Requests

Supported Authentication Surrogates for Transparent Requests

)

Note

Surrogate Types | Credential Encryption Disabled Credential Encryption Enabled
Protocol: HTTP HTTPS & Native FTP |HTTP HTTPS & Native FTP
FTP over FTP over
HTTP HTTP
No Surrogate Yes Yes Yes NA NA NA
IP-based Yes Yes Yes Yes Yes Yes
Cookie-based Yes Yes*** Yes*** Yes No/Yes** | Yes***

See also the description of the Authentication Surrogates options in Classifying Users and Client

Software, page 6-3.

Surrogate Types | Credential Encryption Disabled Credential Encryption Enabled
Protocol: HTTP HTTPS Native FTP  |HTTP HTTPS Native FTP
No Surrogate NA NA NA NA NA NA
IP-based Yes No/Yes* No/Yes* Yes No/Yes* No/Yes*
Cookie-based Yes No/Yes** |No/Yes** |Yes No/Yes** |No/Yes**

* Works after the client makes a request to an HTTP site and is authenticated. Before this happens, the
behavior depends on the transaction type:

e Native FTP transactions. Transactions bypass authentication.

e HTTPS transactions. Transactions are dropped. However, you can configure the HTTPS Proxy to
decrypt the first HTTPS request for authentication purposes.

** When cookie-based authentication is used, the Web Proxy cannot authenticate the user for HTTPS,
native FTP, and FTP over HTTP transactions. Due to this limitation, all HTTPS, native FTP, and FTP
over HTTP requests bypass authentication, so authentication is not requested at all.

**% No surrogate is used in this case even though cookie-based surrogate is configured.

Related Topics
e Identification Profiles and Authentication, page 6-8

Tracking Re-Authenticated Users

With re-authentication, if a more privileged user authenticates and is authorized, the Web Proxy caches
this user identity for different amounts of time depending on the authentication surrogates configured:

¢ Session cookie. The privileged user identity is used until the browser is closed or the session
times out.
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Note

Credentials

¢ Persistent cookie. The privileged user identity is used until the surrogate times out.
e IP address. The privileged user identity is used until the surrogate times out.

¢ No surrogate. By default, the Web Proxy requests authentication for every new connection, but
when re-authentication is enabled, the Web Proxy requests authentication for every new request, so
there is an increased load on the authentication server when using NTLMSSP. The increase in
authentication activity may not be apparent to a user, however, because most browsers will cache
the privileged user credentials and authenticate without prompting until the browser is closed. Also,
when the Web Proxy is deployed in transparent mode, and the “Apply same surrogate settings to
explicit forward requests” option is not enabled, no authentication surrogates are used for explicit
forward requests and increased load will occur with re-authentication.

If the Web Security appliance uses cookies for authentication surrogates, Cisco recommends enabling
credential encryption.

Credentials

Authentication credentials are obtained from users by either prompting them to enter their credentials
through their browsers, or another client application, or by obtaining the credentials transparently from
another source.

e Tracking Credentials for Reuse During a Session, page 5-35
e Authentication and Authorization Failures, page 5-36

e Credential Format, page 5-36

¢ Credential Encryption for Basic Authentication, page 5-36

Tracking Credentials for Reuse During a Session

Using authentication surrogates, after a user authenticates once during a session, you can track
credentials for reuse throughout that session rather than having the user authenticate for each new
request. Authentication surrogates may be based on the IP address of the user’s workstation or on a
cookie that is assigned to the session.

For Internet Explorer, be sure the Redirect Hostname is the short host name (containing no dots) or the
NetBIOS name rather than a fully qualified domain. Alternatively, you can add the appliance host name
to Internet Explorer’s Local intranet zone (Tools > Internet options > Security tab); however, this will be
required on every client. For more information about this, see How do I properly set up NTLM with SSO
(credentials sent transparently)?

With Firefox and other non-Microsoft browsers, the parameters network.negotiate-auth.delegation-uris,
network.negotiate-auth.trusted-uris and network.automatic-ntlm-auth.trusted-uris must be set to the
transparent-mode Redirect Hostname. You also can refer to Firefox is not sending authentication credentials
transparently (SSO). This article provides general information about changing Firefox parameters.

For information about the Redirect Hostname, see Configuring Global Authentication Settings, or the CLI
command sethostname.
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Authentication and Authorization Failures

If authentication fails for accepted reasons, such as incompatible client applications, you can grant
guest access.

If authentication succeeds but authorization fails, it is possible to allow re-authentication using a
different set of credentials that may be authorized to access the requested resource.

Related Topics
e Granting Guest Access After Failed Authentication, page 5-31

e Allowing Re-Authentication with Different Credentials, page 5-33

Credential Format

Authentication Scheme Credential Format

NTLMSSP MyDomain\jsmith
Basic jsmith
MyDomain\jsmith

Note  If the user does not enter the Windows domain, the Web Proxy
prepends the default Windows domain.

Credential Encryption for Basic Authentication

About Credential Encryption for Basic Authentication
Enable credential encryption to transmit credentials over HTTPS in encrypted form. This increases
security of the basic authentication process.

The Web Security appliance uses its own certificate and private key by default to create an HTTPS
connection with the client for the purposes of secure authentication. Most browsers will warn users,
however, that this certificate is not valid. To prevent users from seeing the invalid certificate message,
you can upload a valid certificate and key pair that your organization uses.

Configuring Credential Encryption

Before You Begin:

e Configure the appliance to use IP surrogates.

¢ (Optional) Obtain a certificate and unencrypted private key. The certificate and key configured here
are also used by Access Control.

Step 1 Choose Network > Authentication.
Step2  Click Edit Global Settings.

Step3  Check the Use Encrypted HTTPS Connection For Authentication check box in the Credential
Encryption field.
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Step 4 (Optional) Edit the default port number (443) in the HTTPS Redirect Port field for client HTTP
connections during authentication.

Step5  (Optional) Upload a certificate and key:
a. Expand the Advanced section.
b. Click Browse in the Certificate field and find the certificate file you wish to upload.
c. Click Browse in the Key field and find the private key file you wish to upload.
d. Click Upload Files.

Step6  Submit and commit your changes.

Related Topics
e C(Certificate Management, page 22-24.

Troubleshooting Authentication

e LDAP User Fails Authentication due to NTLMSSP, page A-2
e LDAP Authentication Fails due to LDAP Referral, page A-3
e Basic Authentication Fails, page A-3

e Users Erroneously Prompted for Credentials, page A-3

e HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication, page A-11

e (Cannot Access URLs that Do Not Support Authentication, page A-13
¢ Client Requests Fail Upstream Proxy, page A-14
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Classify End-Users and Client Software

e Overview of Classify Users and Client Software, page 6-1

e C(Classify Users and Client Software: Best Practices, page 6-2
e Identification Profile Criteria, page 6-2

e C(Classifying Users and Client Software, page 6-3

e Identification Profiles and Authentication, page 6-8

e Troubleshooting Identification Profiles, page 6-9

Overview of Classify Users and Client Software

Identification Profiles let you classify users and user agents (client software) for these purposes:
e Application of policies (except SaaS)
e Specification of identification and authentication requirements
AsyncOS assigns an Identification Profile to every transaction:
e Custom Identification Profiles — AsyncOS assigns a custom profile based on that identity’s criteria.

¢ The Global Identification Profile — AsyncOS assigns the global profile to transactions that do not
meet the criteria for any custom profile. By default, the global profile does not require authentication.

AsyncOS processes Identification Profiles sequentially, beginning with the first identity. The global
profile is the last profile.

An Identification Profile may include only one criterion. Alternately, profiles that include multiple
criteria require that all the criteria are met.
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One policy may call on multiple Identification Profiles:

Identification Profiles and Users: | Select One or More Identification Profiles

Identification Profile Authorized Users and Groups Add Identity
IdentityPolicy2 - @ All Authenticated Users
Realm: NTLMRealm2 -
—p Selected Groups and Users @

Groups: Mo groups entered
Users: No users entered

IdentityPolicy1 -~ All Authenticated Users

> @ Selected Groups and Users
Groups:

NTLMRealm1

ministratorl ]
rt Publishers

WGA\Domain Guests

Users: No users entered

Guests (users failing authentication)

I IdentityPolicyForFTP  ~  No authentication required i}
IdentityPolicy4 - All Authenticated Users
Selected Groups and Users
Groups: No groups entered @

Users: No users entered

@ Guests (users falling authentication)

This Identification Profile allows guest access and applies to users
who fail authentication.

——— Authentication is not used for this Identification Profile.

The specified user groups in this Identification Profile are authorized
for this policy.

This Identification Profile uses an authentication sequence and this
policy applies to one realm in the sequence.

Classify Users and Client Software: Best Practices

e Create fewer, more general Identification Profiles that apply to all users or fewer, larger groups of
users. Use policies, rather than profiles, for more granular management.

¢ Create Identification Profiles with unique criteria.

e If deployed in transparent mode, create an Identification Profile for sites that do not support
authentication. See Bypassing Authentication, page 5-31.

Identification Profile Criteria

Option Description

Subnet The client subnet must match the list of subnets in a policy.

Protocol The protocol used in the transaction: HTTP, HTTPS, SOCKS, or native FTP.

Port The proxy port of the request must be in the Identification Profile’s list of ports, if
any are listed . For explicit forward connections, this is the port configured in the
browser. For transparent connections, this is the same as the destination port.
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Option Description

User Agent The user agent (client software) making the request must be in the Identification
Profile’s list of user agents, if any are listed. Some user agents cannot handle
authentication, therefore creating an profile that does not require authentication
is necessary.

URL Category |The URL category of the request URL must be in the Identification Profile’s list of
URL categories, if any are listed.

Authentication |If the Identification Profile requires authentication, the client authentication
requirements credentials must match the Identification Profile’s authentication requirements.

Classifying Users and Client Software

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Before You Begin

¢ Create authentication realms. See How to Create an Active Directory Authentication Realm
(NTLMSSP and Basic), page 5-14 or Creating an LDAP Authentication Realm, page 5-16.

¢ Be aware that when you commit changes to Identification Profiles, end-users must re-authenticate.

e If you are in Cloud Connector mode, be aware that an additional Identification Profile option is
available: Machine ID. See Identifying Machines for Policy Application, page 3-10.

e (Optional) Create authentication sequences. See Creating Authentication Sequences, page 5-27
e (Optional) Enable Secure Mobility if the Identification Profile will include mobile users.

¢ (Optional) Understand authentication surrogates. See Tracking Identified Users, page 5-33.

Choose Web Security Manager > Identification Profiles.
Click Add Profile to add a profile.

Use the Enable Identification Profile check box to enable this profile, or to quickly disable it without
deleting it.

Assign a unique profile Name.
A Description is optional.

From the Insert Above drop-down list, choose where this profile is to appear in the table.

N

Note  Position Identification Profiles that do not require authentication above the first Identification
Profile that requires authentication.

In the User Identification Method section, choose an identification method and then supply related
parameters; displayed options vary according to the method chosen.
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There are three type of methods: exempt from authentication/identification, authenticate users, and three
ways to transparently identify users: ISE, ASA (via AnyConnect Secure Mobility), or an appropriately
configured authentication realm. The latter includes either an Active Directory realm, or an LDAP realm

configured as a Novell eDirectory.

a. Choose an identification method from the User Identification Method drop-down list.

Option

Description

Exempt from authentication/
identification

Users are identified primarily by IP address. No additional parameters
are required.

Authenticate users

Users are identified by the authentication credentials they enter.

Transparently identify users
with ISE

Available when the ISE service is enabled (Network > Identity Services
Engine). For these transactions, the user name and associated Secure
Group Tags will be obtained from the Identity Services Engine. For
more information, see Tasks for Certifying and Integrating the ISE
Service, page 8-3.

Transparently identify users
with ASA

Users are identified by the current IP address-to-user name mapping
received from a Cisco Adaptive Security Appliance (for remote users
only). This option appears when Secure Mobility is enabled and
integrated with an ASA. The user name will be obtained from the ASA,
and associated directory groups will be obtained from the selected
authentication realm or sequence.

Transparently identify users
with authentication realm

This option is available when one or more authentication realms are
configured to support transparent identification.

N

Note  When at least one Identification Profile with authentication or transparent identification is
configured, the policy tables will support defining policy membership using user names,
directory groups, and Secure Group Tags.

b. Supply parameters appropriate to the chosen method. Not all of the sections described in this table are

visible for each choice.

Fallback to Authentication
Realm or Guest Privileges

If user authentication is not available from ISE:

e Support Guest Privileges — The transaction will be allowed to
continue, and will match subsequent policies for Guest users from
all Identification Profiles.

¢ Block Transactions — Do not allow Internet access to users who
cannot be identified by ISE.

¢ Support Guest privileges — Check this box to grant guest access to
users who fail authentication due to invalid credentials.
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Authentication Realm

Select a Realm or Sequence — choose a defined authentication realm
or sequence.

Select a Scheme — Choose an authentication scheme:

Kerberos — The client is transparently authenticated by means of
Kerberos tickets.

Basic — The client always prompts users for credentials. After the
user enters credentials, browsers typically offer a check box to
remember the provided credentials. Each time the user opens the
browser, the client either prompts for credentials or resends the
previously saved credentials.

Credentials are sent unsecured as clear text (Base64). A packet
capture between the client and Web Security appliance can reveal
the user name and passphrase.

NTLMSSP - The client transparently authenticates using its
Windows login credentials. The user is not prompted for credentials.

However, the client prompts the user for credentials under the
following circumstances:

— The Windows credentials failed.

— The client does not trust the Web Security appliance because of
browser security settings.

Credentials are sent securely using a three-way handshake (digest style
authentication). The passphrase is never sent across the connection.

Support Guest privileges — Check this box to grant guest access to
users who fail authentication due to invalid credentials.

Realm for Group
Authentication

Select a Realm or Sequence — Choose a defined authentication
realm or sequence.
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M Classifying Users and Client Software

Authentication Surrogates  |Specify how transactions will be associated with a user after successful
authentication (options vary depending on Web Proxy deployment mode):

e TP Address — The Web Proxy tracks an authenticated user at a
particular IP address. For transparent user identification, select
this option.

¢ Persistent Cookie — The Web Proxy tracks an authenticated user on a
particular application by generating a persistent cookie for each user
per application. Closing the application does not remove the cookie.

e Session Cookie — The Web Proxy tracks an authenticated user on a
particular application by generating a session cookie for each user per
domain per application. (However, when a user provides different
credentials for the same domain from the same application, the cookie
is overwritten.) Closing the application removes the cookie.

¢ No Surrogate — The Web Proxy does not use a surrogate to cache the
credentials, and it tracks an authenticated user for every new TCP
connection. When you choose this option, the web interface disables
other settings that no longer apply. This option is available only in
explicit forward mode and when you disable credential encryption on
the Network > Authentication page.

e Apply same surrogate settings to explicit forward requests — Check
to apply the surrogate used for transparent requests to explicit
requests; enables credential encryption automatically. This option
appears only when the Web Proxy is deployed in transparent mode.

Note  You can define a timeout valve for the authentication surrogate
for all requests in Global Authentication Settings.

Step8  In the Membership Definition section, supply membership parameters appropriate to the chosen
identification method. Note that all of the options described in this table are not available to every User
Identification Method.

Membership Definition

Define Members by Configure this Identification Profile to apply to: Local Users Only,
User Location Remote Users Only, or Both. This selection affects the available
authentication settings for this Identification Profile.

Define Members by Subnet | Enter the addresses to which this Identification Profile should apply. You
can use IP addresses, CIDR blocks, and subnets.

Note If nothing is entered, the Identification Profile applies to all
IP addresses.

Define Members by Protocol |Select the protocols to which this Identification Profile should apply; select
all that apply:

e HTTP/HTTPS — Applies to all requests that use HTTP or HTTPS
as the underlying protocol, including FTP over HTTP, and any other
protocol tunneled using HTTP CONNECT.

e Native FTP — Applies to native FTP requests only.
e SOCKS - Applies to SOCKS Policies only
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Classifying Users and Client Software W

Define Members by
Machine ID

Note

Do Not Use Machine ID in This Policy — The user is not identified
by machine ID.

Define User Authentication Policy Based on Machine ID — The
user is identified primarily by machine ID.

Click the Machine Groups area to display the Authorized Machine
Groups page.

For each group you want to add, in the Directory Search field, start
typing the name of the group to add and then click Add. You can
select a group and click Remove to remove it from the list.

Click Done to return to the previous page.
Click the Machine IDs area to display the Authorized Machines page.

In the Authorized Machines, field, enter the machine IDs to
associate with the policy then click Done.

Authentication using Machine ID is supported only in
Connector mode and requires Active Directory.

Advanced

Expand this section to define additional membership requirements.

Proxy Ports — Specify one or more proxy ports used to access the
Web Proxy. Enter port numbers separated by commas. For explicit
forward connections, the proxy port is configured in the browser.

For transparent connections, this is the same as the destination port.

Defining identities by port works best when the appliance is
deployed in explicit forward mode, or when clients explicitly
forward requests to the appliance. Defining identities by port when
client requests are transparently redirected to the appliance may
result in some requests being denied.

URL Categories — Select user-defined or predefined URL categories.
Membership for both is excluded by default, meaning the Web Proxy
ignores all categories unless they are selected in the Add column.

If you need to define membership by URL category, only define it
in the Identity group when you need to exempt from authentication
requests to that category.

User Agents — Defines policy group membership by the user agent
(applications such as Firefox or Chrome Web browsers) used in the
client request. You can select some commonly defined browsers, or
define your own using regular expressions.

Choose whether this policy group should apply only to the selected
user agents, or to any user agent that is not in the list of selected agents.

Submit and Commit Changes.
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W Identification Profiles and Authentication

Related Topics

e Overview of Acquire End-User Credentials, page 5-1

e Managing Web Requests Through Policies Task Overview, page 10-2

Enable/Disable an Identity

Before You Begin
e Be aware that disabling an Identification Profile removes it from associated policies.

¢ Be aware that re-enabling an Identification Profile does not re-associate it with any policies.

Step 1 Choose Web Security Manager > Identification Profiles.

Step2  Click a profile in the Identification Profiles table to open the Identification Profile page for that profile.
Step3  Check or clear Enable Identity immediately under Client/User Identification Profile Settings.

Step4  Submit and Commit Changes.

Identification Profiles and Authentication

Figure 6-1 on page 6-9 shows how the Web Proxy evaluates a client request against Identification
Profiles when the profile is configured to use:

e No authentication surrogates
e [P addresses as authentication surrogates
e (Cookies as authentication surrogates with transparent requests

e Cookies as authentication surrogates with explicit requests and credential encryption is enabled
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Troubleshooting Identification Profiles

Figure 6-1 Transaction Request flow: Identification Profiles and Authentication - No Surrogates
and IP-Based Surrogates

Assign Identity:

Global
Transaction Request Identity

Guest Access Pass
Privileges? authentication?

Terminate request. Assipn the Identity and then evaluate the request against the other
Reply to user with Policy types
authentication required

require Authentication?

Figure 6-2 Transaction Request flow: Identification Profiles and Authentication -
TranCookie-Based Surrogates

Assign ldentity:
. Subnet
Global
Transaction Request Identity

Guest Access Pass Is this a HTTPS ! e ediden
Privileges? authentication? transaction re Authenticatio

Terminate request. Assizn the Identity and then evaluate the request against the other Policy types
Reply to user with
amhentication required

*The web proxy sets theuser nameto NULL.

Troubleshooting Identification Profiles

¢ Basic Authentication Problems, page A-3

¢ Policy Problems, page A-9
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Il Troubleshooting Identification Profiles

e Policy is Never Applied, page A-10
e Upstream Proxy Problems, page A-14

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| 6-10 | I



CHAPTER 7

SaaS Access Control

e Overview of SaaS Access Control, page 7-1

e Configuring the Appliance as an Identity Provider, page 7-2

e Using SaaS Access Control and Multiple Appliances, page 7-4
e Creating SaaS Application Authentication Policies, page 7-4

e Configuring End-user Access to the Single Sign-on URL, page 7-6

Overview of SaaS Access Control

The Web Security appliance uses the Security Assertion Markup Language (SAML) to authorize access
to SaaS applications. It works with SaaS applications that are strictly compliant with SAML version 2.0.

Cisco SaaS Access Control allows you to:
e Control which users can access SaaS applications and from where.
¢ Quickly disable access to all SaaS applications when users are no longer employed by the organization.
e Reduce the risk of phishing attacks that ask users to enter their SaaS user credentials.

e Choose whether users are transparently signed in (single sign-on functionality) or prompted to enter
their authentication user name and pass phrase.

SaaS Access Control only works with SaaS applications that require an authentication mechanism that is
supported by the Web Security appliance. Currently, the Web Proxy uses the “PasswordProtectedTransport”
authentication mechanism.

To enable SaaS Access Control, you must configure settings on both the Web Security appliance and the
SaaS application:

Step 1 Configure the Web Security appliance as |Configuring the Appliance as an Identity Provider,

an identity provider. page 7-2

Step2  |Create an authentication policy for the Creating SaaS Application Authentication
SaaS application. Policies, page 7-4

Step3 | Configure the SaaS application for single |Configuring End-user Access to the Single
sign-on. Sign-on URL, page 7-6

Step4 | (Optional) Configue multiple Web Using SaaS Access Control and Multiple
Security appliances. Appliances, page 7-4
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MW Configuring the Appliance as an Identity Provider

Configuring the Appliance as an Identity Provider

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

When you configure the Web Security appliance as an identity provider, the settings you define apply to
all SaaS applications it communicates with. The Web Security appliance uses a certificate and key to
sign each SAML assertion it creates.

Before You Begin
e (Optional) Locate a certificate (PEM format) and key for signing SAML assertions.
e Upload the certificate to each SaaS application.

Choose Network > Identity Provider for SaaS.

Click Edit Settings.

Check Enable SaaS Single Sign-on Service.

Enter a virtual domain name in the Identity Provider Domain Name field.

Enter a unique text identifier in the Identity Provider Entity ID field (a URI formatted string
is recommended).

Either upload or generate a certificate and key:
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Note

Step 7

Step 8

Configuring the Appliance as an Identity Provider ||

Method

Additional Steps

Upload a certificate

and key

1. Select Use Uploaded Certificate and Key.
2. In the Certificate field, click Browse; locate the file to upload.

Note The Web Proxy uses the first certificate or key in the file. The certificate
file must be in PEM format. DER format is not supported.

3. In the Key field, click Browse; locate the file to upload.
If the key is encrypted, select Key is Encrypted.

Note  The key length must be 512, 1024, or 2048 bits. The private key file
must be in PEM format. DER format is not supported.

4. Click Upload Files.

5. Click Download Certificate to download a copy of the certificate for
transfer to the SaaS applications with which the Web Security appliance
will communicate.

Generate a certificate

and key

1. Select Use Generated Certificate and Key.
2. Click Generate New Certificate and Key.

a. In the Generate Certificate and Key dialog box, enter the information to
display in the signing certificate.

Note  You can enter any ASCII character except the forward slash (/) in the
Common Name field.

b. Click Generate.

3. Click Download Certificate to transfer the certificate to the SaaS
applications with which the Web Security appliance will communicate.

4. (Optional) To use a signed certificate, click the Download Certificate
Signing Request (DCSR) link to submit a request to a certificate authority
(CA). After you receive a signed certificate from the CA, click Browse and
navigate to the signed certificate location. Click Upload File.

If the appliance has both an uploaded certificate and key pair and a generated certificate and key pair, it
only uses the certificate and key pair currently selected in the Signing Certificate section.

Make note of the settings when you configure the appliance as an identity provider. Some of these
settings must be used when configuring the SaaS application for single sign-on.

Submit and Commit Changes.

Next Steps

e After specifying the certificate and key to use for signing SAML assertions, upload the certificate
to each SaaS application.

Related Topics

e Configuring End-user Access to the Single Sign-on URL, page 7-6
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M Using Saa$ Access Control and Multiple Appliances

Using SaaS Access Control and Multiple Appliances

Before You Begin
e Configure the Appliance as an Identity Provider, page 15-2

Step1  Configure the same Identity Provider Domain Name for each Web Security appliance.
Step2  Configure the same Identity Provider Entity ID for each Web Security appliance.

Step3  Upload the same certificate and private key to each appliance on the Network > Identity Provider for
SaaS page.

Stepd  Upload this certificate to each SaaS application you configure.

Creating Saa$S Application Authentication Policies

Before You Begin

¢ Create associated identities.
e Configure Identity Provider, see Configuring the Appliance as an Identity Provider, page 7-2.

e Provide an Identity Provider Signing Certificate and Key: Network > Identity Provider for SaaS >
Enable and Edit Settings.

¢ Create an Authentication Realm, Authentication Realms, page 5-11.

Step 1 Choose Web Security Manager > SaaS Policies.
Step2  Click Add Application.
Step3  Configure the settings:

Property Description

Application Name Enter a name to identify the SaaS application for this policy; each application
name must be unique. The Web Security appliance uses the application name to
generate a single sign-on URL.

Description (Optional) Enter a description for this SaaS policy.
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Creating Saa$S Application Authentication Policies W

Property Description
Metadata for Configure the metadata that describes the service provider referenced in this
Service Provider policy. You can either describe the service provider properties manually or

upload a metadata file provided by the SaaS application.

The Web Security appliance uses the metadata to determine how to
communicate with the SaaS application (service provider) using SAML. Contact
the SaaS application to learn the correct settings to configure the metadata.

Configure Keys Manually — If you select this option, provide the following:

e Service Provider Entity ID. Enter the text (typically in URI format) the
SaaS application uses to identify itself as a service provider.

e Name ID Format. Choose from the drop-down list the format the
appliance should use to identify users in the SAML assertion it sends to
service providers. The value you enter here must match the
corresponding setting configured on the SaaS application.

¢ Assertion Consumer Service URL. Enter the URL to which the Web
Security appliance is to send the SAML assertion it creates. Read the
SaaS application documentation to determine the correct URL to use
(also known as the login URL).

Import File from Hard Disk — If you select this option, click Browse, locate
the file, and then click Import.

Note  This metadata file is an XML document, following the SAML
standard, that describes a service provider instance. Not all SaaS
applications use metadata files, but for those that do, contact the
SaaS application provider for the file.

User Identification / Specify how users are identified/authenticated for SaaS single sign-on:
Authentication for

e Always prompt users for their local authentication credentials.
SaaS SSO

e Prompt users for their local authentication credentials if the Web Proxy
obtained their user names transparently.

e Automatically sign in SaaS users using their local authentication
credentials.

Choose the authentication realm or sequence the Web Proxy should use to
authenticate users accessing this SaaS application. Users must be a member
of the authentication realm or authentication sequence to successfully access
the SaaS application. If an Identity Services Engine is used for
authentication, and LDAP was selected, the realm will be used for the SAML
user names and attribute mapping.
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Property Description
SAML User Specify how the Web Proxy should represent user names to the service provider
Name Mapping in the SAML assertion. You can pass the user names as they are used inside your
network (No mapping), or you can change the internal user names into a
different format using one of the following methods:
e LDAP query. The user names sent to the service provider are based on
one or more LDAP query attributes. Enter an expression containing
LDAP attribute fields and optional custom text. You must enclose
attribute names in angled brackets. You can include any number of
attributes. For example, for the LDAP attributes “user” and “domain,”
you could enter <user>@<domain>.com.
¢ Fixed Rule mapping. The user names sent to the service provider are
based on the internal user name with a fixed string added before or after
the internal user name. Enter the fixed string in the Expression Name
field, with s either before or after the string to indicate its position in
the internal user name.
SAML Attribute (Optional) You can provide to the SaaS application additional information
Mapping about the internal users from the LDAP authentication server if required by

the SaaS application. Map each LDAP server attribute to a SAML attribute.

Authentication Context

Choose the authentication mechanism the Web Proxy uses to authenticate its
internal users.

Note  The authentication context informs the service provider which
authentication mechanism the identity provider used to authenticate
the internal users. Some service providers require a particular
authentication mechanism to allow users to access the SaaS
application. If a service provider requires an authentication context
that is not supported by an identity provider, users cannot access the
service provider using single sign-on from the identity provider.

Step4  Submit and Commit Changes.

What to Do Next

e Set up the single sign-on settings on the SaaS application side, using the same parameters to
configure the application.

Configuring End-user Access to the Single Sign-on URL

After you configure the Web Security appliance as an identity provider and create a SaaS Application

Authentication Policy for the SaaS application, the appliance creates a single sign-on URL (SSO URL).
The Web Security appliance uses the application name configured in the SaaS Application Authentication
Policy to generate the single sign-on URL; the SSO URL format is:

http://IdentityProviderDomainName/SSOURL/ApplicationName

Step1  Obtain the single sign-on URL from the Web Security Manager > SaaS Policies page.

Step2  Make the URL available to end-users depending on which flow type.
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Configuring End-user Access to the Single Sign-on URL W

Step3  If you choose Identity provider initiated flow, the appliance redirects users to the SaaS application.
Step4  If you choose Service Provider initiated flows, you must configure this URL in the SaaS application.

e Always prompt SaaS users for proxy authentication. After entering valid credentials, users are
logged into the SaaS application.

e Transparently sign in SaaS users. Users are logged into the SaaS application automatically.

Note  To achieve single sign-on behavior using explicit forward requests for all authenticated users when the
appliance is deployed in transparent mode, select “Apply same surrogate settings to explicit forward
requests” when you configure the Identity group.
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Integrate the Cisco Identity Services Engine

e Overview of the Identity Services Engine Service, page 8-1

e Identity Services Engine Certificates, page 8-2

e Tasks for Certifying and Integrating the ISE Service, page 8-3
e Connect to the ISE Services, page 8-6

¢ Troubleshooting Identity Services Engine Problems, page 8-7

Overview of the Identity Services Engine Service

Note

About pxGrid

Cisco’s Identity Services Engine (ISE) is an application that runs on separate servers in your network to
provide enhanced identity management. AsyncOS can access user-identity information from an ISE
server. If configured, user names and associated Secure Group Tags will be obtained from the Identity
Services Engine for appropriately configured Identification Profiles, to allow transparent user
identification in policies configured to use those profiles.

The ISE service is not available in Connector mode.

Related Topics
e About pxGrid, page 8-1
e About the ISE Server Deployment and Failover, page 8-2

Cisco’s Platform Exchange Grid (pxGrid) enables collaboration between components of the network
infrastructure, including security-monitoring and network-detection systems, identity and access
management platforms, and so on. These components can use pxGrid to exchange information via a
publish/subscribe method.

There are essentially three pxGrid components: the pxGrid publisher, the pxGrid client, and the
pxGrid controller.

e pxGrid publisher — Provides information for the pxGrid client(s).

e pxGrid client — Any system, such as the Web Security appliance, that subscribes to published
information; in this case, Security Group Tag (SGT) and user-group and profiling information.
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e pxGrid controller — In this case, the ISE pxGrid node that controls the client registration/management
and topic/subscription processes.

Trusted certificates are required for each component, and these must be installed on each host platform.

About the ISE Server Deployment and Failover

A single ISE node set-up is called a “standalone deployment,” and this single node runs the Administration,
Policy Service, and Monitoring personae. To support failover and to improve performance, you must set
up multiple ISE nodes in a “distributed deployment.” The minimum required distributed ISE configuration
to support ISE failover on your Web Security appliance is:

e Two pxGrid nodes

e Two Monitoring nodes

e Two Administration nodes
¢ One Policy Service node

This configuration is referred to in the Cisco Identity Services Engine Hardware Installation Guide as a
“Medium-Sized Network Deployment.” Refer to that network deployments section in the Installation
Guide for additional information.

Related Topics
e Identity Services Engine Certificates, page 8-2

e Tasks for Certifying and Integrating the ISE Service, page 8-3
e Connect to the ISE Services, page 8-6
¢ Troubleshooting Identity Services Engine Problems, page 8-7

Identity Services Engine Certificates
N

Note  This section describes the certificates necessary for ISE connection. Tasks for Certifying and Integrating
the ISE Service, page 8-3 provides detailed information about these certificates. Certificate
Management, page 22-24, provides general certificate-management information for AsyncOS.

A set of three certificates is required for mutual authentication and secure communication between the
Web Security appliance and each ISE server:

e WSA Client Certificate — Used by the ISE server to authenticate the Web Security appliance.

¢ ISE Admin Certificate — Used by the Web Security appliance to authenticate an ISE server on
port 443 for bulk download of ISE user-profile data.

¢ ISE pxGrid Certificate — Used by the Web Security appliance to authenticate an ISE server on
port 5222 for WSA-ISE data subscription (on-going publish/subscribe queries to the ISE server).

These three certificates can be Certificate Authority (CA)-signed or self-signed. AsyncOS provides the
option to generate a self-signed WSA Client certificate, or a Certificate Signing Request (CSR) instead,
if a CA-signed certificate is needed. Similarly, the ISE server provides the option to generate self-signed
ISE Admin and pxGrid certificates, or CSRs instead if CA-signed certificates are needed.
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Related Topics

Tasks for Certifying and Integrating the ISE Service

e Using Self-signed Certificates, page 8-3

e Using CA-signed Certificates, page 8-3

e Overview of the Identity Services Engine Service, page 8-1

e Tasks for Certifying and Integrating the ISE Service, page 8-3

e Connect to the ISE Services, page 8-6

Using Self-signed Certificates

When self-signed certificates are used on the ISE server, all three certificates—the ISE pxGrid and
Admin certificates, developed on the ISE server, as well as the WSA Client certificate, developed on the
WSA—must be added to the Trusted Certificates store on the ISE server (Administration > Certificates
> Trusted Certificates > Import).

Using CA-signed Certificates

In the case of CA-signed certificates:

¢ On the ISE server, ensure the appropriate CA root certificate for the WSA Client certificate is
present in the Trusted Certificates store (Administration > Certificates > Trusted Certificates).

e On the WSA, ensure the appropriate CA root certificates are present in the Trusted Certificates list
(Network > Certificate Management > Manage Trusted Root Certificates). On the Identity Services
Engine page (Network > Identity Services Engine), be sure to upload the CA root certificate(s) for
the ISE Admin and pxGrid certificates.

Tasks for Certifying and Integrating the ISE Service

Step

Task

Links to Related Topics and Procedures

1a

On the WSA, add a WSA
Client certificate.

e Create or upload a CA-signed or self-signed WSA Client certificate
on the WSA.

See Connect to the ISE Services, page 8-6, and Certificate
Management, page 22-24.

1b

On the WSA, download this
WSA Client certificate for
upload to the ISE server.

e Download the WSA Client certificate, save it, and then transfer it to
the ISE server.

See Connect to the ISE Services, page 8-6.

If the WSA Client
Certificate is self-signed,
upload it and its signing
certificate to the ISE server.

e Import the WSA Client certificate downloaded from the WSA in the
previous step, adding it to the ISE server’s Trusted Certificate store.
(Administration > Certificates > Trusted Certificates > Import.)

e Be sure to also add the appropriate signing certificate for this WSA
Client certificate to the Trusted Certificates store on the ISE server,
as discussed in Using Self-signed Certificates, page 8-3.
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B Tasks for Certifying and Integrating the ISE Service

Step |Task

Link

s to Related Topics and Procedures

3 On the ISE server, add
ISE Admin and pxGrid
certificates.

Note

Navigate to the Administration > Certificates page, and generate or
upload ISE Admin and pxGrid certificates:

— For CA-signed certificates, generate two Certificate Signing
Requests, one each for Admin and pxGrid Usage, and then have
the certificates signed.

Upon receipt of the signed certificates, upload both to the
ISE server.

Perform the “Bind the CA Signed Certificate” operation for both.

Be sure to add the CA root certificate to the ISE server’s Trusted
Certificates store.

Restart the ISE server.

— For self-signed certificates, navigate to Administration >
Certificates > System Certificates, and generate two Self Signed
Certificates, one each for Admin and pxGrid. (You can also elect
to generate one common certificate for both.)

Add both to the Trusted Certificates store.
Export the self-signed certificate(s) for import onto the WSA.

Ensure the appropriate self-signed or CA root certificates for
these ISE Admin and pxGrid certificates are added to the Trusted
Certificates store, as discussed in Identity Services Engine
Certificates, page 8-2.

4 Ensure the ISE server is
configured appropriately for
WSA access.

Each ISE server must be configured to allow identity topic subscribers
(such as WSA) to obtain session context in real-time. The basic steps are:

Ensure “Enable Auto Registration” is turned ON (Administration >
pxGrid Services > Top Right).

Delete all existing WSA clients from the ISE server (Administration
> pxGrid Services > Clients).

Be sure the ISE server footer (Administration > pxGrid Services)
says “Connected to pxGrid.”

Configure SGT groups on ISE server (Policy > Results > TrustSec >
Security Groups).

Configure policies that associate the SGT groups with users.

Refer to Cisco Identity Services Engine documentation for
more information.
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Tasks for Certifying and Integrating the ISE Service

Step

Task

Links to Related Topics and Procedures

On the WSA, add the
exported ISE Admin and
pxGrid certificates.

e Upload the ISE Admin and pxGrid certificates for each ISE server
you are configuring on this WSA. See Connect to the ISE Services,
page 8-6.

— If using a single self-signed certificate for both ISE Admin and
pxGrid, upload the file twice, once each in the ISE Admin
Certificate and ISE pxGrid Certificate fields. See Connect to the
ISE Services, page 8-6.

- Ifusing CA-signed certificates, be sure the Certificate Authority
that signed each pair of ISE certificates is listed in the Trusted
Root Certificates list on the WSA. If not, import the CA root
certificate. See Managing Trusted Root Certificates, page 22-25.

Note If the ISE Admin and pxGrid certificates are signed by your
Root CA certificate, be sure to upload Root CA certificate
itself to the ISE Admin Certificate and ISE pxGrid Certificate
fields on the WSA (Network > Identity Services Engine).

Complete configuration of
the WSA for ISE access
and logging.

e Connect to the ISE Services, page 8-6.

e Add the custom field %m to the Access Logs to log the Authentication
mechanism — Customizing Access Logs, page 21-26.

e Verify that the ISE Service Log was created; if it was not, create it —
Adding and Editing Log Subscriptions, page 21-7.

e Ensure the ISE Service Log was created; if not, add it — Adding and
Editing Log Subscriptions, page 21-7.

¢ Define Identification Profiles that access ISE for user identification
and authentication — Classifying Users and Client Software,
page 6-3.

e Configure access policies that utilize ISE identification to define
criteria and actions for user requests — Policy Configuration,
page 10-8.

N

Note

Whenever you upload or change certificates on the ISE server, you must restart the ISE service. Also, a
few minutes may be required before the services and connections are restored.

Related Topics

e Overview of the Identity Services Engine Service, page 8-1

¢ Identity Services Engine Certificates, page 8-2

¢ Troubleshooting Identity Services Engine Problems, page 8-7
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I Connect to the ISE Services

Connect to the ISE Services

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Note

Before You Begin

e Be sure each ISE server is configured appropriately for WSA access; see Tasks for Certifying and
Integrating the ISE Service, page 8-3.

e Obtain ISE server connection information.

e Obtain valid ISE-related certificates (client, Portal and pxGrid) and keys. See also Identity Services
Engine Certificates, page 8-2 for related information.

Choose Network > Identification Service Engine.

Click Edit Settings.

Check Enable ISE Service.

Identify the Primary ISE pxGrid Node using its host name or IPv4 address.

a. Provide an ISE pxGrid Node Certificate for WSA-ISE data subscription (on-going queries to the
ISE server).

Browse to and select the certificate file, and then click Upload File. See Uploading a Certificate and
Key, page 22-26 for additional information.

If using a second ISE server for failover, identify the Secondary ISE pxGrid Node using its host name
or [Pv4 address.

a. Provide the secondary ISE pxGrid Node Certificate.

Browse to and select the certificate file, and then click Upload File. See Uploading a Certificate and
Key, page 22-26 for additional information.

)
Note  During failover from primary to secondary ISE servers, any user not in the existing ISE SGT

cache will be required to authenticate, or will be assigned Guest authorization, depending on
your WSA configuration. After ISE failover is complete, normal ISE authentication resumes.

Upload the ISE Monitoring Node Admin Certificates:

a. Provide the Primary ISE Monitoring Node Admin Certificate for use in bulk download of ISE
user-profile data to the WSA.

Browse to and select the certificate file, and then click Upload File. See Uploading a Certificate and
Key, page 22-26 for additional information.

b. If using a second ISE server for failover, provide the Secondary ISE Monitoring Node
Admin Certificate.

Provide a WSA Client Certificate for WSA-ISE server mutual authentication:

This must be a CA trusted-root certificate. See Identity Services Engine Certificates, page 8-2 for
related information.

e Use Uploaded Certificate and Key
For both the certificate and the key, click Choose and browse to the respective file.

If the Key is Encrypted, check this box.
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Troubleshooting Identity Services Engine Problems

Click Upload Files. (See Uploading a Certificate and Key, page 22-26 for
additional information about this option.)

e Use Generated Certificate and Key

Click Generate New Certificate and Key. (See Generating a Certificate and Key, page 22-26
for additional information about this option.)

Step 8 Download the WSA Client Certificate, save it, and then upload it to the ISE server host (Administration
> Certificates > Trusted Certificates > Import on the specified server).

Step9  (Optional) Click Start Test to test the connection with the ISE pxGrid node(s).
Step10 Click Submit.

What to Do Next
e C(Classify End-Users and Client Software, page 6-1

e Create Policies to Control Internet Requests, page 10-1

Related Information

e http://www.cisco.com/c/en/us/support/security/identity-services-engine/products-implementation-de
sign-guides-list.html, particularly “How To Integrate Cisco WSA using ISE and TrustSec through
pxGrid.”

Troubleshooting Identity Services Engine Problems

e Identity Services Engine Problems, page A-7
— Tools for Troubleshooting ISE Issues, page A-7
— ISE Server Connection Issues, page A-8

— ISE-related Critical Log Messages, page A-9
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CHAPTER

Classify URLs for Policy Application

e Overview of Categorizing URL Transactions, page 9-1

e Configuring the URL Filtering Engine, page 9-4

e Managing Updates to the Set of URL Categories, page 9-4
e Filtering Transactions Using URL Categories, page 9-9

¢ Creating and Editing Custom URL Categories, page 9-13
e Filtering Adult Content, page 9-15

e Redirecting Traffic in the Access Policies, page 9-17

e Warning Users and Allowing Them to Continue, page 9-17
e Creating Time Based URL Filters, page 9-19

e Viewing URL Filtering Activity, page 9-19

e Regular Expressions, page 9-20

e URL Category Descriptions, page 9-23

Overview of Categorizing URL Transactions

Using policy groups, you can create secure policies that control access to web sites containing
questionable content. The sites that are blocked, allowed, or decrypted depend on the categories you
select when setting up category blocking for each policy group. To control user access based on a URL
category, you must enable Cisco Web Usage Controls. This is a multi-layered URL filtering engine that
uses domain prefixes and keyword analysis to categorize URLs.

You can use URL categories when performing the following tasks:

Option Method

Define policy group membership Matching URLs to URL Categories, page 9-3
Control access to HTTP, HTTPS, and FTP Filtering Transactions Using URL Categories,
requests page 9-9

Create user defined custom URL categories that |Creating and Editing Custom URL Categories,
specify specific hostnames and IP addresses page 9-13
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I Overview of Categorizing URL Transactions

Categorization of Failed URL Transactions

The Dynamic Content Analysis engine categorizes URLs when controlling access to websites in Access
Policies only. It does not categorize URLs when determining policy group membership or when
controlling access to websites using Decryption or Cisco Data Security Policies. This is because the
engine works by analyzing the response content from the destination server, so it cannot be used on
decisions that must be made at request time before any response is downloaded from the server.

If the web reputation score for an uncategorized URL is within the WBRS ALLOW range, AsyncOS
allows the request without performing Dynamic Content Analysis.

After the Dynamic Content Analysis engine categorizes a URL, it stores the category verdict and URL
in a temporary cache. This allows future transactions to benefit from the earlier response scan and be
categorized at request time instead of at response time.

Enabling the Dynamic Content Analysis engine can impact transaction performance. However, most
transactions are categorized using the Cisco Web Usage Controls URL categories database, so the
Dynamic Content Analysis engine is usually only called for a small percentage of transactions.

Enabling the Dynamic Content Analysis Engine

~

Note

Step 1
Step 2
Step 3
Step 4

It is possible for an Access Policy, or an Identity used in an Access Policy, to define policy membership
by a predefined URL category and for the Access Policy to perform an action on the same URL category.
The URL in the request can be uncategorized when determining Identity and Access Policy group
membership, but must be categorized by the Dynamic Content Analysis engine after receiving the server
response. Cisco Web Usage Controls ignores the category verdict from the Dynamic Content Analysis
engine and the URL retains the “uncategorized” verdict for the remainder of the transaction. Future
transactions will still benefit from the new category verdict.

Choose Security Services > Acceptable Use Controls.
Enable the Cisco Web Usage Controls.
Click to enable the Dynamic Content Analysis engine.

Submit and Commit Changes.

Uncategorized URLs

S

Note

An uncategorized URL is a URL that does not match any pre-defined URL category or included custom
URL category.

When determining policy group membership, a custom URL category is considered included only when
it is selected for policy group membership.

All transactions resulting in unmatched categories are reported on the Reporting > URL Categories page
as “Uncategorized URLs.” A large number of uncategorized URLs are generated from requests to web
sites within the internal network. Cisco recommends using custom URL categories to group internal
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URLs and allow all requests to internal web sites. This decreases the number of web transactions
reported as “Uncategorized URLs” and instead reports internal transactions as part of “URL Filtering
Bypassed” statistics.

Related Topics
e Understanding Unfiltered and Uncategorized Data, page 9-19.

e Creating and Editing Custom URL Categories, page 9-13.

Matching URLs to URL Categories

When the URL filtering engine matches a URL category to the URL in a client request, it first evaluates
the URL against the custom URL categories included in the policy group. If the URL in the request does
not match an included custom category, the URL filtering engine compares it to the predefined URL
categories. If the URL does not match any included custom or predefined URL categories, the request is
uncategorized.

When determining policy group membership, a custom URL category is considered included only when
it is selected for policy group membership.

To see what category a particular web site is assigned to, go to the URL in Reporting Uncategorized and
Misclassified URLs, page 9-3.

Related Topics
e Uncategorized URLs, page 9-2.

Reporting Uncategorized and Misclassified URLs

You can report uncategorized and misclassified URLs to Cisco. Cisco provides a URL submission tool
on its website that allows you to submit multiple URLSs simultaneously:

https://securityhub.cisco.com/web/submit_urls

To check the status of submitted URLSs, click the Status on Submitted URLSs tab on this page. You can
also use the URL submission tool to look up the assigned URL category for any URL.

URL Categories Database

The category that a URL falls into is determined by a filtering categories database. The Web Security
appliance collects information and maintains a separate database for each URL filtering engine. The
filtering categories databases periodically receive updates from the Cisco update server.

The URL categories database includes many different factors and sources of data internal to Cisco and
from the Internet. One of the factors occasionally considered, heavily modified from the original, is
information from the Open Directory Project.
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W Configuring the URL Filtering Engine

Je

ﬁ To see what category a particular web site is assigned to, go to the URL in Reporting Uncategorized and
Misclassified URLSs, page 9-3.

Related Topics
e Manually Updating Security Service Components, page 22-29.

Configuring the URL Filtering Engine

By default, the Cisco Web Usage Controls URL filtering engine is enabled in the System Setup Wizard.

Step 1 Choose Security Services > Acceptable Use Controls.

Step2  Click Edit Global Settings.

Step3  Verify the Enable Acceptable Use Controls property is enabled.

Step4  Choose whether or not to enable the Dynamic Content Analysis Engine.

Step5  Choose the default action the Web Proxy should use when the URL filtering engine is unavailable, either
Monitor or Block. Default is Monitor.

Step6  Submit and Commit Changes.

Managing Updates to the Set of URL Categories

The set of predefined URL categories may occasionally be updated in order to accommodate new web
trends and evolving usage patterns. Updates to the URL category set are distinct from the changes that
add new URLs and re-map misclassified URLs. Category set updates may change configurations in your
existing policies and therefore require action. URL category set updates may occur between product
releases; an AsyncOS upgrade is not required.

Information is available from:
http://www.cisco.com/en/US/products/ps10164/prod_release_notes_list.html.

Take the following actions:

When to Act Method

Before updates occur |Understanding the Impacts of URL Category Set Updates, page 9-5
(Do these tasks as part |Controlling Updates to the URL Category Set, page 9-7
of your initial setup) Default Settings for New and Changed Categories, page 9-8

Receiving Alerts About Category and Policy Changes, page 9-8

After updates occur Responding to Alerts about URL Category Set Updates, page 9-8
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Managing Updates to the Set of URL Categories ||

Understanding the Impacts of URL Category Set Updates

URL category set updates can have the following impacts on existing Access Policies, Decryption
Policies, and Cisco Data Security policies, and on Identities:

e Effects of URL Category Set Changes on Policy Group Membership, page 9-5
e Effects of URL Category Set Updates on Filtering Actions in Policies, page 9-5

Effects of URL Category Set Changes on Policy Group Membership

This section applies to all policy types with membership that can be defined by URL category, and to
Identities. When policy group membership is defined by URL category, changes to the category set may
have the following effects:

e If the sole criterion for membership is a deleted category, the policy or identity is disabled.

e If membership in any policy is defined by a URL category that changes, and if this causes ACL list
changes, the web proxy will restart.

Effects of URL Category Set Updates on Filtering Actions in Policies

URL category set updates can change policy behavior in the following ways:

Change Effect on Policies and Identities

A new category can be |For each policy, the default action for newly-added categories is the action specified for

added Uncategorized URLSs for that policy.

A category can be The action associated with the deleted category is deleted.

deleted If the policy depended exclusively on the deleted category, the policy is disabled.
If a policy depends on an identity that depended exclusively on a deleted category, the policy will
be disabled.

A category can be No change to the behavior of the existing policy.

renamed

A category can split A single category can become multiple new categories. Both new categories have the action

associated with the original category.
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Change Effect on Policies and Identities

Two or more existing |If all original categories in a policy had the same action assigned, the merged category has the same
categories can merge  |action as the original categories. If all original categories were set to “Use Global Setting” then the
merged category is also set to “Use Global Setting.”

If the policy had different actions assigned to the original categories, the action assigned to the
merged category depends on the Uncategorized URLSs setting in that policy:

e If Uncategorized URLs is set to Block (or “Use Global Setting” when the global setting is
Block), then the most restrictive action among the original categories is applied to the merged
category.

e If Uncategorized URLs is set to any action other than Block (or “Use Global Setting” when the
global setting is anything other than Block), then the least restrictive action among the original
categories is applied to the merged category.

In this case, sites that were previously blocked may now be accessible to users.

If policy membership is defined by URL category, and some of the categories involved in the merge,
or the Uncategorized URLs action, are not included in the policy membership definition, then the
values in the Global Policy are used for the missing items.

e The order of restrictiveness is as follows (not all actions are available for all policy types):Block
e Drop

e Decrypt

e Warn

e Time-based

e Monitor

e Pass Through

Note Time-based policies that are based on merged categories adopt the action associated with any
one of the original categories. (In time-based policies, there may be no obviously most- or
least-restrictive action.)

Related Topics
e Merged Categories - Examples, page 9-6.

Merged Categories - Examples

Some examples of merged categories, based on settings on the URL Filtering page for the policy:

Original Category 1 |Original Category 2 Uncategorized URLs Merged Category
Monitor Monitor (Not Applicable) Monitor
Block Block (Not Applicable) Block
Use Global Use Global Settings (Not Applicable) Use Global
Settings Settings
Warn Block Monitor Warn

Use the least restrictive among the original

categories.
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Original Category 1 |Original Category 2 Uncategorized URLs Merged Category
Monitor ¢ Block or e Block or Block
e Use Global Settings, ¢ Use Global Setting, when Global is set to
when Global is set to Block Block
Use the most restrictive among the original
categories.
Block e Monitor or e Monitor or Monitor
¢ Use Global Settings, ¢ Use Global Setting, when Global is set to
when Global is set to Monitor Monitor

Use the least restrictive among the original
categories.

For policies in An action for this category is not |An action for Uncategorized URLs is not Monitor
which membership |specified in this policy, but the specified in this policy, but the value in the
is defined by URL |value in the Global Policy for this |Global Policy for Uncategorized URLs is
category: category is Block Monitor

Monitor

Controlling Updates to the URL Category Set

By default, URL category set updates to occur automatically. These updates may change existing policy
configurations, so you may prefer to disable all automatic updates.

Option Method

If you disable updates, you will need to Manually Updating the URL Category Set, page 9-7

manually update all services listed in the and

Update Servers (list) section of the System Manually Updating Security Service Components,

Administration > Upgrade and Update Settings |page 22-29

page

Disabling all automatic updates Configuring Upgrade and Service Update Settings,
page 22-32.

~

Note If you use the CLI, disable updates by setting the update interval to zero (0)

Manually Updating the URL Category Set
N

Note Do not interrupt an update in progress.

If you have disabled automatic updates, you can manually update the set of URL categories at your
convenience.
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Step 1 Choose Security Services > Acceptable Use Controls.
Step2  Determine whether an update is available:

Look at the “Cisco Web Usage Controls - Web Categorization Categories List” item in the Acceptable
Use Controls Engine Updates table.

Step3  To update, click Update Now.

Default Settings for New and Changed Categories

URL category set updates may change the behavior of your existing policies. You should specify default
settings for certain changes when you configure your policies, so that they are ready when URL category
set updates occur. When new categories are added, or existing categories merge into a new category, the
default action for these categories for each policy are affected by the Uncategorized URLSs setting in that
policy.

Verifying Existing Settings and/or Making Changes

Step 1 Choose Web Security Manager.
Step2  Foreach Access Policy, Decryption Policy, and Cisco Data Security policy click the URL Filtering link.
Step3  Check the selected setting for Uncategorized URLs.

Related Topics
e Effects of URL Category Set Updates on Filtering Actions in Policies, page 17-6.

Receiving Alerts About Category and Policy Changes

Category set updates trigger two types of alerts:
e Alerts about category changes

e Alerts about policies that have changed or been disabled as a result of category set changes.

Step1  Choose System Administration > Alerts.

Step2  Click Add Recipient and add email address (or multiple email addresses).
Step3  Decide which Alert Types and Alert Severities to receive.

Step4  Submit and Commit Changes.

Responding to Alerts about URL Category Set Updates

When you receive an alert about category set changes, you should do the following:
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e Check policies and identities to be sure that they still meet your policy goals after category merges,
additions, and deletions, and

¢ Consider modifying policies and identities to benefit from new categories and the added granularity

of split categories.

Related Topics
e Understanding the Impacts of URL Category Set Updates, page 9-5

Filtering Transactions Using URL Categories

The URL filtering engine configured allows you to filter transactions in Access, Decryption, and Data
Security Policies. When you configure URL categories for policy groups, you can configure actions for
custom URL categories, if any are defined, and predefined URL categories.

The URL filtering actions you can configure depends on the type of policy group:

Option Method

Access Policies Configuring URL Filters for Access Policy Groups, page 9-9

Decryption Policies Configuring URL Filters for Decryption Policy Groups,
page 9-11

Cisco Data Security Policies Configuring URL Filters for Data Security Policy Groups,
page 9-12

Configuring URL Filters for Access Policy Groups

Step 1
Step 2
Step 3

You can configure URL filtering for user defined Access Policy groups and the Global Policy Group.

Choose Web Security Manager > Access Policies.
Click the link in the policies table under the URL Filtering column for the policy group you want to edit.

(Optional) In the Custom URL Category Filtering section, you can add custom URL categories on which
to take action in this policy:

a. Click Select Custom Categories.
b. Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request
against. The URL filtering engine compares client requests against included custom URL categories, and
ignores excluded custom URL categories. The URL filtering engine compares the URL in a client
request to included custom URL categories before predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering section.
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Stepd  In the Custom URL Category Filtering section, choose an action for each included custom URL

category.

Action Description

Use Global Uses the action for this category in the Global Policy Group. This is the default action

Setting for user defined policy groups.

Applies to user defined policy groups only.

Note When a custom URL category is excluded in the global Access Policy, then
the default action for included custom URL categories in user defined Access
Policies is Monitor instead of Use Global Settings. You cannot choose Use
Global Settings when a custom URL category is excluded in the global
Access Policy.

Redirect Redirects traffic originally destined for a URL in this category to a location you
specify. When you choose this action, the Redirect To field appears. Enter a URL to
which to redirect all traffic.

Allow Always allows client requests for web sites in this category.

Allowed requests bypass all further filtering and malware scanning.

Only use this setting for trusted web sites. You might want to use this setting for

internal sites.

Monitor The Web Proxy neither allows nor blocks the request. Instead, it continues to evaluate
the client request against other policy group control settings, such as web reputation
filtering.

Warn The Web Proxy initially blocks the request and displays a warning page, but allows
the user to continue by clicking a hypertext link in the warning page.

Block The Web Proxy denies transactions that match this setting.

Time-Based The Web Proxy blocks or monitors the request during the time ranges you specify.

Step5  In the Predefined URL Category Filtering section, choose one of the following actions for each category:

Use Global Settings
Monitor

Warn

Block

Time-Based

Step6  In the Uncategorized URLs section, choose the action to take for client requests to web sites that do not
fall into a predefined or custom URL category. This setting also determines the default action for new
and merged categories resulting from URL category set updates.

Step7  Submit and Commit Changes.

Related Topics

Redirecting Traffic in the Access Policies, page 9-17.
Warning Users and Allowing Them to Continue, page 9-17
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e Creating and Editing Custom URL Categories, page 9-13

e Effects of URL Category Set Updates on Filtering Actions in Policies, page 9-5

Configuring URL Filters for Decryption Policy Groups

Step 1
Step 2

Step 3

Step 4

You can configure URL filtering for user defined Decryption Policy groups and the global Decryption

Policy group.

Choose Web Security Manager > Decryption Policies.

Click the link in the policies table under the URL Categories column for the policy group you want to

edit.

(Optional) In the Custom URL Category Filtering section, you can add custom URL categories on which
to take action in this policy:

a. Click Select Custom Categories.

b. Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request
against. The URL filtering engine compares client requests against included custom URL
categories, and ignores excluded custom URL categories. The URL filtering engine compares the
URL in a client request to included custom URL categories before predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering

section.

Choose an action for each custom and predefined URL category.

Action Description
Use Global Uses the action for this category in the global Decryption Policy group. This is the
Setting default action for user defined policy groups.

Applies to user defined policy groups only.

When a custom URL category is excluded in the global Decryption Policy, then the
default action for included custom URL categories in user defined Decryption

Policies is Monitor instead of Use Global Settings. You cannot choose Use Global
Settings when a custom URL category is excluded in the global Decryption Policy.

Pass Through

Passes through the connection between the client and the server without inspecting
the traffic content.

Monitor

The Web Proxy neither allows nor blocks the request. Instead, it continues to
evaluate the client request against other policy group control settings, such as web
reputation filtering.

Decrypt

Allows the connection, but inspects the traffic content. The appliance decrypts the
traffic and applies Access Policies to the decrypted traffic as if it were a plain text
HTTP connection. By decrypting the connection and applying Access Policies, you
can scan the traffic for malware.

Drop

Drops the connection and does not pass the connection request to the server. The
appliance does not notify the user that it dropped the connection.
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Step 5

Step 6

Filtering Transactions Using URL Categories

~

Note  If you want to block a particular URL category for HTTPS requests, choose to decrypt that URL
category in the Decryption Policy group and then choose to block the same URL category in the
Access Policy group.

In the Uncategorized URLSs section, choose the action to take for client requests to web sites that do not
fall into a predefined or custom URL category.

This setting also determines the default action for new and merged categories resulting from URL
category set updates.

Submit and Commit Changes.

Configuring URL Filters for Data Security Policy Groups

Step 1
Step 2

Step 3

You can configure URL filtering for user defined Data Security Policy groups and the Global Policy
Group.

Choose Web Security Manager > Cisco Data Security.

Click the link in the policies table under the URL Categories column for the policy group you want to
edit.

(Optional) In the Custom URL Category Filtering section, you can add custom URL categories on which
to take action in this policy:

a. Click Select Custom Categories.

b. Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request
against. The URL filtering engine compares client requests against included custom URL
categories, and ignores excluded custom URL categories. The URL filtering engine compares the
URL in a client request to included custom URL categories before predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering
section.
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Step 5

Step 6

Step 7

Creating and Editing Custom URL Categories W

In the Custom URL Category Filtering section, choose an action for each custom URL category.

Action Description
Use Global Uses the action for this category in the Global Policy Group. This is the default
Setting action for user defined policy groups.

Applies to user defined policy groups only.

When a custom URL category is excluded in the global Cisco Data Security Policy,
then the default action for included custom URL categories in user defined Cisco
Data Security Policies is Monitor instead of Use Global Settings. You cannot choose
Use Global Settings when a custom URL category is excluded in the global Cisco
Data Security Policy.

Allow Always allows upload requests for web sites in this category. Applies to custom URL
categories only.

Allowed requests bypass all further data security scanning and the request is
evaluated against Access Policies.

Only use this setting for trusted web sites. You might want to use this setting for
internal sites.

Monitor The Web Proxy neither allows nor blocks the request. Instead, it continues to
evaluate the upload request against other policy group control settings, such as web
reputation filtering.

Block The Web Proxy denies transactions that match this setting.

In the Predefined URL Category Filtering section, choose one of the following actions for each category:
e Use Global Settings
e Monitor
e Block

In the Uncategorized URLS section, choose the action to take for upload requests to web sites that do not
fall into a predefined or custom URL category. This setting also determines the default action for new
and merged categories resulting from URL category set updates.

Submit and Commit Changes.

Related Topics
e Effects of URL Category Set Updates on Filtering Actions in Policies, page 9-5.

Creating and Editing Custom URL Categories

You can also create user defined custom URL categories that specify specific hostnames and IP
addresses. In addition, you can edit and delete existing URL categories. When you include these custom
URL categories in the same Access, Decryption, or Cisco Data Security Policy group and define
different actions to each category, the action of the higher included custom URL category takes effect.
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S

Note

Step 1
Step 2

Step 3

Step 4

Step 5

The Web Security appliance uses the first four characters of custom URL category names preceded by
“c_" in the access logs. Consider the custom URL category name if you use Sawmill for to parse the
access logs. If the first four characters of the custom URL category include a space, Sawmill for cannot
properly parse the access log entry. Instead, only use supported characters in the first four characters if
you will use Sawmill for to parse the access logs. If you want to include the full name of a custom URL
category in the access logs, add the %XF format specifier to the access logs.

Choose Web Security Manager > Custom URL Categories.

To create a custom URL category, click Add Custom Category. To edit an existing custom URL
category, click the name of the URL category.

Enter the settings in the table below for the custom URL category.

Setting Description

Category Name Enter a name for the URL category. This name appears when you configure
URL filtering for policy groups.

List Order Choose the order in the list of custom URL categories to place this category.
Enter “1” for the topmost URL category.

The URL filtering engine evaluates a client request against the custom URL
categories in the order specified.

Sites Enter one or more addresses that belong in the custom category.

You can enter multiple addresses separated by line breaks or commas.

Advanced: Regular | You can use regular expressions to specify multiple web servers that match
Expressions the pattern you enter.

Note The URL filtering engine compares URLs with addresses entered in
the Sites field first. If the URL of a transaction matches an entry in
the Sites field, it is not compared to any expression entered here.

See Regular Expressions, page 9-20 for more information about using
regular expressions.

(Optional) Click Sort URLSs to sort all addresses in the Sites field.

A

Note  Once you sort the addresses, you cannot retrieve their original order.

Submit and Commit Changes.
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Filtering Adult Content 1l

Related Topics
e Regular Expressions, page 9-20.

e Customizing Access Logs, page 21-26.

Filtering Adult Content

Note

You can configure the Web Security appliance to filter adult content from some web searches and
websites. To enforce safe search and site content ratings, the AVC engine takes advantage of the safe
mode feature implemented at a particular website by rewriting URLs and/or web cookies to force the
safety mode to be on.

The following features filter adult content:

Option Description

Enforce safe searches You can configure the Web Security appliance so that outgoing search
requests appear to search engines as safe search requests. This can
prevent users from bypassing acceptable use policies using search
engines.

Enforce site content ratings |Some content sharing sites allow users to restrict their own access to the
adult content on these sites by either enforcing their own safe search
feature or blocking access to adult content, or both. This classification
feature is commonly called content ratings.

Any Access Policy that has either the safe search or site content ratings feature enabled is considered a
safe browsing Access Policy.

Enforcing Safe Searches and Site Content Ratings

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6
Step 7

~

Note

Choose Web Security Manager > Access Policies.
Click the link under the URL Categories column for an Access Policy group or the Global Policy Group.

When editing a user-defined Access Policy, choose Define Content Filtering Custom Settings in the
Content Filtering section.

Click the Enable Safe Search check box to enable the safe search feature.

Choose whether to block users from search engines that are not currently supported by the Web Security
appliance safe search feature.

Click the Enable Site Content Rating check box to enable the site content ratings feature.

Choose whether to block all adult content from the supported content ratings websites or to display the
end-user URL filtering warning page.

When the URL of one of the supported search engines or supported content ratings websites is included
in a custom URL category with the Allow action applied, no search results are blocked and all content
is visible.
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W Filtering Adult Content

Step8  Submit and Commit Changes.

Related Topics
e Warning Users and Allowing Them to Continue, page 9-17.

e Controlling Access to Web Applications, page 17-18

Logging Adult Content Access

By default, the access logs include a safe browsing scanning verdict inside the angled brackets of each
entry. The safe browsing scanning verdict indicates whether or not either the safe search or site content
ratings feature was applied to the transaction. You can also add the safe browsing scanning verdict
variable to the access logs or W3C access logs:

e Access logs: %XS

e W3C access logs: x-request-rewrite

Value Description

ensrch The original client request was unsafe and the safe search feature was applied.

encrt The original client request was unsafe and the site content ratings feature was applied.
unsupp The original client request was to an unsupported search engine.

err The original client request was unsafe, but neither the safe search nor the site content

ratings feature could be applied due to an error.

- Neither the safe search nor the site content ratings feature was applied to the client request
because the features were bypassed (for example, the transaction was allowed in a custom
URL category) or the request was made from an unsupported application.

Requests blocked due to either the safe search or site content rating features, use one of the following
ACL decision tags in the access logs:

e BLOCK_SEARCH_UNSAFE

e BLOCK_CONTENT_UNSAFE

e BLOCK_UNSUPPORTED_SEARCH_APP

¢ BLOCK_CONTINUE_CONTENT_UNSAFE

Related Topics
e ACL Decision Tags, page 21-16.
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Redirecting Traffic in the Access Policies W

Redirecting Traffic in the Access Policies

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

Note

You can configure the Web Security appliance to redirect traffic originally destined for a URL in a

custom URL category to a location you specify. This allows you to redirect traffic at the appliance

instead of at the destination server. You can redirect traffic for a custom Access Policy group or the
Global Policy Group

Before You Begin

¢ To redirect traffic you must define at least one custom URL category.

Choose Web Security Manager > Access Policies.
Click the link under the URL Categories column for an Access Policy group or the Global Policy Group.
In the Custom URL Category Filtering section, click Select Custom Categories.

In the Select Custom Categories for this Policy dialog box, choose Include in policy for the custom
URL category you want to redirect.

Click Apply.
Click the Redirect column for the custom category you want to redirect.
Enter the URL to which you want to redirect traffic in the Redirect To field for the custom category.

Submit and Commit Changes.

Beware of infinite loops when you configure the appliance to redirect traffic.

Related Topics
¢ Creating and Editing Custom URL Categories, page 9-13

Logging and Reporting

When you redirect traffic, the access log entry for the originally requested website has an ACL tag that
starts with REDIRECT_CUSTOMCAT. Later in the access log (typically the next line) appears the entry
for the website to which the user was redirected.

The reports displayed on the Reporting tab display redirected transactions as “Allowed.”

Warning Users and Allowing Them to Continue

You can warn users that a site does not meet the organization’s acceptable use policies. Users are tracked
in the access log by user name if authentication has made a user name available, and tracked by IP
address if no user name is available.

You can warn and allow users to continue using one of the following methods:

¢ Choose the Warn action for a URL category in an Access Policy group or
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B Warning Users and Allowing Them to Continue

¢ Enable the site content ratings feature and warn users that access adult content instead of blocking
them.

Configuring Settings for the End-User Filtering Warning Page
N

Note  The warn and continue feature only works for HTTP and decrypted HTTPS transactions. It does not
work with native FTP transactions.

S

Note  When the URL filtering engine warns users for a particular request, it provides a warning page that the
Web Proxy sends to the end user. (However, not all websites display the warning page to the end user.
When this happens, users are blocked from the URL that is assigned the Warn option without being given
the chance to continue accessing the site anyway.

Step 1 Choose Security Services > End-User Notification.
Step2  Click Edit Settings.
Step3  Configure the following settings on the End-User Filtering Warning page:

Option Method

Time Between Warning The Time Between Warning determines how often the Web Proxy
displays the end-user URL filtering warning page for each URL category
per user.

This setting applies to users tracked by username and users tracked by IP
address.

Specify any value from 30 to 2678400 seconds (one month). Default is 1
hour (3600 seconds).

Custom Message The custom message is text you enter that appears on every end-user URL
filtering warning page.

Include some simple HTML tags to format the text.

Stepd  Click Submit.

Related Topics
e Filtering Adult Content, page 9-15

e Custom Messages on Notification Pages, page 17-10

e Configuring the End-User URL Filtering Warning Page, page 17-9
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Creating Time Based URL Filters 1l

Creating Time Based URL Filters

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6

Step 7

You can configure how the Web Security appliance to handles requests for URLSs in particular categories
differently based on time and day.

Before You Begin
Go to the Web Security Manager > Defined Time Range page to define at least one time range.

Choose Web Security Manager > Access Policies.

Click the link in the policies table under the URL Categories column for the policy group you want to
edit.

Select Time-Based for the custom or predefined URL category you want to configure based on time
range.

In the In Time Range field, choose the defined time range to use for the URL category.

In the Action field, choose the action to enact on transactions in this URL category during the defined
time range.

In the Otherwise field, choose the action to enact on transactions in this URL category outside the
defined time range.

Submit and Commit Changes.

Related Topics
e Time Ranges and Volume Quotas, page 10-12

Viewing URL Filtering Activity

The Reporting > URL Categories page provides a collective display of URL statistics that includes
information about top URL categories matched and top URL categories blocked. This page displays
category-specific data for bandwidth savings and web transactions.

Related Topics
e Generate Reports to Monitor End-user Activity, page 18-1

Understanding Unfiltered and Uncategorized Data

When viewing URL statistics on the Reporting > URL Categories page, it is important to understand
how to interpret the following data:

Data Type Description

URL Filtering Bypassed Represents policy, port, and admin user agent blocking that
occurs before URL filtering.

Uncategorized URL Represents all transactions for which the URL filtering
engine is queried, but no category is matched.
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M Regular Expressions

URL Category Logging in Access Logs

The access log file records the URL category for each transaction in the scanning verdict information
section of each entry.

Related Topics
e Monitor System Activity Through Logs, page 21-1.

e URL Category Descriptions, page 9-23.

Regular Expressions

Note

Note

The Web Security appliance uses a regular expression syntax that differs slightly from the regular
expression syntax used by other Velocity pattern-matching engine implementations. Further, the
appliance does not support using a backward slash to escape a forward slash. If you need to use a forward
slash in a regular expression, simply type the forward slash without a backward slash.

Technically, AsyncOS for Web uses the Flex regular expression analyzer. For more detailed information
about how it reads regular expressions, see http://flex.sourceforge.net/manual/Patterns.html.

You can use regular expressions in the following locations:

¢ Custom URL categories for Access Policies. When you create a custom URL category to use with
Access Policy groups, you can use regular expressions to specify multiple web servers that match
the pattern you enter.

e Custom user agents to block. When you edit the applications to block for an Access Policy group,
you can use regular expressions to enter specific user agents to block.

Regular expressions that perform extensive character matching consume resources and can affect system
performance. For this reason, regular expressions should be cautiously applied.

Related Topics
e Creating and Editing Custom URL Categories, page 9-13

e Policy: Protocols and User Agents, page 9-13

Forming Regular Expressions

Regular expressions are rules that typically use the word “matches” in the expressions. They can be
applied to match specific URL destinations or web servers. For example, the following regular
expression matches any pattern containing “blocksite.com’:

\.blocksite\.com
Consider the following regular expression example:
server[0-9]\.example\.com

In this example, server [0-9] matches server0, serverl, server2, ..., server9 in the domain

example.com.
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Regular Expressions W

In the following example, the regular expression matches files ending in .exe, .zip, and .bin in the
downloads directory.

/downloads/.*\. (exe|zip|bin)

Note  You must enclose regular expressions that contain blank spaces or non-alphanumeric characters in
ASCII quotation marks.

Guidelines for Avoiding Validation Failures

Follow these guidelines to minimize validation failures:

Use literal expressions rather than wildcards and bracketed expressions whenever possible. A literal
expression is essentially just straight text such as “It’s as easy as aBc123”. This is less likely
to fail than using “It’s as easy as [A-C]{3}[1-3]{3}”. The latter expression results in the
creation of non-deterministic finite automatons (NFA) entries, which can dramtically increase
processing time.

Avoid the use of an unescaped dot whenever possible. The dot is a special regular-expression
character that means match any character except for a newline. If you want to match an actual dot,
for example, as in “url.com”, then escape the dot using the \ character, as in “url\.com”. Escaped
dots are treated as literal entries and therefore do not cause issues.

Similarly, use more specific matches rather than unescaped dots wherever possible. For example, if
you want to match a URL that is followed by a single digit, use “ur1[0-9]” rather than “ur1.”.

Unescaped dots in a larger regular expression can be especially problematic and should be avoided.
For example, “Four score and seven years ago our fathers brought forth on this
continent, a new nation, conceived in Liberty, and dedicated to the proposition that
all men are created .qual” may cause a failure. Replacing the dot in “.qual” with the literal
“equal” should resolve the problem.

Also, an unescaped dot in a pattern that will return more than 63 characters after the dot will be
disabled by the pattern-matching engine. Correct or replace the pattern.

You cannot use “.*” to begin or end a regular expression. You also cannot use “./” in a regular
expression intended to match a URL, nor can you end such an expression with a dot.

Combinations of wild cards and bracket expressions can cause problems. Eliminate as many
combinations as possible. For example,

“id: [A-F0-91{8}-[A-F0-9]1{4}-[A-F0-9]{4}-[A-F0-9]1{4}-[A-F0-9]1{12}\) Gecko/20100101
Firefox/9\.0\.1\$” may cause a failure, while “Gecko/20100101 Firefox/9\.0\.1\$” will not.
The latter expression does not include any wild cards or bracketed expressions, and both expressions
use only escaped dots.

When wilds cards and bracketed expressions cannot be eliminated, try to reduce the expression’s
size and complexity. For example, “[0-9a-z]{64}” may cause a failure. Changing it to something
smaller or less complex, such as “[0-9]{64}” or “[0-9a-z]{40}” may resolve the problem.

If a failure occurs, try to resolve it by applying these rules to the wildcard (such as *, + and .) and
bracketed expressions.
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M Regular Expressions

Regular Expression Character Table

Meta-
character

Description

Matches any single character, except the newline character (0x0OA). For example, the
regular expression r.t matches the strings rat, rut, r t, but not root.

Be wary of using unescaped dots in long patterns, and especially in the middle of longer
patterns. See Guidelines for Avoiding Validation Failures, page 9-21for more information.

Matches zero or more occurrences of the character immediately preceding. For example,
the regular expression . * means match any string of characters, and [0-9] * matches any
string of digits.

Be wary of using this meta-character, especially in conjunction with the dot character. Any
pattern containing an unescaped dot that returns more than 63 characters after the dot will be
disabled. See Guidelines for Avoiding Validation Failures, page 9-21for more information.

The escape character; it means treat the following meta-character as an ordinary character.
For example, \~ is used to match the caret character (*) rather than the beginning of a line.
Similarly, the expression \ . is used to match an actual dot rather than any single character.

Matches the beginning of a line. For example, the regular expression “when in matches
the beginning of the string “When in the course of human events” but not the string “What
and when in the”.

Matches the end of a line or string. For example, bs\ . matches any line or string that ends
with “b.”

Matches one or more occurrences of the character or regular expression immediately
preceding. For example, the regular expression 9+ matches 9, 99, and 999.

Matches zero or one occurrence of the preceding pattern element. For example, colouzr
matches both “colour” and “color” since the “u” is optional.

O

Treat the expression between the left and right parens as a group, limiting the scope of
other meta-characters. For example, (abc) + matches one or more occurrences of the string
“abc”; such as, “abcabcabc” or “abc123” but not “abab” or “ab123”.

Logical OR: matches the preceding pattern or the following pattern. For example
(him|her) matches the line “it belongs to him” and the line “it belongs to her” but does
not match the line “it belongs to them.”

Matches any one of the characters between the brackets. For example, the regular

G

expression r[aou] t matches “rat”, “rot”, and “rut”, but not “ret”.

Ranges of characters are specified by a beginning character, a hyphen, and an ending
character. For example, the pattern [0-9] means match any digit. Multiple ranges can be
specified as well. The pattern [a-za-z] means match any upper- or lower-case letter. To
match any character except those in the range (that is, the complementary range), use a
caret as the first character after the opening bracket. For example, the expression
[~269a-7] matches any characters except 2, 6, 9, and uppercase letters.
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Meta-
character |Description

{} Specifies the number of times to match the previous pattern.
For example:
D{1,3} matches one to three occurrences of the letter D

Matches a specific number {n} or a minimum number {z, } of instances of the preceding
pattern. For example, the expression a[0-9] {3} matches “A” followed by exactly three
digits. That is, it matches “A123” but not “A1234”. The expression [0-9] {4, } matches
any sequence of four or more digits.

Literally interpret any characters enclosed within the quotation marks.

URL Category Descriptions

This section lists the URL categories for Cisco Web Usage Controls. The tables also include the
abbreviated URL category names that may appear in the Web Reputation filtering and anti-malware
scanning section of an access log file entry.

Note  In the access logs, the URL category abbreviations for Cisco Web Usage Controls include the prefix
“IW_” before each abbreviation so that the “art” category becomes “IW_art.”

Abbrevia-
URL Category tion Code |Description Example URLs

Adult adlt 1006 |Directed at adults, but not necessarily pornographic. |www.adultentertainmentexpo
May include adult clubs (strip clubs, swingers clubs, |.com

escort services, strippers); general information
about sex, non-pornographic in nature; genital
piercing; adult products or greeting cards;
information about sex not in the context of health or
disease.

www.adultnetline.com

Advertisements adv 1027 |Banner and pop-up advertisements that often www.adforce.com
accompany a web page; other advertising websites
that provide advertisement content. Advertising
services and sales are classified as “Business and
Industry.”

www.doubleclick.com

Alcohol alc 1077 |Alcohol as a pleasurable activity; beer and wine www.samueladams.com
making, cocktail recipes; liquor sellers, wineries,
vineyards, breweries, alcohol distributors. Alcohol
addiction is classified as “Health and Nutrition.”
Bars and restaurants are classified as “Dining and
Drinking.”

www.whisky.com
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Abbrevia-
URL Category tion Code |Description Example URLs
Arts art 1002 |Galleries and exhibitions; artists and art; WWW.moma.org
photographys; lltejrature and books; performl'ng arts WWW.Nga.20V
and theater; musicals; ballet; museums; design;
architecture. Cinema and television are classified as
“Entertainment.”
Astrology astr 1074 | Astrology; horoscope; fortune telling; numerology; |www.astro.com
psychic advice; tarot.
www.astrology.com
Auctions auct 1088 |Online and offline auctions, auction houses, and www.craigslist.com
classified advertisements.
www.ebay.com
Business and busi 1019 |Marketing, commerce, corporations, business www.freightcenter.com
Industry practices, workforce, human resources,
. . . www.staples.com
transportation, payroll, security and venture capital;
office supplies; industrial equipment (process
equipment), machines and mechanical systems;
heating equipment, cooling equipment; materials
handling equipment; packaging equipment;
manufacturing: solids handling, metal fabrication,
construction and building; passenger transportation;
commerce; industrial design; construction, building
materials; shipping and freight (freight services,
trucking, freight forwarders, truckload carriers,
freight and transportation brokers, expedited
services, load and freight matching, track and trace,
rail shipping, ocean shipping, road feeder services,
moving and storage).
Chat and Instant chat 1040 |Web-based instant messaging and chat rooms. www.icq.com
Messaging www.meebo.com
Cheating and plag 1051 |Promoting cheating and selling written work, such |www.bestessays.com
Plagiarism as term papers, for plagiarism. .
WWW.superiorpapers.com
Child Abuse cprn 1064 |Worldwide illegal child sexual abuse content. —
Content
Computer Security |csec 1065 |Offering security products and services for www.computersecurity.com
corporate and home users.
wWww.symantec.com
Computers and comp 1003 |Information about computers and software, such as |www.xml.com
Internet hardware, software, software support; information
. . www.w3.org
for software engineers, programming and
networking; website design; the web and Internet in
general; computer science; computer graphics and
clipart. “Freeware and Shareware” is a separate
category.
Dating date 1055 |Dating, online personals, matrimonial agencies. www.eharmony.com

www.match.com
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Abbrevia-

URL Category tion Code |Description Example URLs

Digital Postcards  |card 1082 |Enabling sending of digital postcards and e-cards. |www.all-yours.net

www.delivr.net

Dining and food 1061 |Eating and drinking establishments; restaurants, www.hideawaybrewpub.com

Drinking bars, taverns, and pubs; restaurant guides and

; www.restaurantrow.com
reviews.

Dynamic and dyn 1091 |IP addresses of broadband links that usually http://109.60.192.55

Residential indicates users attempting to access th.e1r home http://dynalink.co.jp
network, for example for a remote session to a home
Computer_ http//lpadslnet

Education edu 1001 |Education-related, such as schools, colleges, www.education.com
universities, teaching materials, and teachers’

. ; o . www.greatschools.org
resources; technical and vocational training; online
training; education issues and policies; financial aid;
school funding; standards and testing.

Entertainment ent 1093 |Details or discussion of films; music and bands; www.eonline.com
television; celebrities and fan websites;

. . . . WWW.ew.com
entertainment news; celebrity gossip; entertainment
venues. Compare with the “Arts” category.

Extreme extr 1075 |Material of a sexually violent or criminal nature; www.car-accidents.com

violence and violent behavior; tasteless, often gory .
www.crime-scene-photos.co

photographs, such as autopsy photos; photos of m

crime scenes, crime and accident victims; excessive

obscene material; shock websites.

Fashion fash 1076 |Clothing and fashion; hair salons; cosmetics; www.fashion.net
accessories; ]ewelry;.p'erfqme; pictures and .text. www.findabeautysalon.com
relating to body modification; tattoos and piercing;
modeling agencies. Dermatological products are
classified as “Health and Nutrition.”

File Transfer fts 1071 |File transfer services with the primary purpose of |www.rapidshare.com

Services providing download services and hosted file sharing .

www.yousendit.com

Filter Avoidance filt 1025 |Promoting and aiding undetectable and anonymous |www.bypassschoolfilter.com
web usage, including cgi, php and glype anonymous www.filterbypass.com
proxy services.

Finance fnnc 1015 |Primarily financial in nature, such as accounting finance.yahoo.com
practices and accountants, taxation, taxes, banking, .

. . . . www.bankofamerica.com
insurance, investing, the national economy, personal
finance involving insurance of all types, credit cards,
retirement and estate planning, loans, mortgages.
Stock and shares are classified as “Online Trading.”
Freeware and free 1068 |Providing downloads of free and shareware www.freewarehome.com

Shareware

software.

www.shareware.com
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URL Category

tion

Abbrevia-

Code

Description

Example URLs

Gambling

gamb

1049

Casinos and online gambling; bookmakers and odds;
gambling advice; competitive racing in a gambling
context; sports booking; sports gambling; services
for spread betting on stocks and shares. Websites
dealing with gambling addiction are classified as
“Health and Nutrition.” Government-run lotteries
are classified as “Lotteries”.

www.888.com

www.gambling.com

Games

game

1007

Various card games, board games, word games, and
video games; combat games; sports games;
downloadable games; game reviews; cheat sheets;
computer games and Internet games, such as
role-playing games.

www.games.com

www.shockwave.com

Government and
Law

gov

1011

Government websites; foreign relations; news and
information relating to government and elections;
information relating to the field of law, such as
attorneys, law firms, law publications, legal
reference material, courts, dockets, and legal
associations; legislation and court decisions; civil
rights issues; immigration; patents and copyrights;
information relating to law enforcement and
correctional systems; crime reporting, law
enforcement, and crime statistics; military, such as
the armed forces, military bases, military
organizations; anti-terrorism.

WWW.usa.gov

www.law.com

Hacking

hack

1050

Discussing ways to bypass the security of websites,
software, and computers.

www.hackthissite.org

www.gohacking.com

Hate Speech

hate

1016

Websites promoting hatred, intolerance, or
discrimination on the basis of social group, color,
religion, sexual orientation, disability, class,
ethnicity, nationality, age, gender, gender identity;
sites promoting racism; sexism; racist theology; hate
music; neo-Nazi organizations; supremacism;
Holocaust denial.

www.kkk.com

WWWw.nazi.org

Health and
Nutrition

hlth

1009

Health care; diseases and disabilities; medical care;
hospitals; doctors; medicinal drugs; mental health;
psychiatry; pharmacology; exercise and fitness;
physical disabilities; vitamins and supplements; sex
in the context of health (disease and health care);
tobacco use, alcohol use, drug use, and gambling in
the context of health (disease and health care); food
in general; food and beverage; cooking and recipes;
food and nutrition, health, and dieting; cooking,
including recipe and culinary websites; alternative
medicine.

www.health.com

www.webmd.com

Humor lol

1079

Jokes, sketches, comics and other humorous content.
Adult humor likely to offend is classified as “Adult.”

www.humor.com

www.jokes.com
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Abbrevia-
URL Category tion Code |Description Example URLs
Illegal Activities ilac 1022 |Promoting crime, such as stealing, fraud, illegally |www.ekran.no
accessing telephone networks; compl.lter viruses; www.thedisease net
terrorism, bombs, and anarchy; websites depicting
murder and suicide as well as explaining ways to
commit them.
Illegal Downloads |ildl 1084 |Providing the ability to download software or other |www.keygenguru.com
materials, serial numbers, key generators, and tools
. oo www.zcrack.com
for bypassing software protection in violation of
copyright agreements. Torrents are classified as
“Peer File Transfer.”
Illegal Drugs drug 1047 |Information about recreational drugs, drug WWWw.cocaine.org
paraphernalia, drug purchase and manufacture. www.hightimes.com
Infrastructure and  |infr 1018 |Content delivery infrastructure and dynamically www.akamai.net
Content Delivery generated content; websites that cannot be classified
o www.webstat.net
Networks more specifically because they are secured or
otherwise difficult to classify.
Internet Telephony |voip 1067 |Telephonic services using the Internet. www.evaphone.com
www.skype.com
Job Search job 1004 |Career advice; resume writing and interviewing www.careerbuilder.com
skills; job placement services; job databanks;
. www.monster.com
permanent and temporary employment agencies;
employer websites.
Lingerie and ling 1031 |Intimate apparel and swimwear, especially when wWww.swimsuits.com
Swimsuits modeled. . .
WWwWw.victoriassecret.com
Lotteries lotr 1034 |Sweepstakes, contests and state-sponsored lotteries. |www.calottery.com
www.flalottery.com
Mobile Phones cell 1070 |Short Message Services (SMS); ringtones and www.cbfsms.com
mobile phone downloads. Cellular carrier websites
. . P ” www.zedge.net
are included in the “Business and Industry
category.
Nature natr 1013 |Natural resources; ecology and conservation; www.enature.com

forests; wilderness; plants; flowers; forest
conservation; forest, wilderness, and forestry
practices; forest management (reforestation, forest
protection, conservation, harvesting, forest health,
thinning, and prescribed burning); agricultural
practices (agriculture, gardening, horticulture,
landscaping, planting, weed control, irrigation,
pruning, and harvesting); pollution issues (air
quality, hazardous waste, pollution prevention,
recycling, waste management, water quality, and the
environmental cleanup industry); animals, pets,
livestock, and zoology; biology; botany.

www.nature.org
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Abbrevia-
URL Category tion Code |Description Example URLs
News news 1058 |News; headlines; newspapers; television stations; WWW.cnn.com
magazines; weather; ski conditions. news.bbe.co.uk
Non-Governmental |ngo 1087 |Non-governmental organizations such as clubs, www.panda.org
Organizations lobbies, communities, non-profit organizations and .
) www.unions.org
labor unions.
Non-Sexual Nudity |nsn 1060 |Nudism and nudity; naturism; nudist camps; artistic |www.artenuda.com
nudes. . .
www.naturistsociety.com
Online comm 1024 | Affinity groups; special interest groups; web www.igda.org
Communities newsgroups; message boards. Excludes websites .
e “ . e www.ieee.org
classified as “Professional Networking” or “Social
Networking.”
Online Storage and |osb 1066 |Offsite and peer-to-peer storage for backup, sharing, |www.adrive.com
Backup and hosting. www.dropbox.com
Online Trading trad 1028 |Online brokerages; websites that enable the user to |www.tdameritrade.com
trade stocks online; information relating to the stock
www.scottrade.com
market, stocks, bonds, mutual funds, brokers, stock
analysis and commentary, stock screens, stock
charts, IPOs, stock splits. Services for spread betting
on stocks and shares are classified as “Gambling.”
Other financial services are classified as “Finance.”
Organizational pem 1085 |Websites used to access business email (often via —
Email Outlook Web Access).
Parked Domains park 1092 |Websites that monetize traffic from the domain www.domainzaar.com
using paid listings from an ad network, or are owned
o . . ) www.parked.com
by “squatters” hoping to sell the domain name for a
profit. These also include fake search websites
which return paid ad links.
Peer File Transfer |p2p 1056 |Peer-to-peer file request websites. This does not www.bittorrent.com
track the file transfers themselves. . .
www.limewire.com
Personal Sites pers 1081 |Websites about and from private individuals; www.karymullis.com
personal homepage servers; websites with personal
; . www.stallman.org
contents; personal blogs with no particular theme.
Photo Searches and |img 1090 |Facilitating the storing and searching for, images, |www.flickr.com
Images photographs, and clip-art. www.photobucket.com
Politics pol 1083 |Websites of politicians; political parties; news and |www.politics.com
information on politics, elections, democracy, and . .
. www.thisnation.com
voting.
Pornography porn 1054 |Sexually explicit text or depictions. Includes explicit |www.redtube.com

anime and cartoons; general explicit depictions;
other fetish material; explicit chat rooms; sex
simulators; strip poker; adult movies; lewd art;
web-based explicit email.

www.youporn.com
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Abbrevia-
URL Category tion Code |Description Example URLs
Professional pnet 1089 |[Social networking for the purpose of career or www.linkedin.com
Networking professional development. See also “Social
. www.europeanpwn.net
Networking.
Real Estate rest 1045 |Information that would support the search for real |www.realtor.com
estate; office and commercial space; real estate .
- www.zillow.com
listings, such as rentals, apartments, and homes;
house building.
Reference ref 1017 |City and state guides; maps, time; reference sources; |www.wikipedia.org
dictionaries; libraries.
www.yellowpages.com
Religion rel 1086 |Religious content, information about religions; www.religionfacts.com
religious communities. .
www.religioustolerance.org
and B2B saas 1080 |Web portals for online business services; online www.netsuite.com
meetings.
www.salesforce.com
Safe for Kids kids 1057 |Directed at, and specifically approved for, young kids.discovery.com
children. .
www.nickjr.com
Science and sci 1012 |Science and technology, such as aerospace, www.physorg.com
Technology electronics, engineering, mathematics, and other .
. . . www.science.gov
similar subjects; space exploration; meteorology;
geography; environment; energy (fossil, nuclear,
renewable); communications (telephones,
telecommunications).
Search Engines and |srch 1020 |Search engines and other initial points of access to |www.bing.com
Portals information on the Internet.
www.google.com
Sex Education sxed 1052 |Factual websites dealing with sex; sexual health; www.avert.org
contraception; pregnancy. www.scarleteen.com
Shopping shop 1005 |Bartering; online purchasing; coupons and free WWW.amazon.com
offers; general office supplies; online catalogs; .
i www.shopping.com
online malls.
Social Networking |snet 1069 |Social networking. See also “Professional www.facebook.com
Networking. www.twitter.com
Social Science socs 1014 |Sciences and history related to society; archaeology; |www.archaeology.org
anthropology; .Cultural studies; history; 11ngu|1st1cs; www.anthropology.net
geography; philosophy; psychology; women's
studies.
Society and scty 1010 |Family and relationships; ethnicity; social www.childcare.gov
Culture organizations; genealogy; seniors; child-care. www.familysearch.org
Software Updates |swup 1053 |Websites that host updates for software packages. |www.softwarepatch.com
www.versiontracker.com
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B URL Category Descriptions

Abbrevia-
URL Category tion Code |Description Example URLs
Sports and sprt 1008 |All sports, professional and amateur; recreational |www.espn.com
Recreation activities; fishing; fantasy sports; public parks; .
www.recreation.gov
amusement parks; water parks; theme parks; zoos
and aquariums; spas.
Streaming Audio  |aud 1073 |Real-time streaming audio content including www.live-radio.net
Internet radio and audio feeds.
www.shoutcast.com
Streaming Video vid 1072 |Real-time streaming video including Internet www.hulu.com
television, web casts, and video sharing.
www.youtube.com
Tobacco tob 1078 |Pro-tobacco websites; tobacco manufacturers; pipes |www.bat.com
and smoking products (not marketed for illegal drug
. e « www.tobacco.org
use). Tobacco addiction is classified as “Health and
Nutrition.”
Transportation trns 1044 |Personal transportation; information about cars and |www.cars.com
motorcycles; shopping for new and used cars and
. . www.motorcycles.com
motorcycles; car clubs; boats, airplanes, recreational
vehicles (RVs), and other similar items. Note, car
and motorcycle racing is classified as “Sports and
Recreation.”
Travel trvl 1046 |Business and personal travel; travel information; www.expedia.com
travel resources; travel agents; vacation packages;
. . . www.lonelyplanet.com
cruises; lodging and accommodation; travel
transportation; flight booking; airfares; car rental;
vacation homes.
Unclassified — — Websites which are not in the Cisco database are —
recorded as unclassified for reporting purposes. This
may include mistyped URLs.
Weapons weap 1036 |Information relating to the purchase or use of www.coldsteel.com
conventional weapons such as gun sellers, gun
i . ) www.gunbroker.com
auctions, gun classified ads, gun accessories, gun
shows, and gun training; general information about
guns; other weapons and graphic hunting sites may
be included. Government military websites are
classified as “Government and Law.”
Web Hosting whst 1037 |Website hosting; bandwidth services. www.bluehost.com
www.godaddy.com
Web Page tran 1063 |Translation of web pages between languages. babelfish.yahoo.com
Translation
translate.google.com
Web-Based Email |mail 1038 |Public web-based email services. Websites enabling |mail.yahoo.com

individuals to access their company or
organization’s email service are classified as
“Organizational Email.”

www.hotmail.com

Related Topics

e Managing Updates to the Set of URL Categories, page 9-4
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URL Category Descriptions ||

e Reporting Uncategorized and Misclassified URLs, page 9-3
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Create Policies to Control Internet Requests

e Overview of Policies: Control Intercepted Internet Requests, page 10-1
e Managing Web Requests Through Policies Task Overview, page 10-2
e Managing Web Requests Through Policies Best Practices, page 10-2
e Policies, page 10-2

e Policy Configuration, page 10-8

e Block, Allow, or Redirect Transaction Requests, page 10-9

e Client Applications, page 10-10

e Time Ranges and Volume Quotas, page 10-12

e Access Control by URL Category, page 10-14

¢ Remote Users, page 10-16

e Troubleshooting Policies, page 10-19

Overview of Policies: Control Intercepted Internet Requests

When the user creates a web request the configured Web Security Appliance intercepts the requests and
manages the process of which the request travels to get to its final outcome, be that accessing a particular
web site, an email or even accessing an online application. In configuring the Web Security Appliance
policies are created to define the criteria and actions of requests made by the user.

Policies are the means by which the Web Security Appliance identifies and controls web requests. When
a client sends a web request to a server, the Web Proxy receives the request, evaluates it, and determines
to which policy it belongs. Actions defined in the policy are then applied to the request.

The Web Security Appliance uses multiple policy types to manage different aspects of web requests.
Policy types might fully manage transactions by themselves or pass transactions along to other policy
types for additional processing. Policy types can be groups by the functions they perform, such as access,
routing, or security.

AsyncOS evaluates transactions based on policies before it evaluates external dependencies to avoid
unnecessary external communication from the appliance. For example, if a transaction is blocked based
on a policy that blocks uncategorized URLs, the transaction will not also fail based on a DNS error.

Async0S 9.1 for Cisco Web Security Appliances User Guide
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W Managing Web Requests Through Policies Task Overview

Managing Web Requests Through Policies Task Overview

Task List for Managing Web Requests

Step |through Policies Links to Related Topics and Procedures

1 Set up and sequence Authentication Realms Authentication Realms, page 5-11

2 (For upstream proxies) Create a proxy group. Creating Proxy Groups for Upstream Proxies,
page 2-10

2 (Optional) Create Custom Client Applications |Client Applications, page 10-10

3 (Optional) Create Custom URL Categories Creating Custom URL Categories,
page 10-14

4 Create Identification Profiles Classifying Users and Client Software,
page 6-3

5 (Optional) Create time ranges to Limit Access |Time Ranges and Volume Quotas, page 10-12

by Time of Day

6 Create and Order Policies e Creating a Policy, page 10-5

e Policy Order, page 10-5

Managing Web Requests Through Policies Best Practices

e If you want to use Active Directory user objects to manage web requests, do not use primary groups
as criteria. Active Directory user objects to not contain the primary group.

Policies

e Policy Types, page 10-3
e Policy Order, page 10-5
e C(Creating a Policy, page 10-5
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Policy Types

Policies

Policy Type

Request Type

Description

Link to task

Access

HTTP
Decrypted HTTPS
FTP

Block, allow or redirect inbound HTTP,
FTP, and decrypted HTTPS traffic.

Access policies also manage inbound
encrypted HTTPS traffic if the HTTPS
proxy is disabled.

Creating a Policy, page 10-5

SOCKS

SOCKS

Allow or block SOCKS communication
requests.

Creating a Policy, page 10-5

Application
Authentication

application

Allow or deny access to a Software as a
Service (SaaS) application.

Use single sign-on to authenticate users and
increase security by allowing access to
applications to be quickly disabled.

To use the single sign-on feature of policies
you must configure the Web Security
appliance as an identity provider and upload
or generate a certificate and key for SaaS.

Creating SaaS Application
Authentication Policies, page 7-4

Encrypted
HTTPS
Management

HTTPS

Decrypt, pass through, or drop HTTPS
connections.

AsyncOS passes decrypted traffic to Access
policies for further processing.

Creating a Policy, page 10-5

Data Security

HTTP
Decrypted HTTPS
FTP

Manage data uploads to the web. Data
Security policies scan outbound traffic to
ensure it complies to company rules for data
uploads, based on its destination and
content. Unlike External DLP policies,
which redirect outbound traffic to external
servers for scanning, Data Security policies
use the Web Security appliance to scan and
evaluate traffic.

Creating a Policy, page 10-5

External DLP
(Data Loss
Prevention)

HTTP
Decrypted HTTPS
FTP

Send outbound traffic to servers running
3rd-party DLP systems, which scan it for
adherence to company rules for data
uploads. Unlike Data Security policies,
which also manage data uploads, External
DLP policies move scanning work away
from the Web Security appliance, which
frees resources on the appliance and
leverages any additional functionality
offered by 3rd-party software.

Creating a Policy, page 10-5
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Policy Type Request Type Description Link to task
Outbound e HTTP Block, monitor, or allow requests to upload |Creating a Policy, page 10-5
Malware e Decrypted HTTPS data that may contain malicious data.
Scanning e FTP Prevent malware that is already present on
your network from being transmitted to
external networks.
Routing e HTTP Direct web traffic through upstream proxies |Creating a Policy, page 10-5
e HTTPS or direct it to destination servers. You might
want to redirect traffic through upstream
e FTP

proxies to preserve your existing network
design, to off-load processing from the Web
Security appliance, or to leverage additional
functionality provided by 3rd-party proxy
systems.

If multiple upstream proxies are available,
the Web Security appliance can use load
balancing techniques to distribute data to
them.

Each policy type uses a policy table to store and manage its policies. Each policy table comes with a
predefined, global policy, which maintains default actions for a policy type. Additional, user-defined
policies are created and added to the policy table as required. Policies are processed in the order in which
they are listed in the policy table.

Individual policies define the user-request types they manage, and the actions they perform on those
requests. Each policy definition has two main sections:

¢ Identification Profiles and Users — Identification Profiles are used in policy membership criteria
and are particularly important as they contain many options for identifying web transaction. They
also share many properties with policies.

¢ Advanced - The criteria used to identify users to which the policy applies. One or more criteria can
be specified in a policy, and all must be match for the criteria to be met.

Protocols — Allow the transfer of data between various networking devices such as http, https,
ftp, etc.

Proxy Ports — the numbered port by which the request accesses the web proxy,

Subnets — The logical grouping of connected network devices (such as geographic location or
Local Area Network [LAN]), where the request originated

Time Range — Time ranges can be created for use in policies to identify or apply actions to web
requests based on the time or day the requests were made. The time ranges are created as
individual units.

URL Categories — URL categories are predefined or custom categories of websites, such as
News, Business, Social Media, etc. These can be used to identify or apply actions to web
requests.

User Agents — These are the client applications (such as a web browser Firefox or Chrome) used
to make requests. You can define policy criteria based on user agents, and you can specify
control settings based on user agents. You can also exempt user agents from authentication,
which is useful for applications that cannot prompt for credentials. You can define custom client
applications but cannot reuse these definitions other policies.
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S

Note

Policy Order

Policies W

When you define multiple membership criteria, the client request must meet all criteria to match
the policy.

The order in which policies are listed in a policy table determines the priority with which they are applied
to web requests. Web requests are checked against policies beginning at the top of the table and ending
at the first policy matched. Any policies below that point in the table are not processed.

If no user-defined policy is matched against a web request, then the global policy for that policy type is
applied. Global policies are always positioned last in Policy tables and cannot be re-ordered.

Creating a Policy

Step 1

Step 2
Step 3
Step 4

Step 5

Before You Begin
e Enable the appropriate proxy:

- Web Proxy (for HTTP, decrypted HTTPS, and FTP)
- HTTPS Proxy
- SOCKS Proxy
¢ Create associated Identification Profiles.
e Understand Policy Order, page 10-5.
e (Encrypted HTTPS only) Upload or generate a Certificate and Key.
e (Data Security only) Enable Cisco Data Security Filters Settings.
e (External DLP only) Define an External DLP server.
¢ (Routing only) Define the associated upstream proxy on the Web Security appliance.
e (Optional) Create associated client applications.
e (Optional) Create associated time ranges. See Time Ranges and Volume Quotas.

e (Optional) Create associated URL categories. See Creating Custom URL Categories.

In the Policy Settings section, use the Enable Identity check box to enable this policy, or to quickly
disable it without deleting it.

Assign a unique policy Name.
A Description is optional.
From the Insert Above drop-down list, choose where this policy is to appear in the table.

~

Note  Arrange policies such that, from top to bottom of the table, they are in most-restrictive to
least-restrictive order. See Policy Order, page 10-5 for more information.

In the Policy Member Definition section, specify how user and group membership is defined: from the
Identification Profiles and Users list, choose one of the following:
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¢ All Identification Profiles — This policy will apply to all existing profiles. You must also define
at least one Advanced option.

¢ Select One or More Identification Profiles — A table for specifying individual Identification
Profiles appears, one profile-membership definition per row.

Step6  If you chose All Identification Profiles:

a. Specify the authorized users and groups to which this policy applies by selecting one of the
following options:

e All Authenticated Users — All users identified through authentication or transparent identification.
¢ Selected Groups and Users — Specified users and groups are used.

To add or edit the specified ISE Secure Group Tags (SGTs) and the specified Users, click the
link following the appropriate label. For example, click the list of currently specified users to
edit that list. See Adding and Editing Secure Group Tags for a Policy, page 10-8 for more
information.

e Guests — Users connected as guests and those failing authentication.

e All Users — All clients, whether authenticated or not. If this option is selected, at least one
Advanced option also must be provided.

Step7  If you chose Select One or More Identification Profiles, a profile-selection table appears.

a. Choose an Identification Profile from the Select Identification Profile drop-down list in the
Identification Profiles column.

b. Specify the Authorized Users and Groups to which this policy applies:

e All Authenticated Users — All users identified through authentication or transparent
identification.

¢ Selected Groups and Users — Specified users and groups are used.

To add or edit the specified ISE Secure Group Tags (SGTs) and the specified Users, click the
link following the appropriate label. For example, click the list of currently specified users to
edit that list. See Adding and Editing Secure Group Tags for a Policy, page 10-8 for more
information.

¢ Guests — Users connected as guests and those failing authentication.

¢. To add a row to the profile-selection table, click Add Identification Profile. To delete a row, click
the trash-can icon in that row.

Repeat steps (a) through (c) as necessary to add all desired Identification Profiles.
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Policies W

Step8 Expand the Advanced section to define additional group membership criteria. (This step may be
optional depending on selection in the Policy Member Definition section. Also, some of the following
options will not be available, depending on the type of policy you are configuring.) .

Advanced Option |Description

Protocols Select the protocols to which this policy will apply. All others means any
protocol not selected. If the associated identification profile applies to specific
protocols, this policy applies to those same protocols.

Proxy Ports Applies this policy only to traffic using specific ports to access the web proxy. Enter
one or more port numbers, separating multiple ports with commas.

For explicit forward connections, this is the port configured in the browser.
For transparent connections, this is the same as the destination port.

Note If the associated identification profile applies only to specific proxy
ports, you cannot enter proxy ports here.

Subnets Applies this policy only to traffic on specific subnets. Select Specify subnets and
enter the specific subnets, separated by commas.

Leave Use subnets from selected Identities selected if you do not want additional
filtering by subnet.

Note If the associated identity applies to specific subnets, you can further
restrict the application of this policy to a subset of the addresses to which
the identity applies.

Time Range You can apply time ranges for policy membership:

¢ Time Range — Choose a previously defined time range (Time Ranges and
Volume Quotas, page 10-12).

e Match Time Range — Use this option to indicate whether this time range is
inclusive or exclusive. In other words, whether to match only during the
range specified, or at all times except those in the specified range.

URL Categories You can restrict policy membership by specific destinations (URLs) and by
categories of URLs. Select all desired custom and predefined categories. See
Creating Custom URL Categories, page 10-14 for information about custom
categories.

User Agents You can select specific user agents, and define custom agents using regular
expression, as part of membership definition for this policy.

e Common User Agents

— Browsers — Expand this section to select Internet Explorer and
Firefox versions.

— Others — Expand this section to select specific application-update
agents, such as Microsoft Windows and Adobe Acrobat.

e Custom User Agents — You can enter one or more regular expressions, one
per line, to define custom user agents.

e Match User Agents — Use this option to indicate whether these user-agent
specifications are inclusive or exclusive. In other words, whether to match
only your definitions, or only all definitions except those you specified here.
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Adding and Editing Secure Group Tags for a Policy

To change the list of Secure Group Tags (SGTs) assigned to a particular Identification Profile in a policy,
click the link following the ISE Secure Group Tags label in the Selected Groups and Users list on the
Add/Edit Policy page. (See Creating a Policy, page 10-5.) This link is either “No tags entered,” or itis a
list of currently assigned tags. The link opens the Add/Edit Secure Group Tags page.

All SGTs currently assigned to this policy are listed in the Authorized Secure Group Tags section. All
SGTs available from the connected ISE server are listed in the Secure Group Tag Search section.

Step 1 To add one or more SGTs to the Authorized Secure Group Tags list, select the desired entries in the
Secure Group Tag Search section, and then click Add.

The SGTs already added, are highlighted in green. To quickly find a specific SGT in the list of those
available, enter a text string in the Search field.

Step2  Toremove one or more SGTs from the Authorized Secure Group Tags list, select those entries and then
click Delete.

Step3  Click Done to return to the Add/Edit Group page.

Related Topics
¢ Time Ranges and Volume Quotas

e Using Client Applications in Policies

Policy Configuration

Each row in a table of policies represents a policy definition, and each column displays current contains
a link to a configuration page for that element of the policy.

~
Note  Of the following policy-configuration components, you can specify the “Warn” option only with
URL Filtering.

Option Description
Protocols and Used to control policy access to protocols and configure blocking for particular
User Agents client applications, such as instant messaging clients, web browsers, and Internet

phone services. You can also configure the appliance to tunnel HTTP CONNECT
requests on specific ports. With tunneling enabled, the appliance passes HTTP
traffic through specified ports without evaluating it.

URL Filtering AsyncOS for Web allows you to configure how the appliance handles a
transaction based on the URL category of a particular HTTP or HTTPS request.
Using a predefined category list, you can choose to block, monitor, warn, or set
quota-based or time-based filters.

You can also create custom URL categories and then choose to block, redirect,
allow, monitor, warn, or quota-based or time-based filters for Websites in the
custom category. See Creating and Editing Custom URL Categories, page 9-13
for information about creating custom URL categories.
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Block, Allow, or Redirect Transaction Requests

Option

Description

Applications

The Application Visibility and Control (AVC) engine is an Acceptable Use
policy component that inspects Web traffic to gain deeper understanding and
control of Web traffic used for applications. The appliance allows the Web Proxy
to be configured to block or allow applications by Application Types, and by
individual applications. You can also apply controls to particular application
behaviors, such as file transfers, within a particular application. See Managing
Access to Web Applications, page 15-1 for configuration information.

Objects

Allows the Web Proxy to be configured to block file downloads based on file
characteristics, such as file size and file type. An object is, generally, any item that
can be individually selected, uploaded, downloaded and manipulated, such as:

e Application: pdf, xml, zip, exe

e Text: cmd, csv, html, javascript

e Image: gif, jpeg, png, tiff

e Video: mp4, Quicktime, avi, wmv
e Audio: mp4, wav, webm, mpeg

e Message: http, xml, rfc822, partial
e x-world: wrl, wrz, xof, 3dmf

Note  Object blocking does not inspect inside compressed files.

Anti-Malware
and Reputation

Web reputation filters allow for a web-based reputation score to be assigned to a
URL to determine the probability of it containing URL-based malware.
Anti-malware scanning identifies and stops web-based malware threats.
Advanced Malware Protection identifies malware in downloaded files.

The Anti-Malware and Reputation policy inherits global settings respective to
each component. Within Security Services > Anti-Malware and Reputation,
malware categories can be customized to monitor or block based on malware
scanning verdicts and web reputation score thresholds can be customized.
Malware categories can be further customized within a policy. There are also
global settings for file reputation and analysis services.

For more information, see Anti-Malware and Reputation Settings in Access
Policies, page 13-10 and Configuring File Reputation and Analysis Features,
page 17-4.

Block, Allow, or Redirect Transaction Requests

The web proxy controls web traffic based on the policies that you create for groups of transaction requests.

e Allow. The Web Proxy permits the connection without interruption. Allowed connections may not
have been scanned by the DVS engine.

¢ Block. The Web Proxy does not permit the connection and instead displays an end user notification
page explaining the reason for the block.

¢ Redirect. The Web Proxy does not allow the connection to the originally requested destination
server and instead connects to a different specified URL, see Redirecting Traffic in the Access

Policies.

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Chapter 10 Create Policies to Control Internet Requests |

M Client Applications

S

Note  The preceding actions are final actions that the Web Proxy takes on a client request. The Monitor action
that you can configure for Access Policies is not a final action.

Generally, different types of policies control traffic based on the transport protocol.

Policy Type Protocols Actions Supported
HTTP HTTPS FTP SOCKS Block Allow | Redirect | Monitor

Access X X X X X X X
SOCKS X X X
SAAS X X
Decryption X X X
Data Security X X X X X
External DLP X X X X
Outbound X X X X X
Malware
Scanning
Routing X X X X

A

Note  Decryption policy takes precedence over Access policy.

Client Applications

About Client Applications
Client Applications (such as a web browser) are used to make requests. You can define policy

membership based on client applications, and you can specify control settings and exempt client
applications from authentication, which is useful for applications that cannot prompt for credentials.

Using Client Applications in Policies
Defining Policy Membership Using Client Applications

Step1  Choose a policy type from the Web Security Manager menu.
Step2  Click a policy name in the policies table.
Step3  Expand the Advanced section and click the link in the Client Applications field.
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Step 4

Step 5

Step 6

Client Applications Il

Define one or more of the client applications:

Table 10-1
Option Method
Choose a predefined |Expand the Browser and Other sections and check the required client
client application application check boxes.
Tip Choose only the Any Version options when possible, as this provides
better performance than having multiple selections.
Define a custom Enter an appropriate regular expression in the Custom Client Applications field.
client application Enter additional regular expressions on new lines as required.
Tip Click Example Client Applications Patterns for examples of regular
expressions.

(Optional) Click the Match All Except The Selected Client Applications Definitions radio button to
base the policy membership on all client applications except those you have defined.

Click Done.

Defining Policy Control Settings Using Client Applications

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Choose a policy type from the Web Security Manager menu.
Find the required policy name in the policies table.
Click the cell link in the Protocols and Client Applications column on the same row.

Choose Define Custom Settings from the drop-down list in the Edit Protocols and Client Applications
Settings pane (if not already set).

Enter a regular expression in the Custom Client Applications field that matches the client application
you wish to define. Enter additional regular expressions on new lines as required.

Je

ﬁ Click Example Client Application Patterns for examples of regular expressions.

Submit and commit your changes.

Exempting Client Applications from Authentication

Step Task Link
Step1 |Create an Identification Profile that does not Classifying Users and Client
require authentication. Software

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Chapter 10 Create Policies to Control Internet Requests |

Bl Time Ranges and Volume Quotas

Step2  |Set the Identification Profile membership as the client Using Client Applications in Policies

application to exempt.

Step3  |Place the Identification Profile above all other Identification Policy Order

Profiles in the policies table that require authentication.

Time Ranges and Volume Quotas

Apply time and volume quotas to access policies and decryption policies to restrict a user’s connection
time or data volume (also referred to as a “bandwidth quota”). Quotas allow individual users to continue
accessing an Internet resource (or a class of Internet resources) until they exhaust the data volume or
time limit imposed. AsyncOS enforces defined quotas on HTTP, HTTPS and FTP traffic.

As a user approaches either their time or volume quota, AsyncOS displays first a warning, and then a
block page.

Please note the following regarding use of time and volume quotas:

N

If AsyncOS is deployed in transparent mode and HTTPS proxy is disabled, there is no listening on
port 443, and requests are dropped. This is standard behavior. If AsyncOS is deployed in explicit
mode, you can set quotas in your access policies.

When HTTPS proxy is enabled, possible actions on a request are pass-through, decrypt, drop, or
monitor. Overall, quotas in decryption policies are applicable only to the pass-through categories.

With pass-through, you will also have the option to set quotas for tunnel traffic. With decrypt, this
option is not available, as the quotas configured in the access policy will be applied to decrypted traffic.

If URL Filtering is disabled or if its feature key is unavailable, AsyncOS cannot identify the category
of a URL, and the Access Policy -> URL Filtering page is disabled. Thus, the feature key needs to
be present, and Acceptable Use Policies enabled, to configure quotas..

Many websites such as Facebook and Gmail auto-update at frequent intervals. If such a website is
left open in an unused browser window or tab, it will continue to consume the user’s quota of time
and volume.

A proxy restart will cause quotas to be reset, potentially allowing much more access than planned.
A proxy restart may occur because of a configuration change, a crash, a machine reboot, and so on.
Some confusion is possible, as administrators are not explicitly informed about proxy restarts.

Your EUN pages (both warning and block) cannot be displayed for HTTPS even when
decrypt-for-EUN option is enabled.

Note  The most restrictive quota will always apply when more than one quota applies to any given user.

Volume Quota Calculations

Calculation of volume quotas is as follows:

HTTP and decrypted HTTPS traffic — The HTTP request and response body are counted toward
quota limits. The request headers and response headers will not be counted toward the limits.

Tunnel traffic (including tunneled HTTPS) — AsyncOS simply shuttles the tunneled traffic from the
client to the server, and vice versa. The entire data volume of the tunnel traffic is counted toward
quota limits.
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S

Note

Time Ranges and Volume Quotas

e FTP - The control-connection traffic is not counted. The size of the file uploaded and downloaded
is counted toward quota limits.

Only client-side traffic is counted toward quota limits. Cached content also counts toward the limit, as
client-side traffic is generated even when a response is served from the cache.

Time Quota Calculations

Calculation of time quotas is as follows:

e HTTP and decrypted HTTPS traffic — The duration of each connection to the same URL category,
from formation to disconnect, plus one minute, is counted toward the time quota limit. If multiple
requests are made to the same URL category within one minute of each other, they are counted as
one continuous session and the one minute is added only at the end of this session (that is, after at
least one minute of “silence”).

e Tunnel traffic (including tunneled HTTPS) — The actual duration of the tunnel, from formation to
disconnect, counts toward quota limits. The above calculation for multiple requests applies to
tunneled traffic as well.

e FTP — The actual duration of the FTP control session, from formation to disconnect, counts toward
quota limits. The above calculation for multiple requests applies to FTP traffic as well.

Defining Time and Volume Quotas

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Before You Begin
¢ Go to Security Services > Acceptable Use Controls to enable Acceptable Use Controls.

e Define a time range unless you want the quota to apply as a daily limit. See Defining Time and
Volume Quotas.

Navigate to Web Security Manager > Define Time Ranges and Quotas.
Click Add Quota.
Enter a unique Quota Name in the field.

To reset the quota every day, select Reset this quota daily at and enter a time in the 12-hour format in
the field, then choose AM or PM from the menu. Alternatively, select Select a predefined time range
profile.

To set a time quota, select the Time Quota check box and choose the number of hours from the hrs menu
and the number of minutes from the mins menu, from zero (always blocked) to 23 hours and 59 minutes.

To set a volume quota enter a number in the field and choose KB (kilobytes), MB (megabytes), or GB
(gigabytes) from the menu.

Click Submit and then click Commit Changes to apply your changes. Alternatively, click Cancel to
abandon your changes.

What to Do Next

e (Optional) Navigate to Security Services > End-User Notification to configure end-user
notifications for quotas.
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Access Control by URL Category

You can identify and action web requests based on the category of website they address. The Web

Security appliance ships with many predefined URL categories by default, such as Web-based Email
and others.

Predefined categories, and the websites associated with them, are defined within filtering databases that
reside on the Web Security appliance. These databases are automatically kept up to date by Cisco. You

can also create user-defined custom URL categories, however, for hostnames and IP addresses that you
specify.

URL categories can be used by all policies except policies to identify requests. They can also be used by
Access, Encrypted HTTPS Management and Data Security policies to apply actions to requests.

Creating Custom URL Categories

Before You Begin

¢ Go to Security Services > Acceptable Use Controls to enable Acceptable Use Controls.

Step 1 Choose Web Security Manager > Custom URL Categories.
Step2  Click Add Custom Category.

Step3  Enter the settings for the custom URL category:
Table 10-2

Setting Description

Category Name Enter a name for the URL category. This name appears when you configure
URL filtering for policies.

Note: The Sawmill for reporting tool will not find custom URL categories in
access logs if their names contain spaces in the first four characters.

List Order Choose the order in the list of custom URL categories to place this category.
Enter “1” for the topmost URL category.

The URL filtering engine evaluates a client request against the custom URL
categories in the order specified.
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Table 10-2
Setting Description
Sites Enter one or more addresses that belong in the custom category.

You can enter multiple addresses separated by line breaks or commas. You can
enter addresses using any of the following formats:

IP address, such as 10.1.1.0
e CIDR address, such as 10.1.1.0/24

e Domain name, such as example.com
e Hostname, such as crm.example.com
e Partial hostname, such as .example.com

Note: Entering a partial hostname, such as .example.com, also matches
www.example.com.

Note: It is possible to use the same address in multiple custom URL categories,
but the order in which the categories are listed in is relevant. If you include these
categories in the same policy, and define different actions to each one, then the
action of the category listed highest in the custom URL categories table is what
takes effect.

Advanced: Regular | You can use regular expressions to specify multiple web servers that match the
Expressions pattern you enter.

Note: The URL filtering engine compares URLs with addresses entered in the
Sites field first. If the URL of a transaction matches an entry in the Sites field,
it is not compared to any expression entered here.

Step 4 (Optional) Click Sort URLSs to sort all addresses in the Sites field into alphanumeric order.

N

Note  Once you sort the addresses, you cannot retrieve their original order.

Step5  Submit and commit your changes.

Related Topics

e Regular Expressions

Using URL Categories to Identify Web Requests

Before You Begin
e Enable Acceptable Use Control, see Configuring the URL Filtering Engine.

e (Optional) Create Custom URL Categories, see Creating Custom URL Categories.

Step1  Choose a policy type (except SaaS) from the Web Security Manager menu.
Step2  Click a policy name in the policies table (or add a new policy).
Step3  Expand the Advanced section and click the link in the URL Categories field.
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Step 4

Step 5
Step 6

Click the Add column cells corresponding to URL Categories you wish to identify web requests by. Do
this for the Custom URL Categories and Predefined URL Categories lists as required.

Click Done.

Submit and commit your changes.

Using URL Categories to Action Web Request

Note

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Before You Begin
e Enable Acceptable Use Control, see Configuring the URL Filtering Engine.

e (Optional) Create Custom URL Categories, see Creating Custom URL Categories.

If you have used URL categories as criteria within a policy then those categories alone are available to
specify actions against within the same policy. Some of the options described below may differ or be
unavailable because of this.

Choose one of Access Policies, Cisco Data Security Policies, or Encrypted HTTPS Management
from the Web Security Manager menu.

Find the required policy name in the policies table.

Click the cell link in the URL Filtering column on the same row.

(Optional) Add custom URL categories:

a. Click Select Custom Categories.

b. Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request
against. The URL filtering engine compares client requests against included custom URL
categories, and ignores excluded custom URL categories. The URL filtering engine compares the
URL in a client request to included custom URL categories before predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering
section.

Choose an action for each custom and predefined URL category.

)

Note  Available actions vary between custom and predefined categories and between policy types.

In the Uncategorized URLS section, choose the action to take for client requests to web sites that do not
fall into a predefined or custom URL category.

Submit and commit your changes.

Remote Users

e About Remote Users, page 10-17

e How to Configure Identification of Remote Users, page 10-17
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e Display Remote User Status and Statistics for ASAs, page 10-18

About Remote Users

Cisco AnyConnect Secure Mobility extends the network perimeter to remote endpoints, enabling the
integration of web filtering services offered by the Web Security appliance.

Remote and mobile users use the Cisco AnyConnect Secure VPN (virtual private network)client to
establish VPN sessions with the Adaptive Security Appliance (ASA). The ASA sends web traffic to the
Web Security appliance along with information identifying the user by IP address and user name. The
Web Security appliance scans the traffic, enforces acceptable use policies, and protects the user from
security threats. The security appliance returns all traffic deemed safe and acceptable to the user.

When Secure Mobility is enabled, you can configure identities and policies to apply to users by
their location:

¢ Remote users. These users are connected to the network from a remote location using VPN. The
Web Security appliance automatically identifies remote users when both the Cisco ASA and Cisco
AnyConnect client are used for VPN access. Otherwise, the Web Security appliance administrator
must specify remote users by configuring a range of IP addresses.

¢ Local users. These users are connected to the network either physically or wirelessly.

When the Web Security appliance integrates with a Cisco ASA, you can configure it to identify users by
an authenticated user name transparently to achieve single sign-on for remote users.

How to Configure Identification of Remote Users

Task Further information

1. Configure identification of remote users. |Configuring Identification of Remote Users,
page 10-17

2. Create an identity for remote users. Classifying Users and Client Software, page 6-3

a. In the “Define Members by User Location”
section, select Remote Users Only.

b. In the “Define Members by Authentication”
section, select “Identify Users Transparently
through Cisco ASA Integration.”

3. Create a policy for remote users. Creating a Policy, page 10-5

Configuring Identification of Remote Users

Step1  Security Services > AnyConnect Secure Mobility, and click Enable.
Step2  Read the terms of the AnyConnect Secure Mobility License Agreement, and click Accept.
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Configure how to identify remote users.

Description

Additional Steps

Specify a range of IP addresses
that the appliance should consider
as assigned to remote devices.

1. Enter a range of IP addresses in the IP Range
field.

2. Gotostep4

Specify one or more Cisco ASA
the Web Security appliance
communicates with. The Cisco
ASA maintains an IP
address-to-user mapping and
communicates that information
with the Web Security appliance.
When the Web Proxy receives a
transaction, it obtains the IP
address and determines the user
by checking the IP
address-to-user mapping. When
users are determined by
integrating with a Cisco ASA,
you can enable single sign-on for
remote users.

1. Enter the Cisco ASA host name or IP address.

2. Enter the port number used to access the ASA.
The default port number for the Cisco ASA is
11999.

3. If multiple Cisco ASA are configured in a
cluster, click Add Row and configure each
ASA in the cluster.

Note If two Cisco ASA are configured for high
availability, enter only one host name or IP

address for the active Cisco ASA.

4. Enter the access passphrase for the Cisco ASA.

Note The passphrase you enter here must match
the access passphrase configured for the

specified Cisco ASA.

5. Optional, click Start Test to verify the Web
Security appliance can connect to the
configured Cisco ASA.

Step 3
Option
IP Address
Cisco ASA
Integration
Step 4

Submit and Commit Changes.

Display Remote User Status and Statistics for ASAs

Use this command to display information related to Secure Mobility when the Web Security appliance
is integrated with an ASA.

Command

Description

musstatus

This command displays the following information:

The status of the Web Security appliance connection with each ASA.

The duration of the Web Security appliance connection with each ASA in minutes.

The number of remote clients from each ASA.

The number of remote clients being serviced, which is defined as the number of
remote clients that have passed traffic through the Web Security appliance.

The total number of remote clients.
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Troubleshooting Policies

e Access Policy not Configurable for HTTPS, page A-9

¢ Some Microsoft Office Files Not Blocked, page A-10

¢ Blocking DOS Executable Object Types Blocks Updates for Windows OneCare, page A-10
¢ Identification Profile Disappeared from Policy, page A-10

e Policy is Never Applied, page A-10

e HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication, page A-11

e User Matches Global Policy for HTTPS and FTP over HTTP Requests, page A-11

e User Assigned Incorrect Access Policy, page A-11
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Create Decryption Policies to Control
HTTPS Traffic

Overview of Create Decryption Policies to Control HTTPS Traffic, page 11-1
Managing HTTPS Traffic through Decryption Policies Best Practices, page 11-2
Decryption Policies, page 11-2

Root Certificates, page 11-5

Routing HTTPS Traffic, page 11-11

Overview of Create Decryption Policies to Control HTTPS Traffic

Decryption policies define the handling of HTTPS traffic within the web proxy:

When to decrypt HTTPS traffic.

How to handle requests that use invalid or revoked security certificates.

You can create decryption policies to handle HTTPS traffic in the following ways:

A

Pass through encrypted traffic

Decrypt traffic and apply the content-based access policies defined for HTTP traffic. This also
makes malware scanning possible.

Drop the HTTPS connection

Monitor the request (take no final action) as the web proxy continues to evaluate the request against
policies that may lead to a final drop, pass through, or decrypt action.

Caution  Handle personally identifiable information with care: If you choose to decrypt an end-user’s HTTPS
session, the Web Security appliance access logs and reports may contain personally identifiable
information. The Administrator can configure how much URI text is stored in the logs using the
advancedproxyconfig CLI command and the srTPs subcommand. You can log the entire URI, or a
partial form of the URI with the query portion removed. However, even when you choose to strip the
query from the URI, personally identifiable information may still remain.
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Managing HTTPS Traffic through Decryption Policies Task Overview

Task List for Managing HTTPS Traffic

Step |[through Decryption Policies Links to Related Topics and Procedures
1 Enabling the HTTPS proxy Enabling the HTTPS Proxy, page 11-3
2 Upload or Generate a certificate and key | ® Uploading a Root Certificate and Key, page 11-7

e Generating a Certificate and Key for the HTTPS
Proxy, page 11-7

3 Configuring Decryption options Configuring Decryption Options, page 11-4

5 (Optional) Configure invalid certificate |Configuring Invalid Certificate Handling, page 11-8
handling

6 (Optional) Enabling real-time Enabling Real-Time Revocation Status Checking,
revocation status checking page 11-9

7 (Optional) Manage trusted and blocked |Trusted Root Certificates, page 11-10

certificates

Managing HTTPS Traffic through Decryption Policies

Best Practices

e Create fewer, more general Decryption Policy groups that apply to all users or fewer, larger groups
of users on the network. Then, if you need to apply more granular control to decrypted HTTPS
traffic, use more specific Access Policy groups.

Decryption Policies

The appliance can perform any of the following actions on an HTTPS connection request:

Option

Description

Monitor

Monitor is an intermediary action that indicates the Web Proxy should continue
evaluating the transaction against the other control settings to determine which final
action to ultimately apply.

Drop

The appliance drops the connection and does not pass the connection request to the
server. The appliance does not notify the user that it dropped the connection.

Pass through

The appliance passes through the connection between the client and the server without
inspecting the traffic content.

Decrypt

The appliance allows the connection, but inspects the traffic content. It decrypts the
traffic and applies Access Policies to the decrypted traffic as if it were a plaintext HTTP
connection. By decrypting the connection and applying Access Policies, you can scan
the traffic for malware.
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Enabling the HTTPS Proxy

Step 1

Step 2
Step 3
Step 4

Note

Step 5

Note

Step 6

Step 7

To monitor and decrypt HTTPS traffic, you must enable the HTTPS Proxy. When you enable the HTTPS
Proxy, you must configure what the appliance uses for a root certificate when it sends self-signed server
certificates to the client applications on the network. You can upload a root certificate and key that your
organization already has, or you can configure the appliance to generate a certificate and key with
information you enter.

Once the HTTPS Proxy is enabled, all HTTPS policy decisions are handled by Decryption Policies. Also
on this page, you can configure what the appliance does with HTTPS traffic when the server certificate
is invalid.

Before You Begin

e When the HTTPS proxy is enabled, HTTPS-specific rules in access policies are disabled and the
web proxy processes decrypted HTTPS traffic using rules for HTTP.

Security Services > HTTPS Proxy, click Enable and Edit Settings.

The HTTPS Proxy License Agreement appears.

Read the terms of the HTTPS Proxy License Agreement, and click Accept.
Verify the Enable HTTPS Proxy field is enabled.

In the HTTPS Ports to Proxy field, enter the ports the appliance should check for HTTPS traffic. Port
443 is the default port.

The maximum number of ports for which the Web Security appliance can serve as proxy is 30, which
includes both HTTP and HTTPS.

Upload or generate a root/signing certificate to use for decryption.

If the appliance has both an uploaded certificate and key pair and a generated certificate and key pair, it
only uses the certificate and key pair currently selected in the Root Certificate for Signing section.

In the HTTPS Transparent Request section, select one of the following options:
e Decrypt the HTTPS request and redirect for authentication
e Deny the HTTPS request

This setting only applies to transactions that use IP address as the authentication surrogate and when the
user has not yet been authenticated.

N

Note  This field only appears when the appliance is deployed in transparent mode.

In the Applications that Use HTTPS section, choose whether to enable decryption for enhanced
application visibility and control.

S

Note  Decryption may cause some applications to fail unless the root certificate for signing is installed
on the client. For more information on the appliance root certificate, see.
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Step8  Submit and commit your changes.

Related Topics
e Managing Certificate Validation and Decryption for HTTPS, page 11-6

Controlling HTTPS Traffic

After the Web Security appliance assigns an HTTPS connection request to a Decryption Policy group,
the connection request inherits the control settings of that policy group. The control settings of the
Decryption Policy group determine whether the appliance decrypts, drops, or passes through the
connection:

Option Description

URL Categories You can configure the action to take on HTTPS requests for each predefined
and custom URL category. Click the link under the URL Categories column for
the policy group you want to configure.

Note If you want to block (with end-user notification) a particular URL
category for HTTPS requests instead of drop (with no end-user
notification), choose to decrypt that URL category in the Decryption
Policy group and then choose to block the same URL category in the
Access Policy group.

Web Reputation You can configure the action to take on HTTPS requests based on the web
reputation score of the requested server. Click the link under the Web
Reputation column for the policy group you want to configure.

Default Action You can configure the action the appliance should take when none of the other
settings apply. Click the link under the Default Action column for the policy
group you want to configure.

Note The configured default action only affects the transaction when no
decision is made based on URL category or Web Reputation score. If
Web Reputation filtering is disabled, the default action applies to all
transactions that match a Monitor action in a URL category. If Web
Reputation filtering is enabled, the default action is used only if the
Monitor action is selected for sites with no score.

Configuring Decryption Options

Before You Begin
e Verify that the HTTPS proxy is enabled as described in Enabling the HTTPS Proxy, page 11-3

Step 1 Security Services > HTTPS Proxy.
Step2  Click Edit Settings.
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Step3  Enable the decryption options.

Decryption Option Description
Decrypt for For users who have not been authenticated prior to this HTTPS transaction,
Authentication allow decryption for authentication.

Decrypt for End-User | Allow decryption so that AsyncOS can display the end-user notification.

Notification Note If the certificate is invalid and invalid certificates are set to drop,

when running a policy trace, the first logged action for the transaction
will be “decrypt”.

Decrypt for End-User  |For users who have not acknowledged the web proxy prior to this HTTPS
Acknowledgement transaction, allow decryption so that AsyncOS can display the end-user
acknowledgement.

Decrypt for Application |Enhances the ability of AsyncOS to detect HTTPS applications.
Detection

Authentication and HTTPS Connections

Authentication at the HTTPS connection layer is available for these types of requests:

Option Description

Explicit requests e secure client authentication disabled or

e secure client authentication enabled and an IP-based surrogate

Transparent e [P-based surrogate, decryption for authentication enabled or
requests

e [P-based surrogate, client previously authenticated using an HTTP request

Root Certificates

The HTTPS proxy uses the root certificates and private key files that you upload to the appliance to
decrypt traffic. The root certificate and private key files you upload to the appliance must be in PEM
format; DER format is not supported.

You can enter root certificate information in the following ways:

¢ Generate. You can enter some basic organization information and then click a button so the
appliance generates the rest of the certificate and a private key.

¢ Upload. You can upload a certificate file and its matching private key file created outside of
the appliance.

Note  You can also upload an intermediate certificate that has been signed by a root certificate authority. When
the Web Proxy mimics the server certificate, it sends the uploaded certificate along with the mimicked
certificate to the client application. That way, as long as the intermediate certificate is signed by a root
certificate authority that the client application trusts, the application will trust the mimicked server
certificate, too. See About Certificates and Keys, page 22-25 for more information.
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You can choose how to handle the root certificates issued by the Web Security appliance:

¢ Inform users to accept the root certificate. You can inform the users in your organization what the
new policies are at the company and tell them to accept the root certificate supplied by the
organization as a trusted source.

e Add the root certificate to client machines. You can add the root certificate to all client machines
on the network as a trusted root certificate authority. This way, the client applications automatically
accept transactions with the root certificate.

Step 1 Security Services > HTTPS Proxy.
Step2  Click Edit Settings.
Step3  Click the Download Certificate link for either the generated or uploaded certificate.

Note  To reduce the possibility of client machines getting a certificate error, submit the changes after you
generate or upload the root certificate to the Web Security appliance, then distribute the certificate to
client machines, and then commit the changes to the appliance.

Managing Certificate Validation and Decryption for HTTPS

The Web Security appliance validates certificates before inspecting and decrypting content.

Valid Certificates

Qualities of a valid certificate:
e Not expired. The certificate’s validity period includes the current date.

¢ Recognized certificate authority. The issuing certificate authority is included in the list of trusted
certificate authorities stored on the Web Security appliance.

e Valid signature. The digital signature was properly implemented based on cryptographic standards.
¢ Consistent naming. The common name matches the hostname specified in the HTTP header.

¢ Not revoked. The issuing certificate authority has not revoked the certificate.

Related Topics
e Managing Certificate Validation and Decryption for HTTPS, page 11-6

¢ Configuring Invalid Certificate Handling, page 11-8
e Options for Certificate Revocation Status Checking, page 11-9
e Enabling Real-Time Revocation Status Checking, page 11-9

Invalid Certificate Handling
The appliance can perform one of the following actions for invalid server certificates:
e Drop.
e Decrypt.

e Monitor.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
[ 11-6 | I




| Chapter11  Create Decryption Policies to Control HTTPS Traffic

Root Certificates W

Certificates that are Invalid for Multiple Reasons
For server certificates that are invalid due to both an unrecognized root authority and an expired
certificate, the HTTPS proxy performs the action that applies to unrecognized root authorities.

In all other cases, for server certificates that are invalid for multiple reasons simultaneously, the HTTPS
Proxy performs actions in order from the most restrictive action to the least restrictive action.

Untrusted Certificate Warnings for Decrypted Connections

When the Web Security appliance encounters an invalid certificate and is configured to decrypt the
connection, AsyncOS creates an untrusted certificate that requires the end-user to accept or reject the
connection. The common name of the certificate is “Untrusted Certificate Warning.”

Adding this untrusted certificate to the list of trusted certificates will remove the end user’s option to
accept or reject the connection.

When AsyncOS generates one of these certificates, it creates a proxy log entry with the text “Signing
untrusted key” or “Signing untrusted cert”.

Uploading a Root Certificate and Key

Before You Begin
e Enable the HTTPS Proxy. Enabling the HTTPS Proxy, page 11-3.

Step 1 Security Services > HTTPS Proxy.

Step2  Click Edit Settings.

Step3  Select Use Uploaded Certificate and Key.

Stepd  Click Browse for the Certificate field to navigate to the certificate file stored on the local machine.

If the file you upload contains multiple certificates or keys, the Web Proxy uses the first certificate or
key in the file.

Step5  Click Browse for the Key field to navigate to the private key file.

Note The key length must be 512, 1024, or 2048 bits.

Step6  Select Key is Encrypted if the key is encrypted.
Step7  Click Upload Files to transfer the certificate and key files to the Web Security appliance.
The uploaded certificate information is displayed on the Edit HTTPS Proxy Settings page.

Step8  (Optional) Click Download Certificate so you can transfer it to the client applications on the network.

Generating a Certificate and Key for the HTTPS Proxy

Before You Begin
e Enable the HTTPS Proxy. Enabling the HTTPS Proxy, page 11-3.
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Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8
Step 9

Step 10

Step 11

Security Services > HTTPS Proxy.

Click Edit Settings.

Select Use Generated Certificate and Key.

Click Generate New Certificate and Key.

In the Generate Certificate and Key dialog box, enter the information to display in the root certificate.
You can enter any ASCII character except the forward slash (/) in the Common Name field.

Click Generate.

The generated certificate information is displayed on the Edit HTTPS Proxy Settings page.

(Optional) Click Download Certificate so you can transfer it to the client applications on the network.

(Optional) Click the Download Certificate Signing Request link. so you can submit the Certificate
Signing Request (CSR) to a certificate authority (CA).

(Optional) Upload the signed certificate to the Web Security appliance after receiving it back from the
CA. You can do this at anytime after generating the certificate on the appliance.

Submit and Commit Changes.

Configuring Invalid Certificate Handling

Step 1
Step 2
Step 3

Before You Begin
e Verify that the HTTPS proxy is enabled as described in Enabling the HTTPS Proxy, page 11-3

Security Services > HTTPS Proxy.
Click Edit Settings.

For each type of certificate error, define the proxy response, Drop, Decrypt or Monitor.

Certificate Error Type Description

Expired The current date falls outside of the range of validity for the certificate.

Mismatched hostname The hostname in the certificate does not match the hostname the client was
trying to access.

Note The Web Proxy can only perform hostname match when it is
deployed in explicit forward mode. When it is deployed in
transparent mode, it does not know the hostname of the destination
server (it only knows the IP address), so it cannot compare it to the
hostname in the server certificate.

Unrecognized root Either the root authority or an intermediate certificate authority is
authority/issuer unrecognized.

Invalid signing There was a problem with the signing certificate.

certificate
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Certificate Error Type Description

Invalid leaf certificate There was a problem with the leaf certificate, for example, a rejection,
decoding, or mismatch problem.

All other error types Most other error types are due to the appliance not being able to complete
the SSL handshake with the HTTPS server. For more information about
additional error scenarios for server certificates, see
http://www.openssl.org/docs/apps/verify.html.

Stepd  Submit and Commit Changes.

Options for Certificate Revocation Status Checking

To determine whether the issuing certificate authority has revoked a certificate, the Web Security
appliance can check with the issuing certificate authority in these ways:

¢ Certificate Revocation List (Comodo certificates only). The Web Security appliance checks
Comodo’s certificate revocation list. Comodo maintains this list, updating it according to their own
policies. Depending on when it was last updated, the certificate revocation list may be out of date at
the time the Web Security appliance checks it.

¢ Online Certificate Status Protocol (OCSP). The Web Security appliance checks the revocation
status with the issuing certificate authority in real time. If the issuing certificate authority supports
OCSP, the certificate will include a URL for real-time status checking. This feature is enabled by
default for fresh installations and disabled by default for updates.

~

Note  The Web Security appliance only performs the OCSP query for certificates that it determines to be valid
in all other respects and that include the OCSP URL.

Related Topics
e Enabling Real-Time Revocation Status Checking, page 11-9

e Configuring Invalid Certificate Handling, page 11-8

Enabling Real-Time Revocation Status Checking

Before You Begin
e Ensure the HTTPS Proxy is enabled. See Enabling the HTTPS Proxy, page 11-3

Step1  Security Services > HTTPS Proxy.

Step2  Click Edit Settings.

Step3  Select Enable Online Certificate Status Protocol (OCSP).
Step4d  Configure the OCSP Result Handling properties,

Cisco recommends configuring the OCSP Result Handling options to the same actions as Invalid
Certificate Handling options. For example, if you set Expired Certificate to Monitor, configure Revoked
Certificate to monitor.
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Step 5

Step 6

(Optional) Expand the Advanced configuration section and configure the settings described below.

Field Name Description

OCSP Valid Time to wait before rechecking a valid OCSP response in seconds (s), minutes
Response Cache (m), hours (h), or days (d). Default unit is seconds. Valid range is from 1 second
Timeout to 7 days.

OCSP Invalid Time to wait before rechecking an invalid OCSP response in seconds (s),
Response Cache minutes (m), hours (h), or days (d). Default unit is seconds. Valid range is from
Timeout 1 second to 7 days.

OCSP Network Error |Time to wait before attempting to contact the OCSP responder again after

Cache Timeout

failing to get a response in seconds (s), minutes (m), hours (h), or days (d).
Valid range from 1 second to 24 hours.

Allowed Clock Skew

Maximum allowed difference in time settings between the Web Security
appliance and the OCSP responder in seconds (s) or minutes (m). Valid range
from 1 second to 60 minutes.

Maximum Time to
Wait for OCSP
Response

Maximum time to wait for a response from the OCSP responder. Valid range is
from 1 second to 10 minutes. Specify a shorter duration to reduce delays in end
user access to HTTPS requests in the event that the OCSP responder is
unavailable.

Use upstream proxy
for OCSP checking

Group Name of the upstream proxies.

Servers exempt from
upstream proxy

IP addresses or hostnames of the servers to exempt. May be left blank.

Submit and Commit Changes.

Trusted Root Certificates

The Web Security appliance ships with and maintains a list of trusted root certificates. Web sites with
trusted certificates do not require decryption.

You can manage the trusted certificate list, adding certificates to it and functionally removing certificates
from it. While the Web Security appliance does not delete certificates from the master list, it allows you

to override trust in a certificate, which functionally removes the certificate from the trusted list.

Adding Certificates to the Trusted List

Step 1
Step 2
Step 3
Step 4

Before You Begin

e Verify that the HTTPS Proxy is enabled. See Enabling the HTTPS Proxy, page 11-3

Security Services > HTTPS Proxy.
Click Manage Trusted Root Certificates.

Click Import.

Click Browse and navigate to the certificate file.
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Routing HTTPS Traffic

Step5 Submit and Commit Changes.

Look for the certificate you uploaded in the Custom Trusted Root Certificates list.

Removing Certificates from the Trusted List

Step1  Select Security Services > HTTPS Proxy.
Step2  Click Manage Trusted Root Certificates.
Step3  Select the Override Trust checkbox corresponding to the certificate you wish to remove from the list.

Stepd  Submit and Commit Changes.

Routing HTTPS Traffic

The ability of AsyncOS to route HTTPS transactions based on information stored in client headers is
limited and is different for transparent and explicit HTTPS.

Option Description
Transparent In the case of transparent HTTPS, AsyncOS does not have access to information
HTTPS in the client headers. Therefore, AsyncOS cannot enforce routing policies that

rely on information in client headers.

Explicit HTTPS In the case of explicit HTTPS, AsyncOS has access to the following information
in client headers:

e URL
e Destination port number

Therefore, for explicit HTTPS transactions, it is possible to match a routing
policy based on URL or port number.

Troubleshooting Decryption/HTTPS/Certificates

e Accessing HTTPS Sites Using Routing Policies with URL Category Criteria, page A-7
e HTTPS with IP-based Surrogates and Transparent Requests, page A-7

e Bypassing Decryption for Particular Websites, page A-7

e Alert: Problem with Security Certificate, page A-8
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Scan OQutbhound Traffic for Existing Infections

e Overview of Scanning Outbound Traffic, page 12-1

e Understanding Upload Requests, page 12-2

¢ Creating Outbound Malware Scanning Policies, page 12-3
e Controlling Upload Requests, page 12-4

e Logging of DVS Scanning, page 12-6

Overview of Scanning Outhound Traffic

To prevent malicious data from leaving the network, the Web Security appliance provides the Outbound
Malware Scanning feature. Using policy groups, you can define which uploads are scanned for malware,
which anti-malware scanning engines to use for scanning, and which malware types to block.

The Cisco IronPort Dynamic Vectoring and Streaming (DVS) engine scans transaction requests as they
leave the network. By working with the Cisco IronPort DVS engine, the Web Security appliance enables
you to prevent users from unintentionally uploading malicious data.

You can perform the following tasks:

Task Link to Task

Create policies to block malware Creating Outbound Malware Scanning Policies, page 12-4

Assign upload requests to outbound Controlling Upload Requests, page 12-6
malware policy groups

User Experience When Requests Are Blocked by the DVS Engine

When the Cisco IronPort DVS engine blocks an upload request, the Web Proxy sends a block page to the
end user. However, not all websites display the block page to the end user. Some Web 2.0 websites
display dynamic content using javascript instead of a static webpage and are not likely to display the
block page. Users are still properly blocked from uploading malicious data, but they may not always be
informed of this by the website.
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Understanding Upload Requests

Outbound Malware Scanning Policies define whether or not the Web Proxy blocks HTTP requests and
decrypted HTTPS connections for transactions that upload data to a server (upload requests). An upload
request is an HTTP or decrypted HTTPS request that has content in the request body.

When the Web Proxy receives an upload request, it compares the request to the Outbound Malware
Scanning policy groups to determine which policy group to apply. After it assigns the request to a policy
group, it compares the request to the policy group’s configured control settings to determine whether to
block the request or monitor the request. When an Outbound Malware Scanning Policy determines to
monitor a request, it is evaluated against the Access Policies, and the final action the Web Proxy takes
on the request is determined by the applicable Access Policy.

Note Upload requests that try to upload files with a size of zero (0) bytes are not evaluated against Outbound
Malware Scanning Policies.

Criteria for Group Membership

Each client request is assigned to an Identity and is then evaluated against the other policy types to
determine to which policy group it belongs for each type. The Web Proxy applies the configured policy
control settings to a client request based on the client request’s policy group membership.

The Web Proxy follows a specific process for matching the group membership criteria. It considers the
following factors for group membership:

Criteria Description

Identity Each client request either matches an Identity, fails authentication and is granted
guest access, or fails authentication and is terminated

Authorized users |If the assigned Identity requires authentication, the user must be in the list of
authorized users in the Outbound Malware Scanning Policy group to match the
policy group. The list of authorized users can be any of the specified groups or
users or can be guest users if the Identity allows guest access

Advanced options |You can configure several advanced options for Outbound Malware Scanning
Policy group membership. Some options, such as proxy port and URL category,
can also be defined within the Identity. When an advanced option is configured in
the Identity, it is not configurable in the Outbound Malware Scanning Policy
group level

Matching Client Requests to Outbound Malware Scanning Policy Groups

The Web Proxy compares the upload request status to the membership criteria of the first policy group.
If they match, the Web Proxy applies the policy settings of that policy group.

If they do not match, the Web Proxy compares the upload request to the next policy group. It continues
this process until it matches the upload request to a user defined policy group. If it does not match a user
defined policy group, it matches the global policy group. When the Web Proxy matches the upload
request to a policy group or the global policy group, it applies the policy settings of that policy group.
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Creating Outbound Malware Scanning Policies

Creating Outbound Malware Scanning Policies

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6
Step 7

You can create Outbound Malware Scanning Policy groups based on combinations of several criteria,
such as one or more Identities or the URL category of the destination site. You must define at least one
criterion for policy group membership. When you define multiple criteria, the upload request must meet
all criteria to match the policy group. However, the upload request needs to match only one of the
configured Identities.

Choose Web Security Manager > Outbound Malware Scanning.
Click Add Policy.

Enter a name and an optional description for the policy group.

N

Note  Each policy group name must be unique and only contain alphanumeric characters or the space
character.

In the Insert Above Policy field, select where in the policies table to place the policy group.

When configuring multiple policy groups, you must specify a logical order for each group.

In the Identities and Users section, select one or more Identity groups to apply to this policy group.
(Optional) Expand the Advanced section to define additional membership requirements.

To define policy group membership by any of the advanced options, click the link for the advanced
option and configure the option on the page that appears.

Advanced Option |Description

Protocols Choose whether or not to define policy group membership by the protocol used in
the client request. Select the protocols to include.

“All others” means any protocol not listed above this option.

Note  When the HTTPS Proxy is enabled, only Decryption Policies apply to
HTTPS transactions. You cannot define policy membership by the HTTPS
protocol for Access, Routing, Outbound Malware Scanning, Data Security,
or External DLP Policies.

Proxy Ports Choose whether or not to define policy group membership by the proxy port used
to access the Web Proxy. Enter one or more port numbers in the Proxy Ports field.
Separate multiple ports with commas.

For explicit forward connections, this is the port configured in the browser. For
transparent connections, this is the same as the destination port.

If you define policy group membership by the proxy port when client requests are
transparently redirected to the appliance, some requests might be denied.

Note If the Identity associated with this policy group defines Identity
membership by this advanced setting, the setting is not configurable at the
non-Identity policy group level.
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Advanced Option

Description

Subnets

Choose whether or not to define policy group membership by subnet or other
addresses.

You can select to use the addresses that may be defined with the associated Identity,
or you can enter specific addresses here.

Note If the Identity associated with this policy group defines its membership by
addresses, then in this policy group you must enter addresses that are a
subset of the addresses defined in the Identity. Adding addresses in the
policy group further narrows down the list of transactions that match this
policy group.

URL Categories

Choose whether or not to define policy group membership by URL categories.
Select the user defined or predefined URL categories.

Note If the Identity associated with this policy group defines Identity
membership by this advanced setting, the setting is not configurable at the
non-Identity policy group level.

User Agents

Choose whether or not to define policy group membership by the user agent used
in the client request. You can select some commonly defined browsers, or define
your own using regular expressions. Choose whether this policy group should
apply to the selected user agents or to any user agent that is not in the list of selected
user agents.

Note  If the Identity associated with this policy group defines Identity
membership by this advanced setting, the setting is not configurable at the
non-Identity policy group level.

User Location

Choose whether or not to define policy group membership by user location, either
remote or local.

Step8  Submit your changes.

Step9  Configure Outbound Malware Scanning Policy group control settings to define how the Web Proxy
handles transactions.

The new Outbound Malware Scanning Policy group automatically inherits global policy group settings
until you configure options for each control setting.

Step10 Submit and Commit Changes.

Controlling Upload Requests

Each upload request is assigned to an Outbound Malware Scanning Policy group and inherits the control
settings of that policy group. After the Web Proxy receives the upload request headers, it has the
information necessary to decide if it should scan the request body. The DVS engine scans the request
and returns a verdict to the Web Proxy. The block page appears to the end user, if applicable.

Step 1 Choose Web Security Manager > Outbound Malware Scanning.

Step2  In the Destinations column, click the link for the policy group you want to configure.

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



| Chapter 12

Scan Outbhound Traffic for Existing Infections

Step 3

Step 4

Step 5
Step 6
Step 7
Step 8

Step 9

Step 10

Controlling Upload Requests 1l

In the Edit Destination Settings section, select “Define Destinations Scanning Custom Settings” from
the drop-down menu.

In the Destinations to Scan section, select one of the following:

Option Description

Do not scan any uploads |The DVS engine scans no upload requests. All upload requests are
evaluated against the Access Policies

Scan all uploads The DVS engine scans all upload requests. The upload request is blocked
or evaluated against the Access Policies, depending on the DVS engine
scanning verdict

Scan uploads to specified |The DVS engine scans upload requests that belong in specific custom URL
custom URL categories |categories. The upload request is blocked or evaluated against the Access
Policies, depending on the DVS engine scanning verdict.

Click Edit custom categories list to select the URL categories to scan

Submit your changes.
In the Anti-Malware Filtering column, click the link for the policy group.
In the Anti-Malware Settings section, select “Define Anti-Malware Custom Settings”.

In the Cisco IronPort DVS Anti-Malware Settings section, select which anti-malware scanning engines
to enable for this policy group.

In the Malware Categories section, select whether to monitor or block the various malware categories.

The categories listed in this section depend on which scanning engines you enable.

N

Note  URL transactions are categorized as unscannable when the configured maximum time setting is
reached or when the system experiences a transient error condition. For example, transactions
might be categorized as unscannable during scanning engine updates or AsyncOS upgrades. The
malware scanning verdicts SV_TIMEOUT and SV_ERROR are considered unscannable
transactions.

Submit and Commit Changes.
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Logging of DVS Scanning

The access logs indicate whether or not the DVS engine scanned an upload request for malware. The
scanning verdict information section of each access log entry includes values for the DVS engine activity

for scanned uploads. You can also add one of the fields to the W3C or access logs to more easily find
this DVS engine activity:

Table 12-1 Log Fields in W3C Logs and Format Specifiers in Access Logs
W3C Log Field Format Specifier in Access Logs
x-req-dvs-scanverdict P0X?2

x-req-dvs-threat-name YX4

x-req-dvs-verdictname %X3

When the DVS engine marks an upload request as being malware and it is configured to block malware
uploads, the ACL decision tag in the access logs is BLOCK_AMW_REQ.

However, when the DVS engine marks an upload request as being malware and it is configured to

monitor malware uploads, the ACL decision tag in the access logs is actually determined by the Access
Policy applied to the transaction.

To determine whether or not the DVS engine scanned an upload request for malware, view the results of
the DVS engine activity in the scanning verdict information section of each access log entry.
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e Overview of Configuring Security Services, page 13-1

e Overview of Web Reputation Filters, page 13-2

e Overview of Anti-Malware Scanning, page 13-4

e Understanding Adaptive Scanning, page 13-7

¢ Enabling Anti-Malware and Reputation Filters, page 13-8

1

e Configuring Anti-Malware and Reputation in Policies, page 13-9

e Maintaining the Database Tables, page 13-14

e Logging of Web Reputation Filtering Activity and DVS Scanning, page 13-14

e (Caching, page 13-14

e Malware Category Descriptions, page 13-16

Overview of Configuring Security Services

The Web Security appliance uses security components to protect end users from a range of malware
threats. You can configure anti-malware and web reputation settings for each policy group. When you
configure Access Policies, you can also have AsyncOS for Web choose a combination of anti-malware
scanning and web reputation scoring to use when determining what content to block.

To protect end users from malware, you enable these features on the appliance, and then configure
anti-malware and web reputation settings per policy.

Option

Description

Link

Anti-malware scanning

Works with multiple anti-malware
scanning engines integrated on the
appliance to block malware threats

Overview of Anti-Malware
Scanning, page 13-4

Web Reputation Filters

Analyzes web server behavior and
determines whether the URL contains
URL-based malware

Overview of Web Reputation Filters,
page 13-2

Advanced Malware
Protection

Protects from threats in downloaded
files by evaluating file reputation and
by analyzing file characteristics.

Overview of File Reputation
Filtering and File Analysis,
page 17-1
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Related Topics

Enabling Anti-Malware and Reputation Filters, page 13-8
Related Topics, page 13-9
Understanding Adaptive Scanning, page 13-7

Overview of Web Reputation Filters

Web Reputation Filters assigns a web-based reputation score (WBRS) to a URL to determine the
likelihood that it contains URL-based malware. The Web Security appliance uses web reputation scores
to identify and stop malware attacks before they occur. You can use Web Reputation Filters with Access,
Decryption, and Cisco IronPort Data Security Policies.

Web Reputation Scores

Web Reputation Filters use data to assess the reliability of Internet domains and score the reputation of
URLs. The web reputation calculation associates a URL with network parameters to determine the
probability that malware exists. The aggregate probability that malware exists is then mapped to a Web
Reputation Score between -10 and +10, with +10 being the least likely to contain malware.

Example parameters include the following:

~

URL categorization data

Presence of downloadable code
Presence of long, obfuscated End-User License Agreements (EULAs)
Global volume and changes in volume
Network owner information

History of a URL

Age of a URL

Presence on any block lists

Presence on any allow lists

URL typos of popular domains
Domain registrar information

IP address information

Note Cisco does not collect identifiable information such as user names, passphrases, or client IP addresses.

Understanding How Web Reputation Filtering Works

Web Reputation Scores are associated with an action to take on a URL request. You can configure each
policy group to correlate an action to a particular Web Reputation Score. The available actions depend
on the policy group type that is assigned to the URL request:
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Policy Type Action

Access Policies You can choose to block, scan, or allow
Decryption Policies You can choose to drop, decrypt, or pass through
Cisco IronPort Data Security Policies You can choose to block or monitor

Web Reputation in Access Policies

When you configure web reputation settings in Access Policies, you can choose to configure the settings
manually, or let AsyncOS for Web choose the best options using Adaptive Scanning. When Adaptive
Scanning is enabled, you can enable or disable web reputation filtering in each Access Policy, but you
cannot edit the Web Reputation Scores.

Score Action Description Example

-10to -6.0 |Block Bad site. The request is blocked, | ® URL downloads information without
and no further malware scanning user permission.
occurs.

e Sudden spike in URL volume.
e URL is a typo of a popular domain.

-5.91t05.9 |Scan Undetermined site. Request is e Recently created URL that has a
passed to the DVS engine for dynamic IP address and contains
further malware scanning. The downloadable content.

DVS engine scans the request

e Network owner IP address that has a
and server response content.

positive Web Reputation Score.

6.0 to 10.0 |Allow Good site. Request is allowed. e URL contains no downloadable
No malware scanning required. content.

e Reputable, high-volume domain
with long history.

e Domain present on several allow
lists.

¢ No links to URLs with poor
reputations.

By default, URLs in an HTTP request that are assigned a Web Reputation Score of +7 are allowed and
require no further scanning. However, a weaker score for an HTTP request, such as +3, is automatically
forwarded to the Cisco IronPort DVS engine where it is scanned for malware. Any URL in an HTTP
request that has a poor reputation is blocked.

Related Topics
e Understanding Adaptive Scanning, page 13-7
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Web Reputation in Decryption Policies

Score Action Description

-10t0 -9.0 Drop Bad site. The request is dropped with no notice sent to the end user. Use
this setting with caution.

-8.9t05.9 Decrypt Undetermined site. Request is allowed, but the connection is decrypted
and Access Policies are applied to the decrypted traffic.

6.0 to 10.0 Pass through |Good site. Request is passed through with no inspection or decryption.

Web Reputation in Cisco IronPort Data Security Policies

Score Action Description
-10to -6.0 Block Bad site. The transaction is blocked, and no further scanning occurs.
-5.91t0 0.0 Monitor The transaction will not be blocked based on Web Reputation, and will

proceed to content checks (file type and size).

Note  Sites with no score are monitored.

Overview of Anti-Malware Scanning

The Web Security appliance anti-malware feature uses the Cisco IronPort DVS™ engine in combination
with anti-malware scanning engines to stop web-based malware threats. The DVS engine works with the
Webroot™, McAfee, and Sophos anti-malware scanning engines.

The scanning engines inspect transactions to determine a malware scanning verdict to pass to the DVS
engine. The DVS engine determines whether to monitor or block the request based on the malware
scanning verdicts. To use the anti-malware component of the appliance, you must enable anti-malware
scanning and configure global settings, and then apply specific settings to different policies.

Related Topics
e Enabling Anti-Malware and Reputation Filters, page 13-8

¢ Related Topics, page 13-9

Understanding How the DVS Engine Works

The DVS engine performs anti-malware scanning on URL transactions that are forwarded from the Web
Reputation Filters. Web Reputation Filters calculate the probability that a particular URL contains
malware, and assign a URL score that is associated with an action to block, scan, or allow the transaction.

When the assigned web reputation score indicates to scan the transaction, the DVS engine receives the
URL request and server response content. The DVS engine, in combination with the Webroot and/or
Sophos or McAfee scanning engines, returns a malware scanning verdict. The DVS engine uses
information from the malware scanning verdicts and Access Policy settings to determine whether to
block or deliver the content to the client.
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Working with Multiple Malware Verdicts

The DVS engine might determine multiple malware verdicts for a single URL. Multiple verdicts can
come from one or both enabled scanning engines:

Different verdicts from different scanning engines. When you enable both Webroot and either
Sophos or McAfee, each scanning engine might return different malware verdicts for the same
object. When a URL causes multiple verdicts from both enabled scanning engines, the appliance
performs the most restrictive action. For example, if one scanning engine returns a block verdict and
the other a monitor verdict, the DVS engine always blocks the request.

Different verdicts from the same scanning engine. A scanning engine might return multiple
verdicts for a single object when the object contains multiple infections. When a URL causes
multiple verdicts from the same scanning engine, the appliance takes action according to the verdict
with the highest priority. The following text lists the possible malware scanning verdicts from the
highest to the lowest priority.

e Virus

e Trojan Downloader

e Trojan Horse

e Trojan Phisher

e Hijacker

e System monitor

¢ Commercial System Monitor
e Dialer

e Worm

e Browser Helper Object
e Phishing URL

e Adware

e Encrypted file

e Unscannable

e Other Malware

Webroot Scanning

The Webroot scanning engine inspects objects to determine the malware scanning verdict to send to the
DVS engine. The Webroot scanning engine inspects the following objects:

URL request. Webroot evaluates a URL request to determine if the URL is a malware suspect. If
Webroot suspects the response from this URL might contain malware, the appliance monitors or
blocks the request, depending on how the appliance is configured. If Webroot evaluation clears the
request, the appliance retrieves the URL and scans the server response.

Server response. When the appliance retrieves a URL, Webroot scans the server response content
and compares it to the Webroot signature database.
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McAfee Scanning

The McAfee scanning engine inspects objects downloaded from a web server in HTTP responses. After
inspecting the object, it passes a malware scanning verdict to the DVS engine so the DVS engine can
determine whether to monitor or block the request.

The McAfee scanning engine uses the following methods to determine the malware scanning verdict:
e Matching virus signature patterns

¢ Heuristic analysis

Matching Virus Signature Patterns

McAfee uses virus definitions in its database with the scanning engine to detect particular viruses, types
of viruses, or other potentially unwanted software. It searches for virus signatures in files. When you
enable McAfee, the McAfee scanning engine uses this method to scan server response content.

Heuristic Analysis

Heuristic analysis is a technique that uses general rules, rather than specific rules, to detect new viruses
and malware. When the McAfee scanning engine uses heuristic analysis, it looks at the code of an object,
applies generic rules, and determines how likely the object is to be virus-like.

Using heuristic analysis increases the possibility of reporting false positives (clean content designated
as a virus) and might impact appliance performance.When you enable McAfee, you can choose whether
or not to also enable heuristic analysis when scanning objects.
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McAfee Categories

McAfee Verdict Malware Scanning Verdict Category
Known Virus Virus

Trojan Trojan Horse

Joke File Adware

Test File Virus

Wannabe Virus

Killed Virus

Commercial Application Commercial System Monitor
Potentially Unwanted Object Adware

Potentially Unwanted Software Package Adware

Encrypted File Encrypted File

Sophos Scanning

The Sophos scanning engine inspects objects downloaded from a web server in HTTP responses. After
inspecting the object, it passes a malware scanning verdict to the DVS engine so the DVS engine can
determine whether to monitor or block the request. You might want to enable the Sophos scanning engine
instead of the McAfee scanning engine if McAfee anti-malware software is installed.

Understanding Adaptive Scanning

Adaptive Scanning decides which anti-malware scanning engine (including Advanced Malware
Protection scanning for downloaded files) will process the web request. Adaptive Scanning applies the
‘Outbreak Heuristics’ anti-malware category to transactions it identifies as malware prior to running any
scanning engines. You can choose whether or not to block these transactions when you configure
anti-malware settings on the appliance.

Adaptive Scanning and Access Policies

When Adaptive Scanning is enabled, some anti-malware and reputation settings that you can configure
in Access Policies are slightly different:

¢ You can enable or disable web reputation filtering in each Access Policy, but you cannot edit the
Web Reputation Scores.

¢ You can enable anti-malware scanning in each Access Policy, but you cannot choose which
anti-malware scanning engine to enable. Adaptive Scanning chooses the most appropriate engine for
each web request.

Note  If Adaptive Scanning is not enabled and an Access Policy has particular web reputation and anti-malware
settings configured, and then Adaptive Scanning is enabled, any existing web reputation and
anti-malware settings are overridden.
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Per-policy Advanced Malware Protection settings are the same whether or not Adaptive Scanning is
enabled.

Enabling Anti-Malware and Reputation Filters

Before You Begin

¢ Check the Web Reputation Filters, DVS engine, and the Webroot, McAfee, and Sophos scanning
engines are enabled. By default these should be enabled during system setup.

Step 1 Choose Security Services > Anti-Malware and Reputation.
Step2  Click Edit Global Settings.

Step3  Configure settings as necessary.

Setting Description

Web Reputation Choose whether or not to enable Web Reputation Filtering.

Filtering

Adaptive Scanning Choose whether or not to enable Adaptive Scanning. You can only enable
Adaptive Scanning when Web Reputation Filtering is enabled.

File Reputation See Enabling and Configuring File Reputation and Analysis Services,

Filtering and page 17-5.

File Analysis

DVS Engine Object Specify a maximum request/response size.

Scanning Limits The Maximum Object Size value you specify applies to the entire size of

requests and responses that might be scanned by all anti-malware and
anti-virus scanning engines and by Advanced Malware Protection features.
When an upload or download size exceeds this size, the security component
may abort the scan in progress and may not provide a scanning verdict to the
Web Proxy.

Sophos Choose whether or not to enable the Sophos scanning engine.
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Setting

Description

McAfee

Choose whether or not to enable the McAfee scanning engine.

When you enable the McAfee scanning engine, you can choose whether or not
to enable heuristic scanning.

Note  Heuristic analysis increases security protection, but can result in false
positives and decreased performance.

Webroot

Choose whether or not to enable the Webroot scanning engine.

When you enable the Webroot scanning engine, you can configure the Threat
Risk Threshold (TRT). The TRT assigns a numerical value to the probability
that malware exists.

Proprietary algorithms evaluate the result of a URL matching sequence and
assign a Threat Risk Rating (TRR). This value is associated with the threat risk
threshold setting. If the TRR value is greater than or equal to the TRT, the URL
is considered malware and is passed on for further processing.

Note  Setting the Threat Risk Threshold to a value lower than 90
dramatically increases the rate of URL blocking and denies legitimate
requests. Cisco strongly recommends maintaining the TRT default
value of 90. The minimum value for a TRT setting is 51.

Step4  Submit and Commit Changes.

Related Topics

e Understanding Adaptive Scanning, page 13-7

e McAfee Scanning, page 13-6

Configuring Anti-Malware and Reputation in Policies

When Anti-Malware and Reputation Filters are enabled on the appliance, you can configure different
settings in policy groups. You can enable monitoring or blocking for malware categories based on
malware scanning verdicts.

You can configure anti-malware settings in the following policy groups:

Policy Type Link to Task
Access Policies Anti-Malware and Reputation Settings in Access Policies,
page 13-10

Outbound Malware Scanning Policies |Controlling Upload Requests Using Outbound Malware

Scanning Policies

You can configure web reputation settings in the following policy groups:
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Policy Type Link to Task

Access Policies Anti-Malware and Reputation Settings in Access Policies,
page 13-10

Decryption Policies Configuring Web Reputation Filter Settings for Decryption

Policy Groups, page 13-13

Cisco Data Security Policies Configuring Web Reputation Filter Settings for Decryption
Policy Groups, page 13-13

You can configure Advanced Malware Protection settings only in Access Policies. See Configuring File
Reputation and Analysis Features, page 17-4.

Anti-Malware and Reputation Settings in Access Policies

~

Note

When Adaptive Scanning is enabled, the web reputation and anti-malware settings you can configure for
Access Policies are slightly different than when Adaptive Scanning is turned off.

If your deployment includes a Security Management appliance, and you are configuring this feature in
a Configuration Master, options on this page depend on whether Adaptive Security is enabled for the
relevant configuration master. Check the setting on the Security Management appliance, on the Web >
Utilities > Security Services Display page.

Related Topics
e Understanding Adaptive Scanning, page 13-7

Configuring Anti-Malware and Reputation Settings with Adaptive Scanning Enabled

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6

Choose Web Security Manager > Access Policies.
Click the Anti-Malware and Reputation link for the Access Policy you want to configure.

Under the Web Reputation and Anti-Malware Settings section, choose Define Web Reputation and
Anti-Malware Custom Settings.

This allows you to configure web reputation and anti-malware settings for this Access Policy that differ
from the global policy.

In the Web Reputation Settings section, choose whether or not to enable Web Reputation Filtering.
Adaptive Scanning chooses the most appropriate web reputation score thresholds for each web request.

Configure the settings in the Advanced Malware Protection Settings section.

Scroll down to the Cisco DVS Anti-Malware Settings section.
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Configure the anti-malware settings for the policy as necessary.

Setting Description

Enable Suspect User |Choose whether or not to scan traffic based on the user-agent field specified in
Agent Scanning the HTTP request header.

When you select this checkbox, you can choose to monitor or block suspect
user agents in the Additional Scanning section at the bottom of the page.

Note  Chrome browsers do notinclude a user-agent string in FTP-over-HTTP
requests; therefore, Chrome cannot be detected as the user agent in
those requests.

Enable Anti-Malware |Choose whether or not to use the DVS engine to scan traffic for malware.
Scanning Adaptive Scanning chooses the most appropriate engine for each web request.

Malware Categories |Choose whether to monitor or block the various malware categories based on
a malware scanning verdict.

Other Categories Choose whether to monitor or block the types of objects and responses listed
in this section.

Note  The category Outbreak Heuristics applies to transactions which are
identified as malware by Adaptive Scanning prior to running any
scanning engines.

Note URL transactions are categorized as unscannable when the configured
maximum time setting is reached or when the system experiences a
transient error condition. For example, transactions might be
categorized as unscannable during scanning engine updates or
AsyncOS upgrades. The malware scanning verdicts SV_TIMEOUT
and SV_ERROR, are considered unscannable transactions.

Submit and Commit Changes.

Related Topics
e Malware Category Descriptions, page 13-16

Configuring Anti-Malware and Reputation Settings with Adaptive Scanning Disabled

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Choose Web Security Manager > Access Policies.
Click the Anti-Malware and Reputation link for the Access Policy you want to configure.

Under the Web Reputation and Anti-Malware Settings section, choose Define Web Reputation and
Anti-Malware Custom Settings.

This allows you to configure web reputation and anti-malware settings for this Access Policy that differ
from the global policy.

Configure the settings in the Web Reputation Settings section.
Configure the settings in the Advanced Malware Protection Settings section.

Scroll down to the Cisco DVS Anti-Malware Settings section.
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Step7  Configure the anti-malware settings for the policy as necessary.

Note  When you enable Webroot, Sophos or McAfee scanning, you can choose to monitor or block some
additional categories in the Malware categories on this page

Setting Description

Enable Suspect User |Choose whether or not to enable the appliance to scan traffic based on the
Agent Scanning user-agent field specified in the HTTP request header.

When you select this checkbox, you can choose to monitor or block suspect user
agents in the Additional Scanning section at the bottom of the page.

Note  Chrome browsers do not include a user-agent string in FTP-over-HTTP
requests; therefore, Chrome cannot be detected as the user agent in
those requests.

Enable Webroot Choose whether or not to enable the appliance to use the Webroot scanning
engine when scanning traffic.

Enable Sophos or Choose whether or not to enable the appliance to use either the Sophos or

McAfee McAfee scanning engine when scanning traffic.

Malware Categories |Choose whether to monitor or block the various malware categories based on a
malware scanning verdict. The categories listed in this section depend on which
scanning engines you enable above.

Other Categories Choose whether to monitor or block the types of objects and responses listed in
this section.

Note URL transactions are categorized as unscannable when the configured
maximum time setting is reached or when the system experiences a
transient error condition. For example, transactions might be
categorized as unscannable during scanning engine updates or AsyncOS
upgrades. The malware scanning verdicts SV_TIMEOUT and
SV_ERROR, are considered unscannable transactions.

Step8  Submit and Commit Changes.

Related Topics
e Configuring Web Reputation Score Thresholds for Access Policies, page 13-13

e Malware Category Descriptions, page 13-16

Configuring Web Reputation Scores

When you install and set up the Web Security appliance, it has default settings for Web Reputation
Scores. However, you can modify threshold settings for web reputation scoring to fit your organization’s
needs.You configure the web reputation filter settings for each policy group.
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Configuring Web Reputation Score Thresholds for Access Policies

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Note

Choose Web Security Manager > Access Policies.

Click the link under the Anti-Malware and Reputation column for the Access Policy group you want to
edit.

Under the Web Reputation and Anti-Malware Settings section, choose Define Web Reputation and
Anti-Malware Custom Settings.

This allows you to configure web reputation and anti-malware settings for this Access Policy that differ
from the global policy.

Verify the Enable Web Reputation Filtering field is enabled.
Move the markers to change the range for URL block, scan, and allow actions.

Submit and Commit Changes.

You can edit the web reputation score thresholds in Access Policies when Adaptive Scanning is disabled

Configuring Web Reputation Filter Settings for Decryption Policy Groups

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Choose Web Security Manager > Decryption Policies.
Click the link under the Web Reputation column for the Decryption Policy group you want to edit.

Under the Web Reputation Settings section, choose Define Web Reputation Custom Settings. This
allows you to override the web reputation settings from the Global Policy Group.

Verify the Enable Web Reputation Filtering field is checked.
Move the markers to change the range for URL drop, decrypt, and pass through actions.

In the Sites with No Score field, choose the action to take on request for sites that have no assigned Web
Reputation Score.

Submit and Commit Changes.

Configuring Web Reputation Filter Settings for Data Security Policy Groups

Step 1
Step 2
Step 3

Step 4
Step 5

Choose Web Security Manager > Cisco IronPort Data Security.

Click the link under the Web Reputation column for the Data Security Policy group you want to edit.
Under the Web Reputation Settings section, choose Define Web Reputation Custom Settings.

This allows you to override the web reputation settings from the Global Policy Group.

Move the marker to change the range for URL block and monitor actions.

Submit and Commit Changes.
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Note  Only negative and zero values can be configured for web reputation threshold settings for Cisco IronPort
Data Security Policies. By definition, all positive scores are monitored

Maintaining the Database Tables

The web reputation, Webroot, Sophos, and McAfee databases periodically receive updates from the
Cisco IronPort update server. Server updates are automated and the update interval is set by the server.

The Web Reputation Database

The Web Security appliance maintains a filtering database that contains statistics and information about
how different types of requests are handled. The appliance can also be configured to send web reputation
statistics to a Cisco SensorBase Network server. SensorBase server information is leveraged with data
feeds from the SensorBase Network and the information is used to produce a Web Reputation Score.

Logging of Web Reputation Filtering Activity and DVS Scanning

The access log file records the information returned by the Web Reputation Filters and the DVS engine
for each transaction. The scanning verdict information section in the access logs includes many fields to
help understand the cause for the action applied to a transaction. For example, some fields display the
web reputation score or the malware scanning verdict Sophos passed to the DVS engine.

Logging Adaptive Scanning

Custom Field |Custom Field in Description
in Access Logs |W3C Logs

%X6 x-as-malware-thr |The anti-malware name returned by Adaptive Scanning. If the
eat-name transaction is not blocked, this field returns a hyphen (“-). This
variable is included in the scanning verdict information (in the
angled brackets at the end of each access log entry).

Transactions blocked and monitored by the adaptive scanning engine use the ACL decision tags:
e BLOCK_AMW_RESP
¢ MONITOR_AMW_RESP

Caching

The following guidelines explains how AsyncOS uses the cache while scanning for malware:
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e AsyncOS only caches objects if the entire object downloads. If malware is blocked during scanning,
the whole object is not downloaded and therefore is not cached.

¢ AsyncOS scans content whether it is retrieved from the server or from the web cache.
e The length of time that content is cached varies with many factors - there is no default.

e AsyncOS rescans content when signatures are updated.
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Malware Category Descriptions

Malware Type

Description

Adware Adware encompasses all software executables and plug-ins that direct users
towards products for sale. These programs may also change security settings
making it impossible for users to make changes to their system settings.

Browser Helper Object |A browser helper object is a browser plug-in that may perform a variety of

functions related to serving advertisements or hijacking user settings.

Commercial System

A commercial system monitor is a piece of software with system monitor

Monitor characteristics that can be obtained with a legitimate license through legal
means.
Dialer A dialer is a program that utilizes your modem or another type of Internet

access to connect you to a phone line or a site that causes you to accrue long
distance charges to which you did not provide your full consent.

Generic Spyware

Spyware is a type of malware installed on computers that collects small
pieces of information about users without their knowledge.

Hijacker

A hijacker modifies system settings or any unwanted changes to a user’s
system that may direct them to a website or run a program without a users
consent.

Known Malicious and
High-Risk Files

These are files that were identified as threats by the Advanced Malware
Protection file reputation service.

Other Malware

This category is used to catch all other malware and suspicious behavior that
does not exactly fit in one of the other defined categories.

Phishing URL

A phishing URL is displayed in the browser address bar. In some cases, it
involves the use of domain names and resembles those of legitimate domains.

PUA

Potentially Unwanted Application. A PUA is an application that is not
malicious, but may be considered to be undesirable.

System Monitor

A system monitor encompasses any software that performs one of the
following:

e Opvertly or covertly records system processes and/or user action.

e Makes those records available for retrieval and review at a later time.

Trojan Downloader

A trojan downloader is a Trojan that, after installation, contacts a remote
host/site and installs packages or affiliates from the remote host.

Trojan Horse

A trojan horse is a destructive program that masquerades as a benign
application. Unlike viruses, Trojan horses do not replicate themselves.

Trojan Phisher

A trojan phisher may sit on an infected computer waiting for a specific web
page to be visited or may scan the infected machine looking for user names
and passphrases.

Virus A virus is a program or piece of code that is loaded onto your computer
without your knowledge.
Worm A worm is program or algorithm that replicates itself over a computer

network and performs malicious actions.
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File Reputation Filtering and File Analysis

e Overview of File Reputation Filtering and File Analysis, page 14-1

e Configuring File Reputation and Analysis Features, page 14-5

e File Reputation and File Analysis Reporting and Tracking, page 14-11
e Taking Action When File Threat Verdicts Change, page 14-13

e Troubleshooting File Reputation and Analysis, page 14-14

Overview of File Reputation Filtering and File Analysis

Advanced Malware Protection protects against zero-day and targeted file-based threats by:
e Obtaining the reputation of known files.
e Analyzing behavior of certain files that are not yet known to the reputation service.

¢ Continuously evaluating emerging threats as new information becomes available, and notifying you
about files that are determined to be threats after they have entered your network.

These features are available only for file downloads. Uploaded files are not evaluated.

The reputation service is in the cloud. The file analysis service has options for either public- or
private-cloud (on-premises).

File Threat Verdict Updates

Threat verdicts can change as new information emerges. A file may initially be evaluated as unknown or
clean, and the user may thus be allowed to access the file. If the threat verdict changes as new
information becomes available, you will be alerted, and the file and its new verdict appear in the AMP
Verdict Updates report. You can investigate the point-of-entry transaction as a starting point to
remediating any impacts of the threat.

Verdicts can also change from malicious to clean.

When the appliance processes subsequent instances of the same file, the updated verdict is
immediately applied.

Information about the timing of verdict updates is included in the file-criteria document referenced in
Supported Files for File Reputation and Analysis Services, page 14-3.
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Related Topics
¢ File Reputation and File Analysis Reporting and Tracking, page 14-11

e Taking Action When File Threat Verdicts Change, page 14-13

File Processing Overview

First, the web site from which the file is downloaded is evaluated against the Web Based Reputation
Service (WBRS).

If the web reputation score of the site is in the range configured to “Scan,” the appliance simultaneously
scans the transaction for malware and queries the cloud-based service for the reputation of the file. (If
the site’s reputation score is in the “Block” range, the transaction is handled accordingly and there is no
need to process the file further.) If malware is found during scanning, the transaction is blocked
regardless of the reputation of the file.

If Adaptive Scanning is also enabled, file reputation evaluation and file analysis are included in
Adaptive Scanning.

Communications between the appliance and the file reputation service are encrypted and protected
from tampering.

After a file’s reputation is evaluated:

e [If the file is known to the file reputation service and is determined to be clean, the file is released to
the end user.

e If the file reputation service returns a verdict of malicious, then the appliance applies the action that
you have specified for such files.

e If the file is known to the reputation service but there is insufficient information for a definitive
verdict, the reputation service returns a threat score based on characteristics of the file such as threat
fingerprint and behavioral analysis. If this score meets or exceeds the configured reputation
threshold, the appliance applies the action that you have configured in the access policy for
malicious or high-risk files.

e If the reputation service has no information about the file, and the file does not meet the criteria for
analysis (see Supported Files for File Reputation and Analysis Services, page 14-3), the file is
considered clean and the file is released to the end user.

e If you have enabled the cloud-based File Analysis service, and the reputation service has no
information about the file, and the file meets the criteria for files that can be analyzed (see Supported
Files for File Reputation and Analysis Services, page 14-3), then the file is considered clean and is
optionally sent for analysis.

e For deployments with on-premises file analysis, the reputation evaluation and file analysis occur
simultaneously. If the reputation service returns a verdict, that verdict is used, as the reputation
service includes inputs from a wider range of sources. If the file is unknown to the reputation
service, the file is released to the user but the file analysis result is updated in the local cache and is
used to evaluate future instances of the file.

e If file reputation or file analysis verdict information is unavailable because the connection with the
service timed out, the file is considered clean and is released to the end user.
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Figure 14-1
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If the file is sent for analysis:
e If the file is sent to the cloud for analysis: Files are sent over HTTPS.
e Analysis normally takes minutes, but may take longer.

e A file that is flagged as malicious after File Analysis may not be identified as malicious by the
reputation service. File reputation is determined by a variety of factors over time, not necessarily by
a single file analysis verdict.

e Results for files analyzed using an on premises Cisco AMP Threat Grid appliance are cached locally.

For information about verdict updates, see File Threat Verdict Updates, page 14-1.

Supported Files for File Reputation and Analysis Services

The reputation service evaluates most file types. File type identification is determined by file content and
is not dependent on the filename extension.

Some files with unknown reputation can be analyzed for threat characteristics. When you configure the
file analysis feature, you choose which file types are analyzed. New types can be added dynamically;
you will receive an alert when the list of uploadable file types changes, and can select added file types
to upload.

Details about what files are supported by the reputation and analysis services are available only to
registered Cisco customers. For information about which files are evaluated and analyzed, see File
Criteria for Advanced Malware Protection Services for Cisco Content Security Products, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-user-guide-list.html.
The criteria for evaluating a file’s reputation and for sending files for analysis may change at any time.

In order to access this document, you must have a Cisco customer account with a support contract. To
register, visit https://tools.cisco.com/RPF/register/register.do.

Your setting for DVS Engine Object Scanning Limits on the Security Services > Anti-Malware and
Reputation page also determines the maximum file size for file reputation and analysis.
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You should configure policies to block download of files that are not addressed by Advanced Malware
Protection.

Note A file that has already been uploaded for analysis from any source will not be uploaded again. To view
analysis results for such a file, search for the SHA-256 from the File Analysis reporting page.

Related Topics

Enabling and Configuring File Reputation and Analysis Services, page 14-7
Ensuring That You Receive Alerts About Advanced Malware Protection Issues, page 14-10

Archive or Compressed File Processing, page 14-4

Archive or Compressed File Processing

If the file is compressed or archived,

Reputation of the compressed or archive file is evaluated.

The compressed or archive file is decompressed and reputations of all the extracted files are
evaluated.

For information about which archived and compressed files are examined, including file formats, see the
information linked from Supported Files for File Reputation and Analysis Services, page 14-3.

In this scenario,

S

Note

If one of the extracted files is malicious, the file reputation service returns a verdict of Malicious for
the compressed or the archive file.

If the compressed or archive file is malicious and all the extracted files are clean, the file reputation
service returns a verdict of Malicious for the compressed or the archive file.

If the verdict of any of the extracted files is unknown, the extracted files are optionally (if configured
and the file type is supported for file analysis) sent for file analysis.

If the extraction of a file fails while decompressing a compressed or an archive file, the file
reputation service returns a verdict of Unscannable for the compressed or the archive file. Keep in
mind that, in this scenario, if one of the extracted files is malicious, the file reputation service returns
a verdict of Malicious for the compressed or the archive file (Malicious verdict takes precedence
over Unscannable verdict).

Reputation of the extracted files with safe MIME types, for example, text/plain, are not
evaluated.

Privacy of Information Sent to the Cloud

Only the SHA that uniquely identifies a file is sent to the reputation service in the cloud. The file
itself is not sent.

If you are using the file analysis service in the cloud and a file qualifies for analysis, the file itself
is sent to the cloud.
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¢ Information about every file that is sent to the cloud for analysis and has a verdict of "malicious" is
added to the reputation database. This information is used along with other data to determine a
reputation score.

Information about files analyzed by an on premises Cisco AMP Threat Grid appliance is not shared
with the reputation service.

Configuring File Reputation and Analysis Features

e Requirements for Communication with File Reputation and Analysis Services, page 14-5

¢ Configuring an On-Premises File Analysis Server, page 14-6

e Enabling and Configuring File Reputation and Analysis Services, page 14-7

e (Public Cloud File Analysis Services Only) Configuring Appliance Groups, page 14-9

e Configuring File Reputation and Analysis Service Action Per Access Policy, page 14-10

e Ensuring That You Receive Alerts About Advanced Malware Protection Issues, page 14-10

e Configuring Centralized Reporting for Advanced Malware Protection Features, page 14-11

Requirements for Communication with File Reputation and Analysis Services

e All Web Security appliances that use these services must be able to connect to them directly over
the internet (excluding File Analysis services configured to use an on-premises Cisco AMP Threat
Grid Appliance.)

¢ By default, communication with file reputation and analysis services is routed through the
Management port (M1) on the appliance. If your appliance does not route data through the
management port, see Routing Traffic to File Reputation and File Analysis Servers Through a Data
Interface, page 14-6.

¢ The following firewall ports must be open:

Firewall Appliance

Ports Description Protocol |In/Out |Hostname Interface

32137 Access to cloud services TCP Out As configured in Security Services > Management,

(default) |for obtaining file Anti-Malware and Reputation, Advanced unless a static

or 443  |reputation. section: Advanced Settings for File Reputation, |route is
Cloud Server Pool parameter. configured to

443 Access to cloud services TCP Out As configured in Security Services > rout§ this

for file analysis. Anti-Malware and Reputation, Advanced traffic through

section: Advanced Settings for File Analysis. a data port.

e When you configure the file reputation feature, choose whether to use SSL over port 443.

Related Topics
¢ Enabling and Configuring File Reputation and Analysis Services, page 14-7
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Routing Traffic to File Reputation and File Analysis Servers Through a Data Interface

If the appliance is configured to restrict the management port to appliance management services only
(on the Network > Interfaces page), configure the appliance to route file reputation and analysis traffic
through the data port instead.

Add routes for data traffic on the Network > Routes page. For general requirements and instructions, see
Configuring TCP/IP Traffic Routes, page 2-19.

For Connection To Destination Network Gateway

The file reputation service |Host name of the Cloud Server Pool, as  |IP address of the gateway for

configured in Security Services > the data port
Anti-Malware and Reputation, Advanced
section: Advanced Settings for File
Reputation.

The file analysis service |Host name of the File Analysis Server, as |IP address of the gateway for

configured in Security Services > the data port
Anti-Malware and Reputation, Advanced
section: Advanced Settings for File
Analysis.

Related Topics

Configuring TCP/IP Traffic Routes, page 2-19

Configuring an On-Premises File Analysis Server

If you will use a Cisco AMP Threat Grid Appliance as a private-cloud file analysis server:

Obtain the Cisco AMP Threat Grid Appliance Setup and Configuration Guide and the Cisco AMP
Threat Grid Appliance Administration Guide. Cisco AMP Threat Grid Appliance documentation is
available from
http://www.cisco.com/c/en/us/support/security/amp-threat-grid-appliances/tsd-products-support-se
ries-home.html.

Use this documentation to perform the tasks described in this topic.
Additional documentation is available from the Help link in the AMP Threat Grid appliance.

In the Administration Guide, search for information about all of the following: integrations with
other Cisco appliances, CSA, Cisco Sandbox API, WSA, and Web Security Appliances.

Set up and configure the Cisco AMP Threat Grid Appliance.

If necessary, update your Cisco AMP Threat Grid Appliance software to version 1.2.1, which
supports integration with Cisco Web Security appliances.

See the AMP Thread Grid documentation for instructions for determining the version number and
for performing the update.

Ensure that your appliances can communicate with each other over your network. Cisco Web
Security appliances must be able to connect to the CLEAN interface of the AMP Threat Grid
appliance.
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e If you will deploy a self-signed certificate: Generate a self-signed SSL certificate from the Cisco
AMP Threat Grid appliance to be used on your Web Security appliance. See instructions for
downloading SSL certificates and keys in the administrator’s guide for your AMP Threat Grid
appliance. Be sure to generate a certificate that has the hostname of your AMP Threat Grid appliance
as CN. The default certificate from the AMP Threat Grid appliance does NOT work.

e Registration of your Web Security appliance with your Threat Grid appliance occurs automatically
when you submit the configuration for File Analysis, as described in Enabling and Configuring File
Reputation and Analysis Services, page 14-7. However, you must activate the registration as
described in the same procedure.

Enabling and Configuring File Reputation and Analysis Services

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Before You Begin
e Acquire feature keys for the file reputation service and the file analysis service.

e Meet the Requirements for Communication with File Reputation and Analysis Services, page 14-5.

e Ensure that a Data network interface is enabled on the appliance if you want to use a Data network
interface for File Reputation and Analysis services. See Enabling or Changing Network Interfaces,
page 2-15.

e Verify connectivity to the update servers configured in Configuring Upgrade and Service Update
Settings, page 22-31.

e If you will use a Cisco AMP Threat Grid Appliance as a private cloud file analysis server, see
Configuring an On-Premises File Analysis Server, page 14-6.

Select Security Services > Anti-Malware and Reputation .

Click Edit Global Settings.

In the Advanced Malware Protection Services section, select Enable File Reputation Filtering.
Accept the license agreement if presented.

In the Advanced Malware Protection Services section, select Enable File Analysis.

In the File Analysis section, select the file types to send to the cloud for analysis.

Adjust the following Advanced Settings for File Reputation as needed:

Option Description

Routing Table The routing table (associated with an appliance network
interface type, either Management or Data) to be used for
Advanced Malware Protection services. If the appliance
has both the Management interface and one or more Data
interfaces enabled, you can select Management or Data.
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Option

Description

SSL Communication for File Reputation

Check Use SSL (Port 443) to communicate on port 443
instead of the default port, 32137.

This option also allows you to configure an upstream proxy
for communication with the file reputation service.

Note  SSL communication over port 32137 may require
you to open that port in your firewall.

Reputation Threshold
e Use value from Cloud Service

e Enter custom value

The upper limit for acceptable file reputation scores.
Scores above this threshold indicate the file is infected.

A

Note Do not change any other settings in this section without guidance from Cisco support.

Step8  If you will use the cloud service for file analysis:

a. Select Advanced Settings for File Analysis.

b. Choose the cloud server that is physically nearest to your Web Security appliances.

Newly available servers will be added to this list periodically using standard update processes.

Step9  If you will use an on-premises Cisco AMP Threat Grid appliance for file analysis:

Configure Advanced Settings for File Analysis:

Option Description

File Analysis |Select Private cloud.

Server URL

Server URL of the on-premises Cisco AMP Threat Grid Appliance. Use the hostname, not the
IP address, for this value and for the certificate.

Certificate Upload a self-signed certificate that you have generated from your on-premises

certificate again.

Cisco AMP Threat Grid Appliance.

The most recently uploaded self-signed certificate is used. It is not possible to access a
certificate uploaded prior to the most recent certificate; if needed, upload the desired

Step 10
Step 11

Submit and commit your changes.

on the AMP Threat Grid appliance.

If you are using an on-premises Cisco AMP Threat Grid appliance, activate the account for this appliance

Complete instructions for activating the "user" account are available in the AMP Threat Grid

documentation.

a. Note the File Analysis Client ID that appears at the bottom of the section. This identifies the "user"

that you will activate.

b. Sign in to the AMP Threat Grid appliance.

c. Select Welcome... > Manage Users and navigate to User Details.
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d. Locate the "user" account based on the File Analysis Client ID of your Web Security appliance.

e. Activate this "user" account for your appliance.

(Public Cloud File Analysis Services Only) Configuring Appliance Groups

In order to allow all content security appliances in your organization to view file analysis result details
in the cloud for files sent for analysis from any appliance in your organization, you need to join all
appliances to the same appliance group.

Step1  Select Security Services > Anti-Malware and Reputation .

Step2  In the Appliance Grouping for File Analysis Cloud Reporting section, enter the File Analysis Cloud
Reporting Group ID.

e If you enter the Group ID incorrectly or need to change it for any other reason, you must open a case
with Cisco TAC.

¢ This change takes effect immediately; it does not require a Commit.

e This value must be identical on all appliances that will share data about files that are uploaded for
analysis.

e Itis suggested to use your CCOID for this value. However, this entry is not validated for accuracy.
e This value is case-sensitive.

e All appliances in the group must be configured to use the same File Analysis server in the cloud.
e An appliance can belong to only one group.

¢ You can add a machine to a group at any time, but you can do it only once.

Step3  Click Add Appliance to Group.

Which Appliances Are In the Analysis Group?

Step 1 Select Security Services > Anti-Malware and Reputation .
Step2  Inthe Appliance Grouping for File Analysis Cloud Reporting section, click View Appliances in Group.

Step3  To view the File Analysis Client ID of a particular appliance, look in the following location:
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Appliance Location of File Analysis Client ID

Email Security Advanced Settings for File Analysis section

appliance on the Security Services > File Reputation and Analysis page.

Web Security Advanced Settings for File Analysis section

appliance on the Security Services > Anti-Malware and Reputation page.
Security Management |At the bottom of the Management Appliance > Centralized Services >
appliance Security Appliances page.

Configuring File Reputation and Analysis Service Action Per Access Policy

Step 1 Select Web Security Manager > Access Policies.
Step2  Click the link in the Anti-Malware and Reputation column for a policy in the table.

Step3  In the Advanced Malware Protection Settings section, select Enable File Reputation Filtering and
File Analysis.

If File Analysis is not enabled globally, only File Reputation Filtering is offered.
Step4  Select an action for Known Malicious and High-Risk Files: Monitor or Block.
The default is Monitor.

Step5  Submit and commit your changes.

Ensuring That You Receive Alerts About Advanced Malware Protection Issues

Ensure that the appliance is configured to send you alerts related to Advanced Malware Protection.

You will receive alerts when:

Alert Description Type Severity
Feature keys expire (As is standard for all features)
The file reputation or file analysis service is unreachable. |Anti-Malware Warning
Communication with cloud services is established. Anti-Malware Info

A file reputation verdict changes. Anti-Malware Info
File types that can be sent for analysis have changed. You |Anti-Malware Info
may want to enable upload of new file types.
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Alert Description Type Severity
Analysis of some file types is temporarily unavailable. Anti-Malware Warning
Analysis of all supported file types is restored after a Anti-Malware Info
temporary outage.

Related Topics
e Several Alerts About Failure to Connect to File Reputation or File Analysis Servers, page 14-14

e Taking Action When File Threat Verdicts Change, page 14-13

Configuring Centralized Reporting for Advanced Malware Protection Features

If you will centralize reporting on a Security Management appliance, see important configuration
requirements in the Advanced Malware Protection sections in the web reporting chapter of the online
help or user guide for your management appliance.

File Reputation and File Analysis Reporting and Tracking

e Identifying Files by SHA-256 Hash, page 14-11

e File Reputation and File Analysis Report Pages, page 14-12

e Viewing File Reputation Filtering Data in Other Reports, page 14-13

e About Web Tracking and Advanced Malware Protection Features, page 14-13

Identifying Files by SHA-256 Hash

Because filenames can easily be changed, the appliance generates an identifier for each file using a
Secure Hash Algorithm (SHA-256). If an appliance processes the same file with different names, all
instances are recognized as the same SHA-256. If multiple appliances process the same file, all instances
of the file have the same SHA-256 identifier.

In most reports, files are listed by their SHA-256 value (in an abbreviated format). To identify the
filenames associated with a malware instance in your organization, select Reporting >

Advanced Malware Protection and click an SHA-256 link in the table. The details page shows associated
filenames.
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File Reputation and File Analysis Report Pages

Report Description
Advanced Malware Shows file-based threats that were identified by the file reputation service.
Protection

To see the users who tried to access each SHA, and the filenames associated
with that SHA-256, click a SHA-256 in the table.

Clicking the link at the bottom of Malware Threat File Details report page
displays all instances of the file in Web Tracking that were encountered
within the maximum available time range, regardless of the time range
selected for the report.

For files with changed verdicts, see the AMP Verdict updates report. Those
verdicts are not reflected in the Advanced Malware Protection report.

Note If one of the extracted files from a compressed or an archive file is
malicious, only SHA value of the compressed or archive file is
included in the Advanced Malware Protection report.

File Analysis Displays the time and verdict (or interim verdict) for each file sent for
analysis.

Files that are whitelisted on the Cisco AMP Threat Grid appliance show as
"clean." For information about whitelisting, see the AMP Threat Grid online
help.

To view more than 1000 File Analysis results, export the data as a .csv file.

Drill down to view detailed analysis results, including the threat
characteristics and score for each file.

You can also view additional details about an SHA directly on the AMP
Threat Grid appliance or cloud server that performed the analysis by
searching for the SHA or by clicking the Cisco AMP Threat Grid link at the
bottom of the file analysis details page.

Note If extracted files from a compressed or an archive file are sent for file
analysis, only SHA values of these extracted files are included in the
File Analysis report.

AMP Verdict Updates |Lists the files processed by this appliance for which the verdict has changed
since the transaction was processed. For information about this situation, see
File Threat Verdict Updates, page 14-1.

To view more than 1000 verdict updates, export the data as a .csv file.

In the case of multiple verdict changes for a single SHA-256, this report
shows only the latest verdict, not the verdict history.

Clicking an SHA-256 link displays web tracking results for all transactions
that included this SHA-256 within the maximum available time range,
regardless of the time range selected for the report.

To view all affected transactions for a particular SHA-256 within the
maximum available time range (regardless of the time range selected for the
report) click the link at the bottom of the Malware Threat Files page.
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Viewing File Reputation Filtering Data in Other Reports

Data for file reputation and analysis is available in other reports where relevant. A "Blocked by
Advanced Malware Protection" column may be hidden by default in applicable reports. To display
additional columns, click the Columns link below the table.

The Report by User Location includes an Advanced Malware Protection tab.

About Web Tracking and Advanced Malware Protection Features

When searching for file threat information in Web Tracking, keep the following points in mind:

To search for malicious files found by the file reputation service, select Known Malicious and
High-Risk Files for the Filter by Malware Category option in the Malware Threat area in the
Advanced section in Web Tracking.

Web Tracking includes only information about file reputation processing and the original file
reputation verdicts returned at the time a transaction was processed. For example, if a file was
initially found to be clean, then a verdict update found the file to be malicious, only the clean verdict
appears in Tracking results.

"Block - AMP" in search results means the transaction was blocked because of the file's reputation
verdict.

In Tracking details, the "AMP Threat Score" is the best-effort score that the cloud reputation service
provides when it cannot determine a clear verdict for the file. In this situation, the score is between
1 and 100. (Ignore the AMP Threat Score if an AMP Verdict is returned or if the score is zero.) The
appliance compares this score to the threshold score (configured on the Security Services >
Anti-Malware and Reputation page) to determine what action to take. By default, files with scores
between 60 and 100 are considered malicious. Cisco does not recommend changing the default
threshold score. The WBRS score is the reputation of the site from which the file was downloaded;
this score is not related to the file reputation.

Verdict updates are available only in the AMP Verdict Updates report. The original transaction
details in Web Tracking are not updated with verdict changes. To see transactions involving a
particular file , click a SHA-256 in the verdict updates report.

Information about File Analysis, including analysis results and whether or not a file was sent for
analysis, are available only in the File Analysis report.

Additional information about an analyzed file may be available from the cloud or on-premises File
Analysis server. To view any available File Analysis information for a file, select Reporting > File
Analysis and enter the SHA-256 to search for the file, or click the SHA-256 link in Web Tracking
details. If the File Analysis service has analyzed the file from any source, you can see the details.
Results are displayed only for files that have been analyzed.

If the appliance processed a subsequent instance of a file that was sent for analysis, those instances
will appear in Web Tracking search results.

Taking Action When File Threat Verdicts Change

Step 1 View the AMP Verdict Updates report.

Step2  Click the relevant SHA-256 link to view web tracking data for all transactions involving that file that
end users were allowed to access.
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Step3  Using the tracking data, identify the users that may have been compromised, as well as information such
as the file names involved in the breach and the web site from which the file was downloaded.

Step4  Check the File Analysis report to see if this SHA-256 was sent for analysis, to understand the threat
behavior of the file in more detail.

Related Topics
e File Threat Verdict Updates, page 14-1

Troubleshooting File Reputation and Analysis

e Log Files, page 14-14

e Several Alerts About Failure to Connect to File Reputation or File Analysis Servers, page 14-14
e API Key Error (On-Premises File Analysis), page 14-15

e Files are Not Uploaded As Expected, page 14-15

¢ File Analysis Details in the Cloud Are Incomplete, page 14-15

e Alerts about File Types That Can Be Sent for Analysis, page 14-16

Log Files

In logs:
e awmp and amp refer to the file reputation service or engine.
® Retrospective refers to verdict updates.
e vrT and sandboxing refer to the file analysis service.

Information about Advanced Malware Protection including File Analysis is logged in Access Logs or in
AMP Engine Logs. For more information, see the chapter on monitoring system activity through logs.

In the log message "Response received for file reputation query" possible values for "upload action" are:
e 0: The file is known to the reputation service; do not send for analysis.
e 1:Send

e 2: The file is known to the reputation service; do not send for analysis.

Several Alerts About Failure to Connect to File Reputation or File Analysis
Servers

Problem You receive several alerts about failures to connect to the file reputation or analysis services in
the cloud. (A single alert may indicate only a transient issue.)

Solution

¢ Ensure that you have met the requirements in Requirements for Communication with File
Reputation and Analysis Services, page 14-5.
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e Check for network issues that may prevent the appliance from communicating with the cloud
services.

e Increase the Query Timeout value:

Select Security Services > Anti-Malware and Reputation . The Query Timeout value is in the
Advanced settings area of the Advanced Malware Protection Services section.

API Key Error (On-Premises File Analysis)

Problem You receive an API key alert when attempting to view File Analysis report details, or the Web
Security appliance is unable to connect to the AMP Threat Grid server to upload files for analysis.

Solution This error can occur if you change the hostname of the AMP Threat Grid server and you are
using a self-signed certificate from the AMP Threat Grid server, as well as possibly under other
circumstances. To resolve the issue:

e Generate a new certificate from the AMP Threat Grid appliance that has the new hostname.
e Upload the new certificate to the Web Security appliance.

¢ Reset the API key on the AMP Threat Grid appliance. For instructions, see the online help on the
AMP Threat Grid appliance.

Related Topics
e Enabling and Configuring File Reputation and Analysis Services, page 14-7

Files are Not Uploaded As Expected

Problem Files are not evaluated or analyzed as expected. There is no alert or obvious error.

Problem Consider the following:

e The file may have been sent for analysis by another appliance and thus already be present on the File
Analysis server or in the cache of the appliance that is processing the file.

¢ Check the maximum file size limit configured for the DVS Engine Object Scanning Limits on the
Security Services > Anti-Malware and Reputation page. This limit applies to Advanced Malware
Protection features.

File Analysis Details in the Cloud Are Incomplete

Problem Complete file analysis results in the public cloud are not available for files uploaded from other
Web Security appliances in my organization.

Solution Be sure to group all appliances that will share file analysis result data. See (Public Cloud File
Analysis Services Only) Configuring Appliance Groups, page 14-9. This configuration must be done on
each appliance in the group.
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Alerts about File Types That Can Be Sent for Analysis

Problem You receive alerts of severity Info about file types that can be sent for file analysis.

Solution This alert is sent when supported file types change, or when the appliance checks to see what
file types are supported. This can occur when:

* You or another administrator changes the file types selected for analysis.

e Supported file types change temporarily based on availability in the cloud service. In this case,
support for the file types selected on the appliance will be restored as soon as possible. Both
processes are dynamic and do not require any action from you.

e The appliance restarts, for example as part of an AsyncOS upgrade.
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Managing Access to Web Applications

Overview of Managing Access to Web Applications, page 15-1
Enabling the AVC Engine, page 15-2

Policy Application Control Settings, page 15-3

Controlling Bandwidth, page 15-5

Controlling Instant Messaging Traffic, page 15-8

Viewing AVC Activity, page 15-8

Overview of Managing Access to Web Applications

The Application Visibility and Control (AVC) engine lets you create policies to control application
activity on the network without having to fully understand the underlying technology of each
application. You can configure application control settings in Access Policy groups. You can block or
allow applications individually or according to application type. You can also apply controls to particular
application types.

Using Access Policies you can:

Control application behaviors

Control the amount of bandwidth used for particular application types

Notify end-users when they are blocked

Assign controls to Instant Messaging, Blogging and Social Media applications

Specify Range Request settings

To control applications using the AVC engine, perform the following tasks:

Task Link to Task
Enable the AVC engine Enabling the AVC Engine, page 15-2
Set Controls in an Access Policy Group Configuring Application Control Settings in an Access

Policy Group, page 15-5

Limit bandwidth consumed by some Controlling Bandwidth, page 15-5

application types to control congestion

Allow instant messaging traffic, but disallow  |Controlling Instant Messaging Traffic, page 15-8

file sharing using instant messenger
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Enabling the AVC Engine

S

Note

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Enable the AVC engine when you enable the Acceptable Use Controls.

You can view the AVC engine scanning activity in the Application Visibility report on the Reporting >
Application Visibility page.

Choose Security Services > Acceptable Use Controls.
Click Enable or Edit Global Settings, depending on the current status of the Acceptable Use Controls.
Be sure Enable Cisco Web Usage Controls is checked.

In the Acceptable Use Controls Service panel, select Cisco Web Usage Controls, and then select Enable
Application Visibility and Control.

Select the Default Action for Unreachable Service: Monitor or Block.

Submit and Commit Changes.

Related Topics
¢ AVC Engine Updates and Default Actions, page 15-2

e User Experience When Requests Are Blocked by the AVC Engine, page 15-3

AVC Engine Updates and Default Actions

Note

AsyncOS periodically queries the update servers for new updates to all security service components,
including the AVC engine. AVC engine updates can include support for new application types and
applications, as well as updated support for existing applications if any application behaviors change.
By updating the AVC engine between AsyncOS version updates, the Web Security appliance remains
flexible without requiring a server upgrade.

AsyncOS for Web assigns the following default actions for the Global Access Policy:
e New Application Types default to Monitor.

e New application behaviors, such as block file transfer within a particular application; defaults
to Monitor.

e New applications for an existing application type default to the Application Type’s default.

In the Global Access Policy, you can set the default action for each Application Type, so new
applications introduced in an AVC engine update automatically inherit the specified default action. See
Configuring Application Control Settings in an Access Policy Group, page 15-5.
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User Experience When Requests Are Blocked by the AVC Engine

When the AVC engine blocks a transaction, the Web Proxy sends a block page to the end user. However,
not all Websites display the block page to the end user; many Websites display dynamic content using
JavaScript instead of a static Webpage and are not likely to display the block page. Users are still properly
blocked from downloading malicious data, but they may not always be informed of this by the Website.

Policy Application Control Settings

Controlling applications involves configuring the following elements:

Option Description

Application Types A category that contains one or more applications.

Applications Particular applications within an Application Type.

Application behaviors Particular actions or behaviors that users can do within an application
that administrators can control. Not all applications include behaviors
you can configure.

You can configure application control settings in Access Policy groups. On the Web Security Manager
> Access Policies page, click the Applications link for the policy group you want to configure. When
configuring applications, you can choose the following actions:

Option Description

Block This action is a final action. Users are prevented from viewing a webpage and
instead an end-user notification page displays

Monitor This action is an intermediary action. The Web Proxy continues comparing the
transaction to the other control settings to determine which final action to apply

Restrict This action indicates that an application behavior is blocked. For example, when
you block file transfers for a particular instant messaging application, the action
for that application is Restrict.

Bandwidth Limit For certain applications, such as Media and Facebook, you can limit the
bandwidth available for Web traffic. You can limit bandwidth for the application
itself, and for its users.

Related Topics
e Range Request Settings, page 15-3
e Rules and Guidelines for Configuring Application Control, page 15-4

Range Request Settings

When HTTP range requests are disabled and a large file is downloaded over multiple streams, the
consolidated package is scanned. This disables the performance advantages of download-management
utilities and applications that are used to download large objects.
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Alternatively, when Range Request Forwarding is enabled (see Configuring Web Proxy Settings,
page 4-3), you can control how incoming range requests are handled on a per-policy basis. This process
is known as “byte serving” and is a means of bandwidth optimization when requesting large files.

However, enabling range request forwarding can interfere with policy-based Application Visibility and
Control (AVC) efficiency, and can compromise security. Please exercise caution and enable HTTP Range
Request Forwarding only if the advantages outweigh the security implications.

Note  The Range Request Settings are read-only when Range Request Forwarding is not enabled. and also
when it is enabled but all applications are set to Monitor. The settings are available when at least one
application is set to Block, Restrict, or Throttle.

Range Request Settings for Policy

Range Request ¢ Do not forward range requests — Any request for a portion of a file is not
Settings forwarded; the entire file is returned.

e Forward range requests — If the requested range is valid, it is forwarded
and the target server will return the only requested portion of the desired file.

Exception list You can specify traffic destinations which are exempt from the current

forwarding selection. That is, when Do not forward range requests is selected,
you can specify destinations for which requests are forwarded. Similarly, when
Forward range requests is selected, you can specify destinations for which
requests are not forwarded.

Rules and Guidelines for Configuring Application Control

Consider the following rules and guidelines when configuring application control settings:

The supported Application Types, applications, and application behaviors may change between
AsyncOS for Web upgrades, or after AVC engine updates.

In Application Type listings, the summary for each Application Type lists the final actions for its
applications, but does not indicate whether these actions are inherited from the global policy or
configured in the current Access Policy. To learn more about the action for a particular application,
expand the application type.

In the Global Access Policy, you can set the default action for each Application Type, so new
applications introduced in an AVC engine update automatically inherit the default action.

You can quickly configure the same action for all applications in an application type by clicking the
“edit all” link for the Application Type in Browse view. However, you can only configure the
application action, not application behavior actions. To configure application behaviors, you must
edit the application individually.

In Search view, when you sort the table by the action column, the sort order is by the final action.
For example, “Use Global (Block)” comes after “Block™ in the sort order.

Decryption may cause some applications to fail unless the root certificate for signing is installed on
the client.

Related Topics

Configuring Application Control Settings in an Access Policy Group, page 15-5
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e Configuring Overall Bandwidth Limits, page 15-6
e Viewing AVC Activity, page 15-8

Configuring Application Control Settings in an Access Policy Group

Step1  Choose Web Security Manager > Access Policies.
Step2  Click the link in the Policies table under the Applications column for the policy group you want to edit.
Step3  When configuring the Global Access Policy:

a. Define the default action for each Application Type in the Default Actions for Application
Types section.

b. You can edit the default actions for each Application Type’s individual members, as a group or
individually, in the Edit Applications Settings section of the page. Editing the default action for
individual applications is described in the following steps.

Step4  When configuring a user defined Access Policy, choose Define Applications Custom Settings in the
Edit Applications Settings section.

Step5  In the Application Settings area, choose Browse view or Search view from the drop-down menu:

¢ Browse view. You can browse Application Types. You can use Browse view to configure all
applications of a particular type at the same time. When an Application Type is collapsed in Browse
view, the summary for the Application Type lists the final actions for its applications; however it
does not indicate whether the actions are inherited from the global policy, or configured in the
current Access Policy.

¢ Search view. You can search for applications by name. You might use Search view when the total
list of applications is long and you need to quickly find and configure a particular application.

Step6  Configure the action for each application and application behavior.
Step7  Configure the bandwidth controls for each applicable application.
Step8  Submit and Commit Changes.

Related Topics
¢ Controlling Bandwidth, page 15-5

Controlling Bandwidth

When both the overall limit and user limit applies to a transaction, the most restrictive option applies.
You can define bandwidth limits for particular URL categories by defining an Identity group for a URL
category and using it in an Access Policy that restricts the bandwidth.

You can define the following bandwidth limits:
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Bandwidth |Description Link to

limit Task

Overall Define an overall limit for all users on the network for the Configuring Overall
supported application types. The overall bandwidth limit Bandwidth Limits,

affects the traffic between the Web Security appliance and web |page 15-6
servers. It does not limit traffic served from the web cache.

User Define a limit for particular users on the network per Configuring User
application type. User bandwidth limits traffic from web Bandwidth Limits,
servers as well as traffic served from the web cache. page 15-6

Note  Defining bandwidth limits only throttles the data going to users. It does not block data based on reaching
a quota. The Web Proxy introduces latency into each application transaction to mimic a slower link to
the server.

Configuring Overall Bandwidth Limits

Step 1 Choose Web Security Manager > Overall Bandwidth Limits

Step2  Click Edit Settings.

Step3  Select the Limit to option.

Stepd  Enter the amount of traffic to limit in either Megabits per second (Mbps) or kilobits per second (kbps).
Step5  Submit and Commit Changes.

Configuring User Bandwidth Limits

You can define user bandwidth limits by configuring bandwidth control settings on the Applications
Visibility and Control page of Access Policies. You can define the following types of bandwidth controls
for users in Access Policies:

Option Description Link to task

Default bandwidth limit  |In the Global Access Policy, you can Configuring the Default
for an application type define the default bandwidth limit for all |Bandwidth Limit for an
applications of an application type. Application Type, page 15-7
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Option Description Link to task
Bandwidth limit for an In a user defined Access Policy, you can |Overriding the Default
application type override the default bandwidth limit for |Bandwidth Limit for an
the application type defined in the Application Type, page 15-7
Global Access Policy.
Bandwidth limit for an In a user defined or Global Access Configuring Bandwidth
application Policy, you can choose to apply the Controls for an Application,

application type bandwidth limit or no |page 15-7
limit (exempt the application type limit).

Configuring the Default Bandwidth Limit for an Application Type

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6

Choose Web Security Manager > Access Policies.
Click the link in the policies table under the Applications column for the Global Access Policy.

In the Default Actions for Application Types section, click the link next to “Bandwidth Limit” for the
application type you want to edit.

Select Set Bandwidth Limit and enter the amount of traffic to limit in either Megabits per second
(Mbps) or kilobits per second (kbps).

Click Apply.

Submit and Commit Changes.

Overriding the Default Bandwidth Limit for an Application Type

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

You can override the default bandwidth limit defined at the Global Access Policy group in the user
defined Access Policies. You can only do this in Browse view.

Choose Web Security Manager > Access Policies.

Click the link in the policies table under the Applications column for the user defined policy group you
want to edit.

Choose Define Applications Custom Settings in the Edit Applications Settings section.
Click the link next to “Bandwidth Limit” for the application type you want to edit.

To choose a different bandwidth limit value, select Set Bandwidth Limit and enter the amount of traffic
to limit in either Megabits per second (Mbps) or kilobits per second (kbps). To specify no bandwidth
limit, select No Bandwidth Limit for Application Type.

Click Apply.

Submit and Commit Changes.

Configuring Bandwidth Controls for an Application

Step 1

Choose Web Security Manager > Access Policies.
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Step 2
Step 3
Step 4
Step 5

Note

Step 6
Step 7

Click the link in the policies table under the Applications column for the policy group you want to edit.
Expand the application type that contains the application you want to define.
Click the link for the application you want to configure.

Select Monitor, and then choose to use either the bandwidth limit defined for the application type or no
limit.

The bandwidth limit setting is not applicable when the application is blocked or when no bandwidth limit
is defined for the application type.

Click Done.

Submit and Commit Changes.

Controlling Instant Messaging Traffic

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

You can block or monitor the IM traffic, and depending on the IM service, you can block particular
activities (also known as application behaviors) in an IM session.

Choose Web Security Manager > Access Policies.

Click the link in the policies table under the Applications column for the policy group you want to edit.
Click Define Applications Custom Setting.

Expand the Instant Messaging application type.

Click the link next to the IM application you want to configure.

To block all traffic for this IM application, select Block.

To monitor the IM application, but block particular activities within the application, select Monitor, and
then select the application behavior to Block.

Click Done.

Submit and Commit Changes.

Viewing AVC Activity

The Reporting > Application Visibility page displays information about the top applications and
application types used. It also displays the top applications and application types blocked.
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AVC Information in Access Log File

Viewing AVC Activity

The access log file records the information returned by the Application Visibility and Control engine
for each transaction. The scanning verdict information section in the access logs includes the fields

listed below:

Description Custom Field in Access Logs Custom Field in W3C Logs
Application name % X0 X-avc-app

Application type %0 Xu X-ave-type

Application behavior %Xb x-avc-behavior
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Prevent Loss of Sensitive Data

e Overview of Data Security and External DLP Policies, page 13-1

e Managing Upload Requests, page 13-2

e Managing Upload Requests on an External DLP System, page 16-3

e Evaluating Data Security and External DLP Policy Group Membership, page 16-4
e Creating Data Security and External DLP Policies, page 16-5

e Managing Settings for Upload Requests, page 16-7

e Defining External DLP Systems, page 16-9

e Controlling Upload Requests Using External DLP Policies, page 16-11

e Logging of Data Loss Prevention Scanning, page 16-12

Overview of Prevent Loss of Sensitive Data

The Web Security appliance secures your data by providing the following capabilities:

Option Description

Cisco IronPort Data Security |The Cisco IronPort Data Security Filters on the Web Security appliance
Filters evaluate data leaving the network over HTTP, HTTPS and FTP.

Third party data loss The Web Security appliance integrates with leading third party

prevention (DLP) integration |content-aware DLP systems that identify and protect sensitive data. The
Web Proxy uses the Internet Content Adaptation Protocol (ICAP) which
allows proxy servers to offload content scanning to external systems

When the Web Proxy receives an upload request, it compares the request to the Data Security and
External DLP Policy groups to determine which policy group to apply. If both types of policies are
configured, it compares the request to Cisco IronPort Data Security Policies before external DLP
Policies. After it assigns the request to a policy group, it compares the request to the policy group’s
configured control settings to determine what to do with the request. How you configure the appliance
to handle upload requests depends on the policy group type.

Note  Upload requests that try to upload files with a size of zero (0) bytes are not evaluated against Cisco
IronPort Data Security or External DLP Policies.
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Bl Managing Upload Requests

To restrict and control data that is leaving the network, you can perform the following tasks:

Task Link to Task
Create Cisco IronPort Data Security Policies Managing Upload Requests, page 13-2

Create External DLP Policies Managing Upload Requests on an External DLP
System, page 13-3

Create Data Security and External DLP Policies |Creating Data Security and External DLP Policies,
page 16-5

Control Upload Requests using Cisco IronPort |Managing Settings for Upload Requests, page 13-7
Data Security Policies

Control Upload Requests Using External DLP |Controlling Upload Requests Using External DLP
Policies Policies, page 13-11

Bypassing Upload Requests Below a Minimum Size

Note

To help reduce the number of upload requests recorded in the log files, you can define a minimum request
body size, below which upload requests are not scanned by the Cisco IronPort Data Security Filters or
the external DLP server.

To do this, use the following CLI commands:
® datasecurityconfig. Applies to the Cisco IronPort Data Security Filters.
® externaldlpconfig. Applies to the configured external DLP servers.

The default minimum request body size is 4 KB (4096 bytes) for both CLI commands. Valid values are
1 to 64 KB. The size you specify applies to the entire size of the upload request body.

All chunk encoded uploads and all native FTP transactions are scanned by the Cisco IronPort Data
Security Filters or external DLP servers when enabled. However, they can still be bypassed based on a
custom URL category.

User Experience When Requests Are Blocked As Sensitive Data

When the Cisco IronPort Data Security Filters or an external DLP server blocks an upload request, it
provides a block page that the Web Proxy sends to the end user. Not all websites display the block page
to the end user. For example, some Web 2.0 websites display dynamic content using javascript instead
of a static webpage and are not likely to display the block page. Users are still properly blocked from
performing data security violations, but they may not always be informed of this by the website.

Managing Upload Requests

Before You Begin
¢ Go to Security Services > Data Security Filters to enable the Cisco IronPort Data Security Filters.
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Step 1

Managing Upload Requests on an External DLP System ||

Create and configure Data Security Policy groups. Cisco IronPort Data Security Policies use URL
filtering, web reputation, and upload content information when evaluating the upload request. You
configure each of these security components to determine whether or not to block the upload request.

When the Web Proxy compares an upload request to the control settings, it evaluates the settings in order.
Each control setting can be configured to perform one of the following actions for Cisco IronPort Data
Security Policies:

Action Description

Block The Web Proxy does not permit the connection and instead displays an end user
notification page explaining the reason for the block.

Allow The Web Proxy bypasses the rest of the Data Security Policy security service scanning
and then evaluates the request against the Access Policies before taking a final action.

For Cisco IronPort Data Security Policies, Allow bypasses the rest of data security
scanning, but does not bypass External DLP or Access Policy scanning. The final action
the Web Proxy takes on the request is determined by the applicable Access Policy (or
an applicable external DLP Policy that may block the request).

Monitor The Web Proxy continues comparing the transaction to the other Data Security Policy
group control settings to determine whether to block the transaction or evaluate it
against the Access Policies.

For Cisco IronPort Data Security Policies, only the Block action is a final action that the Web Proxy takes
on a client request. The Monitor and Allow actions are intermediary actions. In both cases, the Web
Proxy evaluates the transaction against the External DLP Policies (if configured) and Access Policies.
The Web Proxy determines which final action to apply based on the Access Policy group control settings
(or an applicable external DLP Policy that may block the request).

Related Topics
e Managing Upload Requests on an External DLP System, page 13-3

e Managing Settings for Upload Requests, page 16-7

Managing Upload Requests on an External DLP System

Step 1

Step 2

To configure the Web Security appliance to handle upload requests on an external DLP system, perform
the following tasks:

Choose Network > External DLP Servers. Define an external DLP system. To pass an upload request
to an external DLP system for scanning, you must define at least one ICAP-compliant DLP system on
the Web Security appliance.

Create and configure External DLP Policy groups. After an external DLP system is defined, you
create and configure External DLP Policy groups to determine which upload requests to send to the DLP
system for scanning.
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W Evaluating Data Security and External DLP Policy Group Membership

Step3  When an upload request matches an External DLP Policy, the Web Proxy sends the upload request to the
DLP system using the Internet Content Adaptation Protocol (ICAP) for scanning. The DLP system scans
the request body content and returns a block or allow verdict to the Web Proxy. The allow verdict is
similar to the Allow action for Cisco IronPort Data Security Policies in that the upload request will be
compared to the Access Policies. The final action the Web Proxy takes on the request is determined by
the applicable Access Policy.

Related Topics
e Controlling Upload Requests Using External DLP Policies, page 16-11
e Defining External DLP Systems, page 16-9

Evaluating Data Security and External DLP Policy Group
Membership

Each client request is assigned to an Identity and then is evaluated against the other policy types to
determine which policy group it belongs for each type. The Web Proxy evaluates upload requests against
the Data Security and External DLP Policies. The Web Proxy applies the configured policy control
settings to a client request based on the client request’s policy group membership.

Matching Client Requests to Data Security and External DLP Policy Groups

To determine the policy group that a client request matches, the Web Proxy follows a specific process
for matching the group membership criteria. It considers the following factors for group membership:

¢ Identity. Each client request either matches an Identity, fails authentication and is granted guest
access, or fails authentication and gets terminated.

e Authorized users. If the assigned Identity requires authentication, the user must be in the list of
authorized users in the Data Security or External DLP Policy group to match the policy group. The
list of authorized users can be any of the specified groups or users or can be guest users if the Identity
allows guest access.

e Advanced options. You can configure several advanced options for Data Security and External DLP
Policy group membership. Some options (such as proxy port and URL category) can also be defined
within the Identity. When an advanced option is configured in the Identity, it is not configurable in
the Data Security or External DLP Policy group level.

The information in this section gives an overview of how the Web Proxy matches upload requests to both
Data Security and External DLP Policy groups.

The Web Proxy sequentially reads through each policy group in the policies table. It compares the upload
request status to the membership criteria of the first policy group. If they match, the Web Proxy applies
the policy settings of that policy group.

If they do not match, the Web Proxy compares the upload request to the next policy group. It continues
this process until it matches the upload request to a user defined policy group. If it does not match a user
defined policy group, it matches the global policy group. When the Web Proxy matches the upload
request to a policy group or the global policy group, it applies the policy settings of that policy group.
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Creating Data Security and External DLP Policies

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6

You can create Data Security and External DLP Policy groups based on combinations of several criteria,
such as one or more Identities or the URL category of the destination site. You must define at least one
criterion for policy group membership. When you define multiple criteria, the upload request must meet
all criteria to match the policy group. However, the upload request needs to match only one of the
configured Identities.

Choose Web Security Manager > Cisco IronPort Data Security (for Defining Data Security Policy
group membership) or Web Security Manager > External Data Loss Prevention (for Defining
External DLP Policy group membership).

Click Add Policy.

In the Policy Name field, enter a name for the policy group, and in the Description field (optional) add
a description.

N

Note  Each policy group name must be unique and only contain alphanumeric characters or the space
character.

In the Insert Above Policy field, choose where in the policies table to place the policy group.

When configuring multiple policy groups you must specify a logical order for each group. Order your
policy groups to ensure that correct matching occurs.

In the Identities and Users section, choose one or more Identity groups to apply to this policy group.

(Optional) Expand the Advanced section to define additional membership requirements.
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Step7  To define policy group membership by any of the advanced options, click the link for the advanced
option and configure the option on the page that appears.

Advanced Option Description

Protocols Choose whether or not to define policy group membership by the protocol used
in the client request. Select the protocols to include.

“All others” means any protocol not listed above this option.

Note When the HTTPS Proxy is enabled, only Decryption Policies apply to
HTTPS transactions. You cannot define policy membership by the
HTTPS protocol for Access, Routing, Outbound Malware Scanning, Data
Security, or External DLP Policies.

Proxy Ports Choose whether or not to define policy group membership by the proxy port used
to access the Web Proxy. Enter one or more port numbers in the Proxy Ports field.
Separate multiple ports with commas.

For explicit forward connections, this is the port configured in the browser. For
transparent connections, this is the same as the destination port. You might want
to define policy group membership on the proxy port if you have one set of clients
configured to explicitly forward requests on one port, and another set of clients
configured to explicitly forward requests on a different port.

Cisco recommends only defining policy group membership by the proxy port
when the appliance is deployed in explicit forward mode, or when clients
explicitly forward requests to the appliance. If you define policy group
membership by the proxy port when client requests are transparently redirected
to the appliance, some requests might be denied.

Note  If the Identity associated with this policy group defines Identity
membership by this advanced setting, the setting is not configurable at the
non-Identity policy group level.

Subnets Choose whether or not to define policy group membership by subnet or other
addresses.

You can choose to use the addresses that may be defined with the associated
Identity, or you can enter specific addresses here.

Note If the Identity associated with this policy group defines its membership
by addresses, then in this policy group you must enter addresses that are
a subset of the addresses defined in the Identity. Adding addresses in the
policy group further narrows down the list of transactions that match this
policy group.

URL Categories Choose whether or not to define policy group membership by URL categories.

Select the user defined or predefined URL categories.

Note  If the Identity associated with this policy group defines Identity
membership by this advanced setting, the setting is not configurable at the
non-Identity policy group level.

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| 16-6 | I



| Chapter 16

Prevent Loss of Sensitive Data

Step 8
Step 9

Step 10

Managing Settings for Upload Requests ||

Advanced Option Description

User Agents Choose whether or not to define policy group membership by the user agent used
in the client request. You can select some commonly defined browsers, or define
your own using regular expressions. Choose whether this policy group should
apply to the selected user agents or to any user agent that is not in the list of
selected user agents.

Note If the Identity associated with this policy group defines Identity
membership by this advanced setting, the setting is not configurable at the
non-Identity policy group level.

User Location Choose whether or not to define policy group membership by user location, either
remote or local.

This option only appears when the Secure Mobility is enabled.

Submit your changes.

If you are creating a Data Security Policy group, configure its control settings to define how the Web
Proxy handles upload requests.

The new Data Security Policy group automatically inherits global policy group settings until you
configure options for each control setting.

If you are creating an External DLP Policy group, configure its control settings to define how the Web
Proxy handles upload requests.

The new External DLP Policy group automatically inherits global policy group settings until you
configure custom settings.

Submit and Commit Changes.

Related Topics
e Evaluating Data Security and External DLP Policy Group Membership, page 16-4

e Matching Client Requests to Data Security and External DLP Policy Groups, page 16-4
e Managing Settings for Upload Requests, page 16-7
e Controlling Upload Requests Using External DLP Policies, page 16-11

Managing Settings for Upload Requests

Each upload request is assigned to a Data Security Policy group and inherits the control settings of that
policy group. The control settings of the Data Security Policy group determine whether the appliance
blocks the connection or evaluates it against the Access Polices.

Configure control settings for Data Security Policy groups on the Web Security Manager > Cisco
IronPort Data Security page.

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Chapter 16 Prevent Loss of Sensitive Data |

M Managing Settings for Upload Requests

You can configure the following settings to determine what action to take on upload requests:

Option Link

URL Categories URL Categories, page 13-8
Web Reputation Web Reputation, page 13-8
Content Content Blocking, page 13-8

After a Data Security Policy group is assigned to an upload request, the control settings for the policy
group are evaluated to determine whether to block the request or evaluate it against the Access Policies.

URL Categories

AsyncOS for Web allows you to configure how the appliance handles a transaction based on the URL
category of a particular request. Using a predefined category list, you can choose to monitor or block
content by category. You can also create custom URL categories and choose to allow, monitor, or block
traffic for a website in the custom category.

Web Reputation

The Web Reputation setting inherits the global setting. To customize web reputation filtering for a
particular policy group, you can use the Web Reputation Settings pull-down menu to customize web
reputation score thresholds.

Only negative and zero values can be configured for web reputation threshold settings for Cisco IronPort
Data Security Policies. By definition, all positive scores are monitored.

Content Blocking

You can use the settings on the Cisco IronPort Data Security Policies > Content page to configure the
Web Proxy to block data uploads based on the following file characteristics:

¢ File size. You can specify the maximum upload size allowed. All uploads with sizes equal to or
greater than the specified maximum are blocked. You can specify different maximum file sizes for
HTTP/HTTPS and native FTP requests.

When the upload request size is greater than both the maximum upload size and the maximum scan
size (configured in the “DVS Engine Object Scanning Limits” field on Security Services >
Anti-Malware page), the upload request is still blocked, but the entry in the data security logs does
not record the file name and content type. The entry in the access logs is unchanged.

¢ File type. You can block predefined file types or custom MIME types you enter. When you block a
predefined file type, you can block all files of that type or files greater than a specified size. When
you block a file type by size, the maximum file size you can specify is the same as the value for the
“DVS Engine Object Scanning Limits” field on Security Services > Anti-Malware page. By default,
that value is 32 MB.

Cisco IronPort Data Security Filters do not inspect the contents of archived files when blocking by
file type. Archived files can be blocked by its file type or file name, not according to its contents.
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S

Note  For some groups of MIME types, blocking one type blocks all MIME types in the group. For
example, blocking application/x-java-applet blocks all java MIME types, such as
application/java and application/javascript.

¢ File name. You can block files with specified names. You can use text as a literal string or a regular
expression for specifying file names to block.

N

Note  Only enter file names with 8-bit ASCII characters. The Web Proxy only matches file names with
8-bit ASCII characters.

Defining External DLP Systems

Note

The Web Security appliance can integrate with multiple external DLP servers from the same vendor by
defining multiple DLP servers in the appliance. You can define the load-balancing technique the Web
Proxy uses when contacting the DLP systems. This is useful when you define multiple DLP systems. See
SSL Configuration, page 22-23 for information about specifying the protocols used to secure
communications with external DLP servers.

Verify the external DLP server does not send the Web Proxy modified content. AsyncOS for Web only
supports the ability to block or allow upload requests. It does not support uploading content modified by
an external DLP server.

Configuring External DLP Servers

Step 1
Step 2

Choose Network > External DLP Servers.
Click Edit Settings.

Setting Description

Protocol for External |Choose either:

DLP Servers e ICAP - DLP client/server ICAP communications are not encrypted.

e Secure ICAP - DLP client/server ICAP communications are via an
encrypted tunnel. Additional related options appear.
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Setting

Description

External DLP Servers

Enter the following information to access an ICAP compliant DLP system:

Server address and Port — The hostname or IP address and TCP port for
accessing the DLP system.

Reconnection attempts — The number of times the Web Proxy tries to
connect to the DLP system before failing.

Service URL — The ICAP query URL specific to the particular DLP
server. The Web Proxy includes what you enter here in the ICAP request
it sends to the external DLP server. The URL must start with the ICAP
protocol: icap://

Certificate (optional) — The certificate provided to secure each External
DLP Server connection can be Certificate Authority (CA)-signed or
self-signed. Obtain the certificate from the specified server, and then upload
it to the appliance:

— Browse to and select the certificate file, and then click Upload File.

~

Note  This single file must contain both the client certificate and private
key in unencrypted form.

— Use this certificate for all DLP servers using Secure ICAP — Check
this box to use the same certificate for all External DLP Servers you
define here. Leave the option unchecked to enter a different certificate
for each server.

Start Test — You can test the connection between the Web Security
appliance and the defined external DLP server(s) by clicking Start Test.

Load Balancing

If multiple DLP servers are defined, select which load balancing technique the
Web Proxy uses to distribute upload requests to different DLP servers. You can
choose the following load balancing techniques:

None (failover). The Web Proxy directs upload requests to one DLP
server. It tries to connect to the DLP servers in the order they are listed. If
one DLP server cannot be reached, the Web Proxy attempts to connect to
the next one in the list.

Fewest connections. The Web Proxy keeps track of how many active
requests are with the different DLP servers and it directs the upload
request to the DLP server currently servicing the fewest number of
connections.

Hash based. The Web Proxy uses a hash function to distribute requests to
the DLP servers. The hash function uses the proxy ID and URL as inputs
so that requests for the same URL are always directed to the same DLP
server.

Round robin. The Web Proxy cycles upload requests equally among all
DLP servers in the listed order.

Service Request
Timeout

Enter how long the Web Proxy waits for a response from the DLP server. When
this time is exceeded, the ICAP request has failed and the upload request is
either blocked or allowed, depending on the Failure Handling setting.

Default is 60 seconds.
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Controlling Upload Requests Using External DLP Policies

Setting Description
Maximum Specifies the maximum number of simultaneous ICAP request connections
Simultaneous from the Web Security appliance to each configured external DLP server. The
Connections Failure Handling setting on this page applies to any request which exceeds this
limit.
Default is 25.
Failure Handling Choose whether upload requests are blocked or allowed (passed to Access

Policies for evaluation) when the DLP server fails to provide a timely response.

Default is allow (“Permit all data transfers to proceed without scanning”).

Trusted Root Browse to and select the trusted-root certificate for the certificate(s) provided

Certificate with the External DLP Servers, and then click Upload File. See Certificate
Management, page 22-24 for additional information.

Invalid Certificate Specify how various invalid certificates are handled: Drop or Monitor.

Options

Server Certificates This section displays all DLP server certificates currently available on

the appliance.

Step3  (Optional) You can add another DLP server by clicking Add Row and entering the DLP Server
information in the new fields provided.

Step4  Submit and Commit Changes.

Controlling Upload Requests Using External DLP Policies

Once the Web Proxy receives the upload request headers, it has the information necessary to decide if
the request should go to the external DLP system for scanning. The DLP system scans the request and
returns a verdict to the Web Proxy, either block or monitor (evaluate the request against the Access
Policies).

Step 1 Choose Web Security Manager > External Data Loss Prevention.

Step2  Click the link under the Destinations column for the policy group you want to configure.

>

Step3  Under the Edit Destination Settings section, choose “Define Destinations Scanning Custom Settings.’
Step4  In the Destination to scan section, choose one of the following options:

e Do not scan any uploads. No upload requests are sent to the configured DLP system(s) for
scanning. All upload requests are evaluated against the Access Policies.

e Scan all uploads. All upload requests are sent to the configured DLP system(s) for scanning. The
upload request is blocked or evaluated against the Access Policies depending on the DLP system
scanning verdict.

¢ Scan uploads to specified custom URL categories only. Upload requests that fall in specific
custom URL categories are sent to the configured DLP system for scanning. The upload request is
blocked or evaluated against the Access Policies depending on the DLP system scanning verdict.
Click Edit custom categories list to select the URL categories to scan.

Step5 Submit and Commit Changes.
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Logging of Data Loss Prevention Scanning

The access logs indicate whether or not an upload request was scanned by either the Cisco IronPort Data
Security Filters or an external DLP server. The access log entries include a field for the Cisco IronPort
Data Security scan verdict and another field for the External DLP scan verdict based.

In addition to the access logs, the Web Security appliance provides the following log file types to
troubleshoot Cisco IronPort Data Security and External DLP Policies:

¢ Data Security Logs. Records client history for upload requests that are evaluated by the Cisco

IronPort Data Security Filters.

¢ Data Security Module Logs. Records messages related to the Cisco IronPort Data Security Filters.

e Default Proxy Logs. In addition recording errors related to the Web Proxy, the default proxy logs
include messages related to connecting to external DLP servers. This allows you to troubleshoot
connectivity or integration problems with external DLP servers.

The following text illustrates a sample Data Security Log entry:

Mon Mar 30 03:02:13 2009 Info:

303 10.1.1.1 - -

<<bar, text/plain, 5120><foo, text/plain, 5120>>
BLOCK_WEBCAT_IDS-allowall-DefaultGroup-DefaultGroup-NONE-DefaultRouting ns server.com nc

Field Value

Description

Mon Mar 30 03:02:13 2009 Info:

Timestamp and trace level

303

Transaction ID

10.1.1.1

Source IP address

User name

Authorized group names

<<bar, text/plain,5120><foo, text/
plain,5120>>

File name, file type, file size for each file uploaded at once

Note  This field does not include text/plain files that are less
than the configured minimum request body size, the

default of which is 4096 bytes.

BLOCK_WEBCAT_IDS-allowall-Default
Group-Defaul tGroup-NONE-DefaultRo
uting

Cisco IronPort Data Security Policy and action

ns

Web reputation score

server.com

Outgoing URL

nc

URL category

Note

To learn when data transfer, such as a POST request, to a site was blocked by the external DLP server,

search for the IP address or hostname of the DLP server in the access logs.
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e End-User Notifications Overview, page 17-1

e Configuring General Settings for Notification Pages, page 17-2

e End-User Acknowledgment Page, page 17-2

¢ End-User Notification Pages, page 17-5

e Configuring the End-User URL Filtering Warning Page, page 17-9

e Configuring FTP Notification Messages, page 17-9

e Custom Messages on Notification Pages, page 17-10

e Editing Notification Page HTML Files Directly, page 17-12

¢ Notification Page Types, page 17-15

End-User Notifications Overview

You can configure the following types of notifications for end users:

Option

Description

Further information

End-user
acknowledgement

page

Informs end users that their web
activity is being filtered and monitored.
An end-user acknowledgment page is
displayed when a user first accesses a
browser after a certain period of time.

End-User Acknowledgment Page,
page 17-2

End-user
notification pages

Page shown to end users when access to
a particular page is blocked, specific to
the reason for blocking it.

End-User Notification Pages, page 17-5

End-user URL
filtering warning
page

Warns end users that a site they are
accessing does not meet your
organization’s acceptable use policies,
and allows them to continue if they
choose.

Configuring the End-User URL Filtering
Warning Page, page 17-9
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Option

Description

Further information

FTP notification
messages

Gives end users the reason a native FTP
transaction was blocked.

Configuring FTP Notification Messages,
page 17-9.

Time and Volume
Quotas Expiry
Warning Page

Notifies end users when their access is
blocked because they have reached the
configured data volume or time limit.

Configure these settings on the Security
Services > End User Notification page,
Time and Volume Quotas Expiry

Warning Page section.

See also Time Ranges and Volume
Quotas, page 10-12.

Configuring General Settings for Notification Pages

Specify display languages and logo for notification pages. Restrictions are described in this procedure.

Select Security Services > End-User Notification.

In the General Settings section, select the language the Web Proxy should use when displaying

e The HTTP language setting applies to all HTTP notification pages (acknowledgment, on-box
end-user, customized end-user, and end-user URL filtering warning).

e The FTP language applies to all FTP notification messages.

Choose whether or not to use a logo on each notification page. You can specify the Cisco logo or any
graphic file referenced at the URL you enter in the Use Custom Logo field.

This setting applies to all HTTP notification pages served over IPv4. AsyncOS does not support images

Step 1
Step2  Click Edit Settings.
Step 3
notification pages.
Step 4
over IPv6.
Step5 Submit and Commit Changes.

Related Topics
e (Caveats for URLs and Logos in Notification Pages, page 17-11

End-User Acknowledgment Page

Note

You can configure the Web Security appliance to inform users that it is filtering and monitoring their
web activity. When configured, the appliance displays an end-user acknowledgment page for every user
accessing the web using HTTP or HTTPS. It displays the end-user acknowledgment page when a user
tries to access a website for the first time, or after a configured time interval.

The Web Proxy tracks users by username if authentication has made a username available. If no user
name is available, you can choose how to track users, either by IP address or web browser session cookie.

Native FTP transactions are exempt from the end-user acknowledgment page.
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Access HTTPS and FTP Sites with the End-User Acknowledgment Page

The end-user acknowledgment page works because it displays an HTML page to the end user that forces
them to click an acceptable use policy agreement. After users click the link, the Web Proxy redirects
clients to the originally requested website. It keeps track of when users accepted the end-user
acknowledgment page using a surrogate (either by IP address or web browser session cookie) if no
username is available for the user.

HTTPS. The Web Proxy tracks whether the user has acknowledged the end-user acknowledgment
page with a cookie, but it cannot obtain the cookie unless it decrypts the transaction. You can choose
to either bypass (pass through) or drop HTTPS requests when the end-user acknowledgment page is
enabled and tracks users using session cookies. Do this using the advancedproxyconfig > EUN CLI
command, and choose bypass for the “Action to be taken for HTTPS requests with Session based
EUA (“bypass” or “drop”).” command.

FTP over HTTP. Web browsers never send cookies for FTP over HTTP transactions, so the Web
Proxy cannot obtain the cookie. To work around this, you can exempt FTP over HTTP transactions
from requiring the end-user acknowledgment page. Do this by creating a custom URL category
using “ftp://” as the regular expression (without the quotes) and defining and Identity policy that
exempts users from the end-user acknowledgment page for this custom URL category.

About the End-user Acknowledgment Page

When a user is tracked by IP address, the appliance uses the shortest value for maximum time
interval and maximum IP address idle timeout to determine when to display the end-user
acknowledgment page again.

When a user is tracked using a session cookie, the Web Proxy displays the end-user acknowledgment
page again if the user closes and then reopens their web browser or opens a second web browser
application.

Using a session cookie to track users when the client accesses HTTPS sites or FTP servers using
FTP over HTTP does not work.

When the appliance is deployed in explicit forward mode and a user goes to an HTTPS site, the
end-user acknowledgment page includes only the domain name in the link that redirects the user to
the originally requested URL. If the originally requested URL contains text after the domain name,
that text is truncated.

When the end-user acknowledgment page is displayed to a user, the access log entry for that
transaction shows OTHER as the ACL decision tag. This is because the originally requested URL
was blocked, and instead the user was shown the end-user acknowledgment page.

Configuring the End-User Acknowledgment Page

You can enable and configure the end-user acknowledgment page in the web interface or the command
line interface. When you configure the end-user acknowledgment page in the web interface, you can
include a custom message that appears on each page.

In the CLL use advancedproxyconfig > eun.

Before You Begin

To configure the display language and customize the displayed logo, see Configuring General
Settings for Notification Pages, page 17-2.
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e If you will customize the message shown to end users, see Custom Messages on Notification Pages,
page 17-10. If you require more customization than the Custom Message box allows, see Editing
Notification Page HTML Files Directly, page 17-12.

Step1  Security Services > End-User Notification.

Step2  Click Edit Settings.

Step3  Enable the “Require end-user to click through acknowledgment page” field.
Step4  Enter options:

Setting Description

Time Between The Time Between Acknowledgments determines how often the Web Proxy
Acknowledgements |displays the end-user acknowledgment page for each user. This setting applies
to users tracked by username and users tracked by IP address or session cookie.
You can specify any value from 30 to 2678400 seconds (one month). Default is
one day (86400 seconds).

When the Time Between Acknowledgments changes and is committed, the Web
Proxy uses the new value even for users who have already acknowledged the
Web Proxy.

Inactivity Timeout |The Inactivity Timeout determines how long a user tracked and acknowledged
by IP address or session cookie (unauthenticated users only) can be idle before
the user is no longer considered to have agreed to the acceptable use policy. You
can specify any value from 30 to 2678400 seconds (one month). Default is four
hours (14400 seconds).
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Setting Description

Surrogate Type Determines which method the Web Proxy uses to track the user:

e TP Address. The Web Proxy allows the user at that IP address to use any
web browser or non-browser HTTP process to access the web once the user
clicks the link on the end-user acknowledgment page. Tracking the user by
IP address allows the user to access the web until the Web Proxy displays a
new end-user acknowledgment page due to inactivity or the configured time
interval for new acknowledgments. Unlike tracking by a session cookie,
tracking by IP address allows the user to open up multiple web browser
applications and not have to agree to the end-user acknowledgment unless
the configured time interval has expired.

Note When IP address is configured and the user is authenticated, the Web
Proxy tracks users by username instead of IP address.

¢ Session Cookie. The Web Proxy sends the user’s web browser a cookie
when the user clicks the link on the end-user acknowledgment page and
uses the cookie to track their session. Users can continue to access the web
using their web browser until the Time Between Acknowledgments value
expires, they have been inactive longer than the allotted time, or they close
their web browser.

If the user using a non-browser HTTP client application, they must be able
to click the link on the end-user acknowledgment page to access the web. If
the user opens a second web browser application, the user must go through
the end-user acknowledgment process again in order for the Web Proxy to
send a session cookie to the second web browser.

Note  Using a session cookie to track users when the client accesses HTTPS
sites or FTP servers using FTP over HTTP is not supported.

Custom message Customize the text that appears on every end-user acknowledgment page. You
can include some simple HTML tags to format the text.

Note  You can only include a custom message when you configure the
end-user acknowledgment page in the web interface, versus the CLI.

See also Custom Messages on Notification Pages, page 17-10.

Step5  (Optional) Click Preview Acknowledgment Page Customization to view the current end-user
acknowledgment page in a separate browser window.

N

Note  If the notification HTML files have been edited, this preview functionality is not available.

Step6  Submit and Commit Changes.

End-User Notification Pages

When a policy blocks a user from a website, you can configure the appliance to notify the user why it
blocked the URL request. There are several ways to achieve this:
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To See
Display predefined, customizable pages that are |Configuring On-Box End-User Notification
hosted on the Web Security appliance. Pages, page 17-6

Redirect the user to HTTP end-user notification |Off-Box End-User Notification Pages, page 17-7
pages at a specific URL.

Configuring On-Box End-User Notification Pages

On-box pages are predefined, customizable notification pages residing on the appliance.

Before You Begin

e To configure the display language and customize the displayed logo, see Configuring General
Settings for Notification Pages, page 17-2.

e If you will customize the message displayed using on-box notifications, review the topics under
Custom Messages on Notification Pages, page 17-10. If you require more customization than the
Custom Message box allows, see Editing Notification Page HTML Files Directly, page 17-12.

Step 1 Security Services > End-User Notification.
Step2  Click Edit Settings.
Step3  From the Notification Type field, choose Use On Box End User Notification.

Step4  Configure the on-box end-user notification page settings.

Setting Description

Custom Message Include any additional text required on each notification page. When you
enter a custom message, AsyncOS places the message before the last
sentence on the notification page which includes the contact information.

Contact Information Customize the contact information listed on each notification page.

AsyncOS displays the contact information sentence as the last sentence on
a page, before providing notification codes that users can provide to the
network administrator.

End-User When enabled, users can report misclassified URLs to Cisco. An additional
Misclassification button appears on the on-box end-user notification pages for sites blocked
Reporting due to suspected malware or URL filters. This button allows the user to

report when they believe the page has been misclassified. It does not appear
for pages blocked due to other policy settings.

Step5  (Optional) Click Preview Notification Page Customization link to view the current end-user
notification page in a separate browser window.

A

Note  If the notification HTML files have been edited, this preview functionality is not available.

Step6  Submit and Commit Changes.
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Off-Box End-User Notification Pages

The Web Proxy can be configured to redirect all HTTP end-user notification pages to a specific URL
that you specify.

Displaying the Correct Off-Box Page Based on the Reason for Blocking Access

By default, AsyncOS redirects all blocked websites to the URL regardless of the reason why it blocked
the original page. However, AsyncOS also passes parameters as a query string appended to the redirect
URL so you can ensure that the user sees a unique page explaining the reason for the block. For more

information on the included parameters, see Off-Box End-User Notification Page Parameters, page 17-7.

When you want the user to view a different page for each reason for a blocked website, construct a CGI
script on the web server that can parse the query string in the redirect URL. Then the server can perform
a second redirect to an appropriate page.

URL Criteria for Off-Box Notification Pages

e You can use any HTTP or HTTPS URL.

e The URL may specify a specific port number.

e The URL may not have any arguments after the question mark.

e The URL must contain a well-formed hostname.
For example, if you have the following URL entered in the Redirect to Custom URL field:
http://www.example.com/eun.policy.html
And you have the following access log entry:

1182468145.492 1 172.17.0.8 TCP_DENIED/403 3146 GET http://www.espn.com/index.html
HTTP/1.1 - NONE/- - BLOCK_WEBCAT-DefaultGroup-DefaultGroup-NONE-NONE-DefaultRouting

Then AsyncOS creates the following redirected URL:

http://www.example.com/eun.policy.html?Time=21/Jun/
2007:23:22:25%20%2B0000&ID=0000000004&Client_IP=172.17.0.8&User=-
&Site=www.espn.com&URI=index.html&Status_Code=403&Decision_Tag=
BLOCK_WEBCAT-DefaultGroup-Defaul tGroup-NONE-NONE-DefaultRouting
&URL_Cat=Sports%$20and%$20Recreation&WBRS=-&DVS_Verdict=-&
DVS_ThreatName=-&Reauth_ URL=-

Off-Box End-User Notification Page Parameters

AsyncOS passes the parameters to the web server as standard URL Parameters in the HTTP GET request.
It uses the following format:

<notification_page_url>?paraml=valuel&param2=value?2
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The table describes the parameters AsyncOS includes in the query string.

Parameter Name

Description

Time Date and time of the transaction.

ID Transaction ID.

Client_IP IP address of the client.

User Username of the client making the request, if available.
Site Hostname of the destination in the HTTP request.

URI URL path specified in the HTTP request.

Status_Code

HTTP status code for the request.

Decision_Tag

ACL decision tag as defined in the Access log entry that indicates how the DVS

engine handled the transaction.

URL_Cat URL category that the URL filtering engine assigned to the transaction request.

Note: AsyncOS for Web sends the entire URL category name for both
predefined and user defined URL categories. It performs URL encoding on the
category name, so spaces are written as “%?20”.

WBRS WBRS score that the Web Reputation Filters assigned to the URL in the request.
DVS_Verdict
DVS_ThreatName |The name of the malware found by the DVS engine.
Reauth_URL

Malware category that the DVS engine assigns to the transaction.

A URL that users can click to authenticate again if the user is blocked from a
website due to a restrictive URL filtering policy. Use this parameter when the
“Enable Re-Authentication Prompt If End User Blocked by URL Category or
User Session Restriction” global authentication setting is enabled and the user is
blocked from a website due to a blocked URL category.

To use this parameter, make sure the CGI script performs the following steps:
1. Get the value of Reauth_Url parameter.

2. URL-decode the value.

3. Base64 decode the value and get the actual re-authentication URL.

4. Include the decoded URL on the end-user notification page in some way,
either as a link or button, along with instructions for users informing them they
can click the link and enter new authentication credentials that allow greater
access.

~

Note  AsyncOS always includes all parameters in each redirected URL. If no value exists for a particular
parameter, AsyncOS passes a hyphen (-).

Redirecting End-User Notification Pages to a Custom URL (0ff-Box)

Step 1 Security Services > End-User Notification.
Step2  Click Edit Settings.
Step3  In the End-User Notification Pages section, choose Redirect to Custom URL.
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Stepd In the Notification Page URL field, enter the URL to which you want to redirect blocked websites.
Step5  (Optional) Click Preview Custom URL link.
Step6  Submit and Commit Changes.

Configuring the End-User URL Filtering Warning Page

An end-user URL filtering warning page is displayed when a user first accesses a website in a particular
URL category after a certain period of time. You can also configure the warning page when a user
accesses adult content when the site content ratings feature is enabled.

Before You Begin

If you will customize the message displayed using on-box notifications, review the topics under Custom
Messages on Notification Pages, page 17-10. If you require more customization than the Custom
Message box allows, see Editing Notification Page HTML Files Directly, page 17-12.

Step1  Security Services > End-User Notification.
Step2  Click Edit Settings.
Step3  Scroll down to the End-User URL Filtering Warning Page section.

Step4  In the Time Between Warning field, enter the time interval the Web Proxy uses between displaying the
end-user URL filtering warning page for each URL category per user.

You can specify any value from 30 to 2678400 seconds (one month). Default is 1 hour (3600 seconds).
You can enter the value in seconds, minutes, or days. Use ‘s’ for seconds, ‘m’ for minutes, and ‘d’ for
days.

Step5 In the Custom Message field, enter text you want to appear on every end-user URL filtering warning
page.

Step6  (Optional) Click Preview URL Category Warning Page Customization to view the current end-user
URL filtering warning page in a separate browser window.

N

Note  If the notification HTML files have been edited, this preview functionality is not available.

Step7  Submit and Commit Changes.

Configuring FTP Notification Messages

The FTP Proxy displays a predefined, customizable notification message to native FTP clients when the
FTP Proxy cannot establish a connection with the FTP server for any reason, such as an error with FTP
Proxy authentication or a bad reputation for the server domain name. The notification is specific to the
reason the connection was blocked.
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Before You Begin

If you will customize the message displayed using on-box notifications, review the topics under Custom
Messages on Notification Pages, page 17-10. If you require more customization than the Custom
Message box allows, see Editing Notification Page HTML Files Directly, page 17-12.

Security Services > End-User Notification.

Click Edit Settings.

Scroll down to the Native FTP section.

In the Language field, select the language to use when displaying native FTP notification messages.

In the Custom Message field, enter the text you want to display in every native FTP notification message.

Submit and Commit Changes.

Custom Messages on Notification Pages

The following sections apply to text entered into the “Custom Message” box for any notification type
configured on the Edit End User Notification page.

e Supported HTML Tags in Custom Messages on Notification Pages, page 17-10
e (Caveats for URLs and Logos in Notification Pages, page 17-11

Supported HTML Tags in Custom Messages on Notification Pages

You can use HTML tags to format the text in any notification on the Edit End User Notification page that
offers a “Custom Message” box. Tags must be in lower case and follow standard HTML syntax (closing
tags, etc.)

You can use the following HTML tags.

o <a></a>

* <span></span>

e <b></b>

e <big></big>

e <br>

e <code></code>

o <em></em>

o <i></i>

e <small></small>

® <strong></strong>
For example, you can make some text italic:
Please acknowledge the following statements <i>before</i> accessing the Internet.

With the <span> tag, you can use any CSS style to format text. For example, you can make some text red:
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<gspan style="color: red”>Warning:</span> You must acknowledge the following statements

<i>before</i> accessing the Internet.

If you need greater flexibility or wish to add JavaScript to your notification pages, you must edit the
HTML notification files directly. JavaScript entered into the Custom Message box for notifications in
the web user interface will be stripped out. See Editing Notification Page HTML Files Directly,

page 17-12.

Caveats for URLs and Logos in Notification Pages

This section applies if you will make any of the following customizations:

¢ Enter text into the “Custom Message” box for any notification on the Edit End User Notification
page
e Directly edit HTML files for on-box notifications

e Use a custom logo

All combinations of URL paths and domain names in embedded links within custom text, and the custom
logo, are exempted from the following for on-box notifications:

e User authentication

e End-user acknowledgment

e All scanning, such as malware scanning and web reputation scoring
For example, if the following URLs are embedded in custom text:
http://www.example.com/index.html
http://www.mycompany.com/logo.jpg
Then all of the following URLs will also be treated as exempt from all scanning:
http://www.example.com/index.html
http://www.mycompany.com/logo.jpg
http://www.example.com/logo.jpg
http://www.mycompany.com/index.html

Also, where an embedded URL is of the form: <protocol>://<domain-name>/<directory path>/ then
all sub-files and sub-directories under that directory path on the host will also be exempted from all
scanning.

For example, if the following URL is embedded: http: //www.example.com/gallery2/ URLSs such as
http://www.example.com/gallery2/main.php Will also be treated as exempt.

This allows you to create a more sophisticated page with embedded content so long as the embedded
content is relative to the initial URL. However, you should also take care when deciding which paths to
include as links and custom logos.
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Editing Notification Page HTML Files Directly

Each notification page is stored on the Web Security appliance as an HTML file. If you require more
customization than the “Custom Message” box in the web-based interface allows, you can directly edit
these HTML files. For example, you can include standard JavaScript or edit the overall look and feel of
each page.

Information in the following sections applies to any type of end-user notification HTML file on the
appliance, including End-User Acknowledgment pages.

Requirements for Editing Notification HTML Files Directly

e FEach notification page file must be a valid HTML file. For a list of HTML tags you can include, see
Supported HTML Tags in Custom Messages on Notification Pages, page 17-10.

¢ The customized notification page file names must exactly match the file names shipped with the
Web Security appliance.

If the configuration\eun directory does not contain a particular file with the required name, then
the appliance displays the standard on-box end-user notification page.

e Do notinclude any links to URLs in the HTML files. Any link included in the notification pages are
subject to the access control rules defined in the Access Policies and users might end up in a
recursive loop.

e Test your HTML files in supported client browsers to ensure that they behave as expected, especially
if they include JavaScript.

e For your customized pages to take effect, you must enable the customized files using the
advancedproxyconfig > EUN > Refresh EUN Pages CLI command.

Editing Notification HTML Files Directly

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

Before You Begin

e Understand the requirements in Requirements for Editing Notification HTML Files Directly,
page 17-12.

e See Variables for Customizing Notification HTML Files and Using Variables in Notification HTML
Files, page 17-13.

Use an FTP client to connect to the Web Security appliance.

Navigate to the configuration\eun directory.

Download the language directory files for the notification pages you want to edit.
On your local machine, use a text or HTML editor to edit the HTML files.

Use the FTP client to upload the customized HTML files to the same directory from which you
downloaded them in step 3.

Open an SSH client and connect to the Web Security appliance.
Run the advancedproxyconfig > EUN CLI command.

Type 2 to use the custom end-user notification pages.
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Step9  If the custom end-user notification pages option is currently enabled when you update the HTML files,
type 1 to refresh the custom end-user notification pages.

If you do not do this, the new files do not take effect until the Web Proxy restarts.
Step10 Commit your change.
Step11  Close the SSH client.

Using Variables in Notification HTML Files

When editing notification HTML files, you can include conditional variables to create if-then statements
to take different actions depending on the current state.

The table describes the different conditional variable formats.

Conditional Variable Format Description

%V This conditional variable evaluates to TRUE if the output of variable
%V is not empty.

%!V Represents the following condition:
else

Use this with the %?V conditional variable.

%#V Represents the following condition:

endif

Use this with the %?V conditional variable.

For example, the following text is some HTML code that uses %R as a conditional variable to check if
re-authentication is offered, and uses %r as a regular variable to provide the re-authentication URL.

%?R
<div align="left">

<form name="ReauthInput" action="%r" method="GET">

<input name="Reauth" type="button" OnClick="document.location="'%r"'"

id="Reauth" value="Login as different user...">

</form>
</div>
S#R

Any variable included in Variables for Customizing Notification HTML Files can be used as a
conditional variable. However, the best variables to use in conditional statements are the ones that relate
to the client request instead of the server response, and the variables that may or may not evaluate to
TRUE instead of the variables that always evaluate to TRUE.

Variables for Customizing Notification HTML Files

You can use variables in the notification HTML files to display specific information to the user. You can
also turn each variable into a conditional variable to create if-then statements. For more information, see
Using Variables in Notification HTML Files, page 17-13.
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Always Evaluates to
TRUE if Used as
Variable |Description Conditional Variable
%a Authentication realm for FTP No
%A ARP address Yes
%b User-agent name No
%B Blocking reason, such as BLOCK-SRC or BLOCK-TYPE No
Yoc Error page contact person Yes
%C Entire Set-Cookie: header line, or empty string No
%d Client IP address Yes
%D User name No
Yoe Error page email address Yes
%E The error page logo URL No
%t User feedback section No
%F The URL for user feedback No
%g The web category name, if available Yes
%G Maximum file size allowed in MB No
%h The hostname of the proxy Yes
9%H The server name of the URL Yes
Y1 Transaction ID as a hexadecimal number Yes
%1 Management [P Address Yes
%j URL category warning page custom text No
Yok Redirection link for the end-user acknowledgment page and No
end-user URL filtering warning page
%K Response file type No
%l WWW-Authenticate: header line No
%L Proxy-Authenticate: header line No
%M The Method of the request, such as “GET” or “POST” Yes
9on Malware category name, if available No
90N Malware threat name, if available No
%0 Web reputation threat type, if available No
%0 Web reputation threat reason, if available No
%p String for the Proxy-Connection HTTP header Yes
%P Protocol Yes
%q Identity policy group name Yes
%Q Policy group name for non-Identity polices Yes
%ot Redirect URL No
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Always Evaluates to
TRUE if Used as
Variable |Description Conditional Variable
%R Re-authentication is offered. This variable outputs an empty string |No
when false and a space when true, so it is not useful to use it alone.
Instead, use it as condition variable.
%S The signature of the proxy No, always evaluates
to FALSE
9ot Timestamp in Unix seconds plus milliseconds Yes
%T The date Yes
9ou The URI part of the URL (the URL excluding the server name) Yes
%U The full URL of the request Yes
Yov HTTP protocol version Yes
oW Management WebUT port Yes
%X Extended blocking code. This is a 16-byte base64 value that Yes
encodes the most of the web reputation and anti-malware
information logged in the access log, such as the ACL decision tag
and WBRS score.
%Y Administrator custom text string, if set, else empty No
%y End-user acknowledgment page custom text Yes
%z Web reputation score Yes
% DLP meta data Yes
% % Prints the percent symbol (%) in the notification page N/A

Notification Page Types

By default, the Web Proxy displays a notification page informing users they were blocked and the reason
for the block.

Most notification pages display a different set of codes that may help administrators or Cisco Customer
Support troubleshoot any potential problem. Some codes are for Cisco internal use only. The different
codes that might appear in the notification pages are the same as the variables you can include in
customized notification pages, as shown in Variables for Customizing Notification HTML Files.

The table describes the different notification pages users might encounter.

File Name and
Notification Title

Notification Description

Notification Text

ERR_ACCEPTED

Feedback Accepted,
Thank You

Notification page that is displayed after the
users uses the “Report Misclassification”
option.

The misclassification report has been sent.
Thank you for your feedback.

ERR_ADAPTIVE_SECUR

ITY

Policy: General

Block page that is displayed when the user is
blocked due to the Adaptive Scanning feature.

Based on your organization’s security policies,
this web site <URL> has been blocked because
its content has been determined to be a security
risk.
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File Name and
Notification Title

Notification Description

Notification Text

ERR_ADULT_CONTENT
Policy Acknowledgment

The warning page that is displayed when the
end-user accesses a page that is classified as
adult content. Users can click an
acknowledgment link to continue to the
originally requested site.

You are trying to visit a web page whose
content are rated as explicit or adult. By
clicking the link below, you acknowledge that
you have read and agree with the organization's
policies that govern the usage of the Internet
for this type of content. Data about your
browsing behavior may be monitored and
recorded. You will be periodically asked to
acknowledge this statement for continued
access to this kind of web page.

Click here to accept this statement and access
the Internet.

ERR_AVC

Policy: Application
Controls

Block page that is displayed when the user is
blocked due to the Application Visibility and
Control engine.

Based on your organization’s access policies,
access to application %1 of type %2 has been
blocked.

ERR_BAD_REQUEST
Bad Request

Error page that results from an invalid
transaction request.

The system cannot process this request. A
non-standard browser may have generated an
invalid HTTP request.

If you are using a standard browser, please
retry the request.

ERR_BLOCK_DEST

Policy: Destination

Block page that is displayed when the user tries
to access a blocked website address.

Based on your organization’s Access Policies,
access to this web site <URL> has been
blocked.

ERR_BROWSER

Security: Browser

Block page that is displayed when the
transaction request comes from an application
that has been identified to be compromised by
malware or spyware.

Based on your organization’s Access Policies,
requests from your computer have been
blocked because it has been determined to be a
security threat to the organization’s network.
Your browser may have been compromised by
a malware/spyware agent identified as
“<malware name>".

Please contact <contact name> <email
address> and provide the codes shown below.

If you are using a non-standard browser and
believe it has been misclassified, use the button
below to report this misclassification.

ERR_BROWSER_CUSTO
M

Policy: Browser

Block page that is displayed when the
transaction request comes from a blocked user
agent.

Based on your organization’s Access Policies,
requests from your browser have been blocked.
This browser “<browser type>" is not
permitted due to potential security risks.

ERR_CERT_INVALID

Invalid Certificate

Block page that is displayed when the
requested HTTPS site uses an invalid
certificate.

A secure session cannot be established because
the site <hostname> provided an invalid
certificate.

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



| Chapter 17

Notify End-Users of Proxy Actions

Notification Page Types ||

File Name and
Notification Title

Notification Description

Notification Text

ERR_CONTINUE_UNAC
KNOWLEDGED

Policy Acknowledgment

Warning page that is displayed when the user
requests a site that is in a custom URL category
that is assigned the Warn action. Users can
click an acknowledgment link to continue to
the originally requested site.

You are trying to visit a web page that falls
under the URL Category <URL category>. By
clicking the link below, you acknowledge that
you have read and agree with the
organization’s policies that govern the usage of
the Internet for this type of content. Data about
your browsing behavior may be monitored and
recorded. You will be periodically asked to
acknowledge this statement for continued
access to this kind of web page.

Click here to accept this statement and access
the Internet.

ERR_DNS_FAIL
DNS Failure

Error page that is displayed when the requested
URL contains an invalid domain name.

The hostname resolution (DNS lookup) for this
hostname <hostname> has failed. The Internet
address may be misspelled or obsolete, the host
<hostname> may be temporarily unavailable,
or the DNS server may be unresponsive.

Please check the spelling of the Internet
address entered. If it is correct, try this request
later.

ERR_EXPECTATION_FA
ILED

Expectation Failed

Error page that is displayed when the
transaction request triggers the HTTP 417
“Expectation Failed” response.

The system cannot process the request for this
site <URL>. A non-standard browser may have
generated an invalid HTTP request.

If using a standard browser, please retry the
request.

ERR_FILE_SIZE
Policy: File Size

Block page that is displayed when the
requested file is larger than the allowed
maximum file size.

Based on your organization’s Access Policies,
access to this web site or download <URL> has
been blocked because the download size
exceeds the allowed limit.

ERR_FILE_TYPE
Policy: File Type

Block page that is displayed when the
requested file is a blocked file type.

Based on your organization’s Access Policies,
access to this web site or download <URL> has
been blocked because the file type “<file
type>" is not allowed.

ERR_FILTER_FAILURE

Filter Failure

Error page that is displayed when the URL
filtering engine is temporarily unable to deliver
a URL filtering response and the “Default
Action for Unreachable Service” option is set
to Block.

The request for page <URL> has been denied
because an internal server is currently
unreachable or overloaded.

Please retry the request later.

ERR_FOUND
Found

Internal redirection page for some errors.

The page <URL> is being redirected to
<redirected URL>.

ERR_FTP_ABORTED
FTP Aborted

Error page that is displayed when the FTP over
HTTP transaction request triggers the HTTP
416 “Requested Range Not Satisfiable”
response.

The request for the file <URL> did not
succeed. The FTP server <hostname>
unexpectedly terminated the connection.

Please retry the request later.
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File Name and
Notification Title

Notification Description

Notification Text

ERR_FTP_AUTH_REQUI
RED

FTP Authorization
Required

Error page that is displayed when the FTP over
HTTP transaction request triggers the FTP 530
“Not Logged In” response.

Authentication is required by the FTP server
<hostname>. A valid user ID and passphrase
must be entered when prompted.

In some cases, the FTP server may limit the
number of anonymous connections. If you
usually connect to this server as an anonymous
user, please try again later.

ERR_FTP_CONNECTION
_FAILED

FTP Connection Failed

Error page that is displayed when the FTP over
HTTP transaction request triggers the FTP 425
“Can’t open data connection” response.

The system cannot communicate with the FTP
server <hostname>. The FTP server may be
temporarily or permanently down, or may be
unreachable because of network problems.

Please check the spelling of the address
entered. If it is correct, try this request later.

ERR_FTP_FORBIDDEN
FTP Forbidden

Error page that is displayed when the FTP over
HTTP transaction request is for an object the
user is not allowed to access.

Access was denied by the FTP server
<hostname>. Your user ID does not have
permission to access this document.

ERR_FTP_NOT_FOUND
FTP Not Found

Error page that is displayed when the FTP over
HTTP transaction request is for an object that
does not exist on the server.

The file <URL> could not be found. The
address is either incorrect or obsolete.

ERR_FTP_SERVER_ERR
FTP Server Error

Error page that is displayed for FTP over
HTTP transactions that try to access a server
that does support FTP. The server usually
returns the HTTP 501 “Not Implemented”
response.

The system cannot communicate with the FTP
server <hostname>. The FTP server may be
temporarily or permanently down, or may not
provide this service.

Please confirm that this is a valid address. If it
is correct, try this request later.

ERR_FTP_SERVICE_UN
AVAIL

FTP Service Unavailable

Error page that is displayed for FTP over
HTTP transactions that try to access an FTP
server that is unavailable.

The system cannot communicate with the FTP
server <hostname>. The FTP server may be
busy, may be permanently down, or may not
provide this service.

Please confirm that this is a valid address. If it
is correct, try this request later.

ERR_GATEWAY_TIMEO
uT

Gateway Timeout

Error page that is displayed when the requested
server has not responded in a timely manner.

The system cannot communicate with the
external server <hostname>. The Internet
server may be busy, may be permanently down,
or may be unreachable because of network
problems.

Please check the spelling of the Internet
address entered. If it is correct, try this request
later.

ERR_IDS_ACCESS_FOR
BIDDEN

IDS Access Forbidden

Block page that is displayed when the user tries
to upload a file that is blocked due to a
configured Cisco Data Security Policy.

Based on your organization’s data transfer
policies, your upload request has been blocked.
File details:

<file details>
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File Name and
Notification Title

Notification Description

Notification Text

ERR_INTERNAL_ERRO
R

Internal Error

Error page that is displayed when there is an
internal error.

Internal system error when processing the
request for the page <URL>.

Please retry this request.

If this condition persists, please contact
<contact name> <email address> and provide
the code shown below.

ERR_MALWARE_SPECI
FIC

Security: Malware
Detected

Block page that is displayed when malware is
detected when downloading a file.

Based on your organization’s Access Policies,
this web site <URL> has been blocked because
it has been determined to be a security threat to
your computer or the organization’s network.

Malware <malware name> in the category
<malware category> has been found on this
site.

ERR_MALWARE_SPECI
FIC_OUTGOING

Security: Malware
Detected

Block page that is displayed when malware is
detected when uploading a file.

Based on your organization’s policy, the
upload of the file to URL (<URL>) has been
blocked because the file was detected to
contain malware that will be harmful to the
receiving end's network security.

Malware Name: <malware name>

Malware Category: <malware category>

ERR_NATIVE_FTP_DENI
ED

Block message displayed in native FTP clients
when the native FTP transaction is blocked.

530 Login denied

ERR_NO_MORE_FORW
ARDS

No More Forwards

Error page that is displayed when the appliance
has detected a forward loop between the Web
Proxy and another proxy server on the
network. The Web Proxy breaks the loop and
displays this message to the client.

The request for the page <URL> failed.

The server address <hostname> may be
invalid, or you may need to specify a port
number to access this server.

ERR_POLICY

Policy: General

Block page that is displayed when the request
is blocked by any policy setting.

Based on your organization’s Access Policies,
access to this web site <URL> has been
blocked.

ERR_PROTOCOL

Policy: Protocol

Block page that is displayed when the request
is blocked based on the protocol used.

Based on your organization’s Access Policies,
this request has been blocked because the data
transfer protocol “<protocol type>" is not
allowed.

ERR_PROXY_AUTH_RE
QUIRED

Proxy Authorization
Required

Notification page that is displayed when users
must enter their authentication credentials to
continue. This is used for explicit transaction
requests.

Authentication is required to access the
Internet using this system. A valid user ID and
passphrase must be entered when prompted.
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File Name and
Notification Title

Notification Description

Notification Text

ERR_PROXY_PREVENT
_MULTIPLE_LOGIN

Already Logged In From
Another Machine

Block page that is displayed when someone
tries to access the web using the same
username that is already authenticated with the
Web Proxy on a different machine. This is used
when the User Session Restrictions global
authentication option is enabled.

Based on your organization’s policies, the
request to access the Internet was denied
because this user ID has an active session from
another IP address.

If you want to login as a different user, click on
the button below and enter a different a user
name and passphrase.

ERR_PROXY_REDIRECT
Redirect

Redirection page.

This request is being redirected. If this page
does not automatically redirect, click here to
proceed.

ERR_PROXY_UNACKNO
WLEDGED

Policy Acknowledgment

End-user acknowledgment page.

For more information, see End-User
Notification Pages, page 17-5.

Please acknowledge the following statements
before accessing the Internet.

Your web transactions will be automatically
monitored and processed to detect dangerous
content and to enforce organization’s policies.
By clicking the link below, you acknowledge
this monitoring and accept that data about the
sites you visit may be recorded. You will be
periodically asked to acknowledge the
presence of the monitoring system. You are
responsible for following organization’s
polices on Internet access.

Click here to accept this statement and access
the Internet.

ERR_PROXY_UNLICEN
SED

Proxy Not Licensed

Block page that is displayed when there is no
valid license key for the Web Security
appliance Web Proxy.

Internet access is not available without proper
licensing of the security device.

Please contact <contact name> <email
address> and provide the code shown below.

Note To access the management interface of
the security device, enter the

configured IP address with port.

ERR_RANGE_NOT_SATI
SFIABLE

Range Not Satisfiable

Error page that is displayed when the requested
range of bytes cannot be satisfied by the web
server.

The system cannot process this request. A
non-standard browser may have generated an
invalid HTTP request.

If you are using a standard browser, please
retry the request.

ERR_REDIRECT_PERM
ANENT

Redirect Permanent

Internal redirection page.

The page <URL> is being redirected to
<redirected URL>.

ERR_REDIRECT_REPEA
T_REQUEST

Redirect

Internal redirection page.

Please repeat your request.
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File Name and
Notification Title

Notification Description

Notification Text

ERR_SAAS_AUTHENTIC
ATION

Policy: Access Denied

Notification page that is displayed when users
must enter their authentication credentials to
continue. This is used for accessing
applications.

Based on your organization’s policy, the
request to access <URL> was redirected to a
page where you must enter the login
credentials. You will be allowed to access the
application if authentication succeeds and you
have the proper privileges.

ERR_SAAS_AUTHORIZ
ATION

Policy: Access Denied

Block page that is displayed when users try to
access a application that they have no privilege
to access.

Based on your organization’s policy, the access
to the application <URL> is blocked because
you are not an authorized user. If you want to
login as a different user, enter a different
username and passphrase for a user that is
authorized to access this application.

ERR_SAML_PROCESSIN
G

Policy: Access Denied

Error page that is displayed when an internal
process fails trying to process the single
sign-on URL for accessing a application.

The request to access <user name> did not go
through because errors were found during the
process of the single sign on request.

ERR_SERVER_NAME_E
XPANSION

Server Name Expansion

Internal redirection page that automatically
expands the URL and redirects users to the
updated URL.

The server name <hostname> appears to be an
abbreviation, and is being redirected to
<redirected URL>.

ERR_URI_TOO_LONG
URI Too Long

Block page that is displayed when the URL
length is too long.

The requested URL was too long and could not
be processed. This may represent an attack on
your network.

Please contact <contact name> <email
address> and provide the code shown below.

ERR_WBRS
Security: Malware Risk

Block page that is displayed when the Web
Reputation Filters block the site due to a low
web reputation score.

Based on your organization’s access policies,
this web site <URL> has been blocked because
it has been determined by Web Reputation
Filters to be a security threat to your computer
or the organization’s network. This web site
has been associated with malware/spyware.

Threat Type: %o
Threat Reason: %0

ERR_WEBCAT
Policy: URL Filtering

Block page that is displayed when users try to
access a website in a blocked URL category.

Based on your organization’s Access Policies,
access to this web site <URL> has been
blocked because the web category “<category
type>" is not allowed.

ERR_WWW_AUTH_REQ
UIRED

WWW Authorization
Required

Notification page that is displayed when the
requested server requires users to enter their
credentials to continue.

Authentication is required to access the
requested web site <hostname>. A valid user
ID and passphrase must be entered when
prompted.
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Generate Reports to Monitor End-user Activity

e Overview of Reporting, page 18-1

e Using the Reporting Tab, page 18-2

e Enabling Centralized Reporting, page 18-7
e Scheduling Reports, page 18-7

e Generating Reports On Demand, page 18-8
e Archived Reports, page 18-9

Overview of Reporting

The Web Security appliance generates high-level reports, allowing you to understand what is happening
on the network and also allowing you to view traffic details for a particular domain, user, or category.
You can run reports to view an interactive display of system activity over a specific period of time, or
you can schedule reports and run them at regular intervals.

Related Topics
¢ Printing and Exporting Reports from Report Pages, page 18-5

Working with Usernames in Reports

Note

Step 1
Step 2
Step 3

When you enable authentication, reports list users by their usernames when they authenticate with the
Web Proxy. By default, usernames are written as they appear in the authentication server. However, you
can choose to make usernames unrecognizable in all reports.

Administrators always see usernames in reports.

Choose Security Services > Reporting, and click Edit Settings.
Under Local Reporting, select Anonymize usernames in reports.

Submit and Commit Changes.
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Report Pages

The Web Security appliance offers the following reports:

e Overview

e Users

e Web Sites

e URL Categories

e Application Visibility

e Anti-Malware

e Client Malware Risk

e Web Reputation Filters
e Layer-4 Traffic Monitor
e Reports by User Location
e Web Tracking

e System Capacity

e System Status

Using the Reporting Tab

The Reporting tab provides several options for viewing system data. The report pages provide an
overview of system activity and support multiple options for viewing system data. You can also search
each page for website and client-specific data.

You can perform the following tasks on most reports on the Reporting tab:

Option

Link to Task

Change the time range displayed in a report

Changing the Time Range, page 18-2

Search for specific clients and domains

Searching Data, page 18-3

Choose which data to display in charts

Choosing Which Data to Chart, page 18-4

Choose and sort columns

Related Topics, page 18-4

Export reports to external files

Printing and Exporting Reports from Report Pages,
page 18-5

Changing the Time Range

You can update the data displayed for each security component using the Time Range field. This option
allows you to generate updates for predefined time ranges and it allows you to define custom time ranges
from a specific start time to a specific end time.
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Note  The time range you select is used throughout all of the report pages until you select a different value in
the Time Range menu.

Time Range Data is returned in...

Hour Sixty (60) complete minutes plus up to 5 additional minutes.

Day One hour intervals for the last 24 hours and including the current partial hour.
Week One day intervals for the last 7 days plus the current partial day.

Month (30 days) |One day intervals for the last 30 days plus the current partial day.

Yesterday The last 24 hours (00:00 to 23:59) using the Web Security appliance defined time
zone.

Custom Range |The custom time range defined by the user.

When you choose Custom Range, a dialog box appears where you can enter the start
and end times.

Note  All reports display date and time information based on the systems configured time zone, shown as a
Greenwich Mean Time (GMT) offset. However, data exports display the time in GMT to accommodate
multiple systems in multiple time zones around the world.

Searching Data

Some reports include a field that allow you to search for particular data points. When you search for data,
the report refines the report data for the particular data set you are searching.You can search for values
that exactly match of the string you enter, or for values that start with the string you enter. The following
report pages include search fields:

Search Fields Description

Users Search for a user by user name or client IP address

Web Sites Search for a server by domain or server IP address

URL Categories Search for a URL category

Application Visibility Search for an application name that the AVC engine monitors and blocks
Client Malware Risk Search for a user by user name or client IP address

Note  You need to configure authentication to view client user IDs as well as client IP addresses.
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Choosing Which Data to Chart

Step 1
Step 2
Step 3

The default charts on each Web Reporting page display commonly-referenced data, but you can choose
to chart different data instead. If a page has multiple charts, you can change each chart. The chart options
are the same as the columns headings of the table(s) in the report.

Click the Chart Options link below a chart.
Choose the data to display.
Click Done.

Related Topics
e Related Topics, page 18-4

Custom Reports

You can create a custom report page by assembling charts (graphs) and tables from existing report pages.

To

Do This

Add modules to your
custom report page

See:
e Modules That Cannot Be Added to Custom Reports, page 18-4.
e Creating Your Custom Report Page, page 18-5

View your custom
report page

1. Choose Reporting > My Reports.

2. Select the time range to view. The time range selected applies to all reports, including all modules
on the My Reports page.

Newly-added modules appear at the top of the relevant section.

Rearrange modules
on your custom
report page

Drag and drop modules into the desired location.

Delete modules from
your custom report

page

Click the [X] in the top right corner of the module.

Generate a PDF or
CSV version of your
custom report

Select Reporting > Archived Reports and click Generate Report Now.

Periodically generate
a PDF or CSV
version of your
custom report

Select Reporting > Scheduled Reports.

Modules That Cannot Be Added to Custom Reports

e Search results, including Web Tracking search results
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Creating Your Custom Report Page

Before You Begin
¢ Ensure that the modules that you want to add can be added. See Modules That Cannot Be Added to
Custom Reports, page 18-4.

e Delete any default modules that you do not need by clicking the [X] in the top right corner of
the module.

Step 1 Use one of the following methods to add a module to your custom report page:

A
Note  Some modules are available only using one of these methods. If you cannot add a module using
one method, try another method.

e Navigate to the report page that has the module that you want to add, then click the [+] button at
the top of the module.

¢ Go to Reporting > My Reports, click the [+] button at the top of one of the sections, then select the
report module that you want to add. You may need to click the [+] button in each section on the My
Reports page in order to find the module that you are looking for.

You can add each module only once; if you have already added a particular module to your report, the
option to add it will not be available.

Step2  If you add a module that you have customized (for example, by adding, deleting, or reordering columns,
or by displaying non-default data in the chart), customize the modules on the My Reports page.

Modules are added with default settings. Time range of the original module is not maintained.

Step3  If you add a chart that includes a separate legend (for example, a graph from the Overview page), add
the legend separately. If necessary, drag and drop it into position beside the data it describes.

Subdomains vs. Second-Level Domains in Reporting and Tracking

In reporting and tracking searches, second-level domains (regional domains listed at
http://george.surbl.org/two-level-tlds) are treated differently from subdomains, even though the two
domain types may appear to be the same. For example:

e Reports will not include results for a two-level domain such as co.uk, but will include results for
foo.co.uk. Reports include subdomains under the main corporate domain, such as cisco.com.

e Tracking search results for the regional domain co.uk will not include domains such as foo.co.uk,
while search results for cisco.com will include subdomains such as subdomain.cisco.com.

Printing and Exporting Reports from Report Pages

You can generate a printer-friendly formatted PDF version of any of the report pages by clicking the
Printable (PDF) link at the top-right corner of the page. You can also export raw data as a
comma-separated value (CSV) file by clicking the Export link.

Because CSV exports include only raw data, exported data from a web-based report page may not
include calculated data such as percentages, even if that data appears in the web-based report.
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Exporting Report Data

Most reports include an Export link that allows you to export raw data to a comma-separated values
(CSV) file. After exporting the data to a CSV file, you can access and manipulate the data in it using

applications such as Microsoft Excel.

The exported CSV data displays all message tracking and reporting data in Greenwich Mean Time
(GMT) regardless of what is set on the Web Security appliance. The purpose of the GMT time conversion
is to allow data to be used independently from the appliance or when referencing data from appliances

in multiple time zones.

The following example is an entry from a raw data export of the Anti-Malware category report, where
Pacific Daylight Time (PDT) is displayed as GMT - 7 hours:

Begin Timestamp, End Timestamp,

1159772400.0,
2100, 2625

1159858799.0,

Begin Date,
Transactions Blocked, Transactions Detected

2006-10-02 07:00 GMT,

End Date, Name, Transactions Monitored,

2006-10-03 06:59 GMT, Adware, 525,

Category Header Value

Description

Begin Timestamp 1159772400.0

Query start time in number of seconds from epoch.

End Timestamp 1159858799.0

Query end time in number of seconds from epoch.

Begin Date 2006-10-02 07:00

Date the query began.

GMT
End Date 2006-10-03 06:59 |Date the query ended.
GMT
Name Adware Name of the malware category.

Transactions Monitored 525

Number of transactions monitored.

Transactions Blocked 2100

Number of transactions blocked.

Transactions Detected 2625

Total number of transactions:

Number of transactions detected + Number of
transactions blocked.

Category headers are different for each type of report.

If you export localized CSV data, the headings may not be rendered properly in some browsers. This
occurs because some browsers may not use the proper character set for the localized text. To work around
this problem, you can save the file to your local machine, and open the file in any web browser using
File > Open. When you open the file, select the character set to display the localized text.
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When the Web Security appliance is managed by a Security Management appliance, you can choose
which appliance displays reports on the web traffic that is processed by the Web Security appliance. You
might want to enable Centralized Reporting when the Security Management appliance manages multiple

Web Security appliances.

Note  When you enable Centralized Reporting, only the System Capacity and System Status reports are
available on the Web Security appliance. To view the other reports, connect to the Security Management

appliance.

Step 1 Choose Security Services > Reporting and click Edit Settings.
Step2  Choose Centralized Reporting.
Step3  Submit and Commit Changes.

Scheduling Reports

You can schedule reports to run on a daily, weekly, or monthly basis. Scheduled reports can be
configured to include data for the previous day, previous seven days, or previous month.

You can schedule reports for the following types of reports:

e Overview

e Users

e Web Sites

e URL Categories

e Application Visibility

e Anti-Malware

¢ Client Malware Risk

e Web Reputation Filters
e Layer-4 Traffic Monitor
e SOCKS Proxy

e Reports by User Location
e System Capacity

e My Reports

Adding a Scheduled Report

Step 1 Choose Reporting > Scheduled Reports and click Add Scheduled Report.

Step2  Select a report type.
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M Generating Reports On Demand

Step 3

Step 4
Step 5

Step 6

Step 7
Step 8

Step 9

Enter a title for the report. To avoid creating multiple reports with the same name, consider using a
descriptive title.

Select a time range for the data included in the report.
Choose the format for the generated report.
The default format is PDF. Most reports also allow you to save raw data as a CSV file.

Depending on the type of report you configure, you can specify different report options, such as the
number of rows to include and by which column to sort the data. Configure these options as necessary.

In the Schedule section, choose whether to run the report daily, weekly, or monthly and at what time.
In the Email field, enter the email address to where to send the generated report.
If you do not specify an email address, the report is archived only.

Submit and Commit Changes.

Editing Scheduled Reports

Step 1
Step 2
Step 3
Step 4

Choose Reporting > Scheduled Reports.
Select the report title from the list.
Modify settings.

Submit and Commit Changes.

Deleting Scheduled Reports

Step 1
Step 2
Step 3
Step 4

S

Note

Choose Reporting > Scheduled Reports.
Select the check boxes corresponding to the reports that you want to delete.
To remove all scheduled reports, select the All check box.

Delete and Commit Changes.

Archived versions of deleted reports are not deleted.

Generating Reports On Demand

Step 1
Step 2
Step 3

Choose Reporting > Archived Reports.
Click Generate Report Now.
Select a report type and edit the title.
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Step 4
Step 5

Step 6

Step 7
Step 8
Step 9
Step 10

Archived Reports I

Select a time range for the data included in the report.
Choose the format for the generated report.
The default format is PDF. Most reports also allow you to save raw data as a CSV file.

Depending on the type of report you configure, you can specify different report options, such as the
number of rows to include and by which column to sort the data. Configure these options as necessary.

Select whether to archive the report (if so, the report will appear on the Archived Reports page).
Specify whether to email the report, and list the email addresses of the recipients.
Click Deliver this Report to generate the report.

Commit Changes.

Archived Reports

The Reporting > Archived Reports page lists available archived reports. Report names in the Report
Title column are interactive and link to a view of each report. The Show menu filters the types of reports
that are listed. Interactive column headings can be used to sort the data in each column.

The appliance stores up to 12 instances of each scheduled report (up to 1000 reports). Archived reports
are stored in the /periodic_reports directory on the appliance. Archived reports are deleted
automatically. As new reports are added, older reports are removed to keep the number at 1000. The limit
of 12 instances applies to each scheduled report with the same name and time range.
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M Archived Reports
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Web Security Appliance Reports

e Overview Page, page 19-1

e System Capacity Page, page 19-2

e System Status Page, page 19-3

Overview Page

The Reporting > Overview page provides a synopsis of the activity on the Web Security appliance. It
includes graphs and summary tables for Web traffic processed by the Web Security appliance.

System Overview

Section Description
Web Proxy Traffic Listing of Average transactions per second in past minute,
Characteristics

Average bandwidth (bps) in past minute, Average response

time (ms) in past minute, and Total current connections.

System Resource Utilization

Listing of current overall CPU Load, RAM and Reporting / logging
disk usage. Click System Status Details to switch to the System
Status page (see System Status Page, page 19-3 for details).

Note The CPU utilization value shown on this page and the CPU
value shown on the System Status page may differ slightly

because they are read separately, at differing moments.

Time Range-based Categories and Summaries

Section

Description

Time Range: Choose a time range for the data displayed in the following sections. Options are Hour,
Day, Week, 30 Days, Yesterday, or a Custom Range.

Total Web Proxy Activity

Displays the actual number of transactions (vertical scale) as well
as the approximate date that the (Web Proxy) activity occurred
(horizontal timeline).

Web Proxy Summary

Allows you to view the percentage of Web Proxy activity that are
suspect or clean Web Proxy activity.
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System Capacity Page

Time Range-based Categories and Summaries

Section

Description

L4 Traffic Monitor Summary

Reports on traffic monitored and blocked by the L4 Traffic Monitor.

Suspect Transactions

Allows you to view the web transactions that have been labeled as
suspect by the various security components.

Displays the actual number of transactions as well as the
approximate date that the activity occurred.

Suspect Transactions Summary

Allows you to view the percentage of blocked or warned
transactions that are suspect.

Top URL Categories:
Total Transactions

Displays the top 10 URL categories that have been blocked.

Top Application Types:
Total Transactions

Displays the top application types that have been blocked by the
AVC engine.

Top Malware Categories:
Monitored or Blocked

Displays all malware categories that have been detected.

Top Users: Blocked or
Warned Transactions

Displays the users that are generating the blocked or warned
transactions. Authenticated users are displayed username and
unauthenticated users are displayed by IP address.

System Capacity Page

The Reporting > System Capacity page displays current and historical information about resource
usage on the Web Security appliance.

When choosing time ranges for viewing data on the System Capacity page, the following is important to

remember:

¢ Hour Report. The Hour report queries the minute table and displays the exact number of items, such
as bytes and connection, that have been recorded by the appliance on an minute by minute basis over

a 60 minute period.

¢ Day Report. The Day report queries the hour table and displays the exact number of items, such as
bytes and connection, that have been recorded by the appliance on an hourly basis over a 24 hour
period. This information is gathered from the hour table.

The Week Report and 30 Days Report work similarly to the Hour and Day Reports.
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System Status Page

System Status Page

Use the Reporting > System Status page to monitor the System Status. This page displays the current
status and configuration of the Web Security appliance.

This Section...

Displays

Web Security
Appliance Status

e System uptime

e System resource utilization — CPU usage, RAM usage, and
percentage of disk space used for reporting and logging.

The CPU utilization value shown on this page and the CPU value
shown on the system Overview page (Overview Page, page 19-1) may
differ slightly because they are read separately, at differing moments.

RAM usage for a system that is working efficiently may be above 90%,
because RAM that is not otherwise in use by the system is used by the
web object cache. If your system is not experiencing serious

performance issues and this value is not stuck at 100%, the system is

operating normally.

Note Proxy Buffer Memory is one component that uses this RAM.

Proxy Traffic
Characteristics

e Transactions per second
¢ Bandwidth

e Response time

¢ Cache hit rate

e Connections

High Availability

External Services

e Identity Services Engine

Current Configuration

Web Proxy settings:
e Web Proxy Status — enabled or disabled.
e Deployment Topology.
e Web Proxy Mode — forward or transparent.
e [P Spoofing — enabled or disabled.
L4 Traffic Monitor settings:

e 14 Traffic Monitor Status — enabled or disabled.

e L4 Traffic Monitor Wiring.
e L4 Traffic Monitor Action — monitor or block.
Web Security Appliance Version Information

Hardware information

Related Topics

e System Capacity Page, page 19-2

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Chapter 19 Web Security Appliance Reports |

Il System Status Page
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Detecting Rogue Traffic on Non-Standard Ports

e Overview of Detecting Rogue Traffic, page 20-1

e Configuring the L4 Traffic Monitor, page 20-1

e List of Known Sites, page 20-2

e Configuring L4 Traffic Monitor Global Settings, page 20-2

e Updating L4 Traffic Monitor Anti-Malware Rules, page 20-2

e Creating a Policy to Detect Rogue Traffic, page 20-3

e Viewing L4 Traffic Monitor Activity, page 20-4

Overview of Detecting Rogue Traffic

The Web Security appliance has an integrated Layer-4 Traffic Monitor that detects rogue traffic across
all network ports and stops malware attempts to bypass port 80. When internal clients are infected with
malware and attempt to phone-home across non-standard ports and protocols, the L4 Traffic Monitor
prevents phone-home activity from going outside the corporate network. By default, the L4 Traffic
Monitor is enabled and set to monitor traffic on all ports. This includes DNS and other services.

The L4 Traffic Monitor uses and maintains its own internal database. This database is continuously
updated with matched results for IP addresses and domain names.

Configuring the L4 Traffic Monitor

Step 1

Configure the L4 Traffic Mon

itor inside the firewall.

Step 2

Ensure the L4 Traffic Monitor is ‘logically’ connected after the proxy ports and before
any device that performs network address translation (NAT) on client IP addresses.

Step 3

Configure the Global Settings

See Configuring L4 Traffic Monitor
Global Settings, page 20-2.

Step 4

Create L4 TrafficMonitor Policies See Creating a Policy to Detect Rogue

Traffic, page 20-3.
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I List of Known Sites

List of Known Sites

Address Description

Known allowed Any IP address or hostname listed in the Allow List property. These addresses
appear in the log files as “whitelist” addresses.

Unlisted Any IP address that is not known to be a malware site nor is a known allowed
address. They are not listed on the Allow List, Additional Suspected Malware
Addresses properties, or in the L4 Traffic Monitor Database. These addresses do
not appear in the log files.

Ambiguous These appear in the log files as “greylist” addresses and include:

— Any IP address that is associated with both an unlisted hostname and a
known malware hostname.

— Any IP address that is associated with both an unlisted hostname and a
hostname from the Additional Suspected Malware Addresses property

Known malware |These appear in the log files as “blacklist” addresses and include:

— Any IP address or hostname that the L4 Traffic Monitor Database
determines to be a known malware site and not listed in the Allow List.

— Any IP address that is listed in the Additional Suspected Malware
Addresses property, not listed in the Allow List and is not ambiguous

Configuring L4 Traffic Monitor Global Settings

Step 1 Choose Security Services > 1.4 Traffic Monitor.
Step2  Click Edit Global Settings.
Step3  Choose whether or not to enable the L4 Traffic Monitor.
Stepd  When you enable the L4 Traffic Monitor, choose which ports it should monitor:
e All ports. Monitors all 65535 TCP ports for rogue activity.
e All ports except proxy ports. Monitors all TCP ports except the following ports for rogue activity.

— Ports configured in the “HTTP Ports to Proxy” property on the Security Services > Web Proxy
page (usually port 80).

— Ports configured in the “Transparent HTTPS Ports to Proxy” property on the Security Services
> HTTPS Proxy page (usually port 443).

Step5 Submit and Commit Changes.

Updating L4 Traffic Monitor Anti-Malware Rules

Step 1 Choose Security Services > 1.4 Traffic Monitor.
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Creating a Policy to Detect Rogue Traffic

Step2  Click Update Now.

Creating a Policy to Detect Rogue Traffic

The actions the L4 Traffic Monitor takes depends on the L4 Traffic Monitor policies you configure:

Step1  Choose Web Security Manager > L4 Traffic Monitor.

Step2  Click Edit Settings.

Step3  On the Edit L4 Traffic Monitor Policies page, configure the L4 Traffic Monitor policies:
a. Define the Allow List
b. Add known good sites to the Allow List

N

Note Do not include the Web Security appliance IP address or hostname to the Allow List
otherwise the L4 Traffic Monitor does not block any traffic.

c. Determine which action to perform for Suspected Malware Addresses:

Action Description
Allow It always allows traffic to and from known allowed and unlisted addresses
Monitor It monitors traffic under the following circumstances:

— When the Action for Suspected Malware Addresses option is set to Monitor, it
always monitors all traffic that is not to or from a known allowed address.

— When the Action for Suspected Malware Addresses option is set to Block, it
monitors traffic to and from ambiguous addresses

Block When the Action for Suspected Malware Addresses option is set to Block, it blocks
traffic to and from known malware addresses

Note  When you choose to block suspected malware traffic, you can also choose whether or not to
always block ambiguous addresses. By default, ambiguous addresses are monitored.

Note If the L4 Traffic Monitor is configured to block, the L4 Traffic Monitor and the Web Proxy
must be configured on the same network. Use the Network > Routes page to confirm that
all clients are accessible on routes that are configured for data traffic.

d. Define the Additional Suspected Malware Addresses properties
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B Viewing L4 Traffic Monitor Activity

~

Note  Adding internal IP addresses to the Additional Suspected Malware Addresses list causes
legitimate destination URLs to show up as malware in L4 Traffic Monitor reports. To avoid
this do not enter internal IP addresses in the “Additional Suspected Malware Addresses”
field on the Web Security Manager > L4 Traffic Monitor Policies page.

Step4  Submit and Commit Changes.

Related Topics
e Opverview of Detecting Rogue Traffic, page 20-1
e Valid Formats, page 20-4.

Valid Formats

When you add addresses to the Allow List or Additional Suspected Malware Addresses properties,

separate multiple entries with whitespace or commas. You can enter addresses in any of the following
formats:

e IPv4 IP address. Example: IPv4 format: 10.1.1.0. IPv6 format: 2002:4559:1FE2::4559:1FE2
e CIDR address. Example: 10.1.1.0/24.

¢ Domain name. Example: example.com.

¢ Hostname. Example: crm.example.com.

Viewing L4 Traffic Monitor Activity

The S-Series appliance supports several options for generating feature specific reports and interactive
displays of summary statistics.

Monitoring Activity and Viewing Summary Statistics

The Reporting > L4 Traffic Monitor page provides statistical summaries of monitoring activity. You
can use the following displays and reporting tools to view the results of L4 Traffic Monitor activity:

To view... See...
Client statistics Reporting > Client Activity
Malware statistics Reporting > L4 Traffic Monitor

Port statistics

L4 Traffic Monitor log files System Administration > Log Subscriptions

e trafmon_errlogs

e trafmonlogs

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| 20-4 | I



| Chapter20 Detecting Rogue Traffic on Non-Standard Ports

Viewing L4 Traffic Monitor Activity

Note  If the Web Proxy is configured as a forward proxy and L4 Traffic Monitor is set to monitor all ports, the
IP address of the proxy’s data port is recorded and displayed as a client IP address in the client activity
report on the Reporting > Client Activity page. If the Web Proxy is configured as a transparent proxy,
enable IP spoofing to correctly record and display the client IP addresses.

L4 Traffic Monitor Log File Entries

The L4 Traffic Monitor log file provides a detailed record of monitoring activity.
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B Viewing L4 Traffic Monitor Activity
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Monitor System Activity Through Logs

e Overview of Logging, page 21-1

e Common Tasks for Logging, page 21-2

e Best Practices for Logging, page 21-2

e Troubleshooting Web Proxy Issues Using Logs, page 21-2

e Log File Types, page 21-3

e Adding and Editing Log Subscriptions, page 21-7

e Pushing Log Files to Another Server, page 21-11

e Archiving Log Files, page 21-11

e Log File Names and Appliance Directory Structure, page 21-12
e Viewing Log Files, page 21-13

e Web Proxy Information in Access Log Files, page 21-13

e Interpreting Access Log Scanning Verdict Entries, page 21-20
e W3C Compliant Access Log Files, page 21-24

e Customizing Access Logs, page 21-26

e Traffic Monitor Log Files, page 21-28

e Log File Fields and Tags, page 21-28

e Troubleshooting Logging, page 21-38

Overview of Logging

The Web Security appliance records its own system and traffic management activities by writing them
to log files. Administrators can consult these log files to monitor and troubleshoot the appliance.

The appliance divides different types of activity into different logging types to simplify the task of
finding information on specific activities. The majority of these are automatically enabled by default,
but some must be manually enabled as required.

You enable and manage log files through log file subscriptions. Subscriptions allow you to define the
settings for creating, customizing, and managing log files.

The two main log files types typically used by administrators are:
e Access log. This records all Web Proxy filtering and scanning activity.

¢ Traffic Monitor log. This records all Layer-4 Traffic Monitor activity.
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I Common Tasks for Logging

You can view current and past appliance activity using these and other log types. Reference tables are
available to help you interpret log file entries.

Related Topics
e Common Tasks for Logging, page 21-2

e Log File Types, page 21-3

Common Tasks for Logging

Task Links to Related Topics and Procedures

Troubleshoot web proxy issues using logs Troubleshooting Web Proxy Issues Using Logs, page 21-2
Add and edit log subscriptions Adding and Editing Log Subscriptions, page 21-7

View log files Viewing Log Files, page 21-13

Interpret log files Interpreting Access Log Scanning Verdict Entries, page 21-20
Customize log files Customizing Access Logs, page 21-26

Push log files to another server Pushing Log Files to Another Server, page 21-11

Archiving log files Archiving Log Files, page 21-11

Best Practices for Logging

e Minimizing the number of log subscriptions will benefit system performance.

e Logging fewer details will benefit system performance.

Troubleshooting Web Proxy Issues Using Logs

By default, the Web Security appliance has one log subscription created for Web Proxy logging
messages, called the “Default Proxy Logs.” This captures basic information on all Web Proxy modules.
The appliance also includes log file types for each Web Proxy module so you can read more specific
debug information for each module without cluttering up the Default Proxy Logs.

Follow the steps below to troubleshoot Web Proxy issues using the various logs available.

Step 1 Read the Default Proxy Logs.

Step2 If you see an entry that might related to the issue but does not have enough information to resolve it,
create a log subscription for the relevant specific Web Proxy module. The following Web Proxy module
logs types are available:
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Access Control Engine Logs
AVC Engine Framework Logs
Configuration Logs
Connection Management Logs
Data Security Module Logs
DCA Engine Framework Logs
Disk Manager Logs

FireAMP

FTP Proxy Logs

HTTPS Logs

License Module Logs

Log File Types ||

Logging Framework Logs

McAfee Integration Framework Logs
Memory Manager Logs
Miscellaneous Proxy Modules Logs
Request Debug Logs

SNMP Module Logs

Sophos Integration Framework Logs
WBRS Framework Logs

WCCP Module Logs

Webcat Integration Framework Logs

Webroot Integration Framework Logs

Step3  Recreate the issue and read the new Web Proxy module log for relevant entries.

Stepd  Repeat as required with other Web Proxy module logs.

Step5 Remove subscriptions that are no longer required.

Related Topics
e Log File Types, page 21-3

e Adding and Editing Log Subscriptions, page 21-7

Log File Types

Some log types related to the web proxy component are not enabled. The main web proxy log type, called

the “Default Proxy Logs,” is enabled by default and captures basic information on all Web Proxy
modules. Each Web Proxy module also has its own log type that you can manually enable as required.

The following table describes the Web Security appliance log file types.

Supports Enabled by

Log File Type Description Syslog Push? |Default?
Access Control Records messages related to the Web Proxy ACL  |No No
Engine Logs (access control list) evaluation engine.
AMP Engine Logs  |Records information about file reputation scanning |Yes Yes

and file analysis (Advanced Malware Protection.)

See also Log Files, page 17-14.
Audit Logs Records AAA (Authentication, Authorization, and |Yes Yes

Accounting) events. Records all user interaction

with the application and command-line interfaces,

and captures committed changes.
Access Logs Records Web Proxy client history. Yes Yes
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Log File Types

Supports Enabled by
Log File Type Description Syslog Push? |Default?
Authentication Records authentication history and messages. No Yes
Framework Logs
AVC Engine Records messages related to communication No No
Framework Logs between the Web Proxy and the AVC engine.
AVC Engine Logs Records debug messages from the AVC engine. Yes Yes
CLI Audit Logs Records a historical audit of command line interface |Yes Yes
activity.
Configuration Logs |Records messages related to the Web Proxy No No
configuration management system.
Connection Records messages related to the Web Proxy No No
Management Logs  |connection management system.
Data Security Logs |Records client history for upload requests that are | Yes Yes
evaluated by the Cisco Data Security Filters.
Data Security Records messages related to the Cisco Data Security |No No
Module Logs Filters.
DCA Engine Records messages related to communication No No
Framework Logs between the Web Proxy and the Cisco Web Usage
(Dynamic Content Controls Dynamic Content Analysis engine.
Analysis)
DCA Engine Logs |Records messages related to the Cisco Web Usage |Yes Yes
(Dynamic Content Controls Dynamic Content Analysis engine.
Analysis)
Default Proxy Logs |Records errors related to the Web Proxy. Yes Yes
This is the most basic of all Web Proxy related logs.
To troubleshoot more specific aspects related to the
Web Proxy, create a log subscription for the
applicable Web Proxy module.
Disk Manager Logs |Records Web Proxy messages related to writing to |No No
the cache on disk.
External Records messages related to using the external No Yes
Authentication Logs |authentication feature, such as communication
success or failure with the external authentication
server.
Even with external authentication is disabled, this
log contains messages about local users
successfully or failing logging in.
Feedback Logs Records the web users reporting misclassified Yes Yes
pages.
FTP Proxy Logs Records error and warning messages related to the |No No
FTP Proxy.
FTP Server Logs Records all files uploaded to and downloaded from |Yes Yes

the Web Security appliance using FTP.
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Supports Enabled by
Log File Type Description Syslog Push? |Default?
GUI Logs Records history of page refreshes in the web Yes Yes
. interface. GUI logs also include information about
(Graphical User . . .
Interface) SMTP transactions, for example information about
scheduled reports emailed from the appliance.
Haystack Logs Haystack logs record web transaction tracking data |Yes Yes
processing.
HTTPS Logs Records Web Proxy messages specific to the No No
HTTPS Proxy (when the HTTPS Proxy is enabled).
ISE Server Logs Records ISE server(s) connection and operational  |Yes Yes
information.
License Module Records messages related to the Web Proxy’s No No
Logs license and feature key handling system.
Logging Framework |Records messages related to the Web Proxy’s No No
Logs logging system.
Logging Logs Records errors related to log management. Yes Yes
McAfee Integration |Records messages related to communication No No
Framework Logs between the Web Proxy and the McAfee scanning
engine.
McAfee Logs Records the status of anti-malware scanning activity |Yes Yes
from the McAfee scanning engine.
Memory Manager Records Web Proxy messages related to managing |No No
Logs all memory including the in-memory cache for the
Web Proxy process.
Miscellaneous Records Web Proxy messages that are mostly used |No No
Proxy Modules Logs |by developers or customer support.
AnyConnect Secure |Records the interaction between the Web Security | Yes Yes
Mobility Daemon appliance and the AnyConnect client, including the
Logs status check.
NTP Logs Records changes to the system time made by the Yes Yes
(Network Time Network Time Protocol.
Protocol)
PAC File Hosting Records proxy auto-config (PAC) file usage by Yes Yes
Daemon Logs clients.
Proxy Bypass Logs |Records transactions that bypass the Web Proxy. No Yes
Reporting Logs Records a history of report generation. Yes Yes
Reporting Query Records errors related to report generation. Yes Yes

Logs
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Log File Types

Supports Enabled by
Log File Type Description Syslog Push? |Default?
Request Debug Logs |Records very detailed debug information on a No No
specific HTTP transaction from all Web Proxy
module log types. You might want to create this log
subscription to troubleshoot a proxy issue with a
particular transaction without creating all other
proxy log subscriptions.
Note: You can create this log subscription in the
CLI only.
Auth Logs Records messages related to the Access Control Yes Yes
feature.
SHD Logs Records a history of the health of system services |Yes Yes
(System Health and a history of unexpected daemon restarts.
Daemon)
SNMP Logs Records debug messages related to the SNMP Yes Yes
network management engine.
SNMP Module Logs |Records Web Proxy messages related to interacting |No No
with the SNMP monitoring system.
Sophos Integration |Records messages related to communication between |No No
Framework Logs the Web Proxy and the Sophos scanning engine.
Sophos Logs Records the status of anti-malware scanning activity |Yes Yes
from the Sophos scanning engine.
Status Logs Records information related to the system, such as |Yes Yes
feature key downloads.
System Logs Records DNS, error, and commit activity. Yes Yes
Traffic Monitor Records L4TM interface and capture errors. Yes Yes
Error Logs
Traffic Monitor Records sites added to the L4TM block and allow |No Yes
Logs lists.
UDS Logs Records data about how the Web Proxy discovers |Yes Yes
. the user name without doing actual authentication.
(User Discovery . . . . . .
Service) It includes information about interacting with the
Cisco adaptive security appliance for the Secure
Mobility as well as integrating with the Novell
eDirectory server for transparent user identification.
Updater Logs Records a history of WBRS and other updates. Yes Yes
W3C Logs Records Web Proxy client history in a W3C Yes No
compliant format.
For more information, see W3C Compliant Access
Log Files, page 21-24.
WBNP Logs Records a history of Cisco SensorBase Network No Yes
(SensorBase participation uploads to the SensorBase network.
Network
Participation)
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Supports Enabled by

Log File Type Description Syslog Push? |Default?

WBRS Framework |Records messages related to communication No No

Logs between the Web Proxy and the Web Reputation

(Web Reputation Filters.

Score)

WCCP Module Logs |Records Web Proxy messages related to No No
implementing WCCP.

Webcat Integration |Records messages related to communication No No

Framework Logs between the Web Proxy and the URL filtering
engine associated with Cisco Web Usage Controls.

Webroot Integration |Records messages related to communication No No
Framework Logs between the Web Proxy and the Webroot scanning
engine.
Webroot Logs Records the status of anti-malware scanning activity |Yes Yes
from the Webroot scanning engine.
Welcome Page Records a history of web clients who click the Yes Yes
Acknowledgement |Accept button on the end-user acknowledgement
Logs page.

Adding and Editing Log Subscriptions

You can create multiple log subscriptions for each type of log file. Subscriptions include configuration
details for archiving and storage, including these:

— Rollover settings, which determine when log files are archived.
— Compression settings for archived logs.

— Retrieval settings for archived logs, which specifies whether logs are archived onto a remote
server or stored on the appliance.

Step 1 Choose System Administration > Log Subscriptions.

Step2  To add a log subscription, click Add Log Subscription. Or, to edit a log subscription, click the name of
the log file in the Log Name field.

Step3  Configure the subscription:

Option Description

Log Type A list of available log file types that you can subscribe to. The other options
on the page may change according to log file type you choose.

Note The Request Debug Logs log type can only be subscribed to using
the CLI and does not appear on this list.

Log Name The name used to refer to the subscription on the Web Security appliance.
This name is also used for the log directory which will store the log files for
the subscription.
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Option Description

Rollover by File Size The maximum file size to which the current log file can grow before it is
archived and a new log file started. Enter a number between 100 kilobytes
and 10 gigabytes.

Rollover by Time The maximum time interval before the current log file is archived and a new
log file started. The following interval types are available:

e None. AsyncOS only performs a rollover when the log file reaches the
maximum file size.

¢ Custom Time Interval. AsyncOS performs a rollover after a specified
amount of time has passed since the previous rollover. Specify the
number of days, hours, minutes, and seconds between rollovers using 4,
h, m, and s as suffixes.

¢ Daily Rollover. AsyncOS performs a rollover every day at a specified
time. Separate multiple times a day using a comma. Use an asterisk (*)
for the hour to have rollover occur every hour during the day. You can
also use an asterisk to rollover every minute of an hour.

e  Weekly Rollover. AsyncOS performs a rollover on one or more days of
the week at a specified time.

Log Style Specifies the log format to use, either Squid, Apache, or Squid Details.
(Access Logs)

Custom Fields Allows you to include custom information in each access log entry.
(Access Logs) The syntax for entering format specifiers in the Custom Field is as follows:

<format_specifier_1> <format_specifier_2> ...

For example: ga %b %E

You can add tokens before the format specifiers to display descriptive text in
the access log file. For example:
client_IP %a body_bytes %b error_type %E

where client_IP is the description token for log format specifier ¢a, and so
on.

File Name The name of the log files. Current log files are appended with a . c extension
and rolled over log files are appended with the file creation timestamp and a
.s extension.
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Option

Description

Log Fields
(W3C Access Logs)

Allows you to choose the fields you want to include in the W3C access log.

Select a field in the Available Fields list, or type a field in the Custom Field
box, and click Add.

The order the fields appear in the Selected Log Fields list determines the
order of fields in the W3C access log file. You can change the order of fields
using the Move Up and Move Down buttons. You can remove a field by
selecting it in the Selected Log Fields list and clicking Remove.

You can enter multiple user defined fields in the Custom Fields box and add
them simultaneously as long as each entry is separated by a new line (click
Enter) before clicking Add.

When you change the log fields included in a W3C log subscription, the log
subscription automatically rolls over. This allows the latest version of the log
file to include the correct new field headers.

Log Compression

Specifies whether or not rolled over files are compressed. AsyncOS
compresses log files using the gzip compression format.

Log Exclusions
(Optional)

(Access Logs)

Allows you to specify HTTP status codes (4xx or 5xx only) to exclude the
associated transactions from an access log or a W3C access log.

For example, entering 401 will filter out authentication failure requests that
have that transaction number.

Log Level

Specifies the level of detail for log entries. Choose from:

e Critical. Includes errors only. This is the least detailed setting and is
equivalent to the syslog level “Alert.”

e Warning. Includes errors and warnings. This log level is equivalent to
the syslog level “Warning.”

e Information. Includes errors, warnings and additional system
operations. This is the default detail level and is equivalent to the syslog
level “Info.”

¢ Debug. Includes data useful for debugging system problems. Use the
Debug log level when you are trying to discover the cause of an error.
Use this setting temporarily, and then return to the default level. This log
level is equivalent to the syslog level “Debug.”

e Trace. This is the most detailed setting. This level includes a complete
record of system operations and activity. The Trace log level is
recommended only for developers. Using this level causes a serious
degradation of system performance and is not recommended. This log
level is equivalent to the syslog level “Debug.”

Note  More detailed settings create larger log files and have a greater
impact on system performance.

Retrieval Method

Specifies where rolled over log files are stored and how they are retrieved for
reading. See below for descriptions of the available methods.
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Option Description

Retrieval Method: The FTP on Appliance method (equivalent to FTP Poll) requires a remote
FTP client accessing the appliance to retrieve log files using an admin or

FTP on Appliance ,
operator user’s username and passphrase.

When you choose this method, you must enter the maximum number of log
files to store on the appliance. When the maximum number is reached, the
system deletes the oldest file.

This is the default retrieval method.

Retrieval Method: The FTP on Remote Server method (equivalent to FTP Push) periodically
FTP on Remote Server pushes log files to an FTP server on a remote computer.
When you choose this method, you must enter the following information:
e FTP server hostname
e Directory on FTP server to store the log file

e Username and passphrase of a user that has permission to connect to the
FTP server

Note AsyncOS for Web only supports passive mode for remote FTP
servers. It cannot push log files to an FTP server in active mode.

Retrieval Method: The SCP on Remote Server method (equivalent to SCP Push) periodically
pushes log files using the secure copy protocol to a remote SCP server. This
method requires an SSH SCP server on a remote computer using the SSH2
protocol. The subscription requires a user name, SSH key, and destination
directory on the remote computer. Log files are transferred based on a
rollover schedule set by you.

SCP on Remote Server

When you choose this method, you must enter the following information:
e SCP server hostname
e Directory on SCP server to store the log file

e Username of a user that has permission to connect to the SCP server

Retrieval Method: You can only choose syslog for text-based logs.

Syslog Push The Syslog Push method sends log messages to a remote syslog server on
port 514. This method conforms to RFC 3164.

When you choose this method, you must enter the following information:
¢ Syslog server hostname
e Protocol to use for transmission, either UDP or TCP
e Maximum message size
Valid values for UDP are 1024 to 9216.
Valid values for TCP are 1024 to 65535.

Maximum message size depends on the syslog server configuration.

e Facility to use with the log

Step4  Submit and commit your changes.
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What to Do Next

e If you chose SCP as the retrieval method, notice that the appliance displays an SSH key, which you
will add to the SCP server host. See Pushing Log Files to Another Server, page 21-11.

Related Topics
e Log File Types, page 21-3
e Log File Names and Appliance Directory Structure, page 21-12

Pushing Log Files to Another Server

Before You Begin

e Create or edit the desired log subscription, choosing SCP as the retrieval method. Adding and
Editing Log Subscriptions, page 21-7

Step 1 Add keys to the remote system:
a. Access the CLI.
b. Enter the logconfig -> hostkeyconfig command.

¢. Use the commands below to display the keys:

Command Description

Host Display system host keys. This is the value to place in the remote system’s
‘known_hosts’ file.

User Displays the public key of the system account that pushes the logs to the remote
machine. This is the same key that is displayed when setting up an SCP push
subscription. This is the value to place in the remote system’s ‘authorized_keys’ file.

d. Add these keys to the remote system.
Step2  Still in the CLI, add the remote server’s SSH public host key to the appliance:

Command Description
New Add a new key.

Fingerprint Display system host key fingerprints.

e. Commit your changes.

Archiving Log Files
AsyncOS archives (rolls over) log subscriptions when a current log file reaches a user-specified limit of
maximum file size or maximum time since last rollover.
These archive settings are included in log subscriptions:

¢ Rollover by File Size
e Rollover by Time

Async0S 9.1 for Cisco Web Security Appliances User Guide
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e Log Compression
e Retrieval Method

You can also manually archive (rollover) log files.

Step1  Choose System Administration > Log Subscriptions.

Step2  Check the checkbox in the Rollover column of the log subscriptions you wish to archive, or check the
All checkbox to select all the subscriptions.

Step3  Click Rollover Now to archive the selected logs.

Related Topics
e Adding and Editing Log Subscriptions, page 21-7
e Log File Names and Appliance Directory Structure, page 21-12

Log File Names and Appliance Directory Structure

The appliance creates a directory for each log subscription based on the log subscription name. The name
of the log file in the directory is composed of the following information:

¢ Log file name specified in the log subscription

e Timestamp when the log file was started

e A single-character status code, either .c (signifying current) or .s (signifying saved)
The filename of logs are made using the following formula:
/LogSubscriptionName/LogFilename.@timestamp.statuscode

~

Note  You should only transfer log files with the saved status.

Reading and Interpreting Log Files

You can read current log file activity as a means of monitoring and troubleshooting the Web Security
appliance. This is done using the appliance interface.

You can also read archived files for a record of past activity. This can be done using the appliance
interface if the archived files are stored on the appliance; otherwise they must be read from their external
storage location using an appropriate method.

Each item of information in a log file is represented by a field variable. By determining which fields
represent which items of information, you can look up the field function and interpret the log file
contents. For W3C compliant access logs, the file header lists field names in the order in which they
appear in log entries. For standard Access logs, however, you must consult the documentation regarding
this log type for information on its field order.

Related Topics
e Viewing Log Files, page 21-13.
¢ Web Proxy Information in Access Log Files, page 21-13.
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e Interpreting W3C Access Logs, page 21-24.
e Interpreting Traffic Monitor Logs, page 21-28.
e Log File Fields and Tags, page 21-28.

Viewing Log Files

Step 1
Step 2
Step 3
Step 4
Step 5

Before You Begin

e Be aware that this method of viewing is for log files that are stored on the appliance. The process of
viewing files stored externally goes beyond the scope of this documentation.

Choose Administration > Log Subscriptions.

Click the name of the log subscription in the Log Files column of the list of log subscriptions.
When prompted, enter the administers username and passphrase for accessing the appliance.
When logged in, click one of the log files to view it in your browser or to save it to disk.

Refresh the browser for updated results.

)

Note If a log subscription is compressed, download, decompress, and then open it.

Related Topics
¢ Web Proxy Information in Access Log Files, page 21-13.

e Interpreting W3C Access Logs, page 21-24.
e Interpreting Traffic Monitor Logs, page 21-28.

Web Proxy Information in Access Log Files

Access log files provides a descriptive record of all Web Proxy filtering and scanning activity. Access
log file entries display a record of how the appliance handled each transaction.

Access logs are available in two formats: Standard and W3C compliant. W3C-compliant log files are
more customizable with regard to their content and layout than standard Access logs.

The following text is an example access log file entry for a single transaction:

1278096903.150 97 172.xx.xx.xx TCP_MISS/200 8187 GET http://my.site.com/ -
DIRECT/my.site.com text/plain

DEFAULT_ CASE_11-PolicyGroupName-Identity-OutboundMalwareScanningPolicy-DataSecurityPolic
y-ExternalDLPPolicy-RoutingPolicy
<IW_comp,6.9,-,"-",-,-,-,-,"=-", -, -, -, "=-",-,-,"=-","-", -, -, IW_comp, -, "-","-", "Unknown", "Un
known","-","-",198.34,0,-, [Local],"-",37,"W32.CiscoTestVector", 33,0, "WSA-INFECTED-FILE.p
df","£d5ef49d4213e05£448£f11ed9¢c98253d85829614fba368ad21dl4eb64cd26da5e”> -
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Format Specifier

Field Value

Field Description

Yot 1278096903.150 Timestamp since UNIX epoch.
%e 97 Elapsed time (latency) in milliseconds.
%a 172.xx.xx. XX Client IP address.
Note: You can choose to mask the IP address in the access logs
using the advancedproxyconfig > authentication CLI
command.
Yow TCP_MISS Transaction result code.
For more information, see W3C Compliant Access Log Files,
page 21-24.
%h 200 HTTP response code.
%5 8187 Response size (headers + body).
%2r GET http://my.site.com/ First line of the request.
Note: When the first line of the request is for a native FTP
transaction, some special characters in the file name are URL
encoded in the access logs. For example, the “@” symbol is
written as “%40” in the access logs.
The following characters are URL encoded:
&# s+, ;= {} [1
% A - Authenticated username.
Note: You can choose to mask the username in the access logs
using the advancedproxyconfig > authentication CLI
command.
%H DIRECT Code that describes which server was contacted for the
retrieving the request content.
Most common values include:
e NONE. The Web Proxy had the content, so it did not
contact any other server to retrieve the content.
e DIRECT. The Web Proxy went to the server named in the
request to get the content.
e DEFAULT_PARENT. The Web Proxy went to its primary
parent proxy or an external DLP server to get the content.
%d my.site.com Data source or server IP address.
Yoc text/plain Response body MIME type.
%D DEFAULT_CASE_11 ACL decision tag.

Note: The end of the ACL decision tag includes a dynamically
generated number that the Web Proxy uses internally. You can
ignore this number.

For more information, see ACL Decision Tags, page 21-16.
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Format Specifier Field Value Field Description

N/A (Part of the ACL PolicyGroupName Name of policy group responsible for the final decision on this

decision tag) transaction (Access Policy, Decryption Policy, or Data Security
Policy). When the transaction matches a global policy, this
value is “DefaultGroup.”
Any space in the policy group name is replaced with an
underscore ( _ ).

N/A (Part of the ACL Identity Identity policy group name.

decision tag)

Any space in the policy group name is replaced with an
underscore ( _ ).

N/A (Part of the ACL
decision tag)

OutboundMalwareScanning

Policy

Outbound Malware Scanning Policy group name.

Any space in the policy group name is replaced with an
underscore ( _ ).

N/A (Part of the ACL
decision tag)

DataSecurityPolicy

Cisco IronPort Data Security Policy group name. When the
transaction matches the global Cisco IronPort Data Security
Policy, this value is “DefaultGroup.” This policy group name
only appears when Cisco IronPort Data Security Filters is
enabled. “NONE” appears when no Data Security Policy was
applied.

Any space in the policy group name is replaced with an
underscore ( _ ).

N/A (Part of the ACL
decision tag)

ExternalDLPPolicy

External DLP Policy group name. When the transaction
matches the global External DLP Policy, this value is
“DefaultGroup.” “NONE” appears when no External DLP
Policy was applied.

Any space in the policy group name is replaced with an
underscore ( _ ).

N/A (Part of the ACL
decision tag)

RoutingPolicy

Routing Policy group name as
ProxyGroupName/ProxyServerName.

When the transaction matches the global Routing Policy, this
value is “DefaultRouting.” When no upstream proxy server is
used, this value is “DIRECT.”

Any space in the policy group name is replaced with an
underscore ( _ ).

% Xr

<IW_comp,6.9,-,"-",-, -, -, -, "

. .
,IW_comp, -, "-","-", "Unknown"

, "Unknown","-","-",198.34,0,
-, [Local]l,"-",37,"W32.CiscoT

estVector",33,0, "WSA-INFECTE
D-FILE.pdf", "fd5e£f49d4213e05
£448£11ed9c98253d85829614fba
368a421dl4e64cd26dase”>

Scanning verdict information. Inside the angled brackets, the
access logs include verdict information from various scanning
engines.

For more information about the values included within the
angled brackets, see Interpreting Access Log Scanning Verdict
Entries, page 21-20 and Malware Scanning Verdict Values,
page 21-37.

%?BLOCK_SUSPECT
_USER_AGENT,
MONITOR_SUSPECT
_USER_AGENT?%
<User-Agent: %! %-%.

Suspect user agent.
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Transaction Result Codes

Transaction result codes in the access log file describe how the appliance resolves client requests. For
example, if a request for an object can be resolved from the cache, the result code is Tcp_uIT. However,
if the object is not in the cache and the appliance pulls the object from an origin server, the result code
is rcp_m1ss. The following table describes transaction result codes.

Result Code

Description

TCP_HIT

The object requested was fetched from the disk cache.

TCP_IMS_HIT

The client sent an IMS (If-Modified-Since) request for an object and the
object was found in the cache. The proxy responds with a 304 response.

TCP_MEM_HIT

The object requested was fetched from the memory cache.

TCP_MISS

The object was not found in the cache, so it was fetched from the origin
server.

TCP_REFRESH_HIT

The object was in the cache, but had expired. The proxy sent an IMS
(If-Modified-Since) request to the origin server, and the server
confirmed that the object has not been modified. Therefore, the
appliance fetched the object from either the disk or memory cache.

TCP_CLIENT_REFRESH_MISS

The client sent a “don’t fetch response from cache” request by issuing
the ‘Pragma: no-cache’ header. Due to this header from the client, the
appliance fetched the object from the origin server.

TCP_DENIED

The client request was denied due to Access Policies.

UDP_MISS

The object was fetched from the origin server.

NONE

There was an error in the transaction. For example, a DNS failure or
gateway timeout.

ACL Decision Tags

An ACL decision tag is a field in an access log entry that indicates how the Web Proxy handled the
transaction. It includes information from the Web Reputation filters, URL categories, and the

scanning engines.

Note  The end of the ACL decision tag includes a dynamically generated number that the Web Proxy uses
internally to increase performance. You can ignore this number.

The following table describes the ACL decision tag values.

ACL Decision Tag

Description

ALLOW_ADMIN_ERROR_PAGE

The Web Proxy allowed the transaction to an notification page
and to any logo used on that page.

ALLOW_CUSTOMCAT

The Web Proxy allowed the transaction based on custom URL
category filtering settings for the Access Policy group.

ALLOW_WBRS

The Web Proxy allowed the transaction based on the Web
Reputation filter settings for the Access Policy group.

BLOCK_ADMIN

Transaction blocked based on some default settings for the
Access Policy group.
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ACL Decision Tag

Description

BLOCK_ADMIN_CONNECT

Transaction blocked based on the TCP port of the destination as
defined in the HTTP CONNECT Ports setting for the Access
Policy group.

BLOCK_ADMIN_CUSTOM_USER_AGENT

Transaction blocked based on the user agent as defined in the
Block Custom User Agents setting for the Access Policy group.

BLOCK_ADMIN_HTTPS_NonLocalDestin

ation

Transaction blocked; client tried to bypass authentication using
the SSL port as an explicit proxy. To prevent this, if an SSL
connection is to the WSA itself, only requests to the actual WSA
redirect hostname are allowed.

BLOCK_ADMIN_IDS

Transaction blocked based on the MIME type of the request
body content as defined in the Data Security Policy group.

BLOCK_ADMIN_FILE_ TYPE

Transaction blocked based on the file type as defined in the
Access Policy group.

BLOCK_ADMIN_PROTOCOL

Transaction blocked based on the protocol as defined in the
Block Protocols setting for the Access Policy group.

BLOCK_ADMIN_SIZE

Transaction blocked based on the size of the response as
defined in the Object Size settings for the Access Policy group.

BLOCK_ADMIN_SIZE_IDS

Transaction blocked based on the size of the request body content
as defined in the Data Security Policy group.

BLOCK_AMP_RESP

The Web Proxy blocked the response based on the Advanced
Malware Protection settings for the Access Policy group.

BLOCK_AMW_REQ

The Web Proxy blocked the request based on the Anti-Malware
settings for the Outbound Malware Scanning Policy group. The
request body produced a positive malware verdict.

BLOCK_AMW_RESP

The Web Proxy blocked the response based on the
Anti-Malware settings for the Access Policy group.

BLOCK_AMW_REQ_URL

The Web Proxy suspects the URL in the HTTP request might
not be safe, so it blocked the transaction at request time based
on the Anti-Malware settings for the Access Policy group.

BLOCK_AVC

Transaction blocked based on the configured Application
settings for the Access Policy group.

BLOCK_CONTENT_UNSAFE

Transaction blocked based on the site content ratings settings
for the Access Policy group. The client request was for adult
content and the policy is configured to block adult content.

BLOCK_CONTINUE_CONTENT_UNSAFE

Transaction blocked and displayed the Warn and Continue page
based on the site content ratings settings in the Access Policy
group. The client request was for adult content and the policy is
configured to give a warning to users accessing adult content.

BLOCK_CONTINUE_CUSTOMCAT

Transaction blocked and displayed the Warn and Continue page
based on a custom URL category in the Access Policy group
configured to “Warn.”

BLOCK_CONTINUE_WEBCAT

Transaction blocked and displayed the Warn and Continue page
based on a predefined URL category in the Access Policy group
configured to “Warn.”
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ACL Decision Tag

Description

BLOCK_CUSTOMCAT

Transaction blocked based on custom URL category filtering
settings for the Access Policy group.

BLOCK_ICAP

The Web Proxy blocked the request based on the verdict of the
external DLP system as defined in the External DLP Policy

group.

BLOCK_SEARCH_UNSAFE

The client request included an unsafe search query and the
Access Policy is configured to enforce safe searches, so the
original client request was blocked.

BLOCK_SUSPECT_USER_AGENT

Transaction blocked based on the Suspect User Agent setting
for the Access Policy group.

BLOCK_UNSUPPORTED_SEARCH_APP

Transaction blocked based on the safe search settings for the
Access Policy group. The transaction was for an unsupported
search engine, and the policy is configured to block
unsupported search engines.

BLOCK_WBRS

Transaction blocked based on the Web Reputation filter settings
for the Access Policy group.

BLOCK_WBRS_IDS

The Web Proxy blocked the upload request based on the Web
Reputation filter settings for the Data Security Policy group.

BLOCK_WEBCAT

Transaction blocked based on URL category filtering settings
for the Access Policy group.

BLOCK_WEBCAT_IDS

The Web Proxy blocked the upload request based on the URL
category filtering settings for the Data Security Policy group.

DECRYPT_ADMIN

The Web Proxy decrypted the transaction based on some
default settings for the Decryption Policy group.

DECRYPT_ADMIN_EXPIRED_CERT

The Web Proxy decrypted the transaction although the server
certificate has expired.

DECRYPT_WEBCAT

The Web Proxy decrypted the transaction based on URL
category filtering settings for the Decryption Policy group.

DECRYPT_WBRS

The Web Proxy decrypted the transaction based on the Web
Reputation filter settings for the Decryption Policy group.

DEFAULT_CASE

The Web Proxy allowed the client to access the server because
none of the AsyncOS services, such as Web Reputation or
anti-malware scanning, took any action on the transaction.

DROP_ADMIN

The Web Proxy dropped the transaction based on some default
settings for the Decryption Policy group.

DROP_ADMIN_EXPIRED_CERT

The Web Proxy dropped the transaction because the server
certificate has expired.

DROP_WEBCAT

The Web Proxy dropped the transaction based on URL category
filtering settings for the Decryption Policy group.

DROP_WBRS

The Web Proxy dropped the transaction based on the Web
Reputation filter settings for the Decryption Policy group.

MONITOR_ADMIN_EXPIRED_CERT

The Web Proxy monitored the server response because the
server certificate has expired.
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ACL Decision Tag

Description

MONITOR_AMP_RESP

The Web Proxy monitored the server response based on
the Advanced Malware Protection settings for the Access
Policy group.

MONITOR_AMW_RESP

The Web Proxy monitored the server response based on the
Anti-Malware settings for the Access Policy group.

MONITOR_AMW_RESP_URL

The Web Proxy suspects the URL in the HTTP request might
not be safe, but it monitored the transaction based on the
Anti-Malware settings for the Access Policy group.

MONITOR_AVC

The Web Proxy monitored the transaction based on the
Application settings for the Access Policy group.

MONITOR_CONTINUE_CONTENT_UNSAFE

Originally, the Web Proxy blocked the transaction and
displayed the Warn and Continue page based on the site content
ratings settings in the Access Policy group. The client request
was for adult content and the policy is configured to give a
warning to users accessing adult content. The user accepted the
warning and continued to the originally requested site, and no
other scanning engine subsequently blocked the request.

MONITOR_CONTINUE_CUSTOMCAT

Originally, the Web Proxy blocked the transaction and
displayed the Warn and Continue page based on a custom URL
category in the Access Policy group configured to “Warn.” The
user accepted the warning and continued to the originally
requested site, and no other scanning engine subsequently
blocked the request.

MONITOR_CONTINUE_WEBCAT

Originally, the Web Proxy blocked the transaction and
displayed the Warn and Continue page based on a predefined
URL category in the Access Policy group configured to “Warn.
The user accepted the warning and continued to the originally
requested site, and no other scanning engine subsequently
blocked the request.

bl

MONITOR_IDS

The Web Proxy scanned the upload request using either a Data
Security Policy or an External DLP Policy, but did not block the
request. It evaluated the request against the Access Policies.

MONITOR_SUSPECT_USER_AGENT

The Web Proxy monitored the transaction based on the Suspect
User Agent setting for the Access Policy group.

MONITOR_WBRS

The Web Proxy monitored the transaction based on the Web
Reputation filter settings for the Access Policy group.

NO_AUTHORIZATION

The Web Proxy did not allow the user access to the application
because the user was already authenticated against an
authentication realm, but not against any authentication realm
configured in the Application Authentication Policy.

NO_PASSWORD

The user failed authentication.

PASSTHRU_ADMIN

The Web Proxy passed through the transaction based on some
default settings for the Decryption Policy group.

PASSTHRU_ADMIN_EXPIRED_CERT

The Web Proxy passed through the transaction although the
server certificate has expired.
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ACL Decision Tag Description

PASSTHRU_WEBCAT The Web Proxy passed through the transaction based on URL
category filtering settings for the Decryption Policy group.

PASSTHRU_WBRS The Web Proxy passed through the transaction based on the
Web Reputation filter settings for the Decryption Policy group.
REDIRECT_CUSTOMCAT The Web Proxy redirected the transaction to a different URL

based on a custom URL category in the Access Policy group
configured to “Redirect.”

SAAS_AUTH The Web Proxy allowed the user access to the application
because the user was authenticated transparently against the
authentication realm configured in the Application
Authentication Policy.

OTHER The Web Proxy did not complete the request due to an error,
such as an authorization failure, server disconnect, or an abort
from the client.

Interpreting Access Log Scanning Verdict Entries

Note

The access log file entries aggregate and display the results of the various scanning engines, such as URL
filtering, Web Reputation filtering, and anti-malware scanning. The appliance displays this information
in angled brackets at the end of each access log entry.

The following text is the scanning verdict information from an access log file entry. In this example, the
Webroot scanning engine found the malware:

<IW_infr,ns, 24, "Trojan-Phisher-Gamec",0,354385,12559,-,"-",—-,—-,-,"=",—, =, "=","=", -, -,
IW_infr,-, "Trojan Phisher","-", "Unknown", "Unknown","-","-",489.73,0,-, [Local],"-"
,37,"W32.CiscoTestVector",33,0, "WSA-INFECTED-FILE.pdf", "fd5ef49d4213e05f448f11ed9c98253d
85829614fba368a421dldebdcd26dabe”>

For an example of a whole access log file entry, see Web Proxy Information in Access Log Files,
page 21-13.

Each element in this example corresponds to a log-file format specifier as shown in the following table:

Position |Field Value

Format Specifier |Description

1 IW_infr

% XC The URL category assigned to the transaction, abbreviated. This
field shows “nc” when no category is assigned.

For a list of URL category abbreviations, see URL Category
Descriptions, page 9-23.

2 ns

Yo XW Web Reputation filters score. This field either shows the score as a
number, “ns” for no score, or “dns” when there is a DNS lookup error.

Yo Xv The malware scanning verdict Webroot passed to the DVS engine.
Applies to responses detected by Webroot only.

For more information, see Malware Scanning Verdict Values,
page 21-37.
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Web Proxy Information in Access Log Files

Position |Field Value Format Specifier |Description

4 “Trojan-Phisher-Gamec” |“%Xn” Name of the spyware that is associated with the object. Applies to
responses detected by Webroot only.

5 0 DXt The Webroot specific value associated with the Threat Risk Ratio
(TRR) value that determines the probability that malware exists.
Applies to responses detected by Webroot only.

6 354385 %Xs A value that Webroot uses as a threat identifier. Cisco Customer
Support may use this value when troubleshooting an issue. Applies
to responses detected by Webroot only.

7 12559 %Xi A value that Webroot uses as a trace identifier. Cisco Customer
Support may use this value when troubleshooting an issue. Applies
to responses detected by Webroot only.

8 - %Xd The malware scanning verdict McAfee passed to the DVS engine.
Applies to responses detected by McAfee only.

For more information, see Malware Scanning Verdict Values,
page 21-37.

9 b “%Xe” The name of the file McAfee scanned. Applies to responses detected
by McAfee only.

10 - Yo Xt A value that McAfee uses as a scan error. Cisco Customer Support
may use this value when troubleshooting an issue. Applies to
responses detected by McAfee only.

11 - %Xg A value that McAfee uses as a detection type. Cisco Customer
Support may use this value when troubleshooting an issue. Applies
to responses detected by McAfee only.

12 - %Xh A value that McAfee uses as a virus type. Cisco Customer Support
may use this value when troubleshooting an issue. Applies to
responses detected by McAfee only.

13 b “%Xj” The name of the virus that McAfee scanned. Applies to responses
detected by McAfee only.

14 - % XY The malware scanning verdict Sophos passed to the DVS engine.
Applies to responses detected by Sophos only.

For more information, see Malware Scanning Verdict Values,
page 21-37.

15 - Yo Xx A value that Sophos uses as a scan return code. Cisco Customer
Support may use this value when troubleshooting an issue. Applies
to responses detected by Sophos only.

16 A “%Xy” The file location where Sophos found the objectionable content. For
non-archive files, this value is the file name itself. For an archive file,
it is the object in the archive, such as archive.zip/virus.exe.
Applies to responses detected by Sophos only.

17 b “%Xz” A value that Sophos uses as the threat name. Cisco Customer Support
may use this value when troubleshooting an issue. Applies to
responses detected by Sophos only.
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B Web Proxy Information in Access Log Files

Position

Field Value

Format Specifier

Description

18

%X1

The Cisco Data Security scan verdict based on the action in the
Content column of the Cisco Data Security Policy. The following list
describes the possible values for this field:

e 0. Allow
e 1. Block

¢ - (hyphen). No scanning was initiated by the Cisco Data
Security Filters. This value appears when the Cisco Data
Security Filters are disabled, or when the URL category action
is set to Allow.

19

%Xp

The External DLP scan verdict based on the result given in the ICAP

response. The following list describes the possible values for this
field:

e 0. Allow
e 1. Block

e - (hyphen). No scanning was initiated by the external DLP server.
This value appears when External DLP scanning is disabled, or
when the content was not scanned due to an exempt URL category
on the External DLP Policies > Destinations page.

20

IW_infr

%BXQ

The URL category verdict determined during request-side scanning,
abbreviated. This field lists a hyphen ( - ) when URL filtering is
disabled.

For a list of URL category abbreviations, see URL Category
Descriptions, page 9-23.

21

D XA

The URL category verdict determined by the Dynamic Content
Analysis engine during response-side scanning, abbreviated. Applies
to the Cisco Web Usage Controls URL filtering engine only. Only
applies when the Dynamic Content Analysis engine is enabled and
when no category is assigned at request time (a value of “nc” is listed
in the request-side scanning verdict).

For a list of URL category abbreviations, see URL Category
Descriptions, page 9-23.

22

“Trojan Phisher”

“%XZ”

Unified response-side anti-malware scanning verdict that provides
the malware category independent of which scanning engines are
enabled. Applies to transactions blocked or monitored due to server
response scanning.

23

“%an

The threat type returned by the Web Reputation filters which resulted
in the target website receiving a poor reputation. Typically, this field
is populated for sites at reputation of -4 and below.

24

“Unknown”

“%XO”

The application name as returned by the AVC engine, if applicable.
Only applies when the AVC engine is enabled.

25

“Unknown”

“%Xun

The application type as returned by the AVC engine, if applicable.
Only applies when the AVC engine is enabled.

26

“%Xb”

The application behavior as returned by the AVC engine, if
applicable. Only applies when the AVC engine is enabled.
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Position |Field Value Format Specifier |Description

27 n- “%XS” Safe browsing scanning verdict. This value indicates whether either
the safe search or the site content ratings feature was applied to
the transaction.

For a list of the possible values, see Logging Adult Content Access,

page 9-16.
28 489.73 %XB The average bandwidth consumed serving the request, in Kb/sec.
29 0 %XT A value that indicates whether the request was throttled due to

bandwidth limit control settings, where “1” indicates the request was
throttled, and “0” indicates it was not.

30 [Locall %1 The type of user making the request, either “[Local]” or “[Remote].”
Only applies when AnyConnect Secure Mobility is enabled. When it
is not enabled, the value is a hyphen (-).

31 n- “%X3” Unified request-side anti-malware scanning verdict independent of
which scanning engines are enabled. Applies to transactions blocked
or monitored due to client request scanning when an Outbound
Malware Scanning Policy applies.

32 b “%X4” The threat name assigned to the client request that was blocked or
monitored due to an applicable Outbound Malware Scanning Policy.

This threat name is independent of which anti-malware scanning
engines are enabled.

33 37 Do X#1# Verdict from Advanced Malware Protection file scanning:
e 0: File is not malicious

e 1: File was not scanned because of its file type

e 2: File scan timed out

¢ 3: Scan error

e Greater than 3: File is malicious

34 "W32.CiscoTestVector" %0 XH#H2# Threat name, as determined by Advanced Malware Protection file
scanning; "-" indicates no threat.
35 33 Yo X#3# Reputation score from Advanced Malware Protection file scanning.

This score is used only if the cloud reputation service is unable to
determine a clear verdict for the file.

For details, see information about the Threat Score and the
reputation threshold in Chapter 17, “File Reputation Filtering and
File Analysis.”

36 0 Yo X #4# Indicator of upload and analysis request:

“0” indicates that Advanced Malware Protection did not request
upload of the file for analysis.

“1” indicates that Advanced Malware Protection did request upload
of the file for analysis.
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Position |Field Value Format Specifier Description
37 "WSA-INFECTED-FILE.pdf |%X#5# The name of the file being downloaded and analyzed.
38 "£d5ef49d4213e05£448f1 |G XH#OH# The SHA-256 identifier for this file.
1ed9c98253d85829614fba
368a421dl4e64cd26dase

Refer to Log File Fields and Tags, page 21-28 for a description of each format specifier’s function.

Related Topics
e Web Proxy Information in Access Log Files, page 21-13

e Customizing Access Logs, page 21-26.

e W3C Compliant Access Log Files, page 21-24
e Viewing Log Files, page 21-13

e Log File Fields and Tags, page 21-28

W3C Compliant Access Log Files

The Web Security appliance provides two different log types for recording Web Proxy transaction
information: access logs and W3C access logs. W3C access logs are W3C compliant, and record
transaction history in the W3C Extended Log File (ELF) Format.

e W3C Field Types, page 21-24
e Interpreting W3C Access Logs, page 21-24

W3C Field Types

When defining a W3C access log subscription, you must choose which log fields to include, such as the
ACL decision tag or the client IP address. You can include one of the following types of log fields:

¢ Predefined. The web interface includes a list of fields from which you can choose.

e User defined. You can type a log field that is not included in the predefined list.

Interpreting W3C Access Logs

Consider the following rules and guidelines when interpreting W3C access logs:

e Administrators decide what data is recorded in each W3C access log subscription; therefore, W3C
access logs have no set field format.

e W3C logs are self-describing. The file format (list of fields) is defined in a header at the start of each
log file.

¢ Fields in the W3C access logs are separated by a white space.

e If a field contains no data for a particular entry, a hyphen ( - ) is included in the log file instead.
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W3C Compliant Access Log Files
e Each line in the W3C access log file relates to one transaction, and each line is terminated by a LF
sequence.
e W3C Log File Headers, page 21-25
e W3C Field Prefixes, page 21-25
W3C Log File Headers
Each W3C log file contains header text at the beginning of the file. Each line starts with the # character
and provides information about the Web Security appliance that created the log file. The W3C log file
headers also include the file format (list of fields), making the log file self-describing.
The following table describes the header fields listed at the beginning of each W3C log file.
Header Field |Description
Version The version of the W3C ELF format used.
Date The date and time at which the header (and log file) was created.
System The Web Security appliance that generated the log file in the format “Management_IP
- Management_hostname.”
Software The Software which generated these logs
Fields The fields recorded in the log
Example W3C log file:
#Version: 1.0
#Date: 2009-06-15 13:55:20
#System: 10.1.1.1 - wsa.ga
#Software: AsyncOS for Web 6.3.0
#Fields: timestamp x-elapsed-time c-ip x-resultcode-httpstatus sc-bytes cs-method
cs-url cs-username x-hierarchy-origin cs-mime-type x-acltag x-result-code
X-suspect-user-agent
W3C Field Prefixes

Most W3C log field names include a prefix that identifies from which header a value comes, such as the
client or server. Log fields without a prefix reference values that are independent of the computers
involved in the transaction. The following table describes the W3C log fields prefixes.

Prefix Header Description

c Client

S Server

cs Client to server

sc Server to client

X Application specific identifier.
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W Customizing Access Logs

For example, the W3C log field “cs-method” refers to the method in the request sent by the client to the
server, and “c-ip” refers to the client’s IP address.

Related Topics
e Web Proxy Information in Access Log Files, page 21-13.

e Customizing Access Logs, page 21-26.
e Traffic Monitor Log Files, page 21-28.
e Log File Fields and Tags, page 21-28.
e Viewing Log Files, page 21-13.

Customizing Access Logs

You can customize regular and W3C access logs to include many different fields to capture
comprehensive information about web traffic within the network using predefined fields or user defined
fields.

Related Topics
e For a list of predefined fields, see Log File Fields and Tags, page 21-28.

e For information on user defined fields, see Access Log User Defined Fields, page 21-26.

Access Log User Defined Fields

If the list of predefined Access log and W3C log fields does not include all header information you want
to log from HTTP/HTTPS transactions, you can type a user defined log field in the Custom Fields text
box when you configure the access and W3C log subscriptions.

Custom log fields can be any data from any header sent from the client or the server. If a request or
response does not include the header added to the log subscription, the log file includes a hyphen as the
log field value.

The following table defines the syntax to use for access and W3C logs:

Access Log Format
Header Type Specifier Syntax W3C Log Custom Field Syntax
Header from the client application |%<ClientHeaderName: cs(ClientHeaderName)
Header from the server %<ServerHeaderName: sc(ServerHeaderName)

For example, if you want to log the If-Modified-Since header value in client requests, enter the following
text in the Custom Fields box for a W3C log subscription:

cs(If-Modified-Since)

Related Topics
e Customizing Regular Access Logs, page 21-27.

e Customizing W3C Access Logs, page 21-27.
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Customizing Access Logs 1l

Customizing Regular Access Logs

Step 1
Step 2
Step 3

Step 4

Choose System Administration > Log Subscriptions.
Click the access log file name to edit the access log subscription.
Enter the required format specifiers in the Custom Field.

The syntax for entering format specifiers in the Custom Field is as follows:

<format_specifier_1> <format_specifier_2> ...

For example: $a %b %E

You can add tokens before the format specifiers to display descriptive text in the access log file.
For example:

client_IP %a body_bytes %b error_type $%E

where client_1p is the description token for log format specifier %a, and so on.

N

Note  You can create a custom field for any header in a client request or a server response.

Submit and commit your changes.

Related Topics
e Web Proxy Information in Access Log Files, page 21-13.

e Log File Fields and Tags, page 21-28.
e Access Log User Defined Fields, page 21-26.

Customizing W3C Access Logs

Step 1
Step 2
Step 3

Step 4

Choose System Administration > Log Subscriptions
Click the W3C log file name to edit the W3C log subscription.
Type a field in the Custom Field box, and click Add.

The order the fields appear in the Selected Log Fields list determines the order of fields in the W3C
access log file. You can change the order of fields using the Move Up and Move Down buttons. You can
remove a field by selecting it in the Selected Log Fields list and clicking Remove.

You can enter multiple user defined fields in the Custom Fields box and add them simultaneously as long
as each entry is separated by a new line (click Enter) before clicking Add.

When you change the log fields included in a W3C log subscription, the log subscription automatically
rolls over. This allows the latest version of the log file to include the correct new field headers.

~

Note  You can create a custom field for any header in a client request or a server response.

Submit and commit your changes.
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B Traffic Monitor Log Files

Related Topics
e W3C Compliant Access Log Files, page 21-24.
e Log File Fields and Tags, page 21-28.
e Access Log User Defined Fields, page 21-26.

Traffic Monitor Log Files

Layer-4 Traffic Monitor log files provides a detailed record of Layer-4 monitoring activity. You can view
Layer-4 Traffic Monitor log file entries to track updates to firewall block lists and firewall allow lists.

Interpreting Traffic Monitor Logs
Use the examples below to interpret the various entry types contains in Traffic Monitor Logs.

Example 1

172 .xx.xx.xx discovered for blocksite.net (blocksite.net) added to firewall block list.

In this example, where a match becomes a block list firewall entry. The Layer-4 Traffic Monitor matched
an IP address to a domain name in the block list based on a DNS request which passed through the
appliance. The IP address is then entered into the block list for the firewall.

Example 2

172 .xx.xx.xx discovered for www.allowsite.com (www.allowsite.com) added to firewall allow
list.

In this example, a match becomes an allow list firewall entry. The Layer-4 Traffic Monitor matched a
domain name entry and added it to the appliance allow list. The IP address is then entered into the allow
list for the firewall.

Example 3

Firewall noted data from 172.xx.xx.xx to 209.xx.xx.xx (allowsite.net) :80.

In this example, the Layer-4 Traffic Monitor logs a record of data that passed between an internal IP
address and an external IP address which is on the block list. Also, the Layer-4 Traffic Monitor is set to
monitor, not block.

Related Topics
e Viewing Log Files, page 21-13

Log File Fields and Tags

e Access Log Format Specifiers and W3C Log File Fields, page 21-29
e Transaction Result Codes, page 21-16

e ACL Decision Tags, page 21-16

e Malware Scanning Verdict Values, page 21-37
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Access Log Format Specifiers and W3C Log File Fields

Log files use variables to represent the individual items of information that make up each log file entry.
These variables are called format specifiers in Access logs and log fields in W3C logs and each format
specifier has a corresponding log field.

To configure Access Logs to display these values, see Customizing Access Logs, page 21-26 and
information about custom fields in Adding and Editing Log Subscriptions, page 21-7.

The following table describes these variables:

Format Specifier in
Access Logs

Log Field in W3C Logs

Description

%:<1 x-p2s-first-byte-time The time it takes from the moment the Web Proxy
starts connecting to the server to the time it is first
able to write to the server. If the Web Proxy has to
connect to several servers to complete the
transaction, it is the sum of those times.

%:<a X-p2p-auth-wait-time Wait-time to receive the response from the Web
Proxy authentication process, after the Web Proxy
sent the request.

%:<b X-p2s-body-time Wait-time to write request body to server after header.

%:<d X-p2p-dns-wait-time Time taken by the Web Proxy to send the DNS
request to the Web Proxy DNS process.

%:<h x-p2s-header-time Wait-time to write request header to server after
first byte.

%<t X-p2p-reputation-wait-time | Wait-time to receive the response from the Web
Reputation Filters, after the Web Proxy sent
the request.

%:<s X-p2p-asw-req-wait-time | Wait-time to receive the verdict from the Web
Proxy anti-spyware process, after the Web Proxy
sent the request.

%:>1 x-s2p-first-byte-time Wait-time for first response byte from server

%:>a X-p2p-auth-svc-time Wait-time to receive the response from the Web
Proxy authentication process, including the time
required for the Web Proxy to send the request.

%:>b x-s2p-body-time Wait-time for complete response body after
header received

%:>c x-p2p-fetch-time Time required for the Web Proxy to read a response
from the disk cache.

Y0:>d X-p2p-dns-sve-time Time taken by the Web Proxy DNS process to send
back a DNS result to the Web Proxy.

9%:>h x-s2p-header-time Wait-time for server header after first response byte

%>t X-p2p-reputation-svc-time | Wait-time to receive the verdict from the Web

Reputation Filters, including the time required for
the Web Proxy to send the request.
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Format Specifier in
Access Logs

Log Field in W3C Logs

Description

90:>s

X-p2p-asw-req-svc-time

Wait-time to receive the verdict from the Web Proxy
anti-spyware process, including the time required
for the Web Proxy to send the request.

%:1<

x-c2p-first-byte-time

Wait-time for first request byte from new
client connection.

%:1>

x-p2c-first-byte-time

Wait-time for first byte written to client.

%:A<

X-p2p-avc-sve-time

Wait-time to receive the response from the AVC
process, including the time required for the Web
Proxy to send the request.

%0:A>

X-p2p-avc-wait-time

Wait-time to receive the response from the AVC
process, after the Web Proxy sent the request.

% :b<

x-c2p-body-time

Wait-time for complete client body.

% :b>

Xx-p2c-body-time

Wait-time for complete body written to client.

%:C<

X-p2p-dca-resp-svc-time

Wait-time to receive the verdict from the Dynamic
Content Analysis engine, including the time
required for the Web Proxy to send the request.

%:C>

X-p2p-dca-resp-wait-time

Wait-time to receive the response from the Dynamic
Content Analysis engine, after the Web Proxy sent
the request.

% h<

x-c2p-header-time

Wait-time for complete client header after first byte

%:h>

x-s2p-header-time

Wait-time for complete header written to client

% -m<

X-p2p-mcafee-resp-svc-
time

Wait-time to receive the verdict from the McAfee
scanning engine, including the time required for the
Web Proxy to send the request.

% :m>

x-p2p-mcafee-resp-wait-
time

Wait-time to receive the response from the McAfee
scanning engine, after the Web Proxy sent the request.

Yo:p<

X-p2p-sophos-resp-svc-
time

Wait-time to receive the verdict from the Sophos
scanning engine, including the time required for the
Web Proxy to send the request.

%:p>

X-p2p-sophos-resp-wait-
time

Wait-time to receive the response from the Sophos
scanning engine, after the Web Proxy sent the request.

Yo W<

X-p2p-webroot-resp-svce-
time

Wait-time to receive the verdict from the Webroot
scanning engine, including the time required for the
Web Proxy to send the request.

% -w>

X-p2p-webroot-resp-wait-
time

Wait-time to receive the response from the Webroot
scanning engine, after the Web Proxy sent the request.

%?™BLOCK_SUSP
ECT_USER_AGE
NT,MONITOR _

SUSPECT_USER _

AGENT?%<User-
Agent:%!%-%.

X-suspect-user-agent

Suspect user agent, if applicable. If the Web Proxy
determines the user agent is suspect, it will log

the user agent in this field. Otherwise, it logs a
hyphen. This field is written with double-quotes
in the access logs.

%<Referer:

cs(Referer)

Referer

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



| Chapter21

Monitor System Activity Through Logs

Log File Fields and Tags W

Format Specifier in
Access Logs

Log Field in W3C Logs

Description

%>Server: sc(Server) Server header in the response.

%a c-ip Client IP Address.

% A cs-username Authenticated user name. This field is written with
double-quotes in the access logs.

%b sc-body-size Bytes sent to the client from the Web Proxy for the
body content.

%B bytes Total bytes used (request size + response size, which
is %q + %s).

%c cs-mime-type Response body MIME type. This field is written
with double-quotes in the access logs.

%C cs(Cookie) Cookie header. This field is written with
double-quotes in the access logs.

%d s-hostname Data source or server IP address.

%D x-acltag ACL decision tag.

%e x-elapsed-time Elapsed time in milliseconds.
For TCP traffic, this is the time elapsed between the
opening and closing of the HTTP connection.
For UDP traffic, this is the time elapsed between the
sending of the first datagram and the time at which the
last datagram can be accepted. A large elapsed time
value for UDP traffic may indicate that a large timeout
value and a long-lived UDP association allowed
datagrams to be accepted longer than necessary.

%E x-error-code Error code number that may help Customer Support
troubleshoot the reason for a failed transaction.(

%f cs(X-Forwarded-For) X-Forwarded-For header.

9%F c-port Client source port

%g cs-auth-group Authorized group names. This field is written with
double-quotes in the access logs.
This field is used for troubleshooting
policy/authentication issues to determine whether a
user is matching the correct group or policy.

%h sc-http-status HTTP response code.

%H s-hierarchy Hierarchy retrieval.

i x-icap-server IP address of the last ICAP server contacted while
processing the request.

%1 x-transaction-id Transaction ID.
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Format Specifier in
Access Logs Log Field in W3C Logs

Description

% DCF

Do not cache response code; DCF flags.
Response code descriptions:
e Response code based on client request:
- 1 =Request had “no-cache” header.
— 2 =_Caching is not authorized for the request.
— 4 = Request is missing the "Variant' header.

— 8 = Username or passphrase needed for
user request.

— 20 = Response for specified HTTP method.

e Response code based on response received by
the appliance:

— 40 = Response contains “Cache-Control:
private” header.

— 80 = Response contains “Cache-Control:
no-store” header.

— 100 = Response indicates that request was
a query.

— 200 =Response has a small “Expires” value
(expires soon).

— 400 = Response does not have “Last
Modified” header.

— 1000 = Response expires immediately.
— 2000 = Response file is too big to cache.
— 20000 = New copy of file exists.

— 40000 = Response has bad/invalid values in
“Vary” header.

— 80000 = Response requires setting of cookies.

— 100000 = Non-cacheable HTTP
STATUS Code.

— 200000 = Object received by appliance was
incomplete (based on size).

— 800000 = Response trailers indicate
no caching.

1000000 = Response requires re-write.

Yk s-ip

Data source IP address (server IP address)

This value is used to determine a requestor when the
IP address is flagged by an intrusion detection
device on your network. Allows you to locate a
client that visited an IP address that has been so
flagged.

%! user-type

Type of user, either local or remote.
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Format Specifier in
Access Logs Log Field in W3C Logs Description

%L x-local_time Request local time in human-readable format:
DD/MMM/YYYY : hh:mm:ss +nnnn. This field is
written with double-quotes in the access logs.

Enabling this field allows you to correlate logs to
issues without having to calculate local time from
epoch time for each log entry.

Jom cs-auth-mechanism Used to troubleshoot authentication issues.

The authentication mechanism used on the
transaction. Possible values are:

e BASIC. The user name was authenticated using
the Basic authentication scheme.

e NTLMSSP. The user name was authenticated
using the NTLMSSP authentication scheme.

e Kerberos. The user name was authenticated
using the Kerberos authentication scheme.

¢ SSO_TUI. The user name was obtained by
matching the client IP address to an
authenticated user name using transparent user
identification.

e SSO_ISE. The user was authenticated by
an ISE server. (Log shows GUEST if that
is chosen as the fall-back mechanism for
ISE authentication.)

e SSO_ASA. The user is a remote user and the
user name was obtained from a Cisco ASA
using the Secure Mobility.

e FORM_AUTH. The user entered
authentication credentials in a form in the web
browser when accessing a application.

e GUEST. The user failed authentication and
instead was granted guest access.

%M CMF Cache miss flags: CMF flags.

%N s-computerName Server name or destination hostname. This field is
written with double-quotes in the access logs.

%op s-port Destination port number.

%P cs-version Protocol.

%q cs-bytes Request size (headers + body).

Yot x-req-first-line Request first line - request method, URI.

%5 sc-bytes Response size (header + body).
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Format Specifier in
Access Logs

Log Field in W3C Logs

Description

%ot timestamp Timestamp in UNIX epoch.

Note: If you want to use a third party log analyzer
tool to read and parse the W3C access logs, you
might need to include the “timestamp” field. Most
log analyzers only understand time in the format
provided by this field.

9ou cs(User-Agent) User agent. This field is written with double-quotes
in the access logs.

This field helps determine if an application is failing
authentication and/or requires different access
permissions.

%U cs-uri Request URI.

%oV date Date in YYYY-MM-DD.

%V time Time in HH:MM:SS.

Yow sc-result-code Result code. For example: TCP_MISS, TCP_HIT.

%W sc-result-code-denial Result code denial.

Yox x-latency Latency.

%X0 x-resp-dvs-scanverdict Unified response-side anti-malware scanning verdict
that provides the malware category number
independent of which scanning engines are enabled.
Applies to transactions blocked or monitored due to
server response scanning.

This field is written with double-quotes in the
access logs.

%X1 x-resp-dvs-threat-name Unified response-side anti-malware scanning verdict
that provides the malware threat name independent
of which scanning engines are enabled. Applies to
transactions blocked or monitored due to server
response scanning.

This field is written with double-quotes in the
access logs.

%X2 x-req-dvs-scanverdict Request side DVS Scan verdict

%X3 x-req-dvs-verdictname Request side DVS verdict name

% X4 x-req-dvs-threat-name Request side DVS threat name

9%X6 x-as-malware-threat-name |Indicates whether Adaptive Scanning blocked the

transaction without invoke any anti-malware
scanning engine. The possible values are:

e 1. Transaction was blocked.
e (. Transaction was not blocked.

This variable is included in the scanning verdict
information (in the angled brackets at the end of
each access log entry).
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Format Specifier in
Access Logs

Log Field in W3C Logs

Description

YD XA x-webcat-resp-code-abbr | The URL category verdict determined during
response-side scanning, abbreviated. Applies to the
Cisco Web Usage Controls URL filtering engine only.

%Xb x-avc-behavior The web application behavior identified by the
AVC engine.

%XB X-avg-bw Average bandwidth of the user if bandwidth limits
are defined by the AVC engine.

Y XC x-webcat-code-abbr URL category abbreviation for the URL category
assigned to the transaction.

%Xd x-mcafee-scanverdict McAfee specific identifier: (scan verdict).

%Xe x-mcafee-filename McAfee specific identifier: (File name yielding
verdict) This field is written with double-quotes in
the access logs.

Yo Xt x-mcafee-av-scanerror McAfee specific identifier: (scan error).

9% XF x-webcat-code-full Full name of the URL category assigned to the
transaction. This field is written with double-quotes
in the access logs.

%Xg x-mcafee-av-detecttype McAfee specific identifier: (detect type).

%XG x-avc-reghead-scanverdict |AVC request header verdict.

%Xh x-mcafee-av-virustype McAfee specific identifier: (virus type).

% XH x-avc-reqbody-scanverdic |AVC request body verdict.

t

%Xi x-webroot-trace-id Webroot specific scan identifier: (Trace ID)

% Xj x-mcafee-virus-name McAfee specific identifier: (virus name). This field
is written with double-quotes in the access logs.

%Xk x-wbrs-threat-type Web reputation threat type.

Y% XK x-wbrs-threat-reason Web reputation threat reason.

%X1 x-ids-verdict Cisco Data Security Policy scanning verdict. If this
field is included, it will display the IDS verdict, or “0”
if IDS was active but the document scanned clean, or
“-” if no IDS policy was active for the request.

Yo XL x-webcat-resp-code-full | The URL category verdict determined during
response-side scanning, full name.Applies to the
Cisco Web Usage Controls URL filtering engine only.

% XM x-ave-resphead-scanverdict |AVC response header verdict.

%Xn x-webroot-threat-name Webroot specific identifier: (Threat name) This field
is written with double-quotes in the access logs.

Y0XN x-ave-regbody-scanverdict |AVC response body verdict.

%X0O X-avc-app The web application identified by the AVC engine.

%Xp x-icap-verdict External DLP server scanning verdict.
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Format Specifier in
Access Logs

Log Field in W3C Logs

Description

% XP

x-acl-added-headers

Unrecognized header. Use this field to log extra
headers in client requests. This supports
troubleshooting of specialized systems that add
headers to client requests as a way of authenticating
and redirecting those requests, for example,
YouTube for Schools.

BXQ

x-webcat-req-code-abbr

The URL category verdict determined during
request-side scanning, abbreviated.

% Xr

x-result-code

Scanning verdict information.

%XR

x-webcat-req-code-full

The URL category verdict determined during
request-side scanning, full name.

XS

x-webroot-spyid

Webroot specific identifier: (Spy ID).

%XS

X-request-rewrite

Safe browsing scanning verdict.

Indicates whether either the safe search or site content
ratings feature was applied to the transaction.

%Xt

x-webroot-trr

Webroot specific identifier: (Threat Risk Ratio
[TRRY)).

%XT

x-bw-throttled

Flag that indicates whether bandwidth limits were
applied to the transaction.

%0 Xu

X-ave-type

The web application type identified by the
AVC engine.

Yo Xv

x-webroot-scanverdict

Malware scanning verdict from Webroot.

%XV

X-request-source-ip

The downstream IP address when the “Enable
Identification of Client IP Addresses using
X-Forwarded-For” checkbox is enabled for the Web
Proxy settings.

YoXW

X-wbrs-score

Decoded WBRS score <-10.0-10.0>.

Y0 XX

x-sophos-scanerror

Sophos specific identifier: (scan return code).

%Xy

x-sophos-file-name

The file location where Sophos found the
objectionable content. For non-archive files, this
value is the file name itself. For archive file, it is the
object in the archive, such as

archive.zip/virus.exe.

% XY

x-sophos-scanverdict

Sophos specific identifier: (scan verdict).

%Xz

X-sophos-virus-name

Sophos specific identifier: (threat name).

%XZ

x-resp-dvs-verdictname

Unified response-side anti-malware scanning verdict
that provides the malware category independent of
which scanning engines are enabled. Applies to
transactions blocked or monitored due to server
response scanning.

This field is written with double-quotes in the
access logs.
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Format Specifier in
Access Logs

Log Field in W3C Logs

Description

Do X#1#

x-amp-verdict

Verdict from Advanced Malware Protection
file scanning:

e (: File is not malicious.

e 1: File was not scanned because of its file type.
e 2: File scan timed out.

e 3: Scan error.

e Greater than 3: File is malicious.

Yo X#2#

x-amp-malware-name

Threat name, as determined by Advanced Malware
Protection file scanning. “-” indicates no threat.

o X H#3#

X-amp-score

Reputation score from Advanced Malware
Protection file scanning.

This score is used only if the cloud reputation service
is unable to determine a clear verdict for the file.

For details, see information about the Threat Score
and the reputation threshold in Chapter 17, “File
Reputation Filtering and File Analysis.”

Yo X#A#

x-amp-upload

Indicator of upload and analysis request:

“0” indicates that Advanced Malware Protection did
not request upload of the file for analysis.

“1” indicates that Advanced Malware Protection did
request upload of the file for analysis.

o XH#H5#

x-amp-filename

The name of the file being downloaded and
analyzed.

Yo X #6#

x-amp-sha

The SHA-256 identifier for this file.

Poy

cs-method

Method.

%Y

cs-url

The entire URL.

N/A

x-hierarchy-origin

Code that describes which server was contacted for
the retrieving the request content (for example,
DIRECT/www.example.com).

N/A

x-resultcode-httpstatus

Result code and the HTTP response code, with a
slash (/) in between.

Related Topics

¢ Web Proxy Information in Access Log Files, page 21-13.

e Interpreting W3C Access Logs, page 21-24.

Malware Scanning Verdict Values

A malware scanning verdict is a value assigned to a URL request or server response that determines the
probability that it contains malware. The Webroot, McAfee, and Sophos scanning engines return the
malware scanning verdict to the DVS engine so the DVS engine can determine whether to monitor or
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block the scanned object. Each malware scanning verdict corresponds to a malware category listed on
the Access Policies > Reputation and Anti-Malware Settings page when you edit the anti-malware

settings for a particular Access Policy.

The following list presents the different Malware Scanning Verdict Values and each corresponding

malware category:

Malware Scanning Verdict Value

Malware Category

- Not Set

0 Unknown

1 Not Scanned

2 Timeout

3 Error

4 Unscannable

10 Generic Spyware

12 Browser Helper Object
13 Adware

14 System Monitor

18 Commercial System Monitor
19 Dialer

20 Hijacker

21 Phishing URL

22 Trojan Downloader

23 Trojan Horse

24 Trojan Phisher

25 Worm

26 Encrypted File

27 Virus

33 Other Malware

34 PUA

35 Aborted

36 Outbreak Heuristics

37 Known Malicious and High-Risk Files

Related Topics

e Web Proxy Information in Access Log Files, page 21-13.

e Interpreting W3C Access Logs, page 21-24.

Troubleshooting Logging

e Custom URL Categories Not Appearing in Access Log Entries, page A-8
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e Logging HTTPS Transactions, page A-8
e Alert: Unable to Maintain the Rate of Data Being Generated, page A-9
e Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs, page A-9
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Perform System Administration Tasks

Overview of System Administration, page 22-1

Saving, Loading, and Resetting the Appliance Configuration, page 22-2
Working with Feature Keys, page 22-3

Virtual Appliance License, page 22-4

Enabling Remote Power Management, page 22-5

Administering User Accounts, page 22-6

Defining User Preferences, page 22-10

Configuring Administrator Settings, page 22-11

Configuring the Return Address for Generated Messages, page 22-14
Managing Alerts, page 22-14

FIPS Compliance, page 22-21

SSL Configuration, page 22-23

System Date and Time Management, page 22-22

Certificate Management, page 22-24

AsyncOS for Web Upgrades and Updates, page 22-28

Reverting to a Previous Version of AsyncOS for Web, page 22-33
Monitoring System Health and Status Using SNMP, page 22-35

Overview of System Administration

The S-Series appliance provides a variety of tools for managing the system. Functionality on System
Administration tab helps you manage the following tasks:

Appliance configuration

Feature keys

Adding, editing, and removing user accounts
AsyncOS software upgrades and updates

System time
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Saving, Loading, and Resetting the Appliance Configuration

All configuration settings within the Web Security appliance are managed using a single XML
configuration file.

e Viewing and Printing the Appliance Configuration, page 22-2

e Saving the Appliance Configuration File, page 22-2

¢ Loading the Appliance Configuration File, page 22-3

e Resetting the Appliance Configuration to Factory Defaults, page 22-3

Viewing and Printing the Appliance Configuration

Step 1 Choose System Administration > Configuration Summary.

Step2  View or print the Configuration Summary page as required.

Saving the Appliance Configuration File

Step 1 Choose System Administration > Configuration File.

Step2  Complete the Configuration File options.

Option Description

Choose from these location options: Allows you to choose where to save the file to

e Download file to local computer to view or
save

e Save file to this appliance (example.com)

e Email file to

Mask passphrases in the Configuration Files If enabled, causes the original, encrypted
passphrase to be replaced with “*****” in the
exported or saved file. Please note, however, that
configuration files with masked passphrases
cannot be loaded directly back into AsyncOS for
Web.

Choose from these file name options: Allows you to choose the configuration file

e Use system-generated file name naming method.

e Use user-defined file name:

Step3  Click Submit.
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Working with Feature Keys

Loading the Appliance Configuration File
A

Caution  Loading configuration will permanently remove all of your current configuration settings. It is strongly
recommended that you save your configuration before performing these actions.

N

Note  If a compatible configuration file is based on an older version of the set of URL categories than the
version currently installed on the appliance, policies and identities in the configuration file may be
modified automatically.

Step 1 Choose System Administration > Configuration File.
Step2  Choose Load Configuration options and a file to load. Note:
Files with masked passphrases cannot be loaded.
Files must have the following header:

<?xml version="1.0" encoding="1S0-8859-1"?> <!DOCTYPE config SYSTEM “config.dtd”>

and a correctly formatted config section:
<config> ... Your configuration information in valid XML </config>
Step3  Click Load.

Step4  Read the warning displayed. If you understand the consequences of proceeding, click Continue.

Resetting the Appliance Configuration to Factory Defaults

You can choose whether or not to retain existing network settings when you reset the appliance
configuration.

This action does not require a commit.

Before You Begin

Save your configuration to a location off the appliance.

Step 1 Choose System Administration > Configuration File.
Step2  Scroll down to view the Reset Configuration section.
Step3  Read the information on the page and select options.

Stepd  Click Reset.

Working with Feature Keys

Feature keys enable specific functionality on your system.Keys are specific to the serial number of your
appliance (you cannot re-use a key from one system on another system).
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e Displaying and Updating Feature Keys, page 22-4
e Changing Feature Key Update Settings, page 22-4

Displaying and Updating Feature Keys

Step 1
Step 2
Step 3

Step 4

Choose System Administration > Feature Keys.
To refresh the list of pending keys, click Check for New Keys to refresh the list of pending keys.

To add a new feature key manually, paste or type the key into the Feature Key field and click Submit
Key. If the feature key is valid, the feature key is added to the display.

To activate a new feature key from the Pending Activation list, mark its “Select” checkbox and click
Activate Selected Keys.

You can configure your appliance to automatically download and install new keys as they are issued. In
this case, the Pending Activation list will always be empty. You can tell AsyncOS to look for new keys
at any time by clicking the Check for New Keys button, even if you have disabled the automatic
checking via the Feature Key Settings page.

Changing Feature Key Update Settings

Step 1
Step 2
Step 3

Step 4

The Feature Key Settings page is used to control whether your appliance checks for and downloads new
feature keys, and whether or not those keys are automatically activated.

Choose System Administration > Feature Key Settings.
Click Edit Settings.
Change the Feature Key Settings as required.

Option Description

Automatic Serving of | Options to automatically check and download feature keys and to
Feature Keys automatically activate downloaded feature keys.

Automatic checks are normally performed once a month but this changes to
once a day when a feature key is to expire in less than 10 days and once a
day after key expiration, for up to one month. After a month, the expired key
is no longer included in the list of expiring/expired keys.

Submit and commit your changes.

Virtual Appliance License

The Cisco Web Security Virtual appliance requires an additional license to run the virtual appliance on

a host.
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Note

Enabling Remote Power Management

For more information about virtual appliance licensing, see the Cisco Content Security Virtual Appliance
Installation Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-lis
t.html.

You cannot open a Technical Support tunnel before installing the virtual appliance license.

After the license expires, the appliance will continue to serve as a web proxy without security services
for180 days. Security service updates do not occur during this period.

You can configure the appliance so you receive alerts about license expiration.

Related Topics
e Managing Alerts, page 22-14

Installing a Virtual Appliance License

See the Cisco Content Security Virtual Appliance Installation Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-lis
t.html.

Enabling Remote Power Management

Step 1
Step 2
Step 3

The ability to remotely reset the power for the appliance chassis is available only on 80- and
90-series hardware.

If you want to be able to remotely reset appliance power, you must enable and configure this
functionality in advance, using the procedure described in this section.

Before You Begin

e (able the dedicated Remote Power Control port directly to a secure network. For information,
see the hardware guide for your appliance model. For the location of this document, see
Documentation Set, page C-2.

¢ Ensure that the appliance is accessible remotely; for example, open any necessary ports through the
firewall.

e This feature requires a unique IPv4 address for the dedicated Remote Power Control interface.
This interface is configurable only via the procedure described in this section; it cannot be
configured using the ipconfig command.

¢ In order to cycle appliance power, you will need a third-party tool that can manage devices that
support the Intelligent Platform Management Interface (IPMI) version 2.0. Ensure that you are
prepared to use such a tool.

e For more information about accessing the command-line interface, see Appendix B, “Command
Line Interface.”

Use SSH or the serial console port to access the command-line interface.
Sign in using an account with Administrator access.

Enter the following commands:
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remotepower
setup

Stepd  Follow the prompts to specify the following:
e The dedicated IP address for this feature, plus netmask and gateway.
e The username and passphrase required to execute the power-cycle command.
These credentials are independent of other credentials used to access your appliance.
Step5 Enter commit to save your changes.
Step6  Test your configuration to be sure that you can remotely manage appliance power.

Step7  Ensure that the credentials that you entered will be available to you in the indefinite future. For example,
store this information in a safe place and ensure that administrators who may need to perform this task
have access to the required credentials.

Related Topics
e Hardware Appliances: Remotely Resetting Appliance Power, page A-12

Administering User Accounts

The following types of users can log into the Web Security appliance to manage the appliance:
e Local users. You can define users locally on the appliance itself.

¢ Users defined in an external system. You can configure the appliance to connect to an external
RADIUS server to authenticate users logging into the appliance.

~

Note  Any user you define can log into the appliance using any method, such as logging into the web interface
or using SSH.

Related Topics
e Managing Local User Accounts, page 22-6.

e RADIUS User Authentication, page 22-8.

Managing Local User Accounts

You can define any number of users locally on the Web Security appliance.

The default system admin account has all administrative privileges. You can change the admin account
passphrase, but you cannot edit or delete this account.

Note  If you have lost the admin user passphrase, contact your Cisco support provider.
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Adding Local User Accounts

Before You Begin

Define the passphrase requirements that all user accounts must follow. See Setting Passphrase
Requirements for Administrative Users, page 22-11.

Step 1 Choose System Administration > Users.
Step2  Click Add User
Step3  Enter a username, noting the following rules:

e Usernames can contain lowercase letters, numbers, and the dash ( - ) character, but cannot begin with
a dash.

e Usernames cannot greater than 16 characters.
e Usernames cannot be special names that are reserved by the system, such as “operator” or “root.”

e If you also use external authentication, usernames should not duplicate externally-authenticated
usernames.

Step4  Enter a full name for the user.

Step5  Select a user type.

User Type Description

Administrator Allows full access to all system configuration settings. However, the upgradecheck
and upgradeinstall CLI commands can be issued only from the system defined
“admin” account.

Operator Restricts users from creating, editing, or removing user accounts. The operators
group also restricts the use of the following CLI commands:

® resetconfig
® upgradecheck

® upgradeinstall

® systemsetup or running the System Setup Wizard

Read-Only User accounts with this role:

Operator . . L .
p e Can view configuration information.

¢ (Can make and submit changes to see how to configure a feature, but they cannot
commit them.

e Cannot make any other changes to the appliance, such as clearing the cache or
saving files.

e (Cannot access the file system, FTP, or SCP.

Guest The guests group users can only view system status information, including reporting
and tracking.

Step6  Enter or generate a passphrase.

Step7  Submit and commit your changes.
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Deleting User Accounts

Step 1 Choose System Administration > Users.
Step2  Click the trash can icon corresponding to the listed user name and confirm when prompted.

Step3  Submit and commit your changes.

Editing User Accounts

Step 1 Choose System Administration > Users.
Step2  Click the user name.
Step3  Make changes to the user on the Edit User page as required.

Step4  Submit and commit your changes.

Changing Passphrases
To change the passphrase of the account currently logged in, select Options > Change Passphrase from
the top right-hand side of the window.

For other accounts, edit the account and change the passphrase in the Local User Settings page.

Related Topics
e Editing User Accounts, page 22-8

e Setting Passphrase Requirements for Administrative Users, page 22-11

RADIUS User Authentication

The Web Security appliance can use a RADIUS directory service to authenticate users that log in to the
appliance using HTTP, HTTPS, SSH, and FTP. You can configure the appliance to contact multiple
external servers for authentication, using either PAP or CHAP authentication. You can map groups of
external users to different Web Security appliance user role types.

Sequence of Events For Radius Authentication

When external authentication is enabled and a user logs into the Web Security appliance, the appliance:
1. Determines if the user is the system-defined “admin” account.
2. If not, checks the first configured external server to determine if the user is defined there.

3. If the appliance cannot connect to the first external server, it checks the next external server in
the list.

4. If the appliance cannot connect to any external server, it tries to authenticate the user as a local user
defined on the Web Security appliance.
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5. If the user does not exist on any external server or on the appliance, or if the user enters the wrong
passphrase, access to the appliance is denied.

Enabling External Authentication Using RADIUS

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

On the System Administration > Users page, click Enable External Authentication.
Choose RADIUS as the Authentication Type.

Enter the host name, port number, and Shared Secret passphrase for the RADIUS server. Default port
is 1812.

Enter the number of seconds the appliance is to wait for a response from the server before timing out.
Choose the authentication protocol used by the RADIUS server.
(Optional) Click Add Row to add another RADIUS server. Repeat steps 3—5 for each RADIUS server.

A

Note  You can add up to ten RADIUS servers.

In the External Authentication Cache Timeout field, enter the number of seconds AsyncOS stores the
external authentication credentials before contacting the RADIUS server again to re-authenticate.
Default is zero.

~

Note  If the RADIUS server uses one-time passphrases, for example passphrases created from a token,
enter zero (0). When the value is set to zero, AsyncOS does not contact the RADIUS server again
to authenticate during the current session.
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Step8  Configure Group Mapping—Select whether to map all externally authenticated users to the
Administrator role or to different appliance-user role types.

Setting

Description

Map externally authenticated
users to multiple local roles.

Enter a group name as defined in the RADIUS CLASS attribute,
and choose an appliance Role type. You can add more role
mappings by clicking Add Row.

AsyncOS assigns RADIUS users to appliance roles based on the
RADIUS CLASS attribute. CLASS attribute requirements:

e three-character minimum
e 253-character maximum
* 1o colons, commas, or newline characters

¢ one or more mapped CLASS attributes for each RADIUS user
(With this setting, AsyncOS denies access to RADIUS users
without a mapped CLASS attribute.)

For RADIUS users with multiple CLASS attributes, AsyncOS
assigns the most restrictive role. For example, if a RADIUS user
has two CLASS attributes, which are mapped to the Operator and
Read-Only Operator roles, AsyncOS assigns the RADIUS user to
the Read-Only Operator role, which is more restrictive than the
Operator role.

These are the appliance roles ordered from most restrictive to least
restrictive:

e Administrator
e Operator
e Read-Only Operator

e Guest

Map all externally authenticated
users to the Administrator role.

AsyncOS assigns all RADIUS users to the Administrator role.

Step9  Submit and commit your changes.

Related Topics

e External Authentication, page 5-11

e Adding Local User Accounts, page 22-7.

Defining User Preferences

Preference settings, such as reporting display formats, are stored for each user and are the same
regardless from which client machine the user logs into the appliance.

Step 1 Choose Options > Preferences.
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Step2  On the User Preferences page, click Edit Preferences.

Step3  Configure the preference settings as required.

Preference Setting

Description

Language Display

The language AsyncOS for Web uses in the web interface and CLI.

Landing Page

The page that displays when the user logs into the appliance.

Reporting Time Range
Displayed (default)

The default time range that displays for reports on the Reporting tab.

Number of Reporting Rows
Displayed

The number of rows of data shown for each report by default.

Step4  Submit and commit your changes.

Configuring Administrator Settings

Setting Passphrase Requirements for Administrative Users

To set passphrase requirements for locally-defined administrative users of the appliance:

Step 1 Select System Administration > Users.

Step2  In the Passphrase Settings section, click Edit Settings.

Step3  Choose options:
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Option

Description

List of words to
disallow in passphrases

Create a .txt file with each forbidden word on a separate line, then select the
file to upload it. Subsequent uploads overwrite previous uploads.

Passphrase Strength

You can display a passphrase-strength indicator when an administrative user
enters a new passphrase.

This setting does not enforce creation of strong passphrases, it merely shows
how easy it is to guess the entered passphrase.

Select the roles for which you wish to display the indicator. Then, for each
selected role, enter a number greater than zero. A larger number means that
a passphrase that registers as strong is more difficult to achieve. This setting
has no maximum value, but a very high number makes it effectively
impossible to enter a passphrase that evaluates as "good."

Experiment to see what number best meets your requirements.

Passphrase strength is measured on a logarithmic scale. Evaluation is based
on the U.S. National Institute of Standards and Technology rules of entropy
as defined in NIST SP 800-63, Appendix A.

Generally, stronger passphrases:
e Are longer
¢ Include upper case, lower case, numeric, and special characters
e Do not include words in any dictionary in any language.

To enforce passphrases with these characteristics, use the other settings on
this page.

Stepd  Submit and commit your changes.

Additional Security Settings for Accessing the Appliance

You can configure the Web Security appliance to have stricter access requirements for administrators
logging into the appliance.
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Command Description

adminaccessconfig Configures the appliance to display any text you specify when an
administrator tries to logs in. The custom banner text appears when an
administrator tries to access the appliance through all interfaces, such as the
web interface or via FTP.

> banner

You can load the custom text by either pasting it into the CLI prompt or by
copying it from a file located on the Web Security appliance. To upload the
text from a file, you must first transfer the file to the configuration directory
on the appliance using FTP

adminaccessconfig Controls from which IP addresses administrators access the Web Security
appliance. Administrators can access the appliance from any machine or

> ipaccess
P from machines with an IP address from a list you specify.

When restrict access to an allow list, you can specify IP addresses, subnets,
or CIDR addresses.

By default, when you list the addresses that can access the appliance, the IP
address of your current machine is listed as the first address in the allow list.
You cannot delete the IP address of your current machine from the allow list.

adminaccessconfig Configures the appliance so administrators log into the web interface on port

S strictss] 8443 using stronger SSL ciphers (greater than 56 bit encryption).

When you configure the appliance to require stronger SSL ciphers, the
change only applies to administrators accessing the appliance using HTTPS
to manage the appliance. It does not apply to other network traffic connected
to the Web Proxy using HTTPS.

Resetting the Administrator Passphrase

Any administrator-level user can change the passphrase for the “admin” user.

Before You Begin

e If you do not know the passphrase for the admin account, contact your customer support provider to
reset the passphrase.

e Understand that changes to the passphrase take effect immediately and do not require you to commit
the change.

Step1  Select Management Appliance > System Administration > Users.
Step2  Click the admin link in the Users list.
Step3  Select Change the passphrase.

Stepd  Generate or enter the new passphrase.
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Managing Alerts

Alerts are email notifications containing information about events occurring on the Cisco Web Security
Appliance appliance. These events can be of varying levels of importance (or severity) from minor
(Informational) to major (Critical) and pertain generally to a specific component or feature on the
appliance.

Note  Toreceive alerts and email notifications, you must configure the SMTP relay host that the appliance uses
to send the email messages.

Alert Classifications and Severities

The information contained in an alert is determined by an alert classification and a severity. You can
specify which alert classifications, at which severity, are sent to any alert recipient.

Alert Classifications

AsyncOS sends the following types of alert:
e System
e Hardware
e Updater
e Web Proxy
e Anti-Malware

e L4 Traffic Monitor

Alert Severities

Alerts can be sent for the following severities:
e Critical: Requires immediate attention.
e Warning: Problem or error requiring further monitoring and potentially immediate attention.

¢ Information: Information generated in the routine functioning of this device.

Managing Alert Recipients
~

Note  If you enabled AutoSupport during System Setup, the email address you specified will receive alerts for
all severities and classes by default. You can change this configuration at any time.

Adding and Editing Alert Recipients

Step1  Choose System Administration > Alerts.
Step2  Click on arecipient in the Alert Recipients list to edit it, or click Add Recipient to add a new recipient.

Step3  Add or edit the recipient’s email address. You can enter multiple addresses, separated by commas.
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Stepd  Select which alert severities to receive for each alert type.

Step5  Submit and commit your changes.

Deleting Alert Recipients

Step1  Choose System Administration > Alerts.

Step2  Click the trash can icon corresponding to the alert recipient in the Alert Recipient listing and confirm.

Step3  Commit your changes.

Configuring Alert Settings

Alert settings are global settings, meaning that they affect how all of the alerts behave.

Step 1 Choose System Administration > Alerts.

Step2  Click Edit Settings.

Step3  Configure the alert settings as required.

Option

Description

From Address to Use
When Sending Alerts

The RFC 2822 compliant “Header From:” address to use when sending
alerts. An option is provided to automatically generate an address based on
the system hostname (“alert@<hostname>")
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Option Description

Wait Before Sending a |Specifies the time interval for duplicate alerts. There are two settings:

Duplicate Alert Initial Number of Seconds to Wait Before Sending a Duplicate Alert. If

you set this value to 0, duplicate alert summaries are not sent and instead, all
duplicate alerts are sent without any delay (this can lead to a large amount of
email over a short amount of time). The number of seconds to wait between
sending duplicate alerts (alert interval) is increased after each alert is sent.
The increase is the number of seconds to wait plus twice the last interval. So
a 5 second wait would have alerts sent at 5 seconds, 15, seconds, 35 seconds,
75 seconds, 155 seconds, 315 seconds, etc.

Maximum Number of Seconds to Wait Before Sending a Duplicate Alert.
You can set a cap on the number of seconds to wait between intervals via the
maximum number of seconds to wait before sending a duplicate alert field.
For example, if you set the initial value to 5 seconds, and the maximum value
to 60 seconds, alerts would be sent at 5 seconds, 15 seconds, 35 seconds, 60
seconds, 120 seconds, etc

Cisco AutoSupport Specifies whether or not to send Cisco the following support information:
e acopy of all alert messages generated by the system

e weekly reports noting the uptime of the system, the output of the status
command, and the AsyncOS version used.

Also specifies whether or not to send internal alert recipients a copy of every
message sent to Cisco. This applies only to recipients that are set to receive
System alerts at Information severity level.

Step4  Submit and commit your changes.

Alert Listing

The following sections list alerts by classification. The table in each section includes the alert name
(internally used descriptor), actual text of the alert, description, severity (critical, information, or
warning) and the parameters (if any) included in the text of the message.

Feature Key Alerts

The following table contains a list of the various feature key alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

Message Alert Severity Parameters

A “$feature” key was downloaded from the key Information. $feature: Name of the feature.
server and placed into the pending area. EULA
acceptance required.
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Message Alert Severity Parameters

Your “$feature” evaluation key has expired. Please |Warning. $feature: Name of the feature.
contact your authorized sales representative.

Your “$feature” evaluation key will expire in under |Warning. $feature: Name of the feature.

$days day(s). Please contact your authorized sales
representative.

$days: The number of days that will pass
before the feature key will expire.

Hardware Alerts

The following table contains a list of the various hardware alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

Message Alert Severity Parameters

A RAID-event has occurred: Warning $error: Text of the RAID error.

$error

Logging Alerts

The following table contains a list of the various logging alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

Message Alert Severity Parameters

$error. Information. $error: The traceback string of the error.

Log Error: Subscription $name: Log partition is Critical. $name: Log subscription name.

full.

Log Error: Push error for subscription $name: Critical. $name: Log subscription name.

Failed to connect to $ip: $reason. $ip: IP address of the remote host.
$reason: Text describing the connect error

Log Error: Push error for subscription $name: An  |Critical. $name: Log subscription name.

FTP command failed to $ip: $reason. $ip: TP address of the remote host.
$reason: Text describing what went wrong.

Log Error: Push error for subscription $name: SCP |Critical. $name: Log subscription name.

failed to transfer to $ip:$port: $reason’, $ip: IP address of the remote host.
$port: Port number on the remote host.
$reason: Text describing what went wrong.

Log Error: 'Subscription $name: Failed to connect |Critical. $name: Log subscription name.

to $hostname ($ip): $error.

$hostname: Hostname of the syslog server.
$ip: IP address of the syslog server.

$error: Text of the error message.
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Message Alert Severity Parameters

Log Error: Subscription $name: Network error Critical. $name: Log subscription name.

Wl.lile sending log data to syslog server $hostname $hostname: Hostname of the syslog server.

($ip): $error
$ip: IP address of the syslog server.
$error: Text of the error message.

Subscription $name: Timed out after $timeout Critical. $name: Log subscription name.

zg?;)))r.lds sending data to syslog server $hostname $timeout: Timeout in seconds.
$hostname: Hostname of the syslog server.
$ip: IP address of the syslog server.

Subscription $name: Syslog server $hostname ($ip) |Critical. $name: Log subscription name.

is not accepting data fast enough. $hostname: Hostname of the syslog server.
$ip: IP address of the syslog server.

Subscription $name: Oldest log file(s) were Information. $name: Log subscription name.

removed because log files reached the maximum
number of $max_num_files. Files removed include:

$files_removed.

$max_num_files: Maximum number of files
allowed per log subscription.

$files_removed: List of files that were
removed.

Reporting Alerts

The following table contains a list of the various reporting alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

Message Alert Severity Parameters

The reporting system is unable to maintain the rate |Critical. Not applicable.

of data being generated. Any new data generated

will be lost.

The reporting system is now able to handle new Information. Not applicable.

data.

A failure occurred while building periodic report Critical. $report_title: Title of the report.
‘$report_title’.

This subscription should be examined and deleted if

its configuration details are no longer valid.

A failure occurred while emailing periodic report  |Critical. $report_title: Title of the report.

‘$report_title’.

This subscription has been removed from the
scheduler.
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Message

Alert Severity

Parameters

Processing of collected reporting data has been
disabled due to lack of logging disk space. Disk
usage is above $threshold percent. Recording of
reporting events will soon become limited and
reporting data may be lost if disk space is not freed
up (by removing old logs, etc).

Once disk usage drops below $threshold percent,
full processing of reporting data will be restarted
automatically.

Warning.

$threshold: Threshold value.

PERIODIC REPORTS: While building periodic
report $report_title' the expected domain
specification file could not be found at
‘$file_name’. No reports were sent.

Critical.

$report_title: Title of the report.

$file_name: Name of the file.

Counter group “$counter_group” does not exist.

Critical.

$counter_group: Name of the counter_group.

PERIODIC REPORTS: While building periodic
report $report_title’ the domain specification file
‘$file_name’ was empty. No reports were sent.

Critical.

$report_title: Title of the report.

$file_name: Name of the file.

PERIODIC REPORTS: Errors were encountered
while processing the domain specification file
‘$file_name’ for the periodic report ‘$report_title’.
Any line which has any reported problem had no
report sent.

$error_text

Critical.

$report_title: Title of the report.
$file_name: Name of the file.

$error_text: List of errors encountered.

Processing of collected reporting data has been
disabled due to lack of logging disk space. Disk
usage is above $threshold percent. Recording of
reporting events will soon become limited and
reporting data may be lost if disk space is not freed
up (by removing old logs, etc).

Once disk usage drops below $threshold percent,
full processing of reporting data will be restarted
automatically.

Warning.

$threshold: Threshold value.

The reporting system has encountered a critical
error while opening the database. In order to prevent
disruption of other services, reporting has been
disabled on this machine. Please contact customer
support to have reporting enabled.

The error message is:

$err_msg

Critical.

$err_msg: Error message text.
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System Alerts
The following table contains a list of the various system alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

Message Alert Severity Parameters

Startup script $name exited with error: $message Critical. $name: Name of the script.
$message: Error message text.

System halt failed: $exit_status: $output', Critical. $exit_status: Exit code of the command.
$output: Output from the command.

System reboot failed: $exit_status: $output Critical. $exit_status: Exit code of the command.
$output: Output from the command.

Process $name listed $dependency as a dependency, |Critical. $name: Name of the process.

but it does not exist. $dependency: Name of the dependency that
was listed.

Process $name listed $dependency as a dependency, |Critical. $name: Name of the process.

but $dependency is not a wait_init process. $dependency: Name of the dependency that
was listed.

Process $name listed itself as a dependency. Critical. $name: Name of the process.

Process $name listed $dependency as a dependency |Critical. $name: Name of the process.

multiple times. $dependency: Name of the dependency that
was listed.

Dependency cycle detected: $cycle. Critical. $cycle: The list of process names involved in
the cycle.

An error occurred while attempting to share Warning. $error: The error message associated with the

statistical data through the Network Participation exception.

feature. Please forward this tracking information to

your support provider:

Error: $error.

There is an error with “$name”. Critical. $name: Name of the process that generated a
core file.

An application fault occurred: “$Serror” Critical. $error: Text of the error, typically a traceback.

Tech support: Service tunnel has been enabled, port |Information. $port: Port number used for the service tunnel.

$port
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Message Alert Severity Parameters
Tech support: Service tunnel has been disabled. Information. Not applicable.
* The host at $ip has been added to the blacklist |Warning. $ip - IP address from which a login attempt
because of an SSH DOS attack. occurred.
e The host at $ip has been permanently added to Description:

the ssh whitelist. IP addresses that try to connect to the

e The host at $ip has been removed from the appliance over SSH but do not provide valid
blacklist credentials are added to the SSH blacklist if
more than 10 failed attempts occur within two
minutes.

When a user logs in successfully from the same
IP address, that IP address is added to the
whitelist.

Addresses on the whitelist are allowed access
even if they are also on the blacklist.

Entries are automatically removed from the
blacklist after about a day.

Updater Alerts

The following table contains a list of the various updater alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

Message Alert Severity Parameters

The $app application tried and failed $attempts Warning. $app: Web Security appliance security service
times to successfully complete an update. This may name.
be due to a network configuration issue or

$attempts: Number of attempts tried.
temporary outage.

The updater has been unable to communicate with |Warning. $threshold: Threshold value time.
the update server for at least $threshold.

Unknown error occurred: $traceback. Critical. $traceback: Traceback information.

Anti-Malware Alerts

For information about alerts related to Advanced Malware Protection, see Ensuring That You Receive
Alerts About Advanced Malware Protection Issues, page 17-11.

FIPS Compliance

Federal Information Processing Standards (FIPS) specify requirements for cryptographic modules that
are used by all government agencies to protect sensitive but unclassified information. FIPS help ensure
compliance with federal security and data privacy requirements. FIPS, developed by the National
Institute for Standards and Technology (NIST), are to use when no voluntary standards exist to meet
federal requirements.

The WSA achieves FIPS 140-2 Level 1 compliance in FIPS mode using Cisco Common Cryptographic
Module (C3M). By default, FIPS mode is disabled.

Async0S 9.1 for Cisco Web Security Appliances User Guide
| g 2221




Chapter 22 Perform System Administration Tasks |

W System Date and Time Management

FIPS Certificate Requirements

FIPS mode requires that all enabled encryption services on the Web Security appliance use a
FIPS-compliant certificate. This applies to the following encryption services:

e HTTPS Proxy

e Authentication

¢ Identity Provider for SaaS

e Appliance Management HTTPS Service

Note  The Appliance Management HTTPS Service must be enabled before FIPS mode can be enabled. The
other encryption services need not be enabled.

A FIPS-compliant certificate must meet these requirements:

Certificate  |Algorithm Bit Key Size |Signature Algorithm Notes

X509 RSA 1024, 2048, |shalWithRSAEncryption |Cisco recommends a bit key
3072, or size of 1024 for best
4096 decryption performance and

sufficient security. A larger
bit size will increase security,
but impact decryption
performance.

DSA 1024 dsaWithSHA1

Enabling or Disabling FIPS Mode

Before You Begin

¢ Ensure the certificates to be used in FIPS mode use FIPS 140-2 approved public key algorithms (see
FIPS Certificate Requirements, page 22-22).

Note Changing the FIPS mode initiates a reboot of the appliance.

Step 1 Choose System Administration > FIPS Mode.

Step2  Click Edit Settings.

Step3  Check or uncheck the Enable FIPS Level 1 Compliance check box.
Step4  Click Submit.

Step5  Click Continue to allow the appliance to reboot.

System Date and Time Management

e Setting the Time Zone, page 22-23
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e Synchronizing the System Clock with an NTP Server, page 22-23

Setting the Time Zone

Step 1
Step 2
Step 3
Step 4

Choose System Administration > Time Zone.
Click Edit Settings.
Select your region, country, and time zone or select the GMT offset.

Submit and commit the changes.

Synchronizing the System Clock with an NTP Server

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Cisco recommends that you set your Web Security appliance to track the current date and time by
querying a Network Time Protocol (NTP) server, not by manually setting the time on the appliance. This
is especially true if your appliance integrates with other devices. All integrated devices should use the
same NTP server.

Choose System Administration > Time Settings.
Click Edit Settings.
Select Use Network Time Protocol as the Time Keeping Method.

Enter the fully qualified hostname or IP address of the NTP server, clicking Add Row as needed to add
Servers.

(Optional) Choose the routing table associated with an appliance network interface type, either
Management or Data, to use for NTP queries. This is the IP address from which NTP queries should
originate.

A
Note  This option is only editable if the appliance is using split routing for data and management
traffic.

Submit and commit your changes.

SSL Configuration

Note

For enhanced security, you can enable and disable SSL v3 and various versions of TLS for several
services. Disabling SSL v3 for all services is recommended for best security. By default, all versions of
TLS are enabled, and SSL is disabled.

You also can use the ss1config CLI command to enable or disable these features. See Web Security
Appliance CLI Commands, page B-6.
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Step 1
Step 2
Step 3

Step 4

Choose System Administration > SSL Configuration.
Click Edit Settings.

Check the corresponding boxes to enable SSL v3 and TLS v1.x for these services:

)

Appliance Management Web User Interface — Changing this setting will disconnect all active
user connections.

Proxy Services — Includes HTTPS Proxy and Credential Encryption for Secure Client. This section
also includes:

— Cipher(s) to Use — You can enter additional cipher suites to be used with Proxy Services
communications. Use colons (:) to separate the suites. The default cipher is DEFAULT: +kEDH;
however, this may change based on your ECDHE cipher selections. Be sure to enter only suites
appropriate to the TLS/SSL versions you have checked. Refer to
https://www.openssl.org/docs/manmaster/apps/ciphers.html for additional information, and
cipher lists.

To prevent use of a particular cipher, add an exclamation point (!) to the front of that string. For
example, ! EXP-DHE-RSA-DES-CBC-SHA.

— Disable TLS Compression (Recommended) — You can check this box to disable TLS
compression; this is recommended for best security.

Secure LDAP Services — Includes Authentication, External Authentication, SaaS SSO, and
Secure Mobility.

Secure ICAP Services (External DLP) — Select the protocol(s) used to secure ICAP
communications between the appliance and external DLP (data loss prevention) servers. See
Configuring External DLP Servers, page 16-9 for more information.

Update Service — Select the protocol(s) used for communications between the appliance and
available update servers. See AsyncOS for Web Upgrades and Updates, page 22-28 for more
information about update services.

Note  Cisco’s Update servers do not support SSL v3, therefore TLS 1.0 or above must be enabled for
the Cisco Update service. However, SSL v3 can still be used with a local update server, if it is
so configured—you must determine which versions of SSL/TLS are supported on that server.

Click Submit.

Certificate Management

The appliance uses digital certificates to establish, confirm and secure a variety of connections. The
Certificate Management page lets you view and update current certificate lists, manage trusted root
certificates, and view blocked certificates.

Related Topics

About Certificates and Keys, page 22-25
Certificate Updates, page 22-25
Managing Trusted Root Certificates, page 22-25
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e Viewing Blocked Certificates, page 22-26

About Certificates and Keys

When a browser prompts its user to authenticate, the browser sends the authentication credentials to
the Web Proxy using a secure HTTPS connection. By default, the Web Security appliance uses the
“Cisco Web Security Appliance Demo Certificate” that comes with it to create an HTTPS connection
with the client. Most browsers will warn users that the certificate is not valid. To prevent users from
seeing the invalid certificate message, you can upload a certificate and key pair that your applications
recognize automatically.

Related Topics
e Uploading or Generating a Certificate and Key, page 22-26

e C(Certificate Signing Requests, page 22-27
¢ Intermediate Certificates, page 22-27

Managing Trusted Root Certificates

Step 1
Step 2
Step 3

Step 4

Step 5

The Web Security appliance ships with and maintains a list of trusted root certificates. Web sites with
trusted certificates do not require decryption.

You can manage the trusted certificate list, adding certificates to it and functionally removing certificates
from it. While the Web Security appliance does not delete certificates from the master list, it allows you
to override trust in a certificate, which functionally removes the certificate from the trusted list.

To add, override or download a trusted root certificate:

Choose Network > Certificate Management.

Click Manage Trusted Root Certificates on the Certificate Management page.

To add a custom trusted root certificate with a signing authority not on the Cisco-recognized list:
Click Import and then browse to, select, and Submit the certificate file.

To override the trust for one or more Cisco-recognized certificates:

a. Check the Override Trust checkbox for each entry you wish to override.

b. Click Submit.

To download a copy of a particular certificate:

a. Click the name of the certificate in the Cisco Trusted Root Certificate List to expand that entry.

b. Click Download Certificate.

Certificate Updates

The Updates section lists version and last-updated information for the Cisco trusted-root-certificate and
blacklist bundles on the appliance. These bundles are updated periodically.
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Step1  Click Update Now on the Certificate Management page to update all bundles for which updates
are available.

Viewing Blocked Certificates

To view a list of certificates which Cisco has determined to be invalid, and has blocked:

Step 1 Click View Blocked Certificates.

Uploading or Generating a Certificate and Key

Certain AsyncOS features require a certificate and key to establish, confirm or secure a connection; for
example, Identity Services Engine (ISE) and Identity Provider for SaaS. You can either upload an
existing certificate and key, or you can generate one when you configure the feature.

Uploading a Certificate and Key

A certificate you upload to the appliance must meet the following requirements:
e It must use the X.509 standard.

e It must include a matching private key in PEM format. DER format is not supported.

Step1  Select Use Uploaded Certificate and Key.
Step 2 In the Certificate field, click Browse; locate the file to upload.

Note  The Web Proxy uses the first certificate or key in the file. The certificate file must be in PEM format.
DER format is not supported.

Step 3 In the Key field, click Browse; locate the file to upload.

Note  The key length must be 512, 1024, or 2048 bits. The private key file must be in PEM format. DER format
is not supported.

Stepd  If the key is encrypted, select Key is Encrypted.
Step5  Click Upload Files.

Generating a Certificate and Key

Step1  Select Use Generated Certificate and Key.
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Step 2

Step 3
Step 4

Certificate Management

Click Generate New Certificate and Key.

a. In the Generate Certificate and Key dialog box, enter the necessary generation information.

N

Note  You can enter any ASCII character except the forward slash (/) in the Common Name field.

b. Click Generate in the Generate Certificate and Key dialog box.

When generation is complete, the certificate information is displayed in the Certificate section,
along with two links: Download Certificate and Download Certificate Signing Request. In
addition, there is a Signed Certificate option that is used to upload the signed certificate when you
receive it from the Certificate Authority (CA).

Click Download Certificate to download the new certificate for upload to the appliance.

Click Download Certificate Signing Request to download the new certificate file for transmission to a
Certificate Authority (CA) for signing. See Certificate Signing Requests, page 22-27 for more
information about this process.

a. When the CA returns the signed certificate, click Browse in the Signed Certificate portion of the
Certificate field to locate the signed-certificate file, and then click Upload File to upload it to
the appliance.

b. Ensure the CA’s root certificate is present in the appliance’s list of trusted root certificates. If it is
not, add it. See Managing Trusted Root Certificates, page 22-25 for more information.

Certificate Signing Requests

Note

The Web Security appliance cannot generate Certificate Signing Requests (CSR) for certificates
uploaded to the appliance. Therefore, to have a certificate created for the appliance, you must issue the
signing request from another system. Save the PEM-formatted key from this system because you will
need to install it on the appliance later.

You can use any UNIX machine with a recent version of OpenSSL installed. Be sure to put the appliance
hostname in the CSR. Use the guidelines at the following location for information on generating a CSR
using OpenSSL:

http://www.modssl.org/docs/2.8/ssl_fag.html#ToC28

Once the CSR has been generated, submit it to a certificate authority (CA). The CA will return the
certificate in PEM format.

If you are acquiring a certificate for the first time, search the Internet for “certificate authority services
SSL server certificates,” and choose the service that best meets the needs of your organization. Follow
the service’s instructions for obtaining an SSL certificate.

You can also generate and sign your own certificate. Tools for doing this are included with OpenSSL,
free software from http://www.openssl.org.

Intermediate Certificates

In addition to root certificate authority (CA) certificate verification, AsyncOS supports the use of
intermediate certificate verification. Intermediate certificates are certificates issued by a trusted root CA
which are then used to create additional certificates. This creates a chained line of trust. For example, a
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certificate may be issued by example.com who, in turn, is granted the rights to issue certificates by a
trusted root CA. The certificate issued by example.com must be validated against example.com’s private
key as well as the trusted root CA’s private key.

AsyncO0S for Web Upgrades and Updates

Cisco periodically releases upgrades (new software versions) and updates (changes to current software
versions) for AsyncOS for Web and its components.

Best Practices For Upgrading Async0OS for Web

e Before you start the upgrade, save the XML configuration file off the Web Security appliance from
the System Administration > Configuration File page or by using the saveconfig command.

e Save other files stored on the appliance, such as PAC files or customized end-user notification pages.

e  When upgrading, do not pause for long amounts of time at the various prompts. If the TCP session
times out during the download, the upgrade may fail.

e After the upgrade completes, save the configuration information to an XML file.

Related Topics
e Saving, Loading, and Resetting the Appliance Configuration, page 22-2.

Upgrading and Updating Async0S and Security Service Components

Upgrading AsyncOS for Web

Before You Begin

e Save the appliance configuration file (see Saving, Loading, and Resetting the Appliance
Configuration, page 22-2).

Step 1 Choose System Administration > System Upgrade.
Step2  Click Available Upgrades.

Step3  Select an upgrade from the list of available upgrades, and click Begin Upgrade to start the upgrade
process. Answer the questions as they appear.

Step4  When the upgrade is complete, click Reboot Now to reboot the Web Security appliance.

Related Topics
e Local And Remote Update Servers, page 22-30.
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Automatic and Manual Update and Upgrade Queries

AsyncOS periodically queries the update servers for new updates to all security service components, but
not for new AsyncOS upgrades. To upgrade AsyncOS, you must manually prompt AsyncOS to query for
available upgrades. You can also manually prompt AsyncOS to query for available security service
updates. For more information, see Reverting to a Previous Version of AsyncOS for Web, page 22-33.

When AsyncOS queries an update server for an update or upgrade, it performs the following steps:
1. Contacts the update server.
Cisco allows the following sources for update servers:

— Cisco update servers. For more information, see Updating and Upgrading from the Cisco
Update Servers, page 22-30.

— Local server. For more information, see Upgrading from a Local Server, page 22-30.

2. Receives an XML file that lists the available updates or AsyncOS upgrade versions. This XML file
is known as the “manifest.”

3. Downloads the update or upgrade image files.

Manually Updating Security Service Components

)

Note

Je

Tp.

A

Note

Step 1
Step 2
Step 3
Step 4

By default, each security service component periodically receives updates to its database tables from the
Cisco update servers. However, you can manually update the database tables.

Some updates are available on demand from the GUI pages related to the feature.

View a record of update activity in the updater log file. Subscribe to the updater log file on the System
Administration > Log Subscriptions page.

Updates that are in-progress cannot be interrupted. All in-progress updates must complete before new
changes can be applied.

Choose System Administration > Upgrade and Update Settings.
Click Edit Update Settings.
Specify the location of the update files.

Initiate the update using the Update Now function key on the component page located on the Security
Services tab. For example, Security Services > Web Reputation Filters page.
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Local And Remote Update Servers

By default, AsyncOS contacts the Cisco update servers for both update and upgrade images and the
manifest XML file. However, you can choose from where to download the upgrade and update images
and the manifest file. Using a local update server for the images or manifest file for any of the following
reasons:

¢ You have multiple appliances to upgrade simultaneously. You can download the upgrade image
to a web server inside your network and serve it to all appliances in your network.

¢ Your firewall settings require static IP addresses for the Cisco update servers. The Cisco update
servers use dynamic IP addresses. If you have strict firewall policies, you may need to configure a
static location for updates and AsyncOS upgrades. For more information, see Configuring a Static
Address for the Cisco Update Servers, page 22-30.

)
Note  Local update servers do not automatically receive security service updates, only AsyncOS upgrades.

After using a local update server for upgrading AsyncOS, change the update and upgrade settings back
to use the Cisco update servers so the security services update automatically again.

Updating and Upgrading from the Cisco Update Servers

A Web Security appliance can connect directly to Cisco update servers and download upgrade images
and security service updates. Each appliance downloads the updates and upgrade images separately.

Configuring a Static Address for the Cisco Update Servers

The Cisco update servers use dynamic IP addresses. If you have strict firewall policies, you may need to
configure a static location for updates and AsyncOS upgrades.

Step1  Contact Cisco Customer Support to obtain the static URL address.

Step2  Navigate to the System Administration > Upgrade and Update Settings page, and click Edit Update
Settings.

Step3  On the Edit Update Settings page, in the “Update Servers (images)” section, choose Local Update
Servers and enter the static URL address received in step 1.

Stepd  Verify that Cisco Update Servers is selected for the “Update Servers (list)” section.

Step5  Submit and commit your changes.

Upgrading from a Local Server

The Web Security appliance can download AsyncOS upgrades from a server within your network instead
of obtaining upgrades directly from the Cisco update servers. When you use this feature, you download
the upgrade image from Cisco once only, and then serve it to all Web Security appliances in your
network.

Figure 22-1 shows how Web Security appliances download upgrade images from local servers.
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Figure 22-1 Upgrading from a Local Server
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Hardware and Software Requirements for Local Upgrade Servers
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Note

For downloading AsyncOS upgrade files, you must have a system in your internal network that has a
web browser and Internet access to the Cisco update servers.

If you need to configure a firewall setting to allow HTTP access to this address, you must configure it
using the DNS name and not a specific IP address.

For hosting AsyncOS upgrade files, a server on the internal network must have a web server, such as
Microsoft IIS (Internet Information Services) or the Apache open source server, which has the following
features:

e Supports the display of directory or filenames in excess of 24 characters.
e Has directory browsing enabled.
¢ Is configured for anonymous (no authentication) or Basic (“simple”) authentication.

¢ Contains at least 350MB of free disk space for each AsyncOS upgrade image.

Configuring Upgrades from a Local Server

N

Note

Step 1
Step 2

Cisco recommends changing the update and upgrade settings to use the Cisco update servers (using
dynamic or static addresses) after the upgrade is complete to ensure the security service components
continue to update automatically.

Configure a local server to retrieve and serve the upgrade files.

Download the upgrade zip file.
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Using a browser on the local server, go to

http://updates.ironport.com/fetch manifest.html to download a zip file of an upgrade image. To
download the image, enter your serial number (for a physical appliance) or VLN (for a virtual appliance)
and the version number of the appliance. You will then be presented with a list of available upgrades.
Click on the upgrade version that you want to download.

Step3  Unzip the zip file in the root directory on the local server while keeping the directory structure intact.

Step4  Configure the appliance to use the local server using the System Administration > Upgrade and Update
Settings page or the updateconfig command.

Step5  On the System Administration > System Upgrade page, click Available Upgrades or run the
upgrade command.

Differences Between Local and Remote Upgrading Methods
The following differences apply when upgrading AsyncOS from a local server rather than from a Cisco
update server:
e The upgrading installs immediately while downloading.

e A banner displays for 10 seconds at the beginning of the upgrade process. While this banner is
displayed, you have the option to type Control+C to exit the upgrade process before downloading
starts.

Configuring Upgrade and Service Update Settings

You can configure how the Web Security appliance downloads security services updates and AsyncOS
for Web upgrades. For example, you can choose which network interface to use when downloading the
files, configure the update interval or disable automatic updates.

Step 1 Choose System Administration > Upgrade and Update Settings.
Step2  Click Edit Update Settings.

Step3  Configure the settings, referencing the following information:

Setting Description

Automatic Updates Choose whether or not to enable automatic updates of the security
components. If you choose automatic updates, enter the time interval. The
default is enabled and the update interval is 5 minutes.

Upgrade Notifications Choose whether to display a notification at the top of the Web Interface
when a new upgrade to AsyncOS is available. The appliance only displays
this notification for administrators.

For more information, see Upgrading AsyncOS for Web, page 22-28.
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Setting

Description

Update Servers (list)

Whether to download the list of available upgrades and updates (the
manifest XML file) from the Cisco update servers or a local web server.

When you choose a local update server, enter the full path to the manifest
XML file for the list including the file name and port number for the
server. If you leave the port field blank, AsyncOS uses port 80. If the
server requires authentication, you can also enter a valid user name and
passphrase.

e The URL for obtaining the manifest for hardware appliances is:
https://update-manifests.ironport.com
e The URL for obtaining the manifest for virtual appliances is:

https://update-manifests.sco.cisco.com

Update Servers (images)

Whether to download upgrade and update images from the Cisco update
servers or a local web server.

When you choose a local update server, enter the base URL and port
number for the server. If you leave the port field blank, AsyncOS uses port
80. If the server requires authentication, you can also enter a valid user
name and passphrase.

Routing Table

Choose which network interface’s routing table to use when contacting the
update servers.

Proxy Server (optional)

If an upstream proxy server exists and requires authentication, enter the
server information and user name and passphrase here.

Step4  Submit and commit your changes.

Related Topics

e Local And Remote Update Servers, page 22-30.

e Automatic and Manual Update and Upgrade Queries, page 22-29.

e Upgrading and Updating AsyncOS and Security Service Components, page 22-28.

Reverting to a Previous Version of AsyncOS for Web

AsyncOS for Web supports the ability to revert the AsyncOS for Web operating system to a previous
qualified build for emergency uses.

A

Note  You cannot revert to a version of AsyncOS for Web earlier than version 7.5.

Reverting AsyncOS on Virtual Appliances Impacts the License

If you revert to AsyncOS 8.0, there is no 180-day grace period during which the appliance processes web
transactions without security features. License expiration dates are unaffected.
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Configuration File Use in the Revert Process

Effective in version 7.5, when you upgrade to a later version, the upgrade process automatically saves
the current system configuration to a file on the Web Security appliance. (However, Cisco recommends
manually saving the configuration file to a local machine as a backup.) This allows AsyncOS for Web to
load the configuration file associated with the earlier release after reverting to the earlier version.
However, when it performs a reversion, it uses the current network settings for the management
interface.

Reverting AsyncOS for an Appliance Managed by the SMA

You can revert AsyncOS for Web from the Web Security appliance. However, if the Web Security
appliance is managed by a Security Management appliance, consider the following rules and guidelines:

e When Centralized Reporting is enabled on the Web Security appliance, AsyncOS for Web finishes
transferring the reporting data to the Security Management appliance before it starts the reversion.
If the files take longer than 40 seconds to transfer to the Security Management appliance, AsyncOS
for Web prompts you to continue waiting to transfer the files, or continue the reversion without
transferring all files.

¢ You must associate the Web Security appliance with the appropriate Configuration Master after
reverting. Otherwise, pushing a configuration from the Security Management appliance to the Web
Security appliance might fail.

Reverting AsyncOS for Web to a Previous Version

A

Caution

Note

Step 1

Reverting the operating system on a Web Security appliance is a very destructive action and destroys all
configuration logs and databases. Reversion also disrupts web traffic handling until the appliance is
reconfigured. Depending on the initial Web Security appliance configuration, this action may destroy
network configuration. If this happens, you will need physical local access to the appliance after
performing the reversion.

If updates to the set of URL categories are available, they will be applied after AsyncOS reversion.

Before You Begin

¢ Contact Cisco Quality Assurance to confirm that you can perform the intended reversion.
e Back up the following information from the Web Security appliance to a separate machine:
— System configuration file (with passphrases unmasked).
— Log files you want to preserve.
- Reports you want to preserve.
— Customized end-user notification pages stored on the appliance.

- PAC files stored on the appliance.

Log into the CLI of the appliance you want to revert.
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Note

Step 2
Step 3
Step 4

Monitoring System Health and Status Using SNMP [l

When you run the revert command in the next step, several warning prompts are issued. After these
warning prompts are accepted, the revert action takes place immediately. Therefore, do not begin the
reversion process until after you have completed the pre-reversion steps.

Enter the revert command.

Confirm twice that you want to continue with the reversion.
Choose one of the available versions to revert to.

The appliance reboots twice.

~

Note  The reversion process is time-consuming. It may take fifteen to twenty minutes before reversion
is complete and console access to the appliance is available again.

The appliance should now run using the selected AsyncOS for Web version. You can access the web
interface from a web browser.

Monitoring System Health and Status Using SNMP

The AsyncOS operating system supports system status monitoring via SNMP (Simple Network
Management Protocol). (For more information about SNMP, see RFCs 1065, 1066, and 1067.)

Please note:
e SNMP is off by default.
e SNMP SET operations (configuration) are not implemented.
¢ AsyncOS supports SNMPv1, v2, and v3. For more information on SNMPv3, see RFCs 2571-2575.

e Message authentication and encryption are mandatory when enabling SNMPv3. Passphrases for
authentication and encryption should be different. The encryption algorithm can be AES
(recommended) or DES. The authentication algorithm can be SHA-1 (recommended) or MDS5. The
snmpconfig command “remembers” your passphrases the next time you run the command.

e The SNMPv3 username is: v3get.

> snmpwalk -v 3 -1 AuthNoPriv -u v3get -a MD5 serv.example.com

e Ifyouuse only SNMPv1 or SNMPv2, you must set a community string. The community string does
not default to public.

e For SNMPv1 and SNMPv2, you must specify a network from which SNMP GET requests are accepted.

e To use traps, an SNMP manager (not included in AsyncOS) must be running and its IP address
entered as the trap target. (You can use a host name, but if you do, traps will only work if DNS
is working.)
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MIB Files

MIB files are available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/tsd-products-support-series-ho
me.html. Use the latest version of each MIB file.

There are multiple MIB files:

e asyncoswebsecurityappliance-mib.txt — an SNMPv2 compatible description of the Enterprise MIB
for Web Security appliances.

¢ ASYNCOS-MAIL-MIB.txt — an SNMPv2 compatible description of the Enterprise MIB for Email
Security appliances.

¢ JRONPORT-SMI.txt — This “Structure of Management Information” file defines the role of the
asyncoswebsecurityappliance-mib.

This release implements a read-only subset of MIB-II as defined in RFCs 1213 and 1907.

Enabling and Configuring SNMP Monitoring

To configure SNMP to gather system status information for the appliance, use the snmpconfig command
in the command-line interface (CLI). After you choose and configure values for an interface, the
appliance responds to SNMPv3 GET requests.

When you use SNMP monitoring, keep the following points in mind:
e These version 3 requests must include a matching passphrase.
e By default, version 1 and 2 requests are rejected.

e If enabled, version 1 and 2 requests must have a matching community string.

Hardware Objects

Hardware sensors conforming to the Intelligent Platform Management Interface Specification (IPMI)
report information such as temperature, fan speed, and power supply status.

To determine the hardware-related objects available for monitoring (for example, the number of fans or
the operating temperature range), see the hardware guide for your appliance model.

Related Topics

e Documentation Set, page C-2

SNMP Traps

SNMP provides the ability to send traps, or notifications, to advise an administration application when one
or more conditions have been met. Traps are network packets that contain data relating to a component of
the system sending the trap. Traps are generated when a condition has been met on the SNMP agent (in this
case, the Cisco Web Security Appliance appliance). After the condition has been met, the SNMP agent

then forms an SNMP packet and sends it to the host running the SNMP management console software.

You can configure SNMP traps (enable or disable specific traps) when you enable SNMP for an
interface.
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To specify multiple trap targets: when prompted for the trap target, you may enter up to 10 comma
separated IP addresses.

Related Topics
e About the connectivityFailure SNMP Trap, page 22-37

About the connectivityFailure SNMP Trap

)o

The connectivityFailure trap is intended to monitor your appliance’s connection to the internet. It does
this by attempting to connect and send an HTTP GET request to a single external server every 5 to 7
seconds. By default, the monitored URL is downloads.ironport.com on port 80.

To change the monitored URL or port, run the snmpconfig command and enable the connecivityFailure
trap, even if it is already enabled. You will see a prompt to change the URL.

To simulate connectivityFailure traps, you can use the dnsconfig CLI command to enter a non-working
DNS server. Lookups for downloads.ironport.com will fail, and traps will be sent every 5-7 seconds. Be
sure to change the DNS server back to a working server after completing your test.

CLI Example: snmpconfig

wsa.example.com> snmpconfig

Current SNMP settings:
SNMP Disabled.

Choose the operation you want to perform:
- SETUP - Configure SNMP.
[1> SETUP

Do you want to enable SNMP?
[Y]>

Please choose an IP interface for SNMP requests.
1. Management (198.51.100.1: wsa.example.com)

[11>

Which port shall the SNMP daemon listen on interface "Management"?
[161]1>

Please select SNMPv3 authentication type:

1. MD5
2. SHA
[1]1> 2

Please select SNMPv3 privacy protocol:

1. DES
2. AES
[1]1> 2

Enter the SNMPv3 authentication passphrase.

[1>

Please enter the SNMPv3 authentication passphrase again to confirm.
[1>

Enter the SNMPv3 privacy passphrase.

[1>
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Please enter the SNMPv3 privacy passphrase again to confirm.
[1>

Service SNMP V1/V2c requests?
[N]> Y

Enter the SNMP V1/V2c community string.
[ironport]> public

Shall SNMP V2c requests be serviced from IPv4 addresses?
[Y]>

From which IPv4 networks shall SNMP V1/V2c requests be allowed? Separate
multiple networks with commas.
[127.0.0.1/321>

Enter the Trap target as a host name, IP address or list of IP
addresses separated by commas (IP address preferred). Enter "None" to disable traps.

[127.0.0.1]> 203.0.113.1

Enter the Trap Community string.
[ironport]> tcomm

Enterprise Trap Status

1. CPUUtilizationExceeded Disabled
2. FIPSModeDisableFailure Enabled
3. FIPSModeEnableFailure Enabled
4. FailoverHealthy Enabled
5. FailoverUnhealthy Enabled
6. RAIDStatusChange Enabled
7. connectivityFailure Disabled
8. fanFailure Enabled
9. highTemperature Enabled
10. keyExpiration Enabled
11. linkUpDown Enabled
12. memoryUtilizationExceeded Disabled
13. powerSupplyStatusChange Enabled
14 . resourceConservationMode Enabled
15. updateFailure Enabled
Do you want to change any of these settings?
[N]> Y

Do you want to disable any of these traps?
[Y]I> n

Do you want to enable any of these traps?
[Y]> vy

Enter number or numbers of traps to enable. Separate multiple numbers with
commas .
[1> 1,7,12

What threshold would you like to set for CPU utilization?
[95]>

What URL would you like to check for connectivity failure?
[http://downloads.ironport.com]>

What threshold would you like to set for memory utilization?
[95]>

Enter the System Location string.
[Unknown: Not Yet Configured]> Network Operations Center - west; rack #30, position 3
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Enter the System Contact string.
[snmp@localhost]> wsa-admin@example.com

Current SNMP settings:

Listening on interface "Management" 198.51.100.1 port 161.

SNMP v3: Enabled.

SNMP v1/v2: Enabled, accepting requests from subnet 127.0.0.1/32
SNMP v1/v2 Community String: public

Trap target: 203.0.113.1

Location: Network Operations Center - west; rack #30, position 3
System Contact: wsa-admin@example.com

Choose the operation you want to perform:
- SETUP - Configure SNMP.
[1>

wsa.example.com> commit

Please enter some comments describing your changes:
[1> Enable and configure SNMP

Changes committed: Fri Nov 06 18:13:16 2015 GMT
wsa.example.com>
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Troubleshooting

e General Troubleshooting Best Practices
¢ Authentication Problems

e Blocked Object Problems

e Browser Problems

e DNS Problems

¢ Failover Problems

e Feature Keys Expired

e FTP Problems

e Hardware Issues

e HTTPS/Decryption/Certificate Problems
e Logging Problems

¢ Policy Problems

¢ Problems with File Reputation and File Analysis
e Reboot Issues

e Site Access Problems

e Upstream Proxy Problems

e Virtual Appliances

e WCCP Problems

e Packet Capture

e  Working With Support

General Troubleshooting Best Practices

Configure your Access Logs to include the following custom fields:
You, %g, %m, %k, %L (These values are case-sensitive.)
For descriptions of these fields, see Access Log Format Specifiers and W3C Log File Fields, page 21-29.

For configuration instructions, see Customizing Access Logs, page 21-26 and Adding and Editing Log
Subscriptions, page 21-7.
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Authentication Problems

e Troubleshooting Tools for Authentication Issues
e Failed Authentication Impacts Normal Operations
e LDAP Problems
e Basic Authentication Problems
¢ Single Sign-On Problems
e Also see:

— General Troubleshooting Best Practices

— HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication

— Cannot Access URLs that Do Not Support Authentication
— Client Requests Fail Upstream Proxy

Troubleshooting Tools for Authentication Issues

KerbTray or klist (both part of the Windows Server Resources Kit) for viewing and purging a Kerberos
ticket cache. Active Directory Explorer for viewing and editing an Active directory. Wireshark is a
packet analyzer you can use for network troubleshooting.

Failed Authentication Impacts Normal Operations

When certain user agents or applications fail to authenticate and are denied access, they repeatedly send
requests to the Web Security appliance, which in turn repeatedly sends requests to the Active Directory
servers with machine credentials, sometimes to the point of impacting normal operations.

For best results, bypass authentication with these user agents. See Bypassing Authentication with
Problematic User Agents, page 5-29.

LDAP Problems

e LDAP User Fails Authentication due to NTLMSSP
e LDAP Authentication Fails due to LDAP Referral

LDAP User Fails Authentication due to NTLMSSP

LDAP servers do not support NTLMSSP. Some client applications, such as Internet Explorer, always
choose NTLMSSP when given a choice between NTLMSSP and Basic. When all of the following
conditions are true, the user will fail authentication:

e The user only exists in the LDAP realm.
e The Identification Profile uses a sequence that contains both LDAP and NTLM realms.
e The Identification Profile uses the “Basic or NTLMSSP” authentication scheme.

e A user sends a request from an application that chooses NTLMSSP over Basic.
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Authentication Problems

Reconfigure the Identification Profile or the authentication realm or the application such that at least one
of the above conditions will be false.

LDAP Authentication Fails due to LDAP Referral

LDAP authentication fails when all of the following conditions are true:
e The LDAP authentication realm uses an Active Directory server.
e The Active Directory server uses an LDAP referral to another authentication server.
e The referred authentication server is unavailable to the Web Security appliance.
Workarounds:

¢ Specify the Global Catalog server (default port is 3268) in the Active Directory forest when you
configure the LDAP authentication realm in the appliance,

e Use the advancedproxyconfig > authentication CLI command to disable LDAP referrals. LDAP
referrals are disabled by default.

Basic Authentication Problems

e Basic Authentication Fails

Related Problems
e Upstream Proxy Does Not Receive Basic Credentials

Basic Authentication Fails

AsyncOS for Web only supports 7-bit ASCII characters for passphrases when using the Basic
authentication scheme. Basic authentication fails when the passphrase contains characters that are not
7-bit ASCII.

Single Sign-0n Problems

e Users Erroneously Prompted for Credentials

Users Erroneously Prompted for Credentials

NTLM authentication does not work in some cases when the Web Security appliance is connected to a
WCCP v2 capable device. When a user makes a request with a highly locked down version of Internet
Explorer that does not do transparent NTLM authentication correctly and the appliance is connected to
a WCCP v2 capable device, the browser defaults to Basic authentication. This results in users getting
prompted for their authentication credentials when they should not get prompted.

Workaround

In Internet Explorer, add the Web Security appliance redirect hostname to the list of trusted sites in the
Local Intranet zone (Tools > Internet Options > Security tab).
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Browser Problems

WPAD Not Working With Firefox

Firefox browsers may not support DHCP lookup with WPAD. For current information, see
https://bugzilla.mozilla.org/show_bug.cgi?id=356831

To use Firefox (or any other browser that does not support DHCP) with WPAD when the PAC file is
hosted on the Web Security appliance, configure the appliance to serve the PAC file through port 80.

Step 1 Choose Security Services > Web Proxy and delete port 80 from the HTTP Ports to Proxy field.
Step2  Use port 80 as the PAC Server Port when you upload the file to the appliance.

Step3  If any browsers are manually configured to point to the web proxy on port 80, reconfigure those browsers
to point to another port in the HTTP Ports to Proxy field.

Step4  Change any references to port 80 in PAC files.

DNS Problems

Alert: Failed to Bootstrap the DNS Cache

If an alert with the message “Failed to bootstrap the DNS cache” is generated when an appliance is
rebooted, it means that the system was unable to contact its primary DNS servers. This can happen at
boot time if the DNS subsystem comes online before network connectivity is established. If this message
appears at other times, it could indicate network issues or that the DNS configuration is not pointing to
a valid server.

Feature Keys Expired

If the feature key for the feature you are trying to access (via the web interface) has expired, please
contact your Cisco representative or support organization.

Failover Problems

Misconfiguration of failover groups might result in multiple master appliances or other failover
problems. Diagnose failover problems using the testfailovergroup subcommand of the CLI
failoverconfig command.

For example:

wsa.wga> failoverconfig
Currently configured failover profiles:
1. Failover Group ID: 61
Hostname: failoverV4Pl.wga, Virtual IP: 10.4.28.93/28
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Priority: 100, Interval: 3 seconds
Status: MASTER
Choose the operation you want to perform:
- NEW - Create new failover group.
- EDIT - Modify a failover group.
- DELETE - Remove a failover group.
- PREEMPTIVE - Configure whether failover is preemptive.
- TESTFAILOVERGROUP - Test configured failover profile(s)
[1> testfailovergroup
Failover group ID to test (-1 for all groups):
[1> 61

Failover Issues on Virtual Appliances

For deployments on virtual appliances, ensure that you have configured the interface/ virtual switch on
the hypervisor to use promiscuous mode.

FTP Problems

e URL Categories Do Not Block Some FTP Sites
e Large FTP Transfers Disconnect
e Zero Byte File Appears On FTP Servers After File Upload
e Chrome Browser Not Detected As User Agent in FTP-over-HTTP Requests, page A-6
e Also see:
— Unable to Route FTP Requests Via an Upstream Proxy

— HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication

URL Categories Do Not Block Some FTP Sites

When a native FTP request is transparently redirected to the FTP Proxy, it contains no hostname
information for the FTP server, only its IP address. Because of this, some predefined URL categories
and Web Reputation Filters that have only hostname information will not match native FTP requests,
even if the requests are destined for those servers. If you wish to block access to these sites, you must
create custom URL categories for them using their IP addresses.

Large FTP Transfers Disconnect

If the connection between the FTP Proxy and the FTP server is slow, uploading a large file may take a long
time, particularly when Cisco Data Security Filters are enabled. This can cause the FTP client to time out
before the FTP Proxy uploads the entire file and you may get a failed transaction notice. The transaction
does not fail, however, but continues in the background and will be completed by the FTP Proxy.

You can workaround this issue by increasing the appropriate idle timeout value on the FTP client.
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Zero Byte File Appears On FTP Servers After File Upload

FTP clients create a zero byte file on FTP servers when the FTP Proxy blocks an upload due to outbound
anti-malware scanning.

Chrome Browser Not Detected As User Agent in FTP-over-HTTP Requests

Chrome browsers do not include a user-agent string in FTP-over-HTTP requests; therefore, Chrome
cannot be detected as the user agent in those requests.

Hardware Issues

e Cycling Appliance Power, page A-6
e Appliance Health and Status Indicators, page A-6
e Alert: Battery Relearn Timed Out (RAID Event) on 380 or 680 Hardware, page A-6

Cycling Appliance Power

Important! If you need to cycle power to your x80 or x90 appliance, wait at least 20 minutes for the
appliance to come up again (all LEDs are green) before pushing the power button.

Appliance Health and Status Indicators

Lights on the front and/or rear panels of your hardware appliance indicate health and status of your
appliance. For descriptions of these indicators, see the hardware guides, such as the Cisco x90 Series
Content Security Appliances Installation and Maintenance Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-lis
t.html.

Specifications for your appliance, such as temperature ranges, are also available in these documents.

Alert: Battery Relearn Timed Out (RAID Event) on 380 or 680 Hardware

This alert may or may not indicate a problem. The battery relearn timeout, in itself, does not mean there
is any problem with the RAID controller. The controller can recover in the subsequent relearn. Please
monitor your email for any other RAID alerts for the next 48 hours, to ensure that this is not the
side-effect of any other problem. If you do not see any other RAID-type alerts from the system, then you
can safely ignore this alert.

HTTPS/Decryption/Certificate Problems

e Accessing HTTPS Sites Using Routing Policies with URL Category Criteria
e HTTPS Request Failures
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HTTPS/Decryption/Certificate Problems

e Bypassing Decryption for Particular Websites
e Alert: Problem with Security Certificate
e Also see:
— Logging HTTPS Transactions
— Access Policy not Configurable for HTTPS

— HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication

Accessing HTTPS Sites Using Routing Policies with URL Category Criteria

For transparently redirected HTTPS requests, the Web Proxy must contact the destination server to
determine the server name and therefore the URL category in which it belongs. Due to this, when the
Web Proxy evaluates Routing Policy Group membership, it cannot yet know the URL category of an
HTTPS request because it has not yet contacted the destination server. If the Web Proxy does not know
the URL category, it cannot match the transparent HTTPS request to a Routing Policy that uses a URL
category as membership criteria.

As a result, transparently redirected HTTPS transactions only match Routing Policies that do not
define Routing Policy Group membership criteria by URL category. If all user-defined Routing Policies
define their membership by URL category, transparent HTTPS transactions match the Default Routing
Policy Group.

HTTPS Request Failures

e HTTPS with IP-based Surrogates and Transparent Requests

HTTPS with IP-based Surrogates and Transparent Requests

If the HTTPS request comes from a client that does not have authentication information available from
an earlier HTTP request, AsyncOS either fails the HTTPS request or decrypts the HTTPS request in
order to authenticate the user, depending on how you configure the HTTPS Proxy. Use the HTTPS
Transparent Request setting on the Security Services > HTTPS Proxy page to define this behavior. Refer
to the Enabling HTTPS Proxy section in Decryption Policies chapter.

Bypassing Decryption for Particular Websites

Step 1

Some HTTPS servers do not work as expected when traffic to them is decrypted by a proxy server, such
as the Web Proxy. For example, some websites and their associated web applications and applets, such
as high security banking sites, maintain a hard-coded list of trusted certificates instead of relying on the
operating system certificate store.

You can bypass decryption for HTTPS traffic to these servers to ensure all users can access these types
of sites.

Create a custom URL category that contains the affected HTTPS servers by configuring the Advanced
properties.
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Step2  Create a Decryption Policy that uses the custom URL category created in Step 1 as part of its
membership, and set the action for the custom URL category to Pass Through.

Alert: Problem with Security Certificate

Typically, the root certificate information you generate or upload in the appliance is not listed as a trusted
root certificate authority in client applications. By default in most web browsers, when users send
HTTPS requests, they will see a warning message from the client application informing them that there
is a problem with the website’s security certificate. Usually, the error message says that the website’s
security certificate was not issued by a trusted certificate authority or the website was certified by an
unknown authority. Some other client applications do not show this warning message to users nor allow
users to accept the unrecognized certificate.

S,
Note  Mozilla Firefox browsers: The certificate you upload must contain

“basicConstraints=CA:TRUE” to work with Mozilla Firefox browsers. This constraint allows
Firefox to recognize the root certificate as a trusted root authority.

Logging Problems

e Custom URL Categories Not Appearing in Access Log Entries

e Logging HTTPS Transactions

e Alert: Unable to Maintain the Rate of Data Being Generated

e Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs

Custom URL Categories Not Appearing in Access Log Entries

When a web access policy group has a custom URL category set to Monitor and some other component,
such as the Web Reputation Filters or the DVS engine, makes the final decision to allow or block a
request for a URL in the custom URL category, then the access log entry for the request shows the
predefined URL category instead of the custom URL category.

Logging HTTPS Transactions

HTTPS transactions in the access logs appear similar to HTTP transactions, but with slightly different
characteristics. What gets logged depends on whether the transaction was explicitly sent or transparently
redirected to the HTTPS Proxy:

e TUNNEL. This gets written to the access log when the HTTPS request was transparently redirected
to the HTTPS Proxy.

e CONNECT. This gets written to the access log when the HTTPS request was explicitly sent to the
HTTPS Proxy.

When HTTPS traffic is decrypted, the access logs contain two entries for a transaction:

e TUNNEL or CONNECT depending on the type of request processed.
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e The HTTP Method and the decrypted URL. For example, “GET https://ftp.example.com”.
The full URL is only visible when the HTTPS Proxy decrypts the traffic.

Alert: Unable to Maintain the Rate of Data Being Generated

AsyncOS for Web sends a critical email message to the configured alert recipients when the internal
logging process drops web transaction events due to a full buffer.

By default, when the Web Proxy experiences a very high load, the internal logging process buffers events
to record them later when the Web Proxy load decreases. When the logging buffer fills completely, the
Web Proxy continues to process traffic, but the logging process does not record some events in the access
logs or in the Web Tracking report. This might occur during a spike in web traffic.

However, a full logging buffer might also occur when the appliance is over capacity for a sustained
period of time. AsyncOS for Web continues to send the critical email messages every few minutes until
the logging process is no longer dropping data.

The critical message contains the following text:

Reporting Client: The reporting system is unable to maintain the rate of data being
generated. Any new data generated will be lost.

If AsyncOS for Web sends this critical message continuously or frequently, the appliance might be over
capacity. Contact Cisco Customer Support to verify whether or not you need additional Web Security
appliance capacity.

Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs

If you want to use a third party log analyzer tool to read and parse the W3C access logs, you might need
to include the “timestamp” field. The timestamp W3C field displays time since the UNIX epoch, and
most log analyzers only understand time in this format.

Policy Problems

e Access Policy not Configurable for HTTPS

e Blocked Object Problems

e Identification Profile Disappeared from Policy

e Policy Match Failures

e Policy Troubleshooting Tool: Policy Trace

e Also see: Accessing HTTPS Sites Using Routing Policies with URL Category Criteria

Access Policy not Configurable for HTTPS

With the HTTPS Proxy is enabled, Decryption Policies handle all HTTPS policy decisions. You can no
longer define Access and Routing Policy group membership by HTTPS, nor can you configure Access
Policies to block HTTPS transactions.
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If some Access and Routing Policy group memberships are defined by HTTPS and if some Access
Policies block HTTPS, then when you enable the HTTPS Proxy, those Access and Routing Policy groups
become disabled. You can choose to enable the policies at any time, but all HTTPS related configurations
are removed.

Blocked Object Problems

e Some Microsoft Office Files Not Blocked
e Blocking DOS Executable Object Types Blocks Updates for Windows OneCare

Some Microsoft Office Files Not Blocked
When you block Microsoft Office files in the Block Object Type section, it is possible that some
Microsoft Office files will not be blocked.

If you need to block all Microsoft Office files, add application/x-ole in the Block Custom MIME
Types field. However, blocking this custom MIME type also blocks all Microsoft Compound Object
format types, such as Visio files and some third-party applications.

Blocking DOS Executable Object Types Blocks Updates for Windows OneCare

When you configure the Web Security appliance to block DOS executable object types, the appliance
also blocks updates for Windows OneCare.

Identification Profile Disappeared from Policy

Disabling an Identification Profile removes it from associated policies. Verify that the Identification
Profile is enabled and then add it to the policy again.

Policy Match Failures

e Policy is Never Applied

e HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication

e User Matches Global Policy for HTTPS and FTP over HTTP Requests

e User Assigned Incorrect Access Policy

Policy is Never Applied

If multiple Identification Profiles have identical criteria, AsyncOS assigns the transactions to the first
Identification Profile that matches. Therefore, transactions never match the additional, identical
Identification Profiles, and any policies that apply to those subsequent, identical Identification Profiles
are never matched or applied.
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HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require Authentication

Configure the appliance to use IP addresses as the surrogate when credential encryption is enabled.

When credential encryption is enabled and configured to use cookies as the surrogate type,
authentication does not work with HTTPS or FTP over HTTP requests. This is because the Web Proxy
redirects clients to the Web Proxy itself for authentication using an HTTPS connection if credential
encryption is enabled. After successful authentication, the Web Proxy redirects clients back to the
original website. In order to continue to identify the user, the Web Proxy must use a surrogate (either the
IP address or a cookie). However, using a cookie to track users results in the following behavior if
requests use HTTPS or FTP over HTTP:

e HTTPS. The Web Proxy must resolve the user identity before assigning a Decryption Policy (and
therefore, decrypt the transaction), but it cannot obtain the cookie to identify the user unless it
decrypts the transaction.

e FTP over HTTP. The dilemma with accessing FTP servers using FTP over HTTP is similar to
accessing HTTPS sites. The Web Proxy must resolve the user identity before assigning an Access
Policy, but it cannot set the cookie from the FTP transaction.

Therefore, HTTPS and FTP over HTTP requests will match only Access Policies that do not require
authentication. Typically, they match the global Access Policy because it never requires authentication.

User Matches Global Policy for HTTPS and FTP over HTTP Requests

When the appliance uses cookie-based authentication, the Web Proxy does not get cookie information
from clients for HTTPS and FTP over HTTP requests. Therefore, it cannot get the user name from the
cookie.

HTTPS and FTP over HTTP requests still match the Identification Profile according to the other
membership criteria, but the Web Proxy does not prompt clients for authentication even if the
Identification Profile requires authentication. Instead, the Web Proxy sets the user name to NULL and
considers the user as unauthenticated.

Then, when the unauthenticated request is evaluated against a policy, it matches only a policy that
specifies “All Identities” and apply to “All Users.” Typically, this is the global policy, such as the global
Access Policy.

User Assigned Incorrect Access Policy

Step 1
Step 2

¢ Clients on your network use Network Connectivity Status Indicator (NCSI)
e Web Security appliance uses NTLMSSP authentication.
e Identification Profile uses IP based surrogates

A user might be identified using the machine credentials instead of the user’s own credentials, and as a
result, might be assigned to an incorrect Access Policy.

Workaround:

e Reduce the surrogate timeout value for machine credentials.

Use the advancedproxyconfig > authentication CLI command.

Enter the surrogate timeout for machine credentials.
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S

Note

You can use the CLI command maxhttpheadersize to change the maximum HTTP header size for proxy
requests. Increasing this value can alleviate Policy Trace failures that can occur when the specified user
belongs to a large number of authentication groups, or when the response header is larger than the current
maximum header size. See Web Security Appliance CLI Commands, page B-6 for more information
about this command.

Problems with File Reputation and File Analysis

See Troubleshooting File Reputation and Analysis, page 17-14.

Reboot Issues

Virtual Appliance Running on KVM Hangs on Reboot

N

Note

Step 1

Step 2

This is a KVM issue and may change at any time.

For more information, see https://www.mail-archive.com/kvm@vger.kernel.org/msg103854.html and
https://bugs.launchpad.net/qemu/+bug/1329956.

Check the following:

cat /sys/module/kvm_intel/parameters/enable_apicv

If the above value is set to Y:

a. Stop your virtual appliances and reinstall the KVM kernel module:

rmmod kvm_intel

modprobe kvm_intel enable_apicv=N

b. Restart your virtual appliance.

Hardware Appliances: Remotely Resetting Appliance Power

If a hardware appliance requires a hard reset, you can reboot the appliance chassis remotely using a
third-party Intelligent Platform Management Interface (IPMI) tool.

Restrictions

e Remote power management is available only on certain hardware. For specifics, see Enabling
Remote Power Management, page 21-4.

e If you want be able to use this feature, you must enable it in advance, before you need to use it. For
details, see Enabling Remote Power Management, page 21-4.
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e Only the following IPMI commands are supported: status, on, off, cycle, reset, diag, soft. Issuing
unsupported commands will produce an “insufficient privileges” error.

Before You Begin

e Obtain and set up a utility that can manage devices using IPMI version 2.0.

e Understand how to use the supported IPMI commands. See the documentation for your IPMI tool.

Step 1 Use IPMI to issue a supported power-cycling command to the IP address assigned to the Remote Power
Control port, which you configured earlier, along with the required credentials.

For example, from a UNIX-type machine with IPMI support, you might issue the command:

ipmitool -I lan -H 192.0.2.1 -U remoteresetuser -P passphrase chassis power reset
where 192.0.2.1 is the IP address assigned to the Remote Power Control port and remoteresetuser
and passphrase are the credentials that you entered while enabling this feature.

Step2  Wait at least 11 minutes for the appliance to reboot.

Site Access Problems

e Cannot Access URLs that Do Not Support Authentication
e Cannot Access Sites With POST Requests

e Also see: Bypassing Decryption for Particular Websites

Cannot Access URLs that Do Not Support Authentication

This is a partial list of applications cannot be used when the Web Security appliance is deployed in
transparent mode because they do not support authentication.

* Mozilla Thunderbird

e Adobe Acrobat Updates

e HttpBridge

e Subversion, by CollabNet

e Microsoft Windows Update
e Microsoft Visual Studio

Workaround: Create a class of user for the URL that does not require authentication.

Related Topics
e Bypassing Authentication, page 5-31

Cannot Access Sites With POST Requests

When the user’s first client request is a POST request and the user still needs to authenticate, the POST
body content is lost. This might be a problem when the POST request is for a application with the Access
Control single sign-on feature in use.
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Workarounds:

e Have users first authenticate with the Web Proxy by requesting a different URL through the browser
before connecting to a URL that uses POST as a first request.

e Bypass authentication for URLs that use POST as a first request.

~

Note  When working with Access Control, you can bypass authentication for the Assertion Consumer
Service (ACS) URL configured in the Application Authentication Policy.

Related Topics
e Bypassing Authentication, page 5-31.

Upstream Proxy Problems

e Upstream Proxy Does Not Receive Basic Credentials

¢ Client Requests Fail Upstream Proxy

Upstream Proxy Does Not Receive Basic Credentials

If both the appliance and the upstream proxy use authentication with NTLMSSP, depending on the
configurations, the appliance and upstream proxy might engage in an infinite loop of requesting
authentication credentials. For example, if the upstream proxy requires Basic authentication, but the
appliance requires NTLMSSP authentication, then the appliance can never successfully pass Basic
credentials to the upstream proxy. This is due to limitations in authentication protocols.

Client Requests Fail Upstream Proxy

Configuration:
¢ Web Security appliance and upstream proxy server use Basic authentication.
e Credential Encryption is enabled on the downstream Web Security appliance.

Client requests fail on the upstream proxy because the Web Proxy receives an “Authorization” HTTP
header from clients, but the upstream proxy server requires a “Proxy-Authorization” HTTP header.

Unable to Route FTP Requests Via an Upstream Proxy

If your network contains an upstream proxy that does not support FTP connections, then you must create
a Routing Policy that applies to all Identities and to just FTP requests. Configure that Routing Policy to
directly connect to FTP servers or to connect to a proxy group whose proxies all support FTP
connections.
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Virtual Appliances

Do Not Use Force Reset, Power Off, or Reset Options During Async0S Startup

The following actions on your virtual host are the equivalent of pulling the plug on a hardware appliance
and are not supported, especially during AsyncOS startup:

¢ In KVM, the Force Reset option.

e In VMWare, the Power Off and Reset options. (These options are safe to use after the appliance has
come up completely.)

Network Connectivity on KVM Deployments Works Initially, Then Fails

Problem Network connectivity is lost after previously working.

Solution This is a KVM issue. See the section on "KVM: Network connectivity works initially, then
fails" in the OpenStack documentation at
http://docs.openstack.org/admin-guide-cloud/content/section_network-troubleshoot.html.

Slow Performance, Watchdog Issues, and High CPU Usage on KVM
Deployments

Problem Appliance performance is slow, watchdog issues occur, and the appliance shows unusually high
CPU usage when running on an Ubuntu virtual machine.

Solution Install the latest Host OS updates from Ubuntu.

General Troubleshooting for Virtual Appliances Running on Linux Hosts

Problem Issues with virtual appliances running on KVM deployments may be related to host OS
configuration issues.

Solution See the troubleshooting section and other information in the Virtualization Deployment and
Administration Guide, available from
https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/7/pdf/Virtualization_Depl
oyment_and_Administration_Guide/Red_Hat_Enterprise_Linux-7-Virtualization_Deployment_and_A
dministration_Guide-en-US.pdf.

WCCP Problems

Maximum Port Entries

In deployments using WCCP, the maximum number of port entries is 30 for HTTP, HTTPS , and FTP
ports combined.
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Packet Capture

The appliance provides the ability to capture and display TCP/IP and other packets being transmitted or
received over the network to which the appliance is attached.

S

Note  The packet capture feature is similar to the Unix tcpdump command.

Starting a Packet Capture

Step1  Choose Support and Help > Packet Capture.
Step2  (Optional) Click Edit Settings to change the packet capture settings.

Option Description

Capture File Size Limit |Specifies the maximum size that the capture file can reach. One the limit is
reached, the data will be discarded and a new file started, unless the Capture
Duration setting is 'Run Capture Until File Size Limit Reached.’

Capture Duration Options for if and when the capture automatically stops. Choose from:

¢ Run Capture Until File Size Limit Reached. The capture runs until the
file limit set above is reached.

¢ Run Capture Until Time Elapsed Reaches. The capture runs for a
specified duration. If you enter the amount of time without specifying
the units, AsyncOS uses seconds by default.

¢ Run Capture Indefinitely. The packet capture runs until you manually
stop it.

Note The capture can be ended manually at any time.

Interfaces The interfaces from which traffic will be captured.

Filters The filtering options to apply when capturing packets. Filtering allows you
to capture required packets only. Choose from:

¢ No Filters. All packets will be captured.

e Predefined Filters. The predefined filters provide filtering by port
and/or IP addresses. If left blank, all traffic will be captured.

¢ Custom Filter. Use this option if you already know the exact syntax of
the packet capture options that you need. Use standard tcpdump syntax.

(Optional) Submit and commit your packet capture changes.

N

Note  When you change the packet capture settings without committing the changes and then start a
packet capture, AsyncOS uses the new settings. This allows you to use the new settings in the
current session without enforcing the settings for future packet capture runs. The settings remain
in effect until you clear them.

Step3  Click Start Capture. To manually stop a running capture, click Stop Capture.
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Managing Packet Capture Files

The appliance saves the captured packet activity to a file and stores the file locally. You can send packet
capture files using FTP to Cisco Customer Support for debugging and troubleshooting purposes.

Downloading or Deleting Packet Capture Files

~

Note  You can also connect to the appliance using FTP and retrieving packet capture files from the captures
directory.

Step 1 Choose Support and Help > Packet Capture.

Step2  Select the packet capture file you wish to use from the Manage Packet Capture Files pane. If this pane
is not visible then no packet capture files have been stored on the appliance.

Step3  Click Download File or Delete Selected Files as required.

Working With Support

e Gathering Information for Efficient Service, page A-17
e Opening a Technical Support Request, page A-17

e Getting Support for Virtual Appliances, page A-18

e Enabling Remote Access to the Appliance, page A-18

Gathering Information for Efficient Service

Before contacting Support:
¢ Enable custom logging fields as described in General Troubleshooting Best Practices, page A-1.

¢ Consider doing a packet capture. See Packet Capture, page A-16.

Opening a Technical Support Request

You can use the appliance to send a non-urgent request for assistance to Cisco Customer Support. When
the appliance sends the request, it also sends the configuration of the appliance. The appliance must be
able to send mail to the Internet to send a support request.

A

Note If you have an urgent issue, please call a Cisco Worldwide Support Center.
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Step 1
Step 2

Step 3
Step 4

Step 5

Before You Begin

e Verify that your Cisco.com user ID is associated with your service agreement contract for this
appliance. To view a list of service contracts that are currently associated with your Cisco.com
profile, visit the Cisco.com Profile Manager at https://sso.cisco.com/autho/forms/CDClogin.html. If
you do not have a Cisco.com user ID, register to get one.

Choose Support And Help > Contact Technical Support.

(Optional) Choose additional recipients for the request. By default, the support request and configuration
file is sent to Cisco Customer Support.

Enter your contact information.
Enter the issue details.
e If you have a customer support ticket already for this issue, enter it.

Click Send. A trouble ticket is created with Cisco.

Getting Support for Virtual Appliances

If you file a support case for a Cisco content security virtual appliance, you must provide your Virtual
License Number (VLN), your contract number, and your Product Identifier code (PID).

You can identify your PID based on the software licenses running on your virtual appliance, by
referencing your purchase order, or from the following table:

Functionality PID Description
Web Security Essentials WSA-WSE-LIC= Includes:

e Web Usage Controls
e Web Reputation
Web Security Premium WSA-WSP-LIC= Includes:

e Web Usage Controls
e Web Reputation

e Sophos and Webroot
Anti-Malware signatures

Web Security Anti-Malware WSA-WSM-LIC= Includes Sophos and Webroot
Anti-Malware signatures

McAfee Anti-Malware WSA-AMM-LIC= —
Advanced Malware Protection WSA-AMP-LIC= —

Enabling Remote Access to the Appliance

The Remote Access option allows Cisco Customer Support to remotely access your appliance for
support purposes.
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Step 1 Choose Support And Help > Remote Access.
Step2  Click Enable.

Step3  Complete the Customer Support Remote Access options:

Option Description

Seed String If you enter a string, the string should not match any existing or future
pass phrase.

The string will appear near the top of the page after you click Submit.

You will give this string to your support representative.

Secure Tunnel Specifies whether or not to use a secure tunnel for remote access
(recommended) connections.

When enabled, the appliance creates an SSH tunnel over the specified port
to the server upgrades.ironport.com, over port 443 (by default). Once a
connection is made, Cisco Customer Support is able to use the SSH tunnel
to obtain access to the appliance.

Once the techsupport tunnel is enabled, it will remain connected to
upgrades.ironport.com for 7 days. After 7 days, no new connections can
be made using the techsupport tunnel, though any existing connections will
continue to exist and work.

The Remote Access account will remain active until specifically deactivated.

Step4  Submit and commit your changes.
Step5  Look for the seed string in the Success message near the top of the page and make a note of it.

For security reasons, this string is not stored on the appliance and there is no way to locate this string
later.

Keep this seed string in a safe place.

Step6  Give the seed string to your Support representative.
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APPENDIX B

Command Line Interface

e Overview of the Command Line Interface, page 27-1
e Accessing the Command Line Interface, page 27-1

e General Purpose CLI Commands, page 27-4

e Web Security Appliance CLI Commands, page 27-6

Overview of the Command Line Interface

The AsyncOS Command Line Interface (CLI) allows you to configure and monitor the Web Security
appliance. The Command Line Interface is accessible using SSH on IP interfaces that have been
configured with these services enabled, or using terminal emulation software on the serial port. By
default, SSH is configured on the Management port.

The commands are invoked by entering the command name with or without any arguments. If you enter
a command without arguments, the command prompts you for the required information.

Accessing the Command Line Interface

First Access

You can connect using one of the following methods:

e Ethernet. Start an SSH session with the IP address of the Web Security appliance. The factory
default IP address is 192.168.42.42. SSH is configured to use port 22.

¢ Serial connection. Start a terminal session with the communication port on your personal computer
that the serial cable is connected to.

You can add other users with differing levels of permissions after you have accessed the CLI the first time
using the aamin account—Iog in to the appliance by entering the default aamin user name and passphrase:

e User name: admin
e Passphrase: ironport

The System Setup Wizard prompts you to change the passphrase for the admin account the first time you
log in with the default passphrase.

You can also reset the aamin account passphrase at any time using the passwd command.
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Subsequent Access

You can connect and log into the appliance at any time, using a valid user name and passphrase. Note
that a listing of recent appliance access attempts, both successes and failures, for the current user name
is displayed automatically upon log-in.

See the following userconfig command description, or Administering User Accounts, page 22-6 for
information about configuring additional users.

Working with the Command Prompt

The top-level command prompt consists of the fully qualified hostname, followed by the greater than (>)
symbol, followed by a space. For example:

example.com>

When running commands, the CLI requires input from you. When the CLI is expecting input, the prompt
displays the default values enclosed in square brackets (1) followed by the greater than (>) symbol.
When there is no default value, the brackets are empty.

For example:

example.com> routeconfig

Choose a routing table:

- MANAGEMENT - Routes for Management Traffic

- DATA - Routes for Data Traffic
[1>

When there is a default setting, the setting is displayed within the command-prompt brackets. For
example:

example.com> setgateway

Warning: setting an incorrect default gateway may cause the current connection
to be interrupted when the changes are committed.

Enter new default gateway:

[172 . xx.xxX.xXxX]>

When a default setting is shown, typing Return is equivalent to accepting the default:

Command Syntax

When operating in the interactive mode, the CLI command syntax consists of single commands with no
white space and no arguments or parameters. For example:

example.com> logconfig
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Select Lists

Accessing the Command Line Interface

When you are presented with multiple choices for input, some commands use numbered lists. Enter the
number of the selection at the prompt.

For example:

Log level:
1. Critical

2. Warning

3. Information
4. Debug

5. Trace

[31> 3

Yes/No Queries

When given a yes or no option, the question is posed with a default in brackets. You may answer ¥, N,
Yes, or No. Case is not significant.

For example:

Do you want to enable the proxy? [Y]> Y

Subcommands

Some commands give you the opportunity to use subcommand directives such as NEw, EDIT, and DELETE.
The ep1T and pELETE functions provide a list of previously configured values.

For example:

example.com> interfaceconfig

Currently configured interfaces:

1. Management (172.xXXX.XX.XX/xx: example.com)
Choose the operation you want to perform:

- NEW - Create a new interface.

- EDIT - Modify an interface.

- DELETE - Remove an interface.

[1>

Within subcommands, typing Enter or Return at an empty prompt returns you to the main command.
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Escaping Subcommands

You can use the Ctrl+C keyboard shortcut at any time within a subcommand to immediately exit return
to the top level of the CLI.

Command History

The CLI keeps a history of all commands entered during a session. Use the Up and Down arrow keys on
your keyboard, or the Ctrl+P and Ctrl+N key combinations to scroll through a running list of the
recently-used commands.

Completing Commands

The AsyncOS CLI supports command completion. You can enter the first few letters of some commands
followed by the Tab key and the CLI completes the string. If the letters you entered are not unique among
commands, the CLI “narrows” the set. For example:

example.com> set (press the Tab key)
setgateway, setgoodtable, sethostname, settime, settz
example.com> seth (pressing the Tab again completes the entry with sethostname)

Committing Configuration Changes Using the CLI

e Many configuration changes do not take effect until you commit them.

¢ The commit command allows you to change configuration settings while other operations proceed
normally.

e To successfully commit changes, you must be at the top-level command prompt. Type Return at an
empty prompt to move up one level in the command line hierarchy.

e Changes to configuration that have not been committed are recorded, but do not go into effect until
you run the commit command. However, not all commands require the commit command to be run.
Exiting the CLI session, system shutdown, reboot, failure, or issuing the clear command clears
changes that have not yet been committed.

e Changes are not actually committed until you receive confirmation and a timestamp.

General Purpose CLI Commands

This section describes some basic commands you might use in a typical CLI session, such as committing
and clearing changes.
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CLI Example: Committing Configuration Changes

Entering comments after the commit command is optional.

example.com> commit

Please enter some comments describing your changes:
[]> Changed “psinet” IP Interface to a different IP address

Changes committed: Wed Jan 01 12:00:01 2007

CLI Example: Clearing Configuration Changes

The clear command clears any changes made to the appliance configuration since the last commit or
clear command was issued.

example.com> clear
Are you sure you want to clear all changes since the last commit? [Y]> ¥y
Changes cleared: Wed Jan 01 12:00:01 2007

example.com>

CLI Example: Exiting the Command Line Interface Session

The exit command logs you out of the CLI application. Configuration changes that have not been
committed are cleared.

example.com> exit
Configuration changes entered but not committed. Exiting will lose changes.
Type 'commit' at the command prompt to commit changes.

Are you sure you wish to exit? [N]> v

CLI Example: Seeking Help on the Command Line Interface

The help command lists all available CLI commands and gives a brief description of each command.
The help command can be invoked by typing either help or a single question mark (?) at the
command prompt.

example.com> help

Further, you can access help for a specific command by entering help commandname.
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Related Topics

e Web Security Appliance CLI Commands, page 27-6.

Web Security Appliance CLI Commands

The Web Security Appliance CLI supports a set of proxy and UNIX commands to access, upgrade, and

administer the system.

A

Note  Not all CLI commands are applicable/available in all operating modes (Standard Cloud Web Security

Connector).

Command

Description

advancedproxyconfig

Configure advanced Web Proxy configurations; subcommands are:

AUTHENTICATION — Authentication configuration options:

When would you like to forward authorization request headers
to a parent proxy

Enter the Proxy Authorization Realm to be displayed in the end
user authentication dialog

Would you like to log the username that appears in the request
URI

Should the Group Membership attribute be used for directory
lookups in the Web UI (when it is not used, empty groups and
groups with different membership attributes will be displayed)

Would you like to use advanced Active Directory connectivity
checks

Would you like to allow case insensitive username matching in
policies

Would you like to allow wild card matching with the character
* for LDAP group names

Enter the charset used by the clients for basic authentication
[ISO-8859-1/UTF-8]

Would you like to enable referrals for LDAP

Would you like to enable secure authentication

Enter the hostname to redirect clients for authentication
Enter the surrogate timeout for user credentials

Enter the surrogate timeout for machine credentials

Enter the surrogate timeout in the case traffic permitted due
to authentication service unavailability

Enter re-auth on request denied option [disabled /
embedlinkinblockpage]

Would you like to send Negotiate header along with NTLM header
for NTLMSSP authentication

Configure username and IP address masking in logs and reports

AsyncO0S 9.1 for Cisco Web Security Appliances User Guide
| B-6 | I



| Appendix B Command Line Interface

Web Security Appliance CLI Commands Il

advancedproxyconfig
(continued)

cacHING — Proxy Caching mode; choose one:
® sSafe Mode

® Optimized Mode

® Aggressive Mode

® Customized Mode
See also Choosing The Web Proxy Cache Mode, page 4-7.
pNs — DNS configuration options:
® Enter the URL format for the HTTP 307 redirection on DNS lookup
failure

® Would you like the proxy to issue a HTTP 307 redirection on DNS
lookup failure

® Would you like proxy not to automatically failover to DNS
results when upstream proxy (peer) is unresponsive

® Find web server by:
0 = Always use DNS answers in order
1 = Use client-supplied address then DNS
2 = Limited DNS usage
3 = Very limited DNS usage
For options 1 and 2, DNS will be used if Web Reputation is enabled. For
options 2 and 3, DNS will be used for explicit proxy requests, if there is
no upstream proxy or in the event the configured upstream proxy fails.
For all options, DNS will be used when Destination IP Addresses are
used in policy membership.

EUN — End-user notification parameters:

® Choose:
1. Refresh EUN pages
2. Use Custom EUN pages
3. Use Standard EUN pages
® Would you like to turn on presentation of the User
Acknowledgement page?
See also Web Proxy Usage Agreement, page 4-10 and End-User Notifications
Overview, page 17-1.

NaTIvEFTP — Native FTP configuration:

® Would you like to enable FTP proxy
® Enter the ports that FTP proxy listens on

® Enter the range of port numbers for the proxy to listen on for
passive FTP connections

® Enter the range of port numbers for the proxy to listen on for
active FTP connections

® Enter the authentication format:
1. Check Point
2. No Proxy Authentication
3. Raptor
® Would you like to enable caching
® Would you like to enable server IP spoofing
® Would you like to pass FTP server welcome message to the clients

® Enter the max path size for the ftp server directory

See also Overview of FTP Proxy Services, page 4-14.

Async0S 9.1 for Cisco Web Security Appliances User Guide g



Appendix B Command Line Interface |

M Web Security Appliance CLI Commands

advancedproxyconfig |rrpovERHTTP — FTP Over HTTP options:

continued
( ) ® Enter the login name to be used for anonymous FTP access

® Enter the password to be used for anonymous FTP access

See also Overview of FTP Proxy Services, page 4-14.

mrTPS — HTTPS-related options:

® HTTPS URI Logging Style

® Would you like to decrypt unauthenticated transparent HTTPS
requests for authentication purpose

® Would you like to decrypt HTTPS requests for End User
Notification purpose

® Action to be taken when HTTPS servers ask for client
certificate during handshake:

1. Pass through the transaction

2. Reply with certificate unavailable
® Do you want to enable server name indication (SNI) extension
® Do you want to enable session resumption

See also Overview of Create Decryption Policies to Control HTTPS Traffic,
page 11-1.

SCANNING — Scanning options:

® JWould you like the proxy to do malware scanning all content
regardless of content type

® Enter the time to wait for a response from an anti-malware
scanning engine (Sophos, McAfee, or Webroot), in seconds

® Do you want to disable Webroot body scanning

See also Overview of Anti-Malware Scanning, page 13-4 and Overview of
Scanning Outbound Traffic, page 12-1.

PROXYCONN — Manage the list of user agents that cannot accept the proxy
connection header. The list entries are interpreted as regular expressions in
Flex (Fast Lexical Analyzer) dialect. A user agent will be matched if any
substring of it matches any regular expression in the list.

¢ Choose the operation you want to perform:
NEW - Add an entry to the list of user agents
DELETE - Remove an entry from the list

CUSTOMHEADERS — Manage custom request headers for specific domains.

¢ Choose the operation you want to perform:
DELETE - Delete entries
NEW - Add new entries

EDIT - Edit entries

See also Adding Custom Headers To Web Requests, page 4-8.
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advancedproxyconfig
(continued)

MISCELLANEOUS — Miscellaneous proxy-related parameters:

® Would you like proxy to respond to health checks from L4
switches (always enabled if WSA is in L4 transparent mode)

® Would you like proxy to perform dynamic adjustment of TCP
receive window size

® Would you like proxy to perform dynamic adjustment of TCP send
window size

® Enable caching of HTTPS responses

® Enter minimum idle timeout for checking unresponsive upstream
proxy (in seconds)

® Enter maximum idle timeout for checking unresponsive upstream
proxy (in seconds)

® Mode of the proxy:
1. Explicit forward mode only
2. Transparent mode with L4 Switch or no device for redirection
3. Transparent mode with WCCP v2 Router for redirection
® gSpoofing of the client IP by the proxy:
1. Disable
2. Enable for all requests
3. Enable for transparent requests only
® Do you want to pass HTTP X-Forwarded-For headers?

® Would you like to permit tunneling of non-HTTP requests on HTTP
ports?

® Would you like to block tunneling of non-SSL transactions on
SSL Ports?

® Would you like proxy to log values from X-Forwarded-For headers
in place of incoming connection IP addresses?

® Do you want proxy to throttle content served from cache?

® Would you like the proxy to use client IP addresses from
X-Forwarded-For headers

See also Using the P2 Data Interface for Web Proxy Data, page 2-15 and
Configuring Web Proxy Settings, page 4-3.

socks — SOCKS Proxy options:

® Would you like to enable SOCKS proxy
® Proxy Negotiation Timeout

® UDP Tunnel Timeout

® SOCKS Control Ports

® UDP Request Ports

See also Using the P2 Data Interface for Web Proxy Data, page 2-15 and
SOCKS Proxy Services, page 4-16.

adminaccessconfig

You can configure the Web Security appliance to have stricter access
requirements for administrators logging into the appliance.

alertconfig

Specify alert recipients, and set parameters for sending system alerts.

authcache

Allows you to delete one or all entries (users) from the authentication cache.
You can also list all users currently included in the authentication cache.

certconfig

Configure security certificates and keys.

clear

Clears pending configuration changes since last commit.

commit

Commits pending changes to the system configuration.
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createcomputerobject |Creates a computer object at the location you specify.
date Displays the current date. Example:
Thu Jan 10 23:13:40 2013 GMT

dnsconfig Configure DNS server parameters.

dnsflush Flush DNS entries on the appliance.

etherconfig Configure Ethernet port connections.

featurekey Submits valid keys to activate licensed features.

featurekeyconfig Automatically check for and update feature keys.

grep Searches named input files for lines containing a match to the given pattern.

help Returns a list of commands.

ifconfig Configure and manage network interfaces including M1, P1, and P2. Displays

or currently configured interfaces, and provides an operations menu to create,

interfaceconfig . A
edit, or delete interfaces.

last Lists user-specific user information that includes ttys and hosts, in reverse
time order or lists the users that are logged in at a specified date and time.

loadconfig Load a system configuration file.

logconfig Configure access to log files.

mailconfig Mail the current configuration file to the address specified.

nslookup Queries Internet domain name servers for information about specified hosts
and domains or to print a list of hosts in a domain.

ntpconfig Configure NTP servers. Displays currently configured interfaces, and
provides an operations menu to add, remove, or set the interface from whose
IP address NTP queries should originate.

packetcapture Intercepts and displays TCP/IP and other packets being transmitted or
received over the network to which the appliance is attached.

passwd Set the passphrase.

pathmtudiscovery Enables or disables Path MTU Discovery.
You might want to disable Path MTU Discovery if you need to packet
fragmentation.

ping Sends an ICMP ECHO REQUEST to the specified host or gateway.

maxhttpheadersize Set the maximum HTTP header size for proxy requests; enter the value in
bytes, or append a K to the number to indicate kilobytes.
Policy Trace can fail for a user that belongs to a large number of
authentication groups. It can also fail if the HTTP response header size is
greater than the current “max header size.” Increasing this value can alleviate
such failures. Minimum value is 32 KB; default value is 32 KB; maximum
value is 1024 KB.

proxyconfig Enables or disables the Web Proxy.

<enable | disable>

proxystat Display web proxy statistics.

quit, q, exit Terminates an active process or session.

reboot Flushes the file system cache to disk, halts all running processes, and restarts
the system.
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resetconfig

Restores the configuration to factory defaults.

rollovernow

Roll over a log file.

routeconfig

Configure destination IP addresses and gateways for traffic. Displays
currently configured routes, and provides an operations menu to create, edit,
or delete, or clear entries.

saveconfig

Saves a copy of the current configuration settings to a file. This file can be
used to restore defaults, if necessary.

setgateway

Configure the default gateway for the machine.

sethostname

Set the hostname parameter.

setntlmsecuritymode

Changes the security setting for the NTLM authentication realm to either
“ads” or “domain”.

® domain — AsyncOS joins the Active Directory domain with a domain
security trust account. AsyncOS requires Active Directory to use only
nested Active Directory groups in this mode.

® ads — AsyncOS joins the domain as a native Active Directory member.

Default is ads.

settime

Set system time.

settz

Displays the current time zone and the time zone version. Provides an
operations menu to set a local time zone.

showconfig

Display all configuration values.

Note  User passphrases are encrypted.

shutdown

Terminates connections and shuts down the system.

smtprelay

Configure SMTP relay hosts for internally generated email. An SMTP relay
host is required to receive system generated email and alerts.

snmpconfig

Configure the local host to listen for SNMP queries and allow SNMP requests.

sshconfig

Configure hostname and host key options for trusted servers.
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sslconfig

Commands for use of communications protocols TLS v1.x and SSL v3 with
Appliance Management Web User Interface, Proxy Services (includes
HTTPS Proxy and Credential Encryption for Secure Client), Secure LDAP
Services (includes Authentication, External Authentication, SaaS SSO, and
Secure Mobility), as well as the Update Service.

VERSIONS — View and change the protocols enabled for specific services.

comprESS — Enable/disable TLS compression. Disabling is recommended for
best security.

c1pHERS — Add/update cipher suites available to selected protocols.

The default cipher is

EECDH:DSS:RSA: INULL: ! eNULL: | EXPORT: ! 3DES: !RC4: |RC2: ! DES: ! SEED
: ICAMELLIA: !SRP: !IDEA: ! ECDHE-ECDSA-AES256-SHA: | ECDHE-RSA-AES2
56-SHA: | DHE-DSS-AES256-SHA: | AES256-SHA : DHE-RSA-AES128-SHA;
however, this may change based on your ECDHE cipher selections.

FALLBACK — Enable/disable the SSL/TLS fall-back option. If enabled,
communications with remote servers will fall back to the lowest configured
protocol following a handshake failure.

After a protocol version is negotiated between client and server,
handshake failure is possible because of implementation issues. If this
option is enabled, the proxy attempts to connect using the lowest version
of the currently configured TLS/SSL protocols.

Note  On new AsyncOS 9.x installations, fall-back is disabled by default. For
upgrades from earlier versions on which the fall-back option exists, the
current setting is retained; otherwise, when upgrading from a version on
which the option did not exist, fall-back is enabled by default.

eEcpHE— Enable/disable use of ECDHE ciphers for LDAP.

Additional ECDH ciphers are supported in successive releases; however,
certain named curves provided with some of the additional ciphers cause
the appliance to close a connection during secure LDAP authentication
and HTTPS traffic decryption. See SSL Configuration, page 22-23 for
more information about specifying additional ciphers.

If you experience these issues, use this option to disable or enable
ECDHE cipher use for either or both features.

status

Displays system status.

supportrequest

Send the support request email to Cisco IronPort Customer Support. This
includes system information and a copy of the master configuration.

tail

Displays the end of a log file. Command accepts log file name or number
as parameters.

example.com> tail system_logs

example.com> tail 9

tcpservices

Displays information about open TCP/IP services.

techsupport

Provides a temporary connection to allow Cisco IronPort Customer Support
to access the system and assist in troubleshooting.

telnet

Communicates with another host using the TELNET protocol.
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testauthconfig

Tests the authentication settings for a given authentication realm against the
authentication servers defined in the realm.

testauthconfig [-d level] [realm name]

Running the command without any option causes the appliance to list the
configured authentication realms from which you can make a selection.

The debug flag (-d) controls the level of debug information. The levels can
range between 0-10. If unspecified, the appliance uses a level of 0. With level
0, the command will return success or failure. If the test settings fail, the
command will list the cause of the failure.

Note Cisco recommends you use level 0. Only use a different debug level
when you need more detailed information to troubleshoot.

traceroute

Traces IP packets through gateways and along the path to a destination host.

tuiconfig
tuistatus

These two commands are documented in Using the CLI to Configure
Advanced Transparent User Identification Settings, page 5-9.

updateconfig

Configure update and upgrade settings.

updatenow

Update all components.

userconfig

Configure system administrators.

version

Displays general system information, installed versions of system software,
and rule definitions.

webcache

Examine or modify the contents of the proxy cache, or configure domains and
URLSs that the appliance never caches. Allows an administrator to remove a
particular URL from the proxy cache or specify which domains or URLSs to
never store in the proxy cache.

who

Displays users logged into the system, for both CLI and Web interface sessions.

Note Individual users can have a maximum of 10 concurrent sessions.

whoami

Displays user information.
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Additional Resources

¢ Cisco Notification Service, page C-1

e Documentation Set, page C-2

e Training, page C-2

e Knowledge Base Articles (TechNotes), page C-2

e (Cisco Support Community, page C-2

e (Customer Support, page C-3

e Registering for a Cisco Account to Access Resources, page C-3
e Third Party Contributors, page C-3

e Cisco Welcomes Your Comments, page C-3

Cisco Notification Service

Sign up to receive notifications relevant to your Cisco Content Security Appliances, such as Security
Advisories, Field Notices, End of Sale and End of Support statements, and information about software
updates and known issues.

You can specify options such as notification frequency and types of information to receive. You should
sign up separately for notifications for each product that you use.

To sign up, visit http://www.cisco.com/cisco/support/notifications.html

A Cisco.com account is required. If you do not have one, see Registering for a Cisco Account to Access
Resources, page C-3.
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Documentation Set

Related documentation for Cisco Web Security Appliances is available from the following locations:

Training

Product

Link

Web Security appliances

(Includes hardware
documentation.)

http://www.cisco.com/c/en/us/support/security/web-security
-appliance/tsd-products-support-series-home.html

Content Security Management
appliances

(Includes hardware
documentation.)

http://www.cisco.com/c/en/us/support/security/content-secu
rity-management-appliance/tsd-products-support-series-home
.html

Cisco Cloud Web Security

(Includes hardware
documentation.)

http://www.cisco.com/c/en/us/support/security/cloud-web-se
curity/tsd-products-support-series-home.html

Information about security technology training:

e Web site for Cisco email and web content security training

http://www.cisco.com/web/learning/le3l/email_sec/index.html

¢ Email contact for information about training in Cisco security technology

stbu-trg@cisco.com

e  Web site for Cisco training for Cisco products

http://www.cisco.com/c/en/us/training-events/training-certifications/overview.html

Knowledge Base Articles (TechNotes)

Step 1

Step 2

Go to the main product page

(http://www.cisco.com/c/en/us/support/security/web-security-appliance/tsd-products-support-series-ho

me.html)

Look for links with TechNotes in the name.

Cisco Support Community

Access the Cisco Support Community for web security and associated management at the following

URL:

https://supportforums.cisco.com/community/5786/web-security
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The Cisco Support Community is a place to discuss general web security issues as well as technical
information about specific Cisco products. For example, posts may include troubleshooting videos.

Customer Support

Cisco TAC: http://www.cisco.com/en/US/support/tsd_cisco_worldwide_contacts.html
Support site for legacy IronPort: http://www.cisco.com/web/services/acquisitions/ironport.html
For virtual appliances, see the Cisco Content Security Virtual Appliance Installation Guide.

For non-critical issues, you can also open a support case from the appliance.

Related Topics
e Working With Support, page A-17.

Registering for a Cisco Account to Access Resources

Access to many resources on Cisco.com requires a Cisco account.

If you do not have a Cisco.com User ID, you can register for one here:
https://tools.cisco.com/RPF/register/register.do

Third Party Contributors

Some software included within AsyncOS is distributed under the terms, notices, and conditions of
software license agreements of FreeBSD, Inc., Stichting Mathematisch Centrum, Corporation for
National Research Initiatives, Inc., and other third party contributors, and all such terms and conditions
are incorporated in license agreements. The full text of these agreements can be found here:

https://support.ironport.com/3rdparty/AsyncOS_User_Guide-1-1.html.

Portions of the software within AsyncOS is based upon the RRDtool with the express written consent of
Tobi Oetiker.

Portions of this document are reproduced with permission of Dell Computer Corporation. Portions of
this document are reproduced with permission of McAfee, Inc. Portions of this document are reproduced
with permission of Sophos Plc.

Cisco Welcomes Your Comments

The Cisco Technical Publications team is interested in improving the product documentation. Your
comments and suggestions are always welcome. You can send comments to the following email address:
contentsecuritydocs@cisco.com

Please include the title of this book and the publication date from the title page in the subject line of your
message.
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End User License Agreement

e Cisco Systems End User License Agreement, page D-1

e Supplemental End User License Agreement for Cisco Systems Content Security Software, page D-8

Cisco Systems End User License Agreement

IMPORTANT: PLEASE READ THIS END USER LICENSE AGREEMENT CAREFULLY. IT IS
VERY IMPORTANT THAT YOU CHECK THAT YOU ARE PURCHASING CISCO SOFTWARE
OR EQUIPMENT FROM AN APPROVED SOURCE AND THAT YOU, OR THE ENTITY YOU
REPRESENT (COLLECTIVELY, THE "CUSTOMER') HAVE BEEN REGISTERED AS THE
END USER FOR THE PURPOSES OF THIS CISCO END USER LICENSE AGREEMENT. IF
YOU ARE NOT REGISTERED AS THE END USER YOU HAVE NO LICENSE TO USE THE
SOFTWARE AND THE LIMITED WARRANTY IN THIS END USER LICENSE AGREEMENT
DOES NOT APPLY. ASSUMING YOU HAVE PURCHASED FROM AN APPROVED SOURCE,
DOWNLOADING, INSTALLING OR USING CISCO OR CISCO-SUPPLIED SOFTWARE
CONSTITUTES ACCEPTANCE OF THIS AGREEMENT.

CISCO SYSTEMS, INC. OR ITS SUBSIDIARY LICENSING THE SOFTWARE INSTEAD OF CISCO
SYSTEMS, INC. ("CISCO") IS WILLING TO LICENSE THIS SOFTWARE TO YOU ONLY UPON
THE CONDITION THAT YOU PURCHASED THE SOFTWARE FROM AN APPROVED SOURCE
AND THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS END USER LICENSE
AGREEMENT PLUS ANY ADDITIONAL LIMITATIONS ON THE LICENSE SET FORTH IN A
SUPPLEMENTAL LICENSE AGREEMENT ACCOMPANYING THE PRODUCT OR AVAILABLE
AT THE TIME OF YOUR ORDER (COLLECTIVELY THE "AGREEMENT"). TO THE EXTENT OF
ANY CONFLICT BETWEEN THE TERMS OF THIS END USER LICENSE AGREEMENT AND
ANY SUPPLEMENTAL LICENSE AGREEMENT, THE SUPPLEMENTAL LICENSE AGREEMENT
SHALL APPLY. BY DOWNLOADING, INSTALLING, OR USING THE SOFTWARE, YOU ARE
REPRESENTING THAT YOU PURCHASED THE SOFTWARE FROM AN APPROVED SOURCE
AND BINDING YOURSELF TO THE AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE
TERMS OF THE AGREEMENT, THEN CISCO IS UNWILLING TO LICENSE THE SOFTWARE TO
YOU AND (A) YOU MAY NOT DOWNLOAD, INSTALL OR USE THE SOFTWARE, AND (B) YOU
MAY RETURN THE SOFTWARE (INCLUDING ANY UNOPENED CD PACKAGE AND ANY
WRITTEN MATERIALS) FOR A FULL REFUND, OR, IF THE SOFTWARE AND WRITTEN
MATERIALS ARE SUPPLIED AS PART OF ANOTHER PRODUCT, YOU MAY RETURN THE
ENTIRE PRODUCT FOR A FULL REFUND. YOUR RIGHT TO RETURN AND REFUND EXPIRES
30 DAYS AFTER PURCHASE FROM AN APPROVED SOURCE, AND APPLIES ONLY IF YOU
ARE THE ORIGINAL AND REGISTERED END USER PURCHASER. FOR THE PURPOSES OF
THIS END USER LICENSE AGREEMENT, AN "APPROVED SOURCE" MEANS (A) CISCO; OR (B)
A DISTRIBUTOR OR SYSTEMS INTEGRATOR AUTHORIZED BY CISCO TO DISTRIBUTE /
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SELL CISCO EQUIPMENT, SOFTWARE AND SERVICES WITHIN YOUR TERRITORY TO END
USERS; OR (C) A RESELLER AUTHORIZED BY ANY SUCH DISTRIBUTOR OR SYSTEMS
INTEGRATOR IN ACCORDANCE WITH THE TERMS OF THE DISTRIBUTOR'S AGREEMENT
WITH CISCO TO DISTRIBUTE / SELL THE CISCO EQUIPMENT, SOFTWARE AND SERVICES
WITHIN YOUR TERRITORY TO END USERS.

THE FOLLOWING TERMS OF THE AGREEMENT GOVERN CUSTOMER'S USE OF THE SOFTWARE
(DEFINED BELOW), EXCEPT TO THE EXTENT: (A) THERE IS A SEPARATE SIGNED CONTRACT
BETWEEN CUSTOMER AND CISCO GOVERNING CUSTOMER'S USE OF THE SOFTWARE, OR (B)
THE SOFTWARE INCLUDES A SEPARATE "CLICK-ACCEPT" LICENSE AGREEMENT OR THIRD
PARTY LICENSE AGREEMENT AS PART OF THE INSTALLATION OR DOWNLOAD PROCESS
GOVERNING CUSTOMER'S USE OF THE SOFTWARE. TO THE EXTENT OF A CONFLICT
BETWEEN THE PROVISIONS OF THE FOREGOING DOCUMENTS, THE ORDER OF
PRECEDENCE SHALL BE (1)THE SIGNED CONTRACT, (2) THE CLICK-ACCEPT AGREEMENT OR
THIRD PARTY LICENSE AGREEMENT, AND (3) THE AGREEMENT. FOR PURPOSES OF THE
AGREEMENT, "SOFTWARE" SHALL MEAN COMPUTER PROGRAMS, INCLUDING FIRMWARE
AND COMPUTER PROGRAMS EMBEDDED IN CISCO EQUIPMENT, AS PROVIDED TO
CUSTOMER BY AN APPROVED SOURCE, AND ANY UPGRADES, UPDATES, BUG FIXES OR
MODIFIED VERSIONS THERETO (COLLECTIVELY, "UPGRADES"), ANY OF THE SAME WHICH
HAS BEEN RELICENSED UNDER THE CISCO SOFTWARE TRANSFER AND RE-LICENSING
POLICY (AS MAY BE AMENDED BY CISCO FROM TIME TO TIME) OR BACKUP COPIES OF ANY
OF THE FOREGOING.

License. Conditioned upon compliance with the terms and conditions of the Agreement, Cisco grants to
Customer a nonexclusive and nontransferable license to use for Customer's internal business purposes
the Software and the Documentation for which Customer has paid the required license fees to an
Approved Source. "Documentation” means written information (whether contained in user or technical
manuals, training materials, specifications or otherwise) pertaining to the Software and made available
by an Approved Source with the Software in any manner (including on CD-Rom, or on-line). In order to
use the Software, Customer may be required to input a registration number or product authorization key
and register Customer's copy of the Software online at Cisco's website to obtain the necessary license
key or license file.

Customer's license to use the Software shall be limited to, and Customer shall not use the Software in
excess of, a single hardware chassis or card or such other limitations as are set forth in the applicable
Supplemental License Agreement or in the applicable purchase order which has been accepted by an
Approved Source and for which Customer has paid to an Approved Source the required license fee (the
"Purchase Order").

Unless otherwise expressly provided in the Documentation or any applicable Supplemental License
Agreement, Customer shall use the Software solely as embedded in, for execution on, or (where the
applicable Documentation permits installation on non-Cisco equipment) for communication with Cisco
equipment owned or leased by Customer and used for Customer's internal business purposes. No other
licenses are granted by implication, estoppel or otherwise.

For evaluation or beta copies for which Cisco does not charge a license fee, the above requirement to
pay license fees does not apply.

General Limitations. This is a license, not a transfer of title, to the Software and Documentation, and
Cisco retains ownership of all copies of the Software and Documentation. Customer acknowledges that
the Software and Documentation contain trade secrets of Cisco or its suppliers or licensors, including
but not limited to the specific internal design and structure of individual programs and associated
interface information. Except as otherwise expressly provided under the Agreement, Customer shall
only use the Software in connection with the use of Cisco equipment purchased by the Customer from
an Approved Source and Customer shall have no right, and Customer specifically agrees not to:
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(i) transfer, assign or sublicense its license rights to any other person or entity (other than in compliance
with any Cisco relicensing/transfer policy then in force), or use the Software on Cisco equipment not
purchased by the Customer from an Approved Source or on secondhand Cisco equipment, and Customer
acknowledges that any attempted transfer, assignment, sublicense or use shall be void;

(i1) make error corrections to or otherwise modify or adapt the Software or create derivative works based
upon the Software, or permit third parties to do the same;

(iii) reverse engineer or decompile, decrypt, disassemble or otherwise reduce the Software to
human-readable form, except to the extent otherwise expressly permitted under applicable law
notwithstanding this restriction or except to the extent that Cisco is legally required to permit such
specific activity pursuant to any applicable open source license;

(iv) publish any results of benchmark tests run on the Software;

(v) use or permit the Software to be used to perform services for third parties, whether on a service
bureau or time sharing basis or otherwise, without the express written authorization of Cisco; or

(vi) disclose, provide, or otherwise make available trade secrets contained within the Software and
Documentation in any form to any third party without the prior written consent of Cisco. Customer shall
implement reasonable security measures to protect such trade secrets.

To the extent required by applicable law, and at Customer's written request, Cisco shall provide
Customer with the interface information needed to achieve interoperability between the Software and
another independently created program, on payment of Cisco's applicable fee, if any. Customer shall
observe strict obligations of confidentiality with respect to such information and shall use such
information in compliance with any applicable terms and conditions upon which Cisco makes such
information available.

Software, Upgrades and Additional Copies. NOTWITHSTANDING ANY OTHER PROVISION OF
THE AGREEMENT: (1) CUSTOMER HAS NO LICENSE OR RIGHT TO MAKE OR USE ANY
ADDITIONAL COPIES OR UPGRADES UNLESS CUSTOMER, AT THE TIME OF MAKING OR
ACQUIRING SUCH COPY OR UPGRADE, ALREADY HOLDS A VALID LICENSE TO THE
ORIGINAL SOFTWARE AND HAS PAID THE APPLICABLE FEE TO AN APPROVED SOURCE
FOR THE UPGRADE OR ADDITIONAL COPIES; (2) USE OF UPGRADES IS LIMITED TO CISCO
EQUIPMENT SUPPLIED BY AN APPROVED SOURCE FOR WHICH CUSTOMER IS THE
ORIGINAL END USER PURCHASER OR LESSEE OR OTHERWISE HOLDS A VALID LICENSE
TO USE THE SOFTWARE WHICH IS BEING UPGRADED; AND (3) THE MAKING AND USE OF
ADDITIONAL COPIES IS LIMITED TO NECESSARY BACKUP PURPOSES ONLY.

Proprietary Notices. Customer agrees to maintain and reproduce all copyright, proprietary, and other
notices on all copies, in any form, of the Software in the same form and manner that such copyright and
other proprietary notices are included on the Software. Except as expressly authorized in the Agreement,
Customer shall not make any copies or duplicates of any Software without the prior written permission
of Cisco.

Term and Termination. The Agreement and the license granted herein shall remain effective until
terminated. Customer may terminate the Agreement and the license at any time by destroying all copies
of Software and any Documentation. Customer's rights under the Agreement will terminate immediately
without notice from Cisco if Customer fails to comply with any provision of the Agreement. Upon
termination, Customer shall destroy all copies of Software and Documentation in its possession or
control. All confidentiality obligations of Customer, all restrictions and limitations imposed on the
Customer under the section titled "General Limitations" and all limitations of liability and disclaimers
and restrictions of warranty shall survive termination of this Agreement. In addition, the provisions of
the sections titled "U.S. Government End User Purchasers" and "General Terms Applicable to the
Limited Warranty Statement and End User License Agreement" shall survive termination of the
Agreement.
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Customer Records. Customer grants to Cisco and its independent accountants the right to examine

Customer's books, records and accounts during Customer's normal business hours to verify compliance
with this Agreement. In the event such audit discloses non-compliance with this Agreement, Customer
shall promptly pay to Cisco the appropriate license fees, plus the reasonable cost of conducting the audit.

Export, Re-Export, Transfer and Use Controls. The Software, Documentation and technology or direct
products thereof (hereafter referred to as Software and Technology), supplied by Cisco under the
Agreement are subject to export controls under the laws and regulations of the United States (U.S.) and
any other applicable countries' laws and regulations. Customer shall comply with such laws and
regulations governing export, re-export, transfer and use of Cisco Software and Technology and will
obtain all required U.S. and local authorizations, permits, or licenses. Cisco and Customer each agree to
provide the other information, support documents, and assistance as may reasonably be required by the
other in connection with securing authorizations or licenses. Information regarding compliance with
export, re-export, transfer and use may be located at the following URL.:

http://www.cisco.com/web/about/doing_business/legal/global_export_trade/general_export/contract_c
ompliance.html.

U.S. Government End User Purchasers. The Software and Documentation qualify as "commercial
items," as that term is defined at Federal Acquisition Regulation ("FAR") (48 C.F.R.) 2.101, consisting
of "commercial computer software" and "commercial computer software documentation" as such terms
are used in FAR 12.212. Consistent with FAR 12.212 and DoD FAR Supp. 227.7202-1 through
227.7202-4, and notwithstanding any other FAR or other contractual clause to the contrary in any
agreement into which the Agreement may be incorporated, Customer may provide to Government end
user or, if the Agreement is direct, Government end user will acquire, the Software and Documentation
with only those rights set forth in the Agreement. Use of either the Software or Documentation or both
constitutes agreement by the Government that the Software and Documentation are "commercial
computer software" and "commercial computer software documentation," and constitutes acceptance of
the rights and restrictions herein.

Identified Components; Additional Terms. The Software may contain or be delivered with one or more
components, which may include third-party components, identified by Cisco in the Documentation,
readme.txt file, third-party click-accept or elsewhere (e.g. on www.cisco.com) (the "Identified
Component(s)") as being subject to different license agreement terms, disclaimers of warranties, limited
warranties or other terms and conditions (collectively, "Additional Terms") than those set forth herein.
You agree to the applicable Additional Terms for any such Identified Component(s)."

Limited Warranty

Subject to the limitations and conditions set forth herein, Cisco warrants that commencing from the date
of shipment to Customer (but in case of resale by an Approved Source other than Cisco, commencing
not more than ninety (90) days after original shipment by Cisco), and continuing for a period of the
longer of (a) ninety (90) days or (b) the warranty period (if any) expressly set forth as applicable
specifically to software in the warranty card accompanying the product of which the Software is a part
(the "Product") (if any): (a) the media on which the Software is furnished will be free of defects in
materials and workmanship under normal use; and (b) the Software substantially conforms to the
Documentation. The date of shipment of a Product by Cisco is set forth on the packaging material in
which the Product is shipped. Except for the foregoing, the Software is provided "AS IS". This limited
warranty extends only to the Software purchased from an Approved Source by a Customer who is the
first registered end user. Customer's sole and exclusive remedy and the entire liability of Cisco and its
suppliers under this limited warranty will be (i) replacement of defective media and/or (ii) at Cisco's
option, repair, replacement, or refund of the purchase price of the Software, in both cases subject to the
condition that any error or defect constituting a breach of this limited warranty is reported to the
Approved Source supplying the Software to Customer, within the warranty period. Cisco or the
Approved Source supplying the Software to Customer may, at its option, require return of the Software
and/or Documentation as a condition to the remedy. In no event does Cisco warrant that the Software is
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error free or that Customer will be able to operate the Software without problems or interruptions. In
addition, due to the continual development of new techniques for intruding upon and attacking networks,
Cisco does not warrant that the Software or any equipment, system or network on which the Software is
used will be free of vulnerability to intrusion or attack.

Restrictions. This warranty does not apply if the Software, Product or any other equipment upon which
the Software is authorized to be used (a) has been altered, except by Cisco or its authorized
representative, (b) has not been installed, operated, repaired, or maintained in accordance with
instructions supplied by Cisco, (c) has been subjected to abnormal physical or electrical stress, abnormal
environmental conditions, misuse, negligence, or accident; or (d) is licensed for beta, evaluation, testing
or demonstration purposes. The Software warranty also does not apply to (e) any temporary Software
modules; (f) any Software not posted on Cisco's Software Center; (g) any Software that Cisco expressly
provides on an "AS IS" basis on Cisco's Software Center; (h) any Software for which an Approved
Source does not receive a license fee; and (i) Software supplied by any third party which is not an
Approved Source.

DISCLAIMER OF WARRANTY

EXCEPT AS SPECIFIED IN THIS WARRANTY SECTION, ALL EXPRESS OR IMPLIED
CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT
LIMITATION, ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, SATISFACTORY
QUALITY, NON-INTERFERENCE, ACCURACY OF INFORMATIONAL CONTENT, OR
ARISING FROM A COURSE OF DEALING, LAW, USAGE, OR TRADE PRACTICE, ARE
HEREBY EXCLUDED TO THE EXTENT ALLOWED BY APPLICABLE LAW AND ARE
EXPRESSLY DISCLAIMED BY CISCO, ITS SUPPLIERS AND LICENSORS. TO THE
EXTENT THAT ANY OF THE SAME CANNOT BE EXCLUDED, SUCH IMPLIED
CONDITION, REPRESENTATION AND/OR WARRANTY IS LIMITED IN DURATION TO
THE EXPRESS WARRANTY PERIOD REFERRED TO IN THE "LIMITED WARRANTY"
SECTION ABOVE. BECAUSE SOME STATES OR JURISDICTIONS DO NOT ALLOW
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, THE ABOVE
LIMITATION MAY NOT APPLY IN SUCH STATES. THIS WARRANTY GIVES CUSTOMER
SPECIFIC LEGAL RIGHTS, AND CUSTOMER MAY ALSO HAVE OTHER RIGHTS WHICH
VARY FROM JURISDICTION TO JURISDICTION. This disclaimer and exclusion shall apply even
if the express warranty set forth above fails of its essential purpose.

Disclaimer of Liabilities - Limitation of Liability. IF YOU ACQUIRED THE SOFTWARE IN THE
UNITED STATES, LATIN AMERICA, CANADA, JAPAN OR THE CARIBBEAN,
NOTWITHSTANDING ANYTHING ELSE IN THE AGREEMENT TO THE CONTRARY, ALL
LIABILITY OF CISCO, ITS AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS,
SUPPLIERS AND LICENSORS COLLECTIVELY, TO CUSTOMER, WHETHER IN CONTRACT,
TORT (INCLUDING NEGLIGENCE), BREACH OF WARRANTY OR OTHERWISE, SHALL NOT
EXCEED THE PRICE PAID BY CUSTOMER TO ANY APPROVED SOURCE FOR THE SOFTWARE
THAT GAVE RISE TO THE CLAIM OR IF THE SOFTWARE IS PART OF ANOTHER PRODUCT,
THE PRICE PAID FOR SUCH OTHER PRODUCT. THIS LIMITATION OF LIABILITY FOR
SOFTWARE IS CUMULATIVE AND NOT PER INCIDENT (I.E. THE EXISTENCE OF TWO OR
MORE CLAIMS WILL NOT ENLARGE THIS LIMIT).

IF YOU ACQUIRED THE SOFTWARE IN EUROPE, THE MIDDLE EAST, AFRICA, ASTIA OR
OCEANIA, NOTWITHSTANDING ANYTHING ELSE IN THE AGREEMENT TO THE CONTRARY,
ALL LTABILITY OF CISCO, ITS AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS,
SUPPLIERS AND LICENSORS COLLECTIVELY, TO CUSTOMER, WHETHER IN CONTRACT,
TORT (INCLUDING NEGLIGENCE), BREACH OF WARRANTY OR OTHERWISE, SHALL NOT
EXCEED THE PRICE PAID BY CUSTOMER TO CISCO FOR THE SOFTWARE THAT GAVE RISE
TO THE CLAIM OR IF THE SOFTWARE IS PART OF ANOTHER PRODUCT, THE PRICE PAID
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FOR SUCH OTHER PRODUCT. THIS LIMITATION OF LIABILITY FOR SOFTWARE IS
CUMULATIVE AND NOT PER INCIDENT (I.E. THE EXISTENCE OF TWO OR MORE CLAIMS
WILL NOT ENLARGE THIS LIMIT). NOTHING IN THE AGREEMENT SHALL LIMIT (I) THE
LIABILITY OF CISCO, ITS AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS,
SUPPLIERS AND LICENSORS TO CUSTOMER FOR PERSONAL INJURY OR DEATH CAUSED
BY THEIR NEGLIGENCE, (II) CISCO'S LIABILITY FOR FRAUDULENT MISREPRESENTATION,
OR (III) ANY LIABILITY OF CISCO WHICH CANNOT BE EXCLUDED UNDER APPLICABLE
LAW.

Disclaimer of Liabilities - Waiver of Consequential Damages and Other Losses. IF YOU ACQUIRED
THE SOFTWARE IN THE UNITED STATES, LATIN AMERICA, THE CARIBBEAN OR CANADA,
REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL
PURPOSE OR OTHERWISE, IN NO EVENT WILL CISCO OR ITS SUPPLIERS BE LIABLE FOR
ANY LOST REVENUE, PROFIT, OR LOST OR DAMAGED DATA, BUSINESS INTERRUPTION,
LOSS OF CAPITAL, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR
PUNITIVE DAMAGES HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY OR WHETHER ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE
OR OTHERWISE AND EVEN IF CISCO OR ITS SUPPLIERS OR LICENSORS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES OR
JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

IF YOU ACQUIRED THE SOFTWARE IN JAPAN, EXCEPT FOR LIABILITY ARISING OUT OF OR
IN CONNECTION WITH DEATH OR PERSONAL INJURY, FRAUDULENT
MISREPRESENTATION, AND REGARDLESS OF WHETHER ANY REMEDY SET FORTH
HEREIN FAILS OF ITS ESSENTIAL PURPOSE OR OTHERWISE, IN NO EVENT WILL CISCO, ITS
AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, SUPPLIERS AND LICENSORS
BE LIABLE FOR ANY LOST REVENUE, PROFIT, OR LOST OR DAMAGED DATA, BUSINESS
INTERRUPTION, LOSS OF CAPITAL, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL,
INCIDENTAL, OR PUNITIVE DAMAGES HOWEVER CAUSED AND REGARDLESS OF THE
THEORY OF LIABILITY OR WHETHER ARISING OUT OF THE USE OF OR INABILITY TO USE
SOFTWARE OR OTHERWISE AND EVEN IF CISCO OR ANY APPROVED SOURCE OR THEIR
SUPPLIERS OR LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

IF YOU ACQUIRED THE SOFTWARE IN EUROPE, THE MIDDLE EAST, AFRICA, ASIA OR
OCEANIA, IN NO EVENT WILL CISCO, ITS AFFILIATES, OFFICERS, DIRECTORS,
EMPLOYEES, AGENTS, SUPPLIERS AND LICENSORS, BE LIABLE FOR ANY LOST REVENUE,
LOST PROFIT, OR LOST OR DAMAGED DATA, BUSINESS INTERRUPTION, LOSS OF CAPITAL,
OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGES,
HOWSOEVER ARISING, INCLUDING, WITHOUT LIMITATION, IN CONTRACT, TORT
(INCLUDING NEGLIGENCE) OR WHETHER ARISING OUT OF THE USE OF OR INABILITY TO
USE THE SOFTWARE, EVEN IF, IN EACH CASE, CISCO, ITS AFFILIATES, OFFICERS,
DIRECTORS, EMPLOYEES, AGENTS, SUPPLIERS AND LICENSORS, HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES OR JURISDICTIONS DO
NOT ALLOW LIMITATION OR EXCLUSION OF CONSEQUENTIAL OR INCIDENTAL
DAMAGES, THE ABOVE LIMITATION MAY NOT FULLY APPLY TO YOU. THE FOREGOING
EXCLUSION SHALL NOT APPLY TO ANY LIABILITY ARISING OUT OF OR IN CONNECTION
WITH: (I) DEATH OR PERSONAL INJURY, (II) FRAUDULENT MISREPRESENTATION, OR (III)
CISCO'S LTABILITY IN CONNECTION WITH ANY TERMS THAT CANNOT BE EXCLUDED
UNDER APPLICABLE LAW.
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Customer acknowledges and agrees that Cisco has set its prices and entered into the Agreement in
reliance upon the disclaimers of warranty and the limitations of liability set forth herein, that the same
reflect an allocation of risk between the parties (including the risk that a contract remedy may fail of its
essential purpose and cause consequential loss), and that the same form an essential basis of the bargain
between the parties.

Controlling Law, Jurisdiction. If you acquired, by reference to the address on the purchase order
accepted by the Approved Source, the Software in the United States, Latin America, or the Caribbean,
the Agreement and warranties ("Warranties") are controlled by and construed under the laws of the State
of California, United States of America, notwithstanding any conflicts of law provisions; and the state
and federal courts of California shall have exclusive jurisdiction over any claim arising under the
Agreement or Warranties. If you acquired the Software in Canada, unless expressly prohibited by local
law, the Agreement and Warranties are controlled by and construed under the laws of the Province of
Ontario, Canada, notwithstanding any conflicts of law provisions; and the courts of the Province of
Ontario shall have exclusive jurisdiction over any claim arising under the Agreement or Warranties. If
you acquired the Software in Europe, the Middle East, Africa, Asia or Oceania (excluding Australia),
unless expressly prohibited by local law, the Agreement and Warranties are controlled by and construed
under the laws of England, notwithstanding any conflicts of law provisions; and the English courts shall
have exclusive jurisdiction over any claim arising under the Agreement or Warranties. In addition, if the
Agreement is controlled by the laws of England, no person who is not a party to the Agreement shall be
entitled to enforce or take the benefit of any of its terms under the Contracts (Rights of Third Parties)
Act 1999. If you acquired the Software in Japan, unless expressly prohibited by local law, the Agreement
and Warranties are controlled by and construed under the laws of Japan, notwithstanding any conflicts
of law provisions; and the Tokyo District Court of Japan shall have exclusive jurisdiction over any claim
arising under the Agreement or Warranties. If you acquired the Software in Australia, unless expressly
prohibited by local law, the Agreement and Warranties are controlled by and construed under the laws
of the State of New South Wales, Australia, notwithstanding any conflicts of law provisions; and the
State and federal courts of New South Wales shall have exclusive jurisdiction over any claim arising
under the Agreement or Warranties. If you acquired the Software in any other country, unless expressly
prohibited by local law, the Agreement and Warranties are controlled by and construed under the laws
of the State of California, United States of America, notwithstanding any conflicts of law provisions;
and the state and federal courts of California shall have exclusive jurisdiction over any claim arising
under the Agreement or Warranties.

For all countries referred to above, the parties specifically disclaim the application of the UN Convention
on Contracts for the International Sale of Goods. Notwithstanding the foregoing, either party may seek
interim injunctive relief in any court of appropriate jurisdiction with respect to any alleged breach of
such party's intellectual property or proprietary rights. If any portion hereof is found to be void or
unenforceable, the remaining provisions of the Agreement and Warranties shall remain in full force and
effect. Except as expressly provided herein, the Agreement constitutes the entire agreement between the
parties with respect to the license of the Software and Documentation and supersedes any conflicting or
additional terms contained in any Purchase Order or elsewhere, all of which terms are excluded. The
Agreement has been written in the English language, and the parties agree that the English version will
govern.

Product warranty terms and other information applicable to Cisco products are available at the following
URL:

http://www.cisco.com/go/warranty
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Content Security Software

IMPORTANT: READ CAREFULLY

This Supplemental End User License Agreement ("SEULA") contains additional terms and conditions
for the Software product licensed under the End User License Agreement ("EULA") between You
("You" as used herein means You and the business entity you represent or "Company") and Cisco
(collectively, the "Agreement"). Capitalized terms used in this SEULA but not defined will have the
meanings assigned to them in the EULA. To the extent that there is a conflict between the terms and
conditions of the EULA and this SEULA, the terms and conditions of this SEULA will take precedence.

In addition to the limitations set forth in the EULA on your access and use of the Software, you agree to
comply at all times with the terms and conditions provided in this SEULA.

DOWNLOADING, INSTALLING, OR USING THE SOFTWARE CONSTITUTES ACCEPTANCE OF
THE AGREEMENT, AND YOU ARE BINDING YOURSELF AND THE BUSINESS ENTITY THAT
YOU REPRESENT TO THE AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF
THE AGREEMENT, THEN CISCO IS UNWILLING TO LICENSE THE SOFTWARE TO YOU AND
(A) YOU MAY NOT DOWNLOAD, INSTALL OR USE THE SOFTWARE, AND (B) YOU MAY
RETURN THE SOFTWARE (INCLUDING ANY UNOPENED CD PACKAGE AND ANY WRITTEN
MATERIALS) FOR A FULL REFUND, OR, IF THE SOFTWARE AND WRITTEN MATERIALS ARE
SUPPLIED AS PART OF ANOTHER PRODUCT, YOU MAY RETURN THE ENTIRE PRODUCT
FOR A FULL REFUND. YOUR RIGHT TO RETURN AND REFUND EXPIRES 30 DAYS AFTER
PURCHASE FROM CISCO OR AN AUTHORIZED CISCO RESELLER, AND APPLIES ONLY IF
YOU ARE THE ORIGINAL END USER PURCHASER.

For purposes of this SEULA, the Product name and the Product description You have ordered is any of
the following Cisco Systems Email Security Appliance ("ESA"), Cisco Systems Web Security Appliance
("WSA") and Cisco Systems Security Management Application ("SMA") (collectively, "Content
Security") and their Virtual Appliance equivalent ("Software"):

Cisco AsyncOS for Email

Cisco AsyncOS for Web

Cisco AsyncOS for Management
Cisco Email Anti-Spam, Sophos Anti-Virus
Cisco Email Outbreak Filters
Cloudmark Anti-Spam

Cisco Image Analyzer

McAfee Anti-Virus

Cisco Intelligent Multi-Scan
Cisco RSA Data Loss Prevention
Cisco Email Encryption

Cisco Email Delivery Mode
Cisco Web Usage Controls

Cisco Web Reputation

Sophos Anti-Malware

Webroot Anti-Malware
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McAfee Anti-Malware

Cisco Email Reporting

Cisco Email Message Tracking

Cisco Email Centralized Quarantine

Cisco Web Reporting

Cisco Web Policy and Configuration Management

Cisco Advanced Web Security Management with Splunk
Email Encryption for Encryption Appliances

Email Encryption for System Generated Bulk Email
Email Encryption and Public Key Encryption for Encryption Appliances
Large Attachment Handling for Encryption Appliances

Secure Mailbox License for Encryption Appliances

Definitions

For purposes of this SEULA, the following definitions apply:

"Company Service" means the Company's email, Internet, security management services provided to
End Users for the purposes of conducting Company's internal business.

"End User" means: (1) for the WSA and SMA, the employee, contractor or other agent authorized by
Company to access the Internet and the SMA via the Company Service; and (2) for the ESA, the email
boxes of the employees, contractors, or other agent authorized by Company to access or use the email
services via the Company Service.

"Ordering Document" means the purchase agreement, evaluation agreement, beta, pre-release agreement
or similar agreement between the Company and Cisco or the Company and a Cisco reseller, or the valid
terms of any purchase order accepted by Cisco in connection therewith, containing the purchase terms
for the Software license granted by this Agreement.

"Personally Identifiable Information" means any information that can be used to identify an individual,
including, but not limited to, an individual's name, user name, email address and any other personally
identifiable information.

"Server" means a single physical computer or devices on a network that manages or provides network
resources for multiple users.

"Services" means Cisco Software Subscription Services.

"Service Description" means the description of the Software Subscription Support Services at
http://www.cisco.com/web/about/doing_business/legal/service_descriptions/index.html

"Telemetry Data" means samples of Company's email and web traffic, including data on email message
and web request attributes and information on how different types of email messages and web requests
were handled by Company's Cisco hardware products. Email message metadata and web requests
included in Telemetry Data are anonymized and obfuscated to remove any Personally Identifiable
Information.

"Term" means the length of the Software subscription You purchased, as indicated in your Ordering
Document.

"Virtual Appliance" means the virtual version of Cisco's email security appliances, web security
appliances, and security management appliances.
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Appendix D End User License Agreement |

Supplemental End User License Agreement for Cisco Systems Content Security Software

"Virtual Machine" means a software container that can run its own operating system and execute
applications like a Server.

Additional License Terms and Conditions
LICENSE GRANTS AND CONSENT TO TERMS OF DATA COLLECTION

License of Software.

By using the Software and the Documentation, Company agrees to be bound by the terms of this
Agreement, and so long as Company is in compliance with this Agreement, Cisco hereby grants to
Company a nonexclusive, non-sublicensable, non-transferable, worldwide license during the Term to use
the Software only on Cisco's hardware products, or in the case of the Virtual Appliances, on a Virtual
Machine, solely in connection with the provision of the Company Service to End Users. The number of
End Users licensed for the use of the Software is limited to the number of End Users specified in the
Ordering Documents. In the event that the number of End Users in connection with the provision of the
Company Service exceeds the number of End Users specified in the Ordering Documents, Company
shall contact an Approved Source to purchase additional licenses for the Software. The duration and
scope of this license(s) is further defined in the Ordering Document. The Ordering Document supersedes
the EULA with respect to the term of the Software license. Except for the license rights granted herein,
no right, title or interest in any Software is granted to the Company by Cisco, Cisco's resellers or their
respective licensors. Your entitlement to Upgrades to the Software is subject to the Service Description.
This Agreement and the Services are co-terminus.

Consent and License to Use Data.

Subject to the Cisco Privacy Statement at http://www.cisco.com/web/siteassets/legal/privacy.html,
Company hereby consents and grants to Cisco a license to collect and use Telemetry Data from the
Company. Cisco does not collect or use Personally Identifiable Information in the Telemetry Data. Cisco
may share aggregated and anonymous Telemetry Data with third parties to assist us in improving your
user experience and the Software and other Cisco security products and services. Company may
terminate Cisco's right to collect Telemetry Data at any time by disabling SenderBase Network
Participation in the Software. Instructions to enable or disable SenderBase Network Participation are
available in the Software configuration guide.

Description of Other Rights and Obligations

Please refer to the Cisco Systems, Inc. End User License Agreement, Privacy Statement and Service
Description of Software Subscription Support Services.
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see also W3C access logs
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access logs
header format specifier 21-36
Access Policies 9-5

and URL category changes 9-5
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URL filters 10-8
ACL decision tags
access log file 21-16
Active Directory  5-1
adding
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WCCP service 2-19
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known allowed address 20-2
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adminaccessconfig command
overview 22-11
adult content
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Advanced Malware Protection 14-1
MONITOR_AMP_RESP 21-19
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alert listing  22-16
alerts
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severities  22-14
alert types 22-14
ambiguous address
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AMP. See Advanced Malware Protection.

AMW

see anti-malware
anonymizing

usernames in reports  18-1
anti-malware

access log file 13-14

configuring 13-8

database 13-14

outbound scanning 12-1

overview 13-4

rules for L4 Traffic Monitor 20-2

scanning verdicts 21-37
anti-malware rules

L4 Traffic Monitor 20-2
anti-malware scanning

outbound 12-1
application behaviors
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application control
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configuring 15-3,15-5

instant messaging traffic 15-8
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limiting 15-5
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overview 15-5
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see known malware address

blocking
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applications 15-5

HTTPS traffic 11-9
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upload requests  16-2
upload requests due to AVC engine 15-3
upload requests due to malware 12-1
URL categories 16-8
user experience 12-1,15-3, 16-2
browsers
see web browsers
bypassing
decryption A-7

upload requests from scanning 16-2
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caching 13-14
capturing network packets
overview A-16

case-sensitivity

in CLI B-3
categories
adult 9-23

advertisements  9-23
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arts  9-24

astrology 9-24
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business and industry 9-24
chat and instant messaging 9-24
cheating and plagiarism 9-24
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computers and internet  9-24
computer security 9-24
dating 9-24
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education 9-25
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parked domains 9-28

peer file transfer 9-28
personal sites 9-28
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professional networking 9-29
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reference 9-29

religion 9-29
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search engines and portals 9-29
sex education 9-29
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social networking 9-29
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software updates 9-29
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streaming audio 9-30
streaming video 9-30
tobacco 9-30
transportation  9-30
travel 9-30

unclassified 9-30
weapons  9-30
web-based email 9-30
web hosting  9-30

web page translation 9-30

category filtering

database 9-3

certificate files

supported formats 11-5
uploading 11-7

certificates

CSR for HTTPS Proxy 11-8

CSR for Identity Provider for SaaS 7-3
CSR for web interface 22-27

FIPS 22-22

generating and signing your own 22-27
invalid 11-8

validating 11-6

Certificate Signing Request (CSR)

for HTTPS Proxy 11-8
for Identity Provider for SaaS 7-3

for web interface 22-27
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Change Password link  22-8
changing passwords 22-8
Cisco ASA integration
overview 10-18
Cisco Cloud Web Security
guest users  3-11
Cisco Data Security Policies
and URL category changes 9-5
Cisco IronPort Data Security Policies
see Data Security Policies
user location of request  16-7
Cisco Web Usage Controls
overview 9-1
CLI
case-sensitivity in  B-3
configuring host keys 21-13
configuring languages 22-10
overview B-1
SSH B-1
Client Signing Required 5-13, 5-15, 5-16
Cloud Connector
authentication failures 3-11

Cloud Web Security Connector

FTP 3-8
cloud connector settings 3-6
cloud routing policies 3-8

Cloud Web Security Connector

HTTPS 3-8

compared to standard mode 3-1

Configuring 3-5

data loss prevention 3-9

directory group policies 3-8

documentation 3-4

logging 3-9

user authentication 3-10
commit command B-4

community string

SNMP 22-35
compression

log file archives 21-9, 21-12
configuring 2-17

administrator settings 22-11

application control settings 15-3

HTTPS Proxy 11-3

URL filters 9-9

Web Reputation Filters 13-12
configuring the appliance

anti-malware 13-8

browser requirements  1-2

enabling features 22-3

network interfaces 2-12

reporting  18-1

scheduling reports 18-7
content filtering

Cisco IronPort Data Security Policies
controlling applications

overview 15-1
controlling bandwidth

overall limits  15-6

overview 15-5

user limits  15-6
control settings

Decryption Policies 11-4
creating

Cisco IronPort Data Security Policies

External DLP Policies 16-5

log subscriptions  21-7

Outbound Malware Scanning Policies
CSS

in end-user notification pages 17-10
custom

date ranges 18-2

end-user notification pages 17-12

headers 21-36

URL categories 9-13

redirecting traffic 9-17

16-8

16-5

12-3

[l AsyncO0S 9.1 for Cisco Web Security Appliances User Guide



custom mask for load balancing 2-21
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data loss prevention
see Outbound Malware Scanning Policies
Data Loss Prevention Policies, External 9-5
datasecurityconfig
CLI command 16-2
Data Security logs
overview 16-12
Data Security Policies
configuring 16-7
content 16-8
creating 16-5
flow diagram 16-8
logging 16-12
membership 16-4
minimum request size 16-2
protocol of request  16-6
proxy port of request  16-6
subnet of request  16-6
URL category of request 16-6
URL filters 16-8
user agent of request  16-7
Web Reputation  16-8
Data Security Policies, Cisco 9-5
decrypting
HTTPS traffic 11-2
decrypting HTTPS traffic
configuring Decryption Policies 11-1
decryption
bypassing A-7
Decryption Policies 9-5
and URL category changes 9-5
blocking 11-9
bypassing decryption A-7
controlling traffic 11-4

control settings  11-4

decrypting traffic 11-1
dropping traffic 11-1
enabling 11-3
logging A-8
Monitor action 11-2
overview 11-2
passing through traffic 11-1
Decryption Policy groups
see also policy groups
default gateway 2-17
default identity  6-1
default route
configuring 2-17
defining
user preferences 22-10
DLP servers
defining 16-9
failover 16-10
DNS
authoritative name servers 2-26
configuring 2-26
split  2-26
DNS cache
flushing 2-26
dropping traffic
Decryption Policies 11-1
DVS engine
how it works 13-4
working with multiple malware verdicts
Dynamic Content Analysis engine
enabling 9-4
Dynamic Vectoring and Streaming engine

see DVS engine
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editing
WCCP service 2-19
editing the appliance
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overview 17-2
end-user notification pages
customizing 17-12
formatting text 17-10
HTML tags 17-10
native FTP  17-9
on-box notification pages 17-6
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variables 17-12
end-user URL category page
configuring 17-9
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etherconfig command
VLAN 2-22
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matching client requests 16-4
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evaluating Outbound Malware Scanning membership
matching client requests 12-2
expired keys
overview A-4
exporting
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External Data Loss Prevention
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CLI command 16-2
External DLP Policies
configuring 16-11
creating 16-5
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load balancing 16-10
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proxy port of request  16-6
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user agent of request  16-7
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see DLP servers
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failover
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overview 22-3
settings 22-4
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Federal Information Processing Standards (FIPS)
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file reputation filtering 14-1
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certificate requirements  22-22
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mode 22-22
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L2 221
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generating

root certificates  11-3
global identity 6-1
greylist address

see ambiguous address

grouping, of appliances for File Analysis result details in

the cloud 14-9
GUI
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hard power reset 22-5
hardware issues, troubleshooting A-6
hash versus mask for load balancing 2-21
headers

custom 21-36
heuristic analysis

McAfee scanning engine 13-6
hostkeyconfig command 21-13
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HTTPS

bypassing decryption A-7

end-user acknowledgement page 17-3

logging A-8
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HTTPS Proxy

configuring 11-3
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and URL category changes

installation
reverting 22-33

installing the appliance

setup worksheet 2-4

instant messaging traffic

controlling 15-8

interfaceconfig command

VLAN 2-23
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signing, leaf certificate

invalid certificates
handling 11-8
IP spoofing

WCCP service 2-22

11-8

9-5

IPv4 2-13
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IPv6 2-13
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Kerberos 5-1
key files
supported formats
keys
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defined 20-2
known malware address
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forwarding method 2-21

L4 Traffic Monitor
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